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L E E S W I J Z E R

Hoe deze handleiding te lezen

Elke vermelding in de handleiding volgt hetzelfde schema. Aan de linkerkant staan de 
bedieningspaden en technische details, rechts in een warme zijbalk vind je altijd de 
eenvoudige uitleg. Kleine pictogrammen aan het begin van de regel verraden je in één 
oogopslag welk soort informatie nu volgt.

D E  V I E R  P I CTO G R A M M E N

Waar vind ik dat? Het concrete klikpad door de app — menubalk, Inspector-
sectie of stap in de beginnersmodus. Ook de bijbehorende toetscombinaties 
staan hier. Het pictogram is een kaartspeld en laat zien: hier zit de functie in de 
gebruikersinterface.

Details. Standaardwaarden, waardebereiken en codepaden. Kom je vooral tegen 
bij de trainingsinstellingen, die geen menu-item zijn, maar numerieke parameters. 
Het pictogram toont een kleine specificatiekaart.

Technisch. Wat de functie intern doet, welke parameters effect hebben, waarop 
ze reageren en welke neveneffecten ze hebben. Voor lezers die willen begrijpen 
wat er op de achtergrond gebeurt. Het pictogram is een blok met schuifregelaars 
en staat symbolisch voor de instellingen onder de motorkap.

Eenvoudig gezegd. De kernboodschap in heldere woorden — zonder vaktaal, 
zonder code. Lees dit gedeelte eerst als je alleen snel wilt weten waarvoor een 
functie dient en wanneer je hem nodig hebt. Het pictogram is een tekstballon en 
staat voor “to the point gebracht”. Deze kolom heeft altijd een warme zandkleu
rige achtergrond, zodat het oog hem meteen vindt.

H O O F D S T U K K L E U R E N

Elk hoofdstuk heeft zijn eigen accentkleur, die je aan het ID-label (bijvoorbeeld M1 ) 
links van elke vermeldingstitel en aan de kleine pictogrammen ervoor herkent. Bij het 
bladeren zie je zo meteen in welk hoofdstuk je bent.

1 Menu's 2 Inspector 3 Instellingen 4 Hulpvensters 6 Training

7 Voorinstellingen 8 Exports 9 SfM 10 Beginnersmodus



N AV I G AT I E T I P S

Snelle start. Als alleen de bediening je interesseert, spring direct naar Hoofd­
stuk 10 — Beginnersmodus. Dat is de begeleide variant met vier stappen en 
heeft geen enkele voorkennis nodig.

Diepere instap. Hoofdstuk 2 — Inspector en Hoofdstuk 7 — Voorinstellingen 
leggen de bedieningselementen en voorgeconfigureerde kwaliteitsprofielen uit, 
die je in de expertmodus tot je beschikking hebt.

Opzoeken. Inhoudsopgave en PDF-volledige-tekst-zoekfunctie helpen om een 
bepaalde functie te vinden. Je hoeft de handleiding niet van voor naar achteren te 
lezen.



R A D I A N C E K I T

H O O F D S T U K

Inleiding — Wat je moet weten

Wat is RadianceKit?

RadianceKit is een native macOS-app die van een reeks gewone foto’s of een video 
een begaanbare 3D-reconstructie maakt. De invoer bestaat bijvoorbeeld uit 50 tot 500 
opnames die je rond een object, door een ruimte of over een landschap hebt gemaakt. 
De uitvoer is een zogenoemde Gaussian-Splatting-scène — een 3D-model dat je op 
de Mac in realtime vanuit elk perspectief kunt bekijken, dat je kunt exporteren en op 
websites kunt insluiten en dat er in de hoofdaspecten fotorealistisch uitziet.

De app draait volledig lokaal op je Mac — er worden geen beelden naar de cloud 
geüpload, er wordt geen login gevraagd, geen abonnement. Hij benut de GPU van je 
Apple-Silicon-Mac (M-serie) intensief: een volledige training kan afhankelijk van scène 
en voorinstelling tussen twee minuten en meerdere uren duren. Tijdens de berekening 
kun je op de Mac gewoon verder werken, RadianceKit draait op de achtergrond door en 
meldt zich wanneer het resultaat klaar is.

Er zijn twee bedieningsmodi: de Beginnersmodus (Simple Mode) leidt je in vier stappen 
door de workflow Import → Voorinstellingen kiezen → Training → Export. De Expertmo­
dus (Expert Mode) opent een grote Inspector met alle instellingen, een live-voorbeeld
venster en diagnose-grafieken. Je kunt op elk moment tussen de modi wisselen; de 
gegevens in de scène blijven daarbij behouden.

Wat is Gaussian Splatting?

Gaussian Splatting (vaak afgekort tot 3DGS of gewoon Splatting) is een relatief nieuwe 
methode voor fotorealistische 3D-weergave, voorgesteld in 2023 in een paper uit Graz 
en INRIA. Het idee: in plaats van een scène als klassiek polygonen-netwerk (driehoe
ken) of als voxel-rooster te modelleren, wordt hij samengesteld uit miljoenen kleine, 
zachte 3D-wolkjes — elk afzonderlijk wolkje is een 3D-Gauss-verdeling (vandaar de 
naam) met eigen positie, grootte, vorm, kleur en doorzichtigheid. Deze wolkjes worden 
zo getraind dat ze vanuit alle gezichtspunten van je invoerfoto’s samen het juiste beeld 
opleveren.
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R A D I A N C E K I T Inleiding — Wat je moet weten

In de praktijk betekent dat: Gaussian Splatting kan reflecties, glanslichten, zacht gebla
derte, haar of gordijnen zo weergeven, zoals klassiek 3D-modelleren dat niet of alleen 
met immense inspanning kan. In ruil daarvoor is het resultaat geen bewerkbaar 3D-
model in de klassieke zin — je kunt niet zomaar een enkele muur verschuiven of een 
vaas verzetten. Het is eerder een bevroren opname van de ruimte, waardoor je je vrij 
kunt bewegen. Voor veel toepassingen — architectuur- visualisatie, productpresentatie, 
virtuele tours, forensiek, cultureel erfgoed — is dat juist de juiste sterkte.

Om uit de invoerbeelden een 3D-scène te maken, zijn twee stappen nodig. Eerst bere
kent de app via een methode genaamd Structure-from-Motion (SfM) waar je camera bij 
elke foto heeft gestaan. Daarbij ontstaat tegelijk een grove puntenwolk van de scène. 
Vervolgens start de eigenlijke Gaussian-Splatting-training: uitgaande van deze grove 
wolk worden de miljoenen 3D-wolkjes stapsgewijs verdeeld, vergroot, verfijnd en in 
positie en kleur bijgeregeld, tot ze vanuit alle invoer-gezichtspunten het passende beeld 
opleveren.

Je hoeft van beide niets te weten om RadianceKit te gebruiken. De beginnersmodus 
blendt deze stappen volledig uit. Maar als je wilt begrijpen wat de diagnose-getallen 
in de expertmodus (iteratie, loss, Gaussians, SSIM …) betekenen of waarom sommige 
scènes mooier worden dan andere, dan vind je in de latere hoofdstukken van de hand
leiding de antwoorden.
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R A D I A N C E K I T Inleiding — Wat je moet weten

H O O F D S T U K

Hoofdstuk 1 — Menubalk

De menubalk van RadianceKit groepeert alle functies die niet direct in het hoofdvenster 
of in de Inspector zitten. Dat zijn in eerste instantie acties die op de hele scène 
werken (openen, opslaan, nieuw project), de training aansturen (start, pauze, hervat
ten), het viewport bedienen (auto-rotatie, screenshot, achtergrondkleur) en exports in 
verschillende 3D- en mediaformaten activeren. Daarnaast komen springpunten naar alle 
hulpvensters (User Guide, Pareto Dashboard, Holdout Analysis, BayesOpt Console).

Toetscombinaties staan steeds rechts van het menu-item. Conventies: ⌘  betekent 
de Command-toets (appel-toets), ⇧  is Shift, ⌥  is Option (Alt) en ⌃  is Control. Voor
beeld: ⇧⌘T  staat voor Shift+Command+T. Alle hier gedocumenteerde toetscombinaties 
zijn via Help → Keyboard Shortcuts (⌘/​) bovendien in een eigen overzichtsvenster 
opgesomd.

De volgende 42 items zijn in de volgorde van de inventaris (M1–M42) gedocumenteerd, 
gegroepeerd naar het bijbehorende top-level-menu. Alle items werden tegen de actuele 
code-stand in (regels 175–477) geverifieerd. Geen items zijn verwijderd of ten opzich
te van de inventaris achterhaald; een nieuw Edit-menu-item (Cmd-Z voor „Remove 
Image“) wordt door het systeem-NSUndoManager-framework opgenomen en verschijnt 
daarom niet in de RadianceKitApp-code (zie opmerking aan het einde van het hoofd
stuk).
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File-menu

Afbeelding 1:  Bestand-menu uitgeklapt — items M1 tot M6

Het File-menu vervangt Apple’s standaard „New Window“-item door projectspecifieke 
acties. Het omvat scènes laden/opslaan, een dynamische recent-lijst, de workspace-
import en het harde terugzetten naar een lege toestand.

M1 File > Open Scene…

WA A R

Menubalk → File → Open Scene… (⌘O).

T E C H N I S C H

Opent een bestandsdialoog voor de formaten 
RadianceScene -bundle, .ply , .splat  en .spz . 

Single-selection, kan zowel bestanden als directo
ries tonen (voor het bundle-formaat). Na succes
volle selectie wordt het pad in de recent-lijst opge
nomen en de scène asynchroon geladen — de 
voorgaande wordt vervangen en de trainingspipe
line met de geladen toestand geïnitialiseerd. PLY/
SPZ/splat-bestanden worden via de respectieve for
maat-loaders gelezen; het .radiancescene -bundle 
is een directory met manifest, cloud-snapshot en 
SfM-resultaten.

E E N VO U D I G  G E Z E G D

Zo laad je een reeds getrainde 
scène weer in de app. Werkt 
met het RadianceKit-eigen for
maat en met de standaardforma
ten PLY, SPLAT en SPZ die andere 
splatting-programma’s produce
ren. Gebruik dit als je bijv. een 
scène ‘s nachts hebt getraind en 
de volgende dag wilt doorgaan 
of exporteren. Bij het openen 
wordt de huidige stand in het 
hoofdvenster vervangen — sla 
dus eerst op als de huidige scè
ne nog belangrijk voor je is. Het 
pad komt automatisch in „Open 
Recent“ (M3) terecht, zodat je 
de volgende keer sneller toegang 
hebt.
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M2 File > Save Scene…

WA A R

Menubalk → File → Save Scene… (⌘S).

T E C H N I S C H

Opent een bestand-opslaan-dialoog met de con
tent-type RadianceScene -bundle en voorafingevul
de bestandsnaam scene.radiancescene. Schrijft een 
directory-pakket met manifest.json , de geseri
aliseerde Gaussian-cloud (PLY-snapshot) en een 
dump van het SfM-resultaat, zodat na het hero
penen ook Continue-Training werkt. Het item is 
gedeactiveerd zolang er nog geen Gaussians be
staan. Slaat niet op in het training-logs-pad, maar 
daar waar de save-dialoog wijst — typisch onder ~/​
Documents/​.

E E N VO U D I G  G E Z E G D

Slaat je huidige scène op als 
bestand (preciezer: als pakket-
map die eruitziet als een be
stand). Pas daarna kun je de
ze scène later met „Open Sce
ne…“ (M1) weer openen. In het 
pakket komen zowel de Gaussi
an-cloud als het SfM-resultaat 
terecht, zodat je ook Continue-
Training (M12–M14) later nog 
kunt aanhangen. Zolang je nog 
geen training hebt voltooid, is 
het item grijs. De standaardnaam 
is scene.radiancescene — je 
kunt echter in de save-dialoog 
een eigen naam toekennen.

M3 File > Open Recent > [scènenaam]

WA A R

Menubalk → File → Open Recent → (lijst).

T E C H N I S C H

Dynamisch submenu dat uit een lijst van de laatst 
geopende paden (in de instellingen opgeslagen) 
wordt gegenereerd. Elk lijst-item krijgt de bestands
naam en wordt bij klik geladen. Wanneer de lijst leeg 
is, verschijnt in plaats daarvan het gedeactiveerde 
label „No Recent Scenes“. Apple-typisch houdt de 
lijst de N laatst geopende scènes vast — de begren
zing vindt plaats bij het schrijven naar de instellin
gen en niet in de menubouwer zelf.

E E N VO U D I G  G E Z E G D

Hier zie je de laatst geopende 
scènes en kun je met een klik 
weer naar binnen springen, zon
der via de bestandsdialoog te 
hoeven gaan. Als je net bent be
gonnen, is de lijst leeg en grijs in 
het menu. Elke scène die je via 
„Open Scene…“ (M1) opent, komt 
automatisch in deze lijst terecht. 
Mocht de lijst je ooit te vol wor
den of wil je hem om privacyre
denen wissen, gebruik dan „Clear 
Recent” (M4).
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M4 File > Open Recent > Clear Recent

WA A R

Menubalk → File → Open Recent → Clear Recent.

T E C H N I S C H

Leegt de recent-lijst in de instellingen. Werkt direct, 
zonder bevestigingsdialoog. Het item verschijnt al
leen wanneer er überhaupt items in de recent-lijst 
staan (het staat onder een divider na de paden).

E E N VO U D I G  G E Z E G D

Wist de lijst met laatst geopen
de scènes. Praktisch wanneer je 
met een testdataset hebt ge
speeld en de paden niet meer 
wilt zien. De scènebestanden zelf 
worden daarbij niet verwijderd — 
alleen de verwijzing in het menu. 
De actie werkt direct, zonder be
vraging; daarna verschijnt in het 
submenu „No Recent Scenes“. 
Het item verschijnt alleen wan
neer er überhaupt scènes in de 
lijst staan — bij een lege lijst is 
hij niet zichtbaar.

M5 File > Import COLMAP / Metashape Workspace…

WA A R

Menubalk → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I).

T E C H N I S C H

Opent een mapkiezer. Verwacht een map met 
de COLMAP-workspace-layout (bijv. sparse/​0/​
cameras.{bin,txt} plus images/​). Na selectie wordt 
een voorcheck van de workspace uitgevoerd — 
deze herkent de drie layouts (sparse/​0/​, sparse/​, 
root) en of de reconstructie binair ( cameras.bin ) 
of als ETH3D-tekst ( cameras.txt ) aanwezig is. Bij 
succes wordt de workspace geïmporteerd; anders 
verschijnt alleen een waarschuwing in de app-log. 
Zie ook hoofdstuk 9 „SfM-Backends“, Q6 voor de 
volledige pipeline-logica.

E E N VO U D I G  G E Z E G D

Als je Metashape, COLMAP, Rea
lityCapture of vergelijkbare soft
ware voor de camerareconstruc
tie gebruikt en een export hebt, 
laad je de map hier in. Radi
anceKit slaat dan de SfM-fase 
over en start direct met de trai
ning — dat scheelt bij grote 
scènes uren. Drag-and-drop op 
het hoofdvenster werkt hetzelf
de. Verwacht wordt een map met 
COLMAP-layout (dus sparse/​0/​ 
met cameras.*  plus images/​
-map). Meer over de ondersteun
de layouts en workflows staat in 
hoofdstuk 9 „SfM-Backends“.

8 / 230



R A D I A N C E K I T Hoofdstuk 1 — Menubalk

M6 File > New Project

WA A R

Menubalk → File → New Project (⇧⌘N).

T E C H N I S C H

Controleert of er niet-opgeslagen werk aanwezig is. 
Zo ja, verschijnt een bevestigingsdialoog voordat er 
iets verloren gaat. Wanneer er niets is om op te 
slaan, loopt het terugzetten direct — het leegt geïm
porteerde beelden, het SfM-resultaat, de Gaussian-
cloud, training-state en alle afhankelijke UI-indica
toren. Let op: een door de gebruiker aangelegde 
voorinstellingen-bibliotheek blijft behouden, omdat 
die in de app-instellingen zit en niet in de project
stand.

E E N VO U D I G  G E Z E G D

Zet alles terug naar een lege 
start — alsof je de app net op
nieuw hebt geopend. Mocht je 
nog niet-opgeslagen werk heb
ben, vraagt de app vooraf na. 
Gebruik dit als je met een ge
heel andere scène wilt beginnen. 
Geïmporteerde beelden, SfM-re
sultaat, Gaussian-cloud en trai
ningsstand worden volledig ge
leegd. Je eigen voorinstellingen 
blijven echter behouden, omdat 
die in de app-instellingen zitten 
en niet bij de scène horen.

Mode-menu

Afbeelding 2:  Modus-menu met Simple- en Expert-Mode-schakelaar

Twee eenvoudige schakelaars tussen de begeleide Simple Mode (wizard-achtig, 4 stap
pen) en de volle Expert Mode (klassieke Inspector-layout met alle regelaars).
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M7 Mode > Simple Mode

WA A R

Menubalk → Mode → Simple Mode (⌘1).

T E C H N I S C H

Schakelt de app-toestand naar de Simple Mode om. 
Het hoofdgebied van de app toont dan de begeleide 
workflow in plaats van de Expert-layout. De mode-
toestand wordt in de instellingen opgeslagen (zie S1 
„Default Mode“ in hoofdstuk 3 Instellingen).

E E N VO U D I G  G E Z E G D

Schakelt over op de stap-voor-
stap-variant waarbij de app 
je door importeren, verwerken, 
voorbeeld en export leidt. Aanbe
volen als je net begint of snel een 
resultaat nodig hebt. De mees
te detail-regelaars zijn verborgen 
— je werkt met zinvolle voorin
stellingen. Wil je later dieper in
gaan, schakel dan gewoon over 
naar de Expert Mode (M8). Welke 
modus bij de app-start actief is, 
kun je in de instellingen (hoofd
stuk 3, S1) vastleggen.

M8 Mode > Expert Mode

WA A R

Menubalk → Mode → Expert Mode (⌘2).

T E C H N I S C H

Schakelt de app-toestand naar de Expert Mode. 
Daarmee verschijnt de volledige Inspector-layout 
met alle secties (Presets, TrainingConfig, Enhance
ments, Metrics, LossChart, ProjectNavigator). In de 
Expert Mode zijn alle trainingparameters, COLMAP-
keuzes, mid-compact-toggles en diagnostics toe
gankelijk. Ook de live-preview werkt alleen in deze 
modus.

E E N VO U D I G  G E Z E G D

Schakelt naar de volledige weer
gave met alle regelaars. Hier zie 
je loss-grafieken in realtime, kun 
je alle parameters fijnafstemmen 
en meerdere vergelijkings-con
figs parallel via voorinstellingen 
beheren. Aanbevolen als je wilt 
begrijpen wat de training intern 
doet, of als je gericht wilt expe
rimenteren. Ook de live-preview, 
COLMAP-keuzes en de diagnos
tics zijn alleen hier bereikbaar. 
Voel je je overweldigd, ga via M7 
terug naar de Simple Mode — je 
scène blijft daarbij behouden.
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Training-menu

Afbeelding 3:  Training-menu met Continue-submenu — items M9 tot M14

Vier acties rond de training-run: starten, pauzeren, afbreken en met een voorgegeven 
iteratie-aantal verlengen. Alle drie Continue-items zijn via IAP-gegated (in de free-trial-
versie niet klikbaar).

M9 Training > Start Training

WA A R

Menubalk → Training → Start Training (⇧⌘T).

T E C H N I S C H

Start de trainingspipeline asynchroon. Voorwaar
de: een SfM-resultaat is aanwezig en er loopt 
momenteel geen andere pipeline. Beide voor
waarden blokkeren het item indien niet vervuld. 
Bij de start worden de actuele configuratie-
waarden gelezen, een nieuw JSONL-log onder ~/​
Documents/​RadianceKit/​Logs/​training_​YYYY-MM-DD_​

HHmmss.jsonl aangelegd, en afhankelijk van strate
gie-keuze het klassieke of het MCMC-pad gevolgd. 
De trainingsstatus wisselt van „idle“ naar „training”.

E E N VO U D I G  G E Z E G D

Druk op de grote groene knop 
— zodra je foto’s hebt geïm
porteerd en de camerarecon
structie klaar is, begint daarmee 
de eigenlijke Gaussian-Splatting-
training. Laat de app draaien; 
afhankelijk van de voorinstel
ling tussen 1 minuut (Quick) en 
meerdere uren (MCMC Quality). 
Het item blijft grijs zolang er 
nog geen SfM-resultaat is of er 
momenteel een andere pipeline 
loopt. Elke run schrijft tussen
door een log naar ~/​Documents/​
RadianceKit/​Logs/​ die je later 
via het Pareto Dashboard (M40) 
kunt analyseren.
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M10 Training > Pause Training

WA A R

Menubalk → Training → Pause Training.

T E C H N I S C H

Pauzeert de lopende training. Wordt alleen vrij
gegeven wanneer de trainingsstatus „training“ is. 
Pauzeren stopt de iteratie-loop bij het volgende 
veiligheids-sync-point, behoudt de volle GPU-state 
(Gaussian-buffers, optimizer-moments, scheduler-
positie) en schakelt naar „paused”. Hervatten ge
beurt door opnieuw te drukken (de item-titel is 
statisch — de app wisselt echter in de eigenlijke 
logica tussen pauze/hervatten). Gepauzeerde trai
ningen overleven geen app-quit; in dat geval beter 
de scène opslaan en later via het Continue-Training-
item (M12–M14) uitbreiden.

E E N VO U D I G  G E Z E G D

Houdt de training even stil, zon
der de voortgang te verliezen. 
Praktisch wanneer je de compu
ter kort voor iets belangrijkers 
nodig hebt. Nog een keer klikken 
hervat. Werkt niet over app-her
starts heen — wil je echt later 
doorgaan, beëindig de training 
met Cancel (M11), sla de scène op 
met Save Scene (M2) en gebruik 
daarna Continue Training (M12–
M14). Tijdens de pauze rust de 
GPU volledig; het geheugen blijft 
echter bezet.

M11 Training > Cancel Training

WA A R

Menubalk → Training → Cancel Training.

T E C H N I S C H

Breekt de lopende training af. Actief wanneer de 
trainingsstatus niet „idle“ is. Zet de cancel-flag in 
de trainingsengine, wat de iteratie-loop bij het vol
gende sync-point netjes beëindigt, het finale sum
mary-item meeschrijft naar het JSONL-log en de 
status terugzet op „idle”. De tot dusver getrainde 
cloud blijft behouden (kan worden opgeslagen of 
geëxporteerd), maar wordt als „cancelled“ gemar
keerd.

E E N VO U D I G  G E Z E G D

Breekt de lopende training defi
nitief af. De huidige stand blijft 
— als je dus na een paar duizend 
iteraties al een toonbaar resul
taat hebt, kun je het daarna toch 
exporteren. Wil je alleen even on
derbreken, gebruik dan in plaats 
daarvan Pause (M10). In het trai
ningslog wordt de run als „can
celled“ gemarkeerd, de finale 
loss-waarde wordt toch wegge
schreven. Een afgebroken scène 
kun je ook via Continue Training 
(M12–M14) later voortzetten, zo
lang de app tussendoor niet werd 
afgesloten.
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M12 Training > Continue Training > +5.000 iterations

WA A R

Menubalk → Training → Continue Training → +5,000 
iterations.

T E C H N I S C H

Hervat de training met 5.000 iteraties. Actief wan
neer een afgeronde training kan worden voortgezet 
en de volledige versie is ontgrendeld. De voort
zetbaarheid geldt wanneer een afgeronde training 
bestaat en de volledige optimizer-state nog in het 
geheugen zit. Bij Continue worden de Adam-mo
ments en de LR-scheduler voortgezet, zodat de 
voortzetting zich gedraagt als een doorlopende 
25K-/45K-/60K-run in plaats van een herstart. Het 
JSONL-log krijgt een nieuwe config-entry met de 
incrementele setup. Alleen in de volledige versie be
schikbaar.

E E N VO U D I G  G E Z E G D

Hangt 5.000 extra trainingstap
pen aan. Gebruik dit als het re
sultaat na de eerste run dichtbij, 
maar nog niet helemaal scherp 
is. Werkt alleen in de betaal
de volledige versie. In tegenstel
ling tot een volledig nieuwe run 
blijft de optimizer-toestand be
houden, zodat de voortzetting 
aanvoelt als een doorlopende 
run. Heb je meer dan 5.000 stap
pen nodig, neem dan meteen M13 
(+10.000) of M14 (+20.000).

M13 Training > Continue Training > +10.000 iterations

WA A R

Menubalk → Training → Continue Training → 
+10,000 iterations.

T E C H N I S C H

Identiek aan M12, maar met 10.000 extra iteraties. 
Zelfde voorwaarden, zelfde LR-scheduler-pad. Aan
bevolen wanneer de initiële training met een mid-
tier-voorinstelling werd gedraaid en je een signifi
cante kwaliteitsverbetering wilt zien zonder de run 
volledig opnieuw te starten.

E E N VO U D I G  G E Z E G D

Verlengt de training met 10.000 
stappen — de middelste van de 
drie beschikbare Continue-waar
den. Goede keuze wanneer de 
eerste run weliswaar oké was, 
maar je toch duidelijk beter wilt 
worden. Net als M12 en M14 
wordt het leerratio-verloop naad
loos voortgezet, in plaats van op
nieuw te beginnen. Alleen in de 
volledige versie beschikbaar.
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M14 Training > Continue Training > +20.000 iterations

WA A R

Menubalk → Training → Continue Training → 
+20,000 iterations.

T E C H N I S C H

Identiek aan M12 / M13, maar met 20.000 extra ite
raties. De grootste vooraf gedefinieerde Continue-
sprong. Bij MCMC-trainingen is dit vaak wat het 
verschil maakt tussen „klopt“ en „benchmark-waar
dig”; bij Classic vanaf 35–40K komt ervaringsgewijs 
weinig bij.

E E N VO U D I G  G E Z E G D

Hangt 20.000 extra trainingstap
pen aan, de maximale Continue-
waarde. Gebruik dit als je werke
lijk het laatste beetje kwaliteit 
eruit wilt halen. Bij klassieke trai
ning na 40.000 stappen levert 
dat vaak niet veel meer op — 
bij MCMC daarentegen loont het 
vaak, omdat daar de convergen
tie langzamer inzet. Reken al 
naar gelang scène met aanzien
lijke extra looptijd. Net als M12 
en M13 is ook dit item alleen in 
de volledige versie beschikbaar.

Viewport-menu

Afbeelding 4:  Weergavevenster-menu met Edit-Mode, camerabesturing en achtergrond-
submenu

Stuurt het 3D-viewport: Edit-Mode voor Gaussian-selectie en cleanup, camerabesturing 
(auto-rotatie, playback, recording), screenshot, achtergrondkleur en reset.
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M15 Viewport > Enter/Exit Edit Mode

WA A R

Menubalk → Viewport → Enter Edit Mode (of „Exit 
Edit Mode“, afhankelijk van toestand). ⇧⌘E.

T E C H N I S C H

De item-titel is dynamisch en toont afhankelijk van 
toestand „Exit Edit Mode“ of „Enter Edit Mode”. Bij 
het drukken wordt de Edit Mode op de viewport-
renderer omgeschakeld. Bij het verlaten van de Edit 
Mode wordt bovendien de huidige selectie terug
gezet. De Edit Mode activeert de klik-selectie op 
Gaussians, de box-selectie en het verwijderen van 
gemarkeerde Gaussians (zie editor-gebied van de 
UI). Gedeactiveerd zolang geen viewport-renderer 
is gekoppeld.

E E N VO U D I G  G E Z E G D

Schakelt tussen normaal 3D-aan
zicht en een bewerkingsmodus 
waarin je afzonderlijke Gaussi
ans kunt markeren en verwij
deren (bijvoorbeeld floaters of 
uitschieters in de achtergrond). 
Bij het verlaten wordt de selec
tie automatisch teruggezet. Het 
item blijft grijs zolang er nog 
geen scène in het viewport zicht
baar is. Het opschrift wisselt 
afhankelijk van toestand tussen 
„Enter Edit Mode“ en „Exit Edit 
Mode” — je ziet dus altijd in wel
ke modus je bent.

M16 Viewport > Toggle Auto-Rotation

WA A R

Menubalk → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T E C H N I S C H

Schakelt de continue rotatie van de viewport-ca
mera om een verticale as door het scènecentrum 
aan of uit. De as en snelheid komen uit de came
rabesturings-configuratie. Auto-rotatie is een puur 
viewport-effect en beïnvloedt noch training noch 
recording — gebruik je parallel de turntable-video-
recorder (M18), levert de auto-rotatie echter precies 
het pad op dat de recorder vastlegt.

E E N VO U D I G  G E Z E G D

Draait de camera continu lang
zaam om je scène, zodat je hem 
van alle kanten kunt zien zon
der met de muis te slepen. Nog 
een keer klikken stopt de rota
tie. Praktisch bij beoordeling van 
afgewerkte scènes of als achter
grondanimatie voor een live-de
mo. Neem je parallel een video 
op (M18), levert de auto-rotatie 
precies de beweging op die de 
recorder vastlegt.
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M17 Viewport > Toggle Camera Playback

WA A R

Menubalk → Viewport → Toggle Camera Playback.

T E C H N I S C H

Schakelt de camera-pad-playback om. Wanneer 
een opgenomen camerapad bestaat (bijv. uit een 
vorige recording of doordat een transforms.json  
is geladen), loopt het pad af — de viewport-camera 
beweegt dus niet meer op muis-/trackpad-invoeren, 
maar reproduceert het traject frame voor frame. 
Opnieuw drukken pauzeert de playback.

E E N VO U D I G  G E Z E G D

Laat een eerder opgenomen of 
geïmporteerde camerabeweging 
aflopen. Zo kun je het oorspron
kelijke pad nalopen waarmee de 
scène werd opgenomen, of een 
geplande orbit-beweging vóór de 
video-export controleren. Terwijl 
de playback loopt, zijn muis- en 
trackpad-invoeren uitgeschakeld 
— de camera volgt strikt het 
pad. Opnieuw klikken pauzeert 
de weergave. Heb je geen ca
merapad geladen of opgenomen, 
gebeurt er niets.

M18 Viewport > Record Turntable Video

WA A R

Menubalk → Viewport → Record Turntable Video.

T E C H N I S C H

Schakelt de viewport-opname om. Bij de eerste 
druk start een frame-opname naar een tijdelijk pad; 
bij de tweede druk wordt de opname beëindigd, 
geëncodeerd en in een MP4-pad geschreven (pad 
wordt via een save-dialoog opgevraagd). In tegen
stelling tot Export → Media → Orbit Video (M31), 
dat een vast 360°-pad bij een instelbare duur gene
reert, neemt de turntable-recorder live op wat je in 
het viewport ziet — je kunt dus ook een handmatige 
camerabeweging opnemen.

E E N VO U D I G  G E Z E G D

Neemt direct in het viewport een 
video op. Of de camera automa
tisch draait of je hem zelf met 
de muis beweegt — alles wat 
je ziet, wordt in een MP4-be
stand opgeslagen. In tegenstel
ling tot de „Orbit Video“-export 
(M31) bepaal je zelf de camera
beweging. Eerste klik start de 
opname, tweede klik beëindigt 
hem en vraagt je naar de op
slaglocatie. Praktisch wanneer je 
bijv. een bepaalde detailpan wilt 
tonen die met de starre orbit-be
weging niet mogelijk zou zijn.
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M19 Viewport > Save Screenshot

WA A R

Menubalk → Viewport → Save Screenshot (⇧⌘S).

T E C H N I S C H

Legt een enkele viewport-frame in volledige ren
der-resolutie vast (dus niet de venster-pixel-layout, 
maar de volle render-target-inhoud) als PNG-be
stand. Het pad wordt via een save-dialoog opge
vraagd. Achtergrondkleur (M21–M23) wordt mee 
ingebrand. MetalFX-/MPS-upscaling-instellingen uit 
de Enhancements (zie I27/I28) werken mee wanneer 
actief — de screenshot toont dus de opgeschaalde 
output.

E E N VO U D I G  G E Z E G D

Slaat een momentopname van je 
huidige 3D-aanzicht op als PNG-
beeld. Praktisch voor marketing
materiaal of een snelle vergelij
king. Let op: de achtergrond is 
onderdeel van het beeld — heb 
je transparantie nodig, exporteer 
dan beter een scènebestand. 
De resolutie komt overeen met 
de interne render-target, niet 
je venstergrootte — het beeld 
is dus vaak scherper dan het 
in het venster oogt. Eventuele 
upscaling-instellingen (Inspector 
→ Enhancements) vloeien even
eens mee in.

M20 Viewport > Copy Camera Info

WA A R

Menubalk → Viewport → Copy Camera Info.

T E C H N I S C H

Leest de huidige viewport-camerapose (positie, 
look-at-punt, up-vector) en de FOV-waarden uit 
de camerabesturing en schrijft ze als meerregelige 
tekst naar het klembord. Formaat is mensleesbaar 
(label = waarde per regel), geen JSON. Praktisch 
om een specifiek aanzicht voor debug-doeleinden 
te reproduceren of met support te delen.

E E N VO U D I G  G E Z E G D

Kopieert de huidige cameraposi
tie en kijkrichting als tekst naar 
het klembord. Wil je bijv. een 
mede-ontwikkelaar tonen vanuit 
waar een plek in de scène 
vreemd oogt, plak je de tekst 
gewoon in een mail- of chatven
ster in. Het formaat is menslees
baar (één regel per waarde), geen 
JSON. Hoofdzakelijk voor bug-
reports of supportverzoeken be
doeld.
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M21 Viewport > Background > Dark Gray

WA A R

Menubalk → Viewport → Background → Dark Gray.

T E C H N I S C H

Stelt de viewport-achtergrondkleur in op een don
kergrijs (RGB 0,1/0,1/0,1). De renderer gebruikt deze 
kleur als achtergrond waarvoor de Gaussians wor
den gecomposit. De standaardkleur bij app-start 
stuurt de settings-optie S3 „Default Viewport Back
ground“.

E E N VO U D I G  G E Z E G D

Kleurt de achtergrond van het 
3D-viewport donkergrijs. Stan
daardkeuze voor de meeste scè
nes — biedt een goed contrast 
met heldere zowel als donkere 
Gaussians, zonder dat het oog 
zich aan een puur zwart of wit 
vlak vastklauwt. De kleur wordt 
ook in screenshots (M19) en or
bit-video’s (M31) overgenomen. 
Vind je Dark Gray te onspectacu
lair, probeer dan ter vergelijking 
ook Black (M22) of White (M23). 
Welke kleur bij de app-start ac
tief is, kun je in de instellingen 
(S3) vastleggen.

M22 Viewport > Background > Black

WA A R

Menubalk → Viewport → Background → Black.

T E C H N I S C H

Stelt de viewport-achtergrondkleur in op puur zwart 
(RGB 0/0/0). Helpt wanneer de scène veel heldere 
floaters heeft en je ze wilt identificeren, of voor 
marketingmateriaal met donkere look-and-feel.

E E N VO U D I G  G E Z E G D

Zwarte achtergrond. Goed voor 
zeer heldere scènes of wanneer 
je in de Edit Mode wilt inzoomen 
en kleine heldere Gaussians (flo
aters) zoekt die in het grijs ver
dwijnen. Ook ideaal voor marke
tingmateriaal met donkere, dra
matische look. De kleur wordt in 
screenshots en orbit-video’s in
gebrand — heb je transparantie 
voor een latere compositie nodig, 
dan is zwart de slechtste keuze. 
Voor donkere floaters wissel je 
nog een keer in de andere rich
ting naar White (M23).
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M23 Viewport > Background > White

WA A R

Menubalk → Viewport → Background → White.

T E C H N I S C H

Stelt de viewport-achtergrondkleur in op puur wit 
(RGB 1/1/1). Nuttig wanneer de scène overwegend 
donkere inhoud heeft en je donkere floaters (typi
sche outdoor-achtergrondruis) wilt zien.

E E N VO U D I G  G E Z E G D

Witte achtergrond. Praktisch 
wanneer het motief licht-op-
donker beter tot zijn recht komt, 
of om donkere uitschieters te 
vinden die je daarna in de Edit 
Mode (M15) kunt verwijderen. Bij 
outdoor-scènes is wit vaak nutti
ger dan zwart, omdat de typische 
outdoor-floaters eerder donker 
zijn. Zoals bij de andere achter
grondopties wordt de kleur in 
screenshots en video’s overge
nomen.

M24 Viewport > Reset Camera

WA A R

Menubalk → Viewport → Reset Camera.

T E C H N I S C H

Reset de viewport-camera, verlaat het training-ca
mera-aanzicht en stopt de auto-rotatie. Daarmee is 
de camera terug op de initiële positie (typisch: voor 
de scène, licht van boven kijkend), de auto-rotatie 
staat uit, en als de renderer juist de training-camera 
(een van de SfM-poses) toonde, gaat hij naar de 
free-camera terug.

E E N VO U D I G  G E Z E G D

Brengt de viewport-camera weer 
in de startpositie terug. Wan
neer je tijdens het rondkijken 
verdwaald bent of de scène uit 
het beeld hebt geschoven — één 
keer hier klikken en je ziet weer 
wat je zou moeten zien. Scha
kelt tegelijk de auto-rotatie uit, 
mocht die juist lopen, en keert 
vanuit een ingevroren training-
camera terug naar de vrije weer
gave. Zo krijg je in elk geval 
een schone herstart van het aan
zicht.
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Export-menu

Afbeelding 5:  Exporteer-menu met drie submenu-groepen — 3D Formats, Media en Photo­
grammetry

Acht export-doelen plus twee photogrammetry-exports, gegroepeerd in drie secties 
(3D Formats, Media, Photogrammetry). De eerste zes worden via een gemeenschappe
lijke helper-routine gebouwd die telkens een save-dialoog opent en de export bij de 
formaatcatalogus registreert. De photogrammetry-items hebben individuele logica. Alle 
photogrammetry- en sommige 3D-exports zijn alleen in de volledige versie beschikbaar.

M25 Export > 3D Formats > Export PLY…

WA A R

Menubalk → Export → 3D Formats → PLY (⌘E).

T E C H N I S C H

Opent een save-dialoog met voorgegeven be
standsnaam gaussians.ply . Bij OK wordt de huidi
ge Gaussian-cloud in het gestandaardiseerde ASCII/
binary-PLY-formaat geschreven — compatibel met 
SuperSplat, PolyCam, PlayCanvas en alle gangbare 
3DGS-viewers. Volle SH-coëfficiënten, volle preci
sie (float32 per veld). Bestandsgrootte vaak meer
dere honderden MB bij ≥ 500K Gaussians.

E E N VO U D I G  G E Z E G D

Slaat je 3D-scène op als stan
daard-PLY-bestand. Dat is het 
meest universele formaat — bij
na elke software kan dit laden, 
van SuperSplat via PolyCam tot 
PlayCanvas. De bestanden wor
den echter groot, vaak meerdere 
honderden megabytes. Gebruik 
PLY wanneer je in volle kwaliteit 
wilt doorgaan of archiveren. Wil 
je de scène via het web delen, 
bekijk dan liever SPZ (M27) of 
Compressed PLY (M26) — die zijn 
aanzienlijk kleiner.
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M26 Export > 3D Formats > Export Compressed PLY…

WA A R

Menubalk → Export → 3D Formats → Compressed 
PLY.

T E C H N I S C H

Schrijft de Gaussian-cloud in het Compressed-PLY-
formaat met custom-kwantisatie van de position-, 
scale-, rotation- en SH-velden. 5–10× kleinere be
standen dan het ongecomprimeerde PLY (M25) 
bij minimale visuele verliezen. Compatibel met Su
perSplat (dat de Compressed-PLY-standaard leest) 
en PlayCanvas. Standaardbestandsnaam gaussians_​
compressed.ply.

E E N VO U D I G  G E Z E G D

Zoals de normale PLY, maar 5–
10 keer kleiner. De kwaliteit 
blijft vrijwel hetzelfde. Gebruik 
dit wanneer je het bestand on
line wilt delen of per e-mail 
verstuurt. Werkt direct met Su
perSplat en PlayCanvas. Heeft 
je doelsysteem echter nog klei
nere bestanden nodig (mobiel, 
browser-demo’s), neem dan in 
plaats daarvan SPZ (M27) — 
die is nog agressiever gecom
primeerd. Voor volle bewerkings
kwaliteit neem het ongecompri
meerde PLY (M25).

M27 Export > 3D Formats > Export SPZ…

WA A R

Menubalk → Export → 3D Formats → SPZ.

T E C H N I S C H

Schrijft de Gaussian-cloud in het SPZ-formaat — het 
door Niantic gepubliceerde gecomprimeerde splat-
formaat met agressieve kwantisatie (~90% kleiner 
dan ongecomprimeerd PLY). Vooral voor web-vie
wers en mobiele apps geoptimaliseerd. Compatibel 
met Niantic Splatt3R, gsplat.js en de Niantic-brow
ser-viewer.

E E N VO U D I G  G E Z E G D

Eén van de kleinste formaten. 
Ongeveer 10× kleiner dan een 
normaal PLY. Gebruik dit voor
al wanneer je de scène in een 
browser wilt tonen of via handy-
app wilt bekijken. Voor maximale 
kwaliteit is PLY de betere keuze. 
SPZ is door Niantic ontwikkeld 
en werkt direct met gsplat.js, 
Splatt3R en de Niantic-web-vie
wer. Vanwege de sterke com
pressie kun je SPZ-bestanden 
niet meer zomaar verder trainen 
— voor bewerking neem PLY.

21 / 230



R A D I A N C E K I T Hoofdstuk 1 — Menubalk

M28 Export > 3D Formats > Export glTF…

WA A R

Menubalk → Export → 3D Formats → glTF.

T E C H N I S C H

Schrijft een .glb -bestand (binary-glTF) met de 
KHR_gaussian_splatting-extension. Standaard-con
form, geschikt voor pipelines die glTF-engines 
zoals Babylon.js of Three.js gebruiken en de 
KHR_gaussian_splatting-extension implementeren.

E E N VO U D I G  G E Z E G D

Slaat de scène op in het glTF-for
maat dat veel 3D-programma’s 
en web-engines begrijpen — 
mits ze de Gaussian-Splatting-
extensie ondersteunen. Heb je 
een specifieke 3D-pipeline (bijv. 
Three.js of Babylon.js) die dat 
begrijpt, dan is dit jouw for
maat. Het bestand komt als bi
nair .glb  naar buiten — één 
enkel pakket dat alles bevat. Voor 
klassieke splatting-workflows is 
meestal PLY of SPZ de betere 
keuze, omdat meer tools die di
rect begrijpen.

M29 Export > 3D Formats > Export .splat…

WA A R

Menubalk → Export → 3D Formats → .splat.

T E C H N I S C H

Schrijft het antimatter15- .splat -formaat — fixed-
size 32 bytes per Gaussian (positie als 3× float32, 
scale als 3× float32, rotation als 4× uint8 genor
maliseerde quaternion, RGB+opacity als 4× uint8). 
Geen SH-coëfficiënten hoger dan DC. Kleinste 
bestand met browser-directe compatibiliteit. Voor 
gsplat.js en antimatter15′s online-demo-viewer.

E E N VO U D I G  G E Z E G D

Het simpelste web-viewer-for
maat. Klein en direct in elke 
browser tonbaar. Verliest echter 
de detailverlichting (hogere SH-
coëfficiënten gaan verloren — de 
splat ziet er vanuit elke kijkhoek 
hetzelfde uit, in plaats van op het 
licht te reageren). Voor maxima
le web-performance goed, voor 
fotorealisme eerder SPZ of PLY. 
Werkt met de antimatter15-on
line-viewer en gsplat.js. Elke 
Gaussian bezet vast 32 bytes, 
wat het formaat simpel en com
patibel maakt — maar wel om de 
prijs van de detaildiepte.
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M30 Export > 3D Formats > Export SOG…

WA A R

Menubalk → Export → 3D Formats → SOG.

T E C H N I S C H

Schrijft de Gaussian-cloud in het SOG-formaat. 
SOG („Self-Organizing Gaussian“) is het PlayCan
vas-formaat met texture-atlas-layout en WebP-
compressie van de gekwantiseerde gegevens. 
Schaalt met 15–20× betere groottelijke verhouding 
dan PLY. De export roept intern cwebp  als extern 
hulpmiddel aan — daardoor in de sandbox-variant 
(App Store) mogelijk beperkt.

E E N VO U D I G  G E Z E G D

Zeer klein formaat voor PlayCan
vas-workflows. Ongeveer 15–20 
keer kleiner dan PLY, omdat de 
gegevens in een texture-atlas-
layout worden gepakt en WebP-
gecomprimeerd. Heb je geen 
PlayCanvas-workflow, is SPZ of 
Compressed PLY meestal de be
tere keuze. De export roept in
tern cwebp  als extern hulpmid
del aan — in de App-Store-versie 
(sandbox) kan deze stap beperkt 
zijn.

M31 Export > Media > Export Orbit Video…

WA A R

Menubalk → Export → Media → Orbit Video.

T E C H N I S C H

Rendert een 360°-orbit om het scènecentrum en 
encodeert dit als MP4 (H.264) of MOV (HEVC, al 
naar gelang systeem-standaard). In tegenstelling tot 
M18 (live-recording) is het pad hier vast voorgege
ven — duur wordt in de instellingen resp. in de 
Simple-Mode-export-stap gekozen.

E E N VO U D I G  G E Z E G D

Genereert automatisch een 
draaivideo om je scène. Geen 
handmatig bewegen nodig. Goed 
voor sociale media of een snel
le demo. Wil je de camera zelf 
besturen, gebruik dan in plaats 
daarvan Record Turntable Video 
(M18). Het pad is vast: een volle 
360°-orbit om het scènecentrum, 
duur kies je in de instellingen of 
in de Simple-Mode-export-stap. 
De video wordt al naar gelang 
systeem als H.264-MP4 of HEVC-
MOV uitgevoerd.
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M32 Export > Media > Export Web Viewer…

WA A R

Menubalk → Export → Media → Web Viewer.

T E C H N I S C H

Verpakt een standalone-HTML-viewer (gsplat.js-ge
baseerd) plus de Gaussian-gegevens base64-geco
deerd in één .html -bestand. Dit bestand draait of
fline in elke moderne browser — geen server-afhan
kelijkheden, geen externe URL’s. Bestandsgrootte is 
ongeveer factor 1,3 groter dan de SPZ-variant (van
wege base64-overhead).

E E N VO U D I G  G E Z E G D

Slaat je scène op als zelf-star
tende webpagina. Dubbelklik op 
het HTML-bestand → browser 
opent → klare interactieve 3D-
scène. Werkt zonder internet, 
laat zich per mail versturen, is 
de eenvoudigste manier om het 
resultaat met vrienden of klanten 
te delen. Het bestand bevat de 
complete gsplat.js-viewer en de 
Gaussian-gegevens in één enkel 
document — niets wordt vanuit 
het web nageladen. Bestands
grootte is ongeveer een derde 
groter dan een SPZ-export, maar 
daarvoor heb je bij de ontvanger 
geen extra software nodig.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

WA A R

Menubalk → Export → Photogrammetry → Export 
SfM (transforms.json).

T E C H N I S C H

Eigen export-pad (niet via de gemeenschappelijke 
helper-routine), omdat geen Gaussian-cloud, maar 
het SfM-resultaat wordt geëxporteerd. Opent een 
save-dialoog met transforms.json  als voorgave 
en content-type json . Bij OK wordt een nerfstu
dio-compatibele transforms.json  met camera-in
trinsics, poses (als 4×4-matrix in NeRF-conventie) 
en frame-paden geschreven. Helptekst in de UI 
wijst erop dat de trainingsbeelden als zustermap 
images/​ moeten worden meegekopieerd. Alleen ac
tief wanneer een SfM-resultaat aanwezig is en de 
volledige versie is ontgrendeld.

E E N VO U D I G  G E Z E G D

Wil je het SfM-resultaat in an
dere software zoals nerfstudio, 
Brush, gsplat of OpenSplat ver
der gebruiken, exporteer hier 
dan de camera-posities. Plaats 
je trainingsbeelden bovendien 
in een images/​-map naast het 
transforms.json -bestand — 

anders kan het doelprogramma 
de beelden niet toewijzen. Het 
item is grijs zolang er nog geen 
SfM-resultaat is, en in de free-
trial-versie geblokkeerd. Voor 
de COLMAP-workspace-workflow 
neem in plaats daarvan M34.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

WA A R

Menubalk → Export → Photogrammetry → Export 
SfM (COLMAP Workspace).

T E C H N I S C H

Opent een save-dialoog met voorgegeven 
naam colmap-workspace  (zonder extensie, om
dat het een map is). Schrijft een standaard-
COLMAP-workspace met sparse/​0/​cameras.bin, 
images.bin , points3D.bin . Maakt het mogelijk 

een in RadianceKit berekende of geïmporteerde 
SfM-reconstructie in andere tools zoals Postshot, 
Nerfstudio of Meshroom te openen, of bij een A/
B-re-run als reeds-berekende invoer in RadianceKit 
zelf (via M5) weer te laden — spaart rekentijd. 
Alleen actief wanneer een SfM-resultaat aanwezig is 
en de volledige versie is ontgrendeld.

E E N VO U D I G  G E Z E G D

Zoals M33, maar in COLMAP-for
maat in plaats van nerfstudio. 
Gebruik je Postshot, Meshroom, 
Nerfstudio of een ander tool 
met COLMAP-workflow, dan is dit 
jouw export. Een praktisch ne
veneffect: je kunt deze map later 
via M5 in RadianceKit terugladen 
en de SfM-rekentijd bij de vol
gende run uitsparen — vooral bij 
grote scènes een tijdwinst van 
uren. Net als M33 alleen beschik
baar wanneer een SfM-resultaat 
aanwezig is, en in de free-trial-
versie geblokkeerd.

Help-menu

Afbeelding 6:  Help-menu met documentatie-, map- en analyse-items

Zeven items: twee documentatievensters (User Guide, Keyboard Shortcuts), drie maps
hortcuts (Training Logs, Exports, Storage), en drie analysevensters (Pareto Dashboard, 
Holdout Analysis, BayesOpt Console). Apple-typisch verschijnt het Help-menu helemaal 
rechts. Het standaard-Help-menu wordt volledig door de RadianceKit-eigen variant ver
vangen.

25 / 230



R A D I A N C E K I T Hoofdstuk 1 — Menubalk

M35 Help > User Guide

WA A R

Menubalk → Help → User Guide (⌘?).

T E C H N I S C H

Opent het User-Guide-venster. Het toont een navi
gatie met onderwerp-zijbalk en scroll-detailgebied 
bij standaardgrootte 860×640. De inhoud is statisch 
ingebed (niet uit Markdown geparsed).

E E N VO U D I G  G E Z E G D

Opent de app-interne handlei
ding. Wil je niet alles in deze 
handleiding nalezen, vind je daar 
de belangrijkste stappen direct 
in het programma. De handlei
ding is als eigen venster met 
onderwerp-zijbalk opgebouwd — 
je kunt dus gericht naar afzon
derlijke onderwerpen springen. 
De inhoud is korter dan deze 
handleiding en concentreert zich 
op de meest voorkomende work
flows.

M36 Help > Keyboard Shortcuts

WA A R

Menubalk → Help → Keyboard Shortcuts (⌘/).

T E C H N I S C H

Opent het Keyboard-Shortcuts-venster — een een
voudige scroll-layout met alle app-toetscombina
ties, gegroepeerd op top-level-menu. Standaard
grootte 440×560. Inhoud is eveneens statisch inge
bed.

E E N VO U D I G  G E Z E G D

Opent een venster met de volle
dige lijst van alle toetscombina
ties. Mocht je je bijv. niet kunnen 
herinneren met welke toets je de 
training start, kijk je daar in. Een 
samenvatting staat ook aan het 
einde van dit hoofdstuk. De lijst 
is naar top-level-menu gegroe
peerd, zodat je snel naar het juis
te gebied springt. Behulpzaam 
als je net van muis- naar toet
senbordstijl overstapt.
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M37 Help > Open Training Logs…

WA A R

Menubalk → Help → Open Training Logs… (⇧⌘L).

T E C H N I S C H

Berekent de logmap als ~/​Documents/​RadianceKit/​
Logs, legt hem indien nodig aan en opent hem in 
Finder. Elke training-run schrijft een eigen JSONL-
bestand training_​YYYY-MM-DD_​HHmmss.jsonl daar
heen.

E E N VO U D I G  G E Z E G D

Opent in de Finder de map 
met alle voorgaande trainings
protocollen. Mocht er iets misge
gaan zijn of wil je nakijken wan
neer precies de training op wel
ke waarde convergeerde, vind je 
dat hier in JSONL-bestanden. Per 
training-run wordt precies één 
bestand met tijdstempel aange
legd — dat kun je ook in andere 
tools inlezen of per mail naar 
support sturen. Wil je een grafi
sche analyse, dan is het Pareto 
Dashboard (M40) de betere in
stap.

M38 Help > Open Exports Folder…

WA A R

Menubalk → Help → Open Exports Folder…

T E C H N I S C H

Analoog aan M37, maar met ~/​Documents/​
RadianceKit/​Exports. Wordt bij de eerste auto-test-
run of bij de eerste klik aangelegd; daarna komen 
daar de standaardpaden van alle auto-test-exports 
terecht (bijv. autotest_​<timestamp>.ply). Handma
tig via de save-dialoog gekozen exports gaan NIET 
noodzakelijk hierheen, maar waar de gebruiker het 
opslaat — daarom is deze map vooral voor auto-
tests interessant.

E E N VO U D I G  G E Z E G D

Opent de map waarin de app haar 
eigen exports neerlegt (vooral 
auto-test-runs). Mocht je een ex
port handmatig met de save-dia
loog elders neergezet hebben, 
staat hij daar en niet in deze 
map. Praktisch om op te ruimen 
of om na te kijken hoeveel ruim
te eerdere test-exports innemen. 
Wil je een compleet overzicht 
inclusief logs en scène-bundles, 
neem dan in plaats daarvan Ma
nage Storage (M39).
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M39 Help > Manage Storage…

WA A R

Menubalk → Help → Manage Storage…

T E C H N I S C H

Opent de Storage-browser (zie hoofdstuk 4 Auxilia
ry Windows, ID’s W7–W12). Somt alle gepersisteer
de scènes, training-logs, exports en caches in de ~/​
Documents/​RadianceKit/​-map met grootte op, biedt 
reveal-in-Finder en move-to-trash per entry.

E E N VO U D I G  G E Z E G D

Opent een venster-browser die je 
toont hoeveel ruimte Radiance
Kit op je schijf inneemt — per 
scène, log en export. Je kunt di
rect afzonderlijke dingen verwij
deren, zonder in Finder te hoe
ven gaan. Praktisch na langer ge
bruik, wanneer de harde schijf 
vol raakt — eerdere logs en au
to-test-exports kunnen zich tot 
meerdere gigabytes optellen. Via 
reveal-in-Finder kom je op elk 
moment ook naar het klassieke 
aanzicht.

M40 Help > Pareto Dashboard…

WA A R

Menubalk → Help → Pareto Dashboard… (⇧⌘D).

T E C H N I S C H

Opent het Pareto-Dashboard (zie hoofdstuk 4, ID’s 
W13–W22). Het dashboard laadt alle JSONL-trai
nings-logs uit ~/​Documents/​RadianceKit/​Logs/​, or
dent ze op scène en voorinstelling en tekent een 
Pareto-scatter-plot (standaard: loss vs Gaussians, 
optioneel loss vs wallclock of PSNR vs iteraties).

E E N VO U D I G  G E Z E G D

Opent een overzicht van al
le voorgaande training-runs als 
diagram. Je ziet meteen welke 
run de beste balans tussen kwa
liteit en grootte heeft geleverd. 
Praktisch wanneer je verschil
lende voorinstellingen onderling 
wilt vergelijken. Standaard toont 
het diagram loss tegen Gaus
sian-aantal — je kunt echter 
ook naar wallclock-tijd of PSNR 
omschakelen. De gegevens ko
men uit de JSONL-trainings-logs 
(M37); hoe meer runs je hebt, hoe 
veelzeggender de analyse wordt.
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M41 Help > Holdout Analysis…

WA A R

Menubalk → Help → Holdout Analysis… (⇧⌘H).

T E C H N I S C H

Opent het Holdout-Analysevenster (zie hoofdstuk 
4, ID’s W23–W29). Laadt een transforms.json , 
tekent de camera’s als 3D-globe en staat train/test-
fold-splits toe (angulair of lineair, 2–8 folds). Output 
is een fold-assignment.json die de training in de 
respectieve trainingsconfiguraties als testset kan 
gebruiken.

E E N VO U D I G  G E Z E G D

Helpt je om je camera-opnames 
in trainings- en testsets op te 
splitsen — zodat je objectief 
kunt meten hoe goed je scène 
is (op beelden die de training 
niet heeft gezien). Eerder een 
onderzoeks- en benchmarktool. 
De camera’s worden als 3D-globe 
weergegeven; je kunt tussen 2 en 
8 folds kiezen, ofwel gelijkmatig 
in hoek of lineair over de volg
orde. Het resultaat is een klein 
JSON-bestand dat de training 
vervolgens als testset gebruikt.

M42 Help > BayesOpt Console…

WA A R

Menubalk → Help → BayesOpt Console… (⇧⌘B).

T E C H N I S C H

Opent de BayesOpt-console (zie hoofdstuk 4, ID’s 
W30–W39). Laadt vooraf gedefinieerde zoekruim
tes (bijv. „MCMC scale-reg + opacity-reg + ssim“), 
voert Bayesian-optimization-trials asynchroon uit en 
toont convergentiecurve en trial-log live.

E E N VO U D I G  G E Z E G D

Een ingebouwde auto-tuner-con
sole. In plaats van handmatig 
verschillende parameters door te 
proberen, kan de app dat zelf 
‘s nachts laten lopen en je aan 
het einde de beste waarden voor 
je scène voorstellen. Zeer ge
vorderd hulpmiddel — voor de 
meeste workflows volstaat een 
goede voorinstelling (zie hoofd
stuk 7). Je kiest een vooraf 
gedefinieerde zoekruimte (bijv. 
„MCMC scale-reg + opacity-reg + 
ssim“) en ziet live de convergen
tiecurve en de trial-log. Plan al 
naar gelang setup meerdere uren 
tot dagen in.

Opmerking: Cmd-Z in het Edit-menu

Sinds mei 2026 ondersteunt de Project Navigator in de Expert Mode het verwijderen 
van geïmporteerde beelden via de min-knop of backspace-toets, en het ongedaan ma
ken via Cmd-Z . Deze Cmd-Z-actie verschijnt in het macOS-Edit-menu (dat door SwiftUI 
wordt geleverd) als „Undo Remove Image“, zolang een verwijderd beeld nog herstelbaar 
is. Hij wordt via het standaard-conforme -systeem geregistreerd, niet in ; daarom is er 
geen eigen M-ID-entry in de inventaris.
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Toetscombinaties in het overzicht

Menu-item Toetscombinatie

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit-menu (systeem-geleverd, in de Expert Mode bij actieve Project-Navigator-selec
tie):

Actie Toetscombinatie

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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H O O F D S T U K

Hoofdstuk 2 — Inspector (Expert View)

Afbeelding 7:  Expertmodus leeg — Project Navigator links (Images 0, Cameras, Log), leeg 
viewport in het midden, Inspector rechts met Presets/Training Configuration/Enhancements/

Training Metrics-secties

Lege Inspector vóór import: Linker zijbalk toont images-teller 0 en drop-hint „Drop 
images here / or tap + to import“. Inspector rechts is volledig functioneel, maar 
voorinstellingen zijn slechts informatief (geen actieve training). Standaardvoorinstelling 
„Preview” (5K iters) is gemarkeerd. Camera-Alignment op Apple Photogrammetry, Den
sification Classic, SSIM Weight 0,20, Render Scale 50%. Lege staten in Training Metrics 
(„Start training to see live metrics“) en Loss History („Loss curve will appear during 
training”).

31 / 230



R A D I A N C E K I T Hoofdstuk 2 — Inspector (Expert View)

Afbeelding 8:  Inspector met 60 flowers-beelden geladen — image-zijbalk toont eerste 
bestandsnamen frame_0001.jpg etc., header „60 images ready“

Inspector na import: Header-status „60 images ready“. Image-zijbalk somt alle 60 
geïmporteerde frames ( frame_0001.jpg  tot frame_0945.jpg , elke 16e frame van een 
960-camera-bouquet-dataset als subset voor snelle iteraties). De auto-render-scale-
logica controleert de beeldresolutie (1536×2048 = 3,1 MP) en past Render Scale 
dienovereenkomstig aan. Play-knop (groen, linksonder) is nu actief en start de training 
met de actieve voorinstelling.

Afbeelding 9:  Inspector mid-training — live-viewport toont flowers-bouquet-reconstructie, 
metrics-balk onderaan (Loss / LR / Gaussian-count / iteraties), voorinstellingskaart „Pre­

view“ met „Modified”-badge indien parameter aangepast

Inspector tijdens training: Titelbalk toont globale voortgang „RadianceKit — Training 
NN%“. Viewport rendert de lopende Gaussian-reconstructie in realtime (elke 50 ite
raties geactualiseerd — live-preview-interval instelbaar in Instellingen → General → 
Training → Live Preview). Metrics-balk onder het viewport: actuele Loss, learning rate, 
Gaussian-count en iteraties-teller (bijv. 1.600/5.000 bij Preview-voorinstelling). Voorin
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stellingskaart „Preview” draagt „Modified“-badge zodra een parameter afwijkt van de 
built-in standaard. Zijbalk „Log” verzamelt SfM- en training-stage-events.

Afbeelding 10:  Inspector na voltooide training — viewport toont voltooide flowers-bouquet-
reconstructie (2.991 Gaussians na 5K iteraties in 13s), titelbalk „Training Complete — 2.991 

Gaussians“

Inspector na training: Titelbalk toont het finale Gaussian-aantal (hier 2.991 — erg 
compact, omdat de synthetische Blender-bouquet-scène op heldere achtergrond een
voudige geometrie heeft). Viewport toont de voltooide puntenwolk — orbitale drag-
navigatie actief (roteert om het scènecentrum). Training-metrics-sectie is nu met finale 
waarden gevuld, loss-history-chart toont het verloop van de gehele 5.000 iteraties. 
Export-sectie onderaan is nu actief (alle formaatknoppen enabled).

De Inspector is de rechter zijbalk in de Expert Mode (⌘2). Hij bundelt alle training-
relevante parameters in zeven inklapbare secties. De standaardvolgorde van boven 
naar beneden bij de eerste start is: Look, Presets, Trainingsconfiguratie, Metrics, Loss-
Chart, Enhancements en Export. De „Look“-sectie (beeldaanpassingen na de training) 
is de echte UI-hernoeming van de vroegere „Finishing”-sectie — haar interne enum-
rawValue  blijft om persistentieredenen „Finishing“, de weergegeven kop heet „Look”. 

Elke sectie kan worden ingeklapt door op de header te klikken, de volgorde kan via 
drag-and-drop opnieuw worden geordend (InspectorView.swift:81-97). Bij de eerste 
start zijn alle zeven secties ingeklapt (inspectorCollapsedSections defaultet op 
Set(InspectorSection.allCases)); de app-state slaat de inklap- en volgorde-voorkeu
ren daarna over app-starts heen op.

Een aantal bedieningselementen uit de Inspector duikt in vrijwel identieke vorm ook in 
de instellingen (hoofdstuk 3) op — typisch SfM-backend, sky-masking en vergelijkbare 
defaults. De scheiding is bewust: de instellingen leveren de app-globale standaard voor 
nieuw aangelegde projecten, de Inspector overschrijft die waarden voor het huidige 
open project. Wie eenmaal de bedieningslogica van één kant kent, kan de andere blind 
gebruiken.

De linker kolom in de Expert Mode — de Project Navigator — hoort niet bij de Inspector, 
maar is zijn directe buur. Daar kunnen geïmporteerde beelden per klik worden geselec
teerd, met spatie in Quick Look worden bekeken en via de min-knop of de delete-toets 
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worden verwijderd (met Cmd-Z om ongedaan te maken). De Inspector volgt de huidige 
zijbalkselectie met context-specifieke detailinformatie, de zeven hoofdsecties blijven 
echter altijd beschikbaar.

Look-sectie (L1–L5)

De Look-sectie (interne rawValue  nog steeds „Finishing“) is de bovenste Inspector-
sectie en verzamelt de beeldaanpassingen na de training op één plek. Alle regelaars 
werken niet-destructief: elke slider past de FinishingPass  opnieuw toe op een onge
wijzigde pristine-snapshot (originele DC-kleur, -opacity, -scaling) — de aanpassing is 
daarmee idempotent, niet cumulatief. Het resultaat verschijnt live in het viewport 
(WYSIWYG, precies zoals de latere export) en wordt in elke export ingebakken. De 
sectie is pas na afronding van een trainingsrun beschikbaar (daarvoor staat er „Avai
lable after a training run completes.”); haar waarden worden bij elke nieuwe training 
teruggezet. Zolang een export loopt, zijn alle regelaars vergrendeld — een lock-hint 
„Locked while exporting — the file uses the current settings.“ verschijnt en de GroupBox 
is disabled.

L1 Saturation-slider

WA A R

Inspector → Look-sectie → GroupBox → Saturation.

T E C H N I S C H

Slider 0,5–1,2, weergave op twee decimalen (bijv. 
„1.00″). Schaalt de SH-DC-chroma van elke Splat 
rond de luminantiewaarde: 1.0 = ongewijzigd, < 1.0 = 
ontzadigd (kleur naar grijswaarde getrokken), > 1.0 
= krachtiger. Wiskundig wordt de DC-kleur uit de 
pristine-snapshot terugberekend ( desaturateDC ), 
zodat herhaald schuiven niet optelt. Werd op DJI-
drone-materiaal gevalideerd (Pensford-viaduct), dat 
doorgaans overtekent — de drone-default ligt op 
0,82. Werkt alleen op de kleur-basis (SH-graad 0), 
hogere SH-coëfficiënten blijven onaangeroerd.

E E N VO U D I G  G E Z E G D

Hoe krachtig de kleuren van de 
voltooide Splat zijn. 1.00 laat al
les zoals getraind, waarden eron
der trekken de kleur richting grijs 
— goed voor drone- of videoma
teriaal, dat er vaak oververzadigd 
uitkomt. Waarden boven 1.0 ma
ken het krachtiger. Je kunt naar 
believen heen en weer schuiven, 
zonder dat er iets „opbouwt“, 
omdat de app altijd vanaf de 
ongewijzigde originele stand op
nieuw rekent. Live zichtbaar in 
het viewport en precies zo in de 
export.
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L2 Splat length-slider

WA A R

Inspector → Look-sectie → GroupBox → Splat 
length.

T E C H N I S C H

Slider 0,3–1,0, weergave op twee decimalen. Trekt 
de drie schaal-assen van elke Gaussian in de log-
ruimte naar hun gemiddelde toe ( shortenScale , 
factor alpha ): 1.0 = ongewijzigd, kleinere waarden 
maken langgerekte „naald“-Splats ronder, 0 zouden 
zuivere bollen zijn. Pakt naaldachtige, overrekte 
Splats aan zonder de totale grootte te veranderen, 
en reduceert daardoor typische „confetti”-artefac
ten. Vanaf de pristine-snapshot (originele log-sca
ling) toegepast, dus idempotent. Commuteert met 
Splat size (L3), omdat beide in de log-ruimte wer
ken.

E E N VO U D I G  G E Z E G D

Maakt te lange, splinterige Splats 
ronder. 1.00 laat de vorm zoals 
getraind, lagere waarden stui
ken de langgerekte „naalden“ tot 
rondere klodders — dat kalmeert 
korrelige, door confetti-artefac
ten geplaagde reconstructies. De 
totale grootte blijft gelijk, het 
gaat alleen om de langgerekt
heid. Laat zich gevaarloos met 
Splat size (L3) combineren.

L3 Splat size-slider

WA A R

Inspector → Look-sectie → GroupBox → Splat size.

T E C H N I S C H

Slider 0,5–2,0, weergave op twee decimalen. 
Schaalt elke Gaussian op alle drie assen uniform 
( sizeScale ): 1.0 = ongewijzigd, < 1.0 = kleiner/
dichter/scherper, > 1.0 = groter/„pluiziger“ (vult ga
ten tussen de Splats). Omdat de schalingen in 
de log-ruimte liggen, wordt de vermenigvuldiging 
als additieve log(factor) -offset gerealiseerd — 
dat commuteert met Splat length (L2), omdat een 
constante offset de afwijking-van-het-gemiddelde 
onaangeroerd laat. Vanaf de pristine-snapshot, dus 
idempotent. Nieuw in deze versie.

E E N VO U D I G  G E Z E G D

Schaalt alle Splats gelijkmatig 
groter of kleiner. 1.00 is de ge
trainde toestand, waarden eron
der maken de puntenwolk dich
ter en scherper, waarden erboven 
dekken gaten tussen de Splats af 
(werkt zachter/„pluiziger“). Han
dig om een gaterige reconstruc
tie optisch te sluiten of omge
keerd meer detail vrij te leggen. 
Verdraagt zich probleemloos met 
Splat length (L2) — beide rege
laars beïnvloeden elkaar niet.
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L4 Fade far region (met sub-sliders)

WA A R

Inspector → Look-sectie → GroupBox → Toggle 
„Fade far region“ plus de sub-sliders „Fade start 
×radius” en „Fade floor“.

T E C H N I S C H

Toggle die een radiale opacity-afname met de 
afstand vanaf het camera-zwaartepunt activeert 
— de zwak waargenomen „far-confetti“ op de 
achtergrond worden uitgefaded. Alleen voor or­
bit-opnames: de toggle is disabled wanneer 
finishingContext.fadeEligible false is (lineaire 
vluchten, te weinig of gedegenereerde camera’s); 
dan verschijnt in plaats van de sub-sliders de 
hint „Far-fade applies only to orbit captures (not 
this scene).” De geschiktheid wordt bepaald via de 
azimut-dekking van de camera-posities (een orbit 
cirkelt rond het zwaartepunt en vult veel kompas-
sectoren, een lineaire vlucht slechts ~2). Twee sub-
sliders sturen de geometrie: Fade start ×radius 
(1,0–3,0) zet de binnenradius als veelvoud van de 
orbit-radius, waarbinnen volle opacity geldt; Fade 
floor (0,0–1,0) is de opacity-factor ver voorbij de fa
de-radius. Belangrijk: de fade slaat het sky-dome-
gebied over (de frozen Gaussians van de indices 
[0, frozenCount)), zodat de bewuste achtergrond-
koepel niet mee-gedimd wordt.

E E N VO U D I G  G E Z E G D

Faded de zwammige resten aan 
de buitenrand van de scène 
uit — precies die „far-confetti“-
klontjes die bij rondom-opnames 
ver achteraan zweven. Werkt al
leen bij echte orbit-/omcirkelop
names; bij rechte drone-vluch
ten of te weinig camera’s is de 
schakelaar grijs en legt een hint 
uit waarom. Is hij actief, komen 
er twee fijnregelaars bij: „Fade 
start ×radius” bepaalt vanaf wel
ke afstand (als veelvoud van de 
omcirkel-radius) het uitfaden be
gint, „Fade floor“ hoe sterk de 
verre Splats aan het eind nog 
zichtbaar blijven (0 = helemaal 
weg, 1 = ongewijzigd). Een be
wust gereconstrueerde sky-do
me (I44) wordt daarbij nooit aan
geraakt — de lucht blijft behou
den.
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L5 Reset finishing-knop

WA A R

Inspector → Look-sectie → GroupBox → „Reset fi
nishing“ (onderaan, kleine knop).

T E C H N I S C H

Zet alle Look-settings terug op de defaults 
(FinishingPass.Settings() = Saturation 1.0, Fade 
uit, Splat length 1.0, Splat size 1.0) en triggert 
direct een hernieuwde finishing, zodat het viewport 
terugspringt naar de ongewijzigde getrainde toe
stand. controlSize(.small). Omdat de hele Look-
stack idempotent vanaf de pristine-snapshot rekent, 
is „terug op default“ exact de oorspronkelijke trai
nings-output — geen kwaliteitsverlies door herhaald 
heen en weer. Zoals alle regelaars van de sectie 
tijdens een lopende export vergrendeld.

E E N VO U D I G  G E Z E G D

Zet met één klik alle Look-rege
laars terug op standaard (Satura
tion 1.00, Fade uit, beide Splat-
sliders op 1.00) — het viewport 
toont daarna weer exact het vers 
getrainde resultaat. Handig wan
neer je hebt zitten spelen en 
netjes opnieuw wilt beginnen. 
Omdat de app altijd vanaf de 
originele stand rekent, is er daar
bij geen kwaliteitsverlies. Terwijl 
een export loopt, is de knop (net 
als de sliders) vergrendeld.

Voorinstellingen-sectie (I1–I11)

De voorinstellingen-sectie is de snelste manier om een geteste configuratie toe te pas
sen. Built-in-voorinstellingen (Capture Class, Classic, MCMC, Hybrid) leveren reprodu
ceerbare startpunten uit 560+ gedocumenteerde experimenten; eigen voorinstellingen 
kunnen worden opgeslagen, geëxporteerd, geïmporteerd en gedeeld. De lijst is op cate
gorieën gegroepeerd (Capture Class, Classic, MCMC, Hybrid, Custom) en meer dan één 
categorie kan tegelijk uitgeklapt zijn. Via het contextmenu-mechanisme (rechtsklik op 
een regel) zijn export, dupliceren en — bij eigen voorinstellingen — verwijderen bereik
baar.
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I1 Save…-knop

WA A R

Inspector → Voorinstellingen-sectie → Save…-knop 
(actiebalk onder).

T E C H N I S C H

Opent een popover met tekstveld en Save-/Cancel-
knoppen. De actuele TrainingConfig-toestand wordt 
als nieuwe gebruikersgedefinieerde voorinstelling 
gepersisteerd (JSON-gecodeerd, app-overkoepe
lend opgeslagen). Het save-proces kopieert alle 81 
trainingparameters plus de actuele densification-
strategie. De voorinstelling komt automatisch in 
de categorie Custom terecht, ongeacht van welke 
built-in-voorinstelling hij is afgeleid. Lege namen en 
pure whitespace-invoer worden verworpen. Reeds 
bestaande namen worden niet afgewezen — elke 
voorinstelling heeft een eigen interne ID, dubbele 
namen zijn technisch toegestaan, maar praktisch 
verwarrend.

E E N VO U D I G  G E Z E G D

Bewaart je actuele configuratie 
als herbruikbare voorinstelling. 
Druk op de knop, geef in de pop
over een naam in en klik Save — 
alle 81 parameters inclusief den
sification-strategie komen onder 
de gekozen naam in de Custom-
categorie. Heb je nodig wanneer 
je je moeite hebt getroost en niet 
bij het volgende project weer van 
voren wilt prutsen. Vooral prak
tisch voor terugkerende setups 
zoals „drone 4K“ of „indoor 
snel”. Dubbele namen zijn tech
nisch toegestaan, maar praktisch 
verwarrend — neem liever iets 
sprekends.

I2 Preset Name-tekstveld

WA A R

Save-popover → tekstveld „Preset Name“.

T E C H N I S C H

Eenvoudig tekstveld met afgeronde rand, brede 
vorm. De waarde wordt bij klik op de Save-knop als 
voorinstellingsnaam overgenomen. Geen lengtebe
grenzing in de UI, maar de opgeslagen naam moet 
JSON-codeerbaar en in de UI-lijsten weergeefbaar 
zijn — emoji en umlauten werken. De inhoud wordt 
bij het openen van de popover automatisch op een 
lege string teruggezet. De Save-knop blijft disabled 
zolang het veld na trim leeg is. Er is geen auto-
suggest en geen voorbelegging met de naam van de 
momenteel actieve voorinstelling.

E E N VO U D I G  G E Z E G D

Hier typ je de naam voor je voor
instelling in. Kies iets sprekends 
zoals „drone 4K 30fps“ of „bin
nenruimte snel” — dat helpt je 
later bij het terugvinden in de 
Custom-categorie. Emoji en um
lauten zijn toegestaan, een harde 
lengtebegrenzing is er niet. Zo
lang het veld leeg is of alleen 
uit spaties bestaat, blijft de Sa
ve-knop grijs. Bij het opnieuw 
openen van de popover is het 
veld weer leeg — er is geen voor
belegging met de actieve voorin
stellingsnaam.
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I3 Cancel-knop (Save-dialoog)

WA A R

Save-popover → Cancel-knop (links).

T E C H N I S C H

Sluit de popover zonder opslaan. Verwerpt de tekst
veld-inhoud — bij het volgende openen wordt hij 
weer door de Save…-knop-logica (I1) op leeg te
ruggezet. Standaard knopstijl, geen bevestigingsdi
alogen, geen hotkeys. De actuele TrainingConfig 
blijft ongewijzigd, omdat het save-pad helemaal niet 
werd uitgevoerd.

E E N VO U D I G  G E Z E G D

Sluit de save-popover zonder iets 
op te slaan. Mocht je je bedacht 
hebben, je vertypt of de dia
loog per ongeluk geopend hebt 
— klik gewoon op Cancel. Je ac
tuele trainingsconfiguratie blijft 
ongewijzigd, omdat er nog niets 
werd geschreven. Bij het volgen
de openen van de popover start 
het naamveld weer leeg. Geen 
veiligheidsbevraging, geen hot
key — gewoon klik en weg.

I4 Save-knop (Save-dialoog)

WA A R

Save-popover → Save-knop (rechts, prominentere 
stijl).

T E C H N I S C H

Triggert de eigenlijke persistering. Valideert nog
maals niet-lege naam (defensieve check) en schrijft 
dan de actuele TrainingConfig als JSON naar het 
app-geheugen. Sluit vervolgens de popover. Blauw 
geaccentueerd, grijs zolang het tekstveld leeg is. 
Wanneer het opslaan mislukt (bijv. omdat de app-
opslag vol is — zeer onwaarschijnlijk), is er momen
teel geen zichtbare foutdialoog; de voorinstelling 
zou dan bij de volgende app-start gewoon niet ver
schijnen.

E E N VO U D I G  G E Z E G D

Met een klik op Save neem je 
de naam over en schrijf je de 
huidige setup als nieuwe voor
instelling weg. De popover sluit 
zich, de voorinstelling duikt met
een in de Custom-categorie van 
de voorinstellingslijst op en kan 
vanaf nu per klik worden geacti
veerd. De knop is blauw geaccen
tueerd ( borderedProminent ) 
en blijft grijs zolang het naam
veld leeg is. Mocht het op
slaan mislukken (bijv. UserDe
faults vol), is er geen zichtbare 
foutdialoog — de voorinstelling 
zou dan bij de volgende app-
start gewoon ontbreken.
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I5 Export…-knop

WA A R

Inspector → Voorinstellingen-sectie → actiebalk → 
Export…-knop.

T E C H N I S C H

Exporteert de momenteel geselecteerde voorinstel
ling als .radiancepreset -bestand (intern JSON). 
Disabled wanneer geen voorinstelling geselecteerd 
is. Bij klik opent de app een save-dialoog met voor
af ingestelde bestandsnaam (voorinstellingsnaam 
+ .radiancepreset -extensie). Het opgeslagen for
maat bevat de complete TrainingConfig plus meta
data (naam, categorie, ID, built-in-vlag). Dubbelklik 
in de Finder opent de app — maar niet automatisch 
de import; de gebruiker moet de Import-knop (I6) 
gebruiken.

E E N VO U D I G  G E Z E G D

Selecteer een voorinstelling in de 
lijst en klik op Export — dan kun 
je hem als .radiancepreset
-bestand opslaan en bijv. naar 
een collega sturen of naar een 
tweede Mac overdragen. De ont
vanger laadt hem aan de andere 
kant met de Import…-knop (I6) 
weer in. Werkt voor built-ins en 
voor je eigen custom-voorinstel
lingen even goed. De knop is 
grijs zolang er in de lijst niets is 
aangeklikt. Tip: via het context
menu (I8) gaat het nog sneller 
— daar hoef je de voorinstelling 
niet eerst te selecteren.

I6 Import…-knop

WA A R

Inspector → Voorinstellingen-sectie → actiebalk → 
Import…-knop.

T E C H N I S C H

Opent een bestandsdialoog die alleen 
.radiancepreset -bestanden toelaat (meervoudige 

selectie gedeactiveerd). Bij het selecteren wordt 
het JSON-bestand geladen, gevalideerd en in de 
Custom-categorie ingevoegd — met nieuwe interne 
ID, zodat geen botsingen met built-ins ontstaan. De 
import zet automatisch de categorie op Custom, 
zelfs als de geëxporteerde voorinstelling oorspron
kelijk bijv. een built-in was. Beschadigde of met 
een oudere schemaversie incompatibele bestanden 
worden stilzwijgend afgewezen, zonder foutdialoog 
(console-log geeft echter uitsluitsel).

E E N VO U D I G  G E Z E G D

Een .radiancepreset -be
stand vanaf de harde schijf in
lezen. Nuttig wanneer iemand 
je een beproefde setup stuurt 
of je zelf je favoriete voorin
stellingen over meerdere Macs 
synchroon wilt houden. Geïm
porteerde voorinstellingen ko
men altijd in de Custom-cate
gorie terecht — ook wanneer 
ze oorspronkelijk uit de built-
ins zijn geëxporteerd. Bescha
digde of verouderde bestanden 
worden stilzwijgend genegeerd; 
in de console-log staat dan de re
den. Meervoudige selectie in de 
dialoog is gedeactiveerd, dus per 
klik slechts één bestand.
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I7 Voorinstellingsregel (klik-activering)

WA A R

Inspector → Voorinstellingen-sectie → elke voorin
stellingsregel in elke categorie.

T E C H N I S C H

Klik op een voorinstellingsregel vervangt alle vel
den van de TrainingConfig door de waarden uit de 
voorinstelling, onthoudt de ID van de actieve voor
instelling en reset de modified-status. Het actieve 
vinkje vóór de regel verschijnt alleen wanneer de 
voorinstelling geselecteerd EN ongewijzigd is. Zodra 
een waarde in de TrainingConfig wordt gewijzigd 
(slider, stepper, toggle in de andere Inspector-sec
ties), verschijnt een oranje „Modified“-badge achter 
de naam. Ingebouwde voorinstellingen kunnen niet 
worden overschreven — bij wijziging moet via de 
Save-knop (I1) een eigen kopie worden aangelegd.

E E N VO U D I G  G E Z E G D

Klik op een regel activeert de 
voorinstelling en neemt alle daar 
opgeslagen waarden over in 
de actuele trainingsinstellingen. 
Het vinkje vóór de naam toont 
welke voorinstelling momenteel 
actief is. Zodra je daarna een 
slider, stepper of toggle in de an
dere secties verstelt, verschijnt 
achter de naam een oranje „Mo
dified“-badge — omdat je setup 
nu afwijkt van de voorinstelling. 
Built-in-voorinstellingen kunnen 
niet worden overschreven; wil je 
wijzigingen behouden, leg dan 
via de Save…-knop (I1) een eigen 
kopie aan of dupliceer de voorin
stelling (I9).

I8 Contextmenu „Export…“

WA A R

Rechtsklik op elke voorinstellingsregel → eerste 
item „Export…“.

T E C H N I S C H

Identieke functionaliteit als I5 (Export…-knop), maar 
comfortabeler bereikbaar — zonder dat de voorin
stelling vooraf geselecteerd hoeft te zijn. Exporteert 
direct de in de regel aangeklikte voorinstelling. 
Werkt voor alle voorinstellingscategorieën gelijk 
(built-in of custom), geen beperking. De export be
vat de built-in-vlag en de oorspronkelijke categorie, 
maar bij re-import wordt de categorie zoals onder I6 
beschreven op Custom gemapt.

E E N VO U D I G  G E Z E G D

Snelle manier om te exporte
ren — rechtsklik op de ge
wenste voorinstelling en kies 
„Export…“. Spaart de omweg 
via eerst-aanklikken en dan op 
de Export…-knop drukken. Werkt 
voor alle categorieën gelijk, ook 
voor built-ins. Het gegenereerde 
.radiancepreset -bestand is 

identiek aan dat van I5; bij latere 
re-import komt het automatisch 
in de Custom-categorie terecht.
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I9 Contextmenu „Duplicate“

WA A R

Rechtsklik op elke voorinstellingsregel → tweede 
item „Duplicate“.

T E C H N I S C H

Kloont de voorinstelling naar de Custom-categorie. 
Genereert een nieuwe interne ID, hangt „ Copy“ aan 
de naam en slaat de kopie op. Werkt ook voor built-
in-voorinstellingen — de kloon is dan bewerkbaar. 
Het origineel blijft onaangeroerd. De TrainingCon
fig wordt waarde-voor-waarde gekopieerd (JSON-
roundtrip), zodat geen referentie-bindingen tussen 
origineel en kopie bestaan.

E E N VO U D I G  G E Z E G D

Genereert een bewerkbare ko
pie van een voorinstelling in 
de Custom-categorie. Praktisch 
wanneer je bijv. de built-in „Qua
lity“-voorinstelling als uitgangs
punt wilt en dan alleen de SSIM-
slider een beetje wilt verschui
ven. Workflow: dupliceren, her
noemen (contextmenu of nieu
we Save…-run), aanpassen, klaar. 
Het origineel blijft onaangeroerd 
— je kunt op elk moment terug. 
Werkt ook voor built-ins, wat de 
enige manier is om hun waarden 
als basis over te nemen en tege
lijk bewerkbaar te maken.

I10 Contextmenu „Delete“

WA A R

Rechtsklik op eigen voorinstellingsregels → laatste 
item „Delete“ (rood, destructive).

T E C H N I S C H

Alleen zichtbaar voor custom-voorinstellingen. 
Built-ins kunnen niet worden verwijderd. Het item 
is als destructief gemarkeerd, verschijnt in het con
textmenu rood en wordt achter een divider gezet, 
zodat men hem niet per ongeluk klikt. Er is geen 
bevestigings- dialoog — één klik verwijdert de voor
instelling onmiddellijk. De verwijderde voorinstelling 
is niet herstelbaar (Cmd-Z werkt hier niet — undo 
bestaat in de huidige build alleen voor de beeldlijst, 
niet voor voorinstellings- operaties). Was de verwij
derde voorinstelling juist actief, blijft de huidige 
TrainingConfig ongewijzigd, alleen de actieve voor
instellings-selectie wordt op nul gezet.

E E N VO U D I G  G E Z E G D

Eigen voorinstellingen verwijde
ren. Bij de built-ins (Quick, Pre
view, Balanced, Quality, Ultra De
tail, Drone / Aerial, 360° Walka
round, Photo / Object etc.) is 
„Delete“ helemaal niet zichtbaar 
— die kun je niet per ongeluk 
killen. Let op: er is geen vei
ligheidsbevraging en geen undo, 
één klik en de voorinstelling is 
weg. Mocht je niet zeker zijn, trek 
vooraf via Export… (I5/I8) een 
veiligheidskopie op schijf — die 
kun je op elk moment weer im
porteren. Was de voorinstelling 
juist actief, blijft je TrainingCon
fig ongewijzigd, alleen het vinkje 
verdwijnt.
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I11 Categorie-header (uitklappen/inklappen)

WA A R

Inspector → Voorinstellingen-sectie → elke catego
rie-header (Capture Class, Classic, MCMC, Hybrid, 
Custom).

T E C H N I S C H

Inklap-status per categorie met verschillende stan
daard: de gecureerde Capture Class-groep start 
uitgeklapt, Classic, MCMC, Hybrid en Custom star
ten ingeklapt. De status wordt niet gepersisteerd 
— bij app-herstart zijn alle categorieën weer in de 
standaard-toestand. De chevron-pijl roteert geani
meerd. Het getal rechts in de header toont het 
aantal voorinstellingen in deze categorie. De klik-
hit-area omvat het hele header-gebied.

E E N VO U D I G  G E Z E G D

Categorieën in- en uitklappen om 
de voorinstellingslijst overzich
telijk te houden. Bij de app-start 
is de Capture Class-groep open, 
Classic, MCMC, Hybrid en Custom 
zijn dicht. Klik op de header (vol
ledig gebied is klikbaar) en de 
lijst gaat met korte chevron-ani
matie open of dicht. Het kleine 
getal rechts toont hoeveel voor
instellingen er in de categorie 
zitten. Na herstart van de app 
is weer de standaard-toestand er 
— de app slaat deze inklap-in
stelling bewust niet op.

Trainingsconfiguratie-sectie (I12–I22)

Afbeelding 11:  Crop alleen Trainingsconfiguratie-sectie — Camera Alignment (Apple Pho­
togrammetry actief, Native (Beta) inactief), Densification (Classic actief), Max Iterations 

5.000 / Densify Until 3.500 met link-symbool, SSIM Weight slider 0,20, Render Scale slider 
op 100% (1.536×2.048 = 3,1 MP)

Hier komen de centrale hefbomen samen: welk SfM-backend moet rekenen, hoe de 
densification werkt, hoeveel iteraties, hoe groot de SSIM-weging. Bij MCMC-strategie 
duiken twee extra toggles op („MCMC Quality“ en „Auto-scale by scene”), die in 
Classic-modus worden verborgen. Bij Native-SfM-backend komt het FOV-override-veld 
erbij, dat alleen voor videoframes zonder EXIF-brandpuntsafstand nodig is.
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I12 Camera Alignment-keuze

WA A R

Inspector → Trainingsconfiguratie → Camera Align
ment (segmented picker boven).

T E C H N I S C H

Segmented picker met twee opties: Apple Photo
grammetry en Native (Beta). De keuze bepaalt het 
gebruikte SfM-backend bij de volgende camerare
constructie. Hij beïnvloedt tegelijk welke andere In
spector-elementen zichtbaar zijn: Native toont aan
vullend het FOV-override (I13), dat alleen bij EXIF-
loze video- frames nodig is. Tip: voor zeer grote 
outdoor-opnames kun je het resultaat van een ex
terne tool (Metashape of COLMAP) via workspace-
import inladen — zie hoofdstuk 1 (M5) en hoofdstuk 
9 (Q3, Q6).

E E N VO U D I G  G E Z E G D

Hier kies je hoe de camera
posities worden gereconstrueerd 
— de belangrijkste schakelaar 
voor de eindkwaliteit. Apple Pho
togrammetry is de snelle stan
daard en volstaat voor de mees
te objectscans volledig. Native 
(Beta) is de App-Store-conforme 
eigen ontwikkeling, goed voor 
orbits en turntable-scènes, en 
heeft bij EXIF-loze videoframes 
het FOV-override (I13) nodig. Bij 
zeer grote outdoor- sets kun je 
de camera’s alternatief in Metas
hape of COLMAP laten berekenen 
en het resultaat via de workspa
ce-import laden. Details en aan
bevelingen per scènetype vind je 
in hoofdstuk 9.

I13 FOV Override-veld (Native SfM)

WA A R

Inspector → Trainingsconfiguratie → FOV Override 
(alleen zichtbaar bij Camera Alignment = Native).

T E C H N I S C H

Numeriek tekstveld (range 0-170°), standaard 0 = 
automatische bepaling uit EXIF of heuristiek. Hand
matige invoer is nodig wanneer de invoerbeelden uit 
een video zijn geëxtraheerd dat geen brandpunts
afstand-metadata bevat. Typische waarden: iPhone 
Wide ≈ 73°, DJI Mavic Wide-Crop ≈ 70°, drone met 
fullframe-sensor ≈ 84°. De waarde wordt op [0, 170] 
geclampt — waarden buiten worden direct terugge
stuwd. Werkt alleen op de native SfM-pipeline (Q4/
Q5); Apple Photogrammetry negeert deze waarde 
volledig.

E E N VO U D I G  G E Z E G D

Hebben je beelden geen EXIF (ty
pisch bij geëxtraheerde videofra
mes), voer je hier de horizontale 
gezichtshoek van de camera in 
graden in. Vuistwaarden: iPhone 
Wide ≈ 73°, DJI Mavic Wide- Crop 
≈ 70°, drone met fullframe-sen
sor ≈ 84°. Een 0 laat de app 
zelf raden — dat gaat vaak goed, 
maar kan bij zeldzame objectie
ven mis gaan. Waarden boven 
170° worden automatisch terug
gestuwd. Het veld is alleen zicht
baar en alleen werkzaam wan
neer je Native als Camera Align
ment (I12) hebt gekozen — Ap
ple Photogrammetry negeert het 
volledig.
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I15 Densification-keuze

WA A R

Inspector → Trainingsconfiguratie → Densification 
(segmented picker, altijd zichtbaar).

T E C H N I S C H

Schakelt tussen de twee densification-strategie
ën: Classic (origineel 3DGS-procedure met clone/
split/prune en gradiënt-drempel) en MCMC (Sto
chastic Gradient Langevin Dynamics met relocati
on, NeurIPS 2024). Bij wisseling van Classic naar 
MCMC zet de app de MCMC-specifieke velden 
automatisch op beproefde standaardwaarden (reg-
weights = 0, MCMC-cap- multiplier 3.0, sample-/
noise-schedule). Zonder deze automatische initiali
satie leden sessies met oude voorinstellingen onder 
de 1.4.4-MCMC-collapse-bug (460K→5 Gaussians, 
watchdog-kill). De picker- selectie bepaalt aanvul
lend welke Inspector-elementen zichtbaar zijn — 
bij MCMC duiken I16/I17 op. Gedetailleerde veldwer
king in hoofdstuk 6, T11–T16 (Classic) en T61–T73 
(MCMC).

E E N VO U D I G  G E Z E G D

De centrale strategie-keuze voor 
de groei van het Gaussian-aan
tal. Classic is goed getuned 
uit 459 experimenten, genereert 
snelle en hoogwaardige resulta
ten en hoeft de MCMC-velden 
niet te kennen. MCMC is de nieu
were benadering (NeurIPS 2024), 
reproduceerbaarder en verzaakt 
aan handmatige drempel-juste
ring — maar rekent ongeveer 6× 
langer bij vergelijkbare kwaliteit. 
Bij omschakelen op MCMC zet de 
app automatisch veilige defaults, 
zodat de training niet in de 1.4.4-
collapse loopt. Details over de 
strategievelden staan in hoofd
stuk 6 (T11–T16 Classic, T61–T73 
MCMC).

I16 MCMC Quality-toggle

WA A R

Inspector → Trainingsconfiguratie → MCMC Quality 
(alleen bij Densification = MCMC).

T E C H N I S C H

Schakelt de gradient-accumulation op 2 stappen 
(actief) resp. 1 stap (inactief). Accumuleert de 
gradiënten uit twee opeenvolgende camera-views, 
voordat de optimizer-step wordt uitgevoerd. Empi
risch (sessie 33, V544a) reduceert dat de finale L1-
fout met ca. 6% (0,0246 met Quality vs 0,0261 zon
der, bij 3-trial-gemiddelde op Horse-Full-MCMC). 
De prijs: verdubbelde trainingstijd. Bij zeer lange 
trainingen (200K iteraties) leidt dat tot bijkomstige 
10+ minuten wachttijd — dus alleen lonend wanneer 
de laatste paar procent kwaliteit werkelijk nodig zijn. 
Werkt alleen op de training in, niet op het export-
formaat of de viewport-weergave.

E E N VO U D I G  G E Z E G D

Quality-modus voor MCMC met 
gradient-accumulation over twee 
views. Maakt het eindresultaat 
empirisch ongeveer 6% beter 
(L1 0,0246 in plaats van 0,0261 
in de horse-test), kost daarvoor 
twee keer zo lang. Als je toch 
al een 200K-MCMC-training rijdt 
(gerust 2 uur), komt er nog een 
krappe uur bovenop. Loont bij fi
nale showcase-renderings of aan 
het einde van een quality-sweep-
sessie, in de dagelijkse work
flow eerder niet. Alleen zichtbaar 
wanneer Densification op MCMC 
staat (I15).
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I17 Auto-scale by scene-toggle

WA A R

Inspector → Trainingsconfiguratie → Auto-scale by 
scene (alleen bij MCMC).

T E C H N I S C H

Wanneer actief, schaalt de effectieve Max-Gaus
sians- bovengrens met de SfM-init-point-count × 
MCMC-cap-multiplier (standaard 3.0). Voorbeeld: 
SfM levert 250K initpunten, basis-cap = 150K, mul
tiplier 3.0 → effectieve bovengrens = max(150K, 
750K) = 750K. Wanneer gedeactiveerd, geldt strikt 
alleen de basis. Werd voor v1.4.5 ingevoerd, omdat 
grote outdoor-opnames met meer dan 1000 fra
mes en overeenkomstig hoge SfM-puntendichtheid 
met de starre 150K-cap-standaard de densificati
on hebben uitgehongerd — overbodige punten ble
ven, nieuwe mochten niet ontstaan. Standaard OFF 
in custom-voorinstellingen, ON in MCMC-built-ins. 
Werkt alleen tijdens de training in, niet bij de export.

E E N VO U D I G  G E Z E G D

Laat het maximumaantal Gaus
sians met de scènegrootte mee
groeien (preciezer: met het aan
tal SfM-initpunten). Bij kleine 
scènes merk je nauwelijks een 
verschil, bij grote outdoor-scè
nes is het vaak doorslaggevend 
voor de kwaliteit — anders „ver
stikt“ de training, omdat de stan
daard bovengrens van 150K voor 
de scène veel te laag is. Werd 
speciaal voor v1.4.5 ingevoerd, 
nadat zeer grote outdoor-sets 
(meer dan 1000 frames) zicht
baar tegen de cap aanhingen. 
Bij de MCMC-built-in-voorinstel
lingen al vooraf ingeschakeld; in 
eigen voorinstellingen standaard 
uit.

I18 Max Iterations-stepper

WA A R

Inspector → Trainingsconfiguratie → GroupBox → 
Max Iterations.

T E C H N I S C H

Stepper met range 1.000–100.000, stapgrootte 
1.000. Bepaalt het totale aantal optimizer-iteraties. 
Lineair gecorreleerd met de trainingstijd (halve
ring = ca. 50% tijd). Empirische sweet-spots: 20K 
(Classic Balanced, L1≈0,028), 40K (Classic Quality, 
L1≈0,023), 200K (MCMC Full, L1≈0,0246). Boven 
40K bij Classic brengt gemiddeld nauwelijks verbe
tering — diminishing returns. Bij het wijzigen wordt, 
indien de link-functie (I19) actief is, Densify Until 
proportioneel meegetrokken (standaard-ratio: 0,5, 
d.w.z. Densify-Until = Max/2).

E E N VO U D I G  G E Z E G D

Hoeveel trainingstappen er wor
den gereden — meer is beter, 
maar kost ook lineair meer tijd. 
Vuistregel: 20.000 voor goede 
kwaliteit, 40.000 voor het opti
mum bij Classic-strategie (daar
boven brengt het gemiddeld nau
welijks nog wat). MCMC heeft 
duidelijk meer nodig, 200.000 is 
hier standaard. Verdubbelen van 
de iteraties verdubbelt grofweg 
de trainingstijd. Bij actieve link-
knop (I19) wordt Densify Until 
proportioneel meegetrokken — 
praktisch altijd wat je wilt.
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I19 Link/Unlink-knop (Densify ↔ Iterations)

WA A R

Inspector → Trainingsconfiguratie → GroupBox → 
kleine Link-knop tussen Max Iterations en Densify 
Until.

T E C H N I S C H

Toggle-knop die de verhouding van Densify Until 
tot Max Iterations bevriest. Bij actief (link-icoon 
geaccentueerd) wordt bij elke wijziging van Max Ite
rations Densify Until proportioneel nagetrokken. Bij 
unlink (link-plus-icoon) blijven de waarden onafhan
kelijk. Standaard is linked, omdat dat de typische 
correlatie weerspiegelt — wanneer je de training op 
dubbele iteraties trekt, wil je meestal ook de den
sification proportioneel langer laten lopen. De ver
houding wordt bij het instellen van de link-knop uit 
de actuele waarde berekend; een typische verhou
ding is 0,5 (Densify-Until = halve iteratie-aantal).

E E N VO U D I G  G E Z E G D

Kleine klemschakelaar tussen 
Max Iterations en Densify Un
til. Wanneer actief (link-icoon 
geaccentueerd), wandelen de 
twee waarden samen — ver
dubbel je de iteraties, ver
dubbelt zich ook Densify Un
til in dezelfde verhouding. In
dien niet ( link.badge.plus -
icoon), kun je ze onafhankelijk 
instellen. Standaard is gelinkt, 
omdat dat de typische correlatie 
weerspiegelt — langere training 
wil meestal ook langere densifi
cation-fase. Voor 99% van de ge
vallen laat hem ingeklikt.

I20 Densify Until-stepper

WA A R

Inspector → Trainingsconfiguratie → GroupBox → 
Densify Until.

T E C H N I S C H

Stepper met range 500–50.000, stapgrootte 500. 
Bepaalt de iteratie-index vanaf waar geen nieuwe 
Gaussians meer door clone/split (Classic) of reloca
tion (MCMC) bijkomen. Na bereiken worden alleen 
nog positie en kleur verfijnd. Hogere waarden = 
meer Gaussians = groter bestand, langere per-ite
ratie-tijd (+30-60% GPU-time per stap). Typische 
waarden: 15K (voor 30K Max-Iter), 20K (voor 40K), 
100K (voor 200K MCMC). Bij actieve link (I19) auto
matisch meegeschaald. Werkt anders bij Classic vs 
MCMC: Classic stopt volledig de groei, MCMC stopt 
de relocation-logica, maar sample-/noise-adaptatie 
loopt door.

E E N VO U D I G  G E Z E G D

Tot welke iteratie nieuwe Gaussi
ans mogen worden toegevoegd 
— bij Classic door clone/split, 
bij MCMC door relocation. Daar
na gaat het alleen nog om de 
kleur- en vorm- verfijning van de 
bestaande punten. Hoger = meer 
detail, maar ook groter bestand 
en +30-60% GPU-tijd per stap. 
Typische waarden: 15K (voor 30K 
Max-Iter), 20K (voor 40K), 100K 
(voor 200K MCMC). Hangt nor
maal via link (I19) aan Max Itera
tions — zelden zinvol dat hand
matig te ontkoppelen.
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I21 SSIM Weight-slider

WA A R

Inspector → Trainingsconfiguratie → GroupBox → 
SSIM Weight.

T E C H N I S C H

Slider 0,0–1,0 in stappen van 0,05, weergave als 
„0,20″. Mengt L1-loss (0,0) en SSIM-loss (1,0). L1 
strakt de helderheid per pixel aan, SSIM de struc
turele gelijkenis (randen, lokale statistieken). Stan
daard 0,2 is de waarde uit het originele 3DGS-paper 
(Kerbl 2023) en reverse-engineered als robuust 
compromis in talrijke sessies. Hogere waarden 
(0,5+) bevoordelen detailbehoud, kunnen echter lo
kale helderheidsfouten negeren. Lagere waarden (< 
0,1) leiden tot detailverlies bij scherpe randen. De 
SSIM- berekening loopt in de shader met een 11×11-
Gaussian-window. Performance: bij 0,0 (alleen L1) is 
de training ca. 8-12% sneller, omdat de SSIM-bere
kening in de shader wordt overgeslagen.

E E N VO U D I G  G E Z E G D

Hoe sterk de structurele beeld
gelijkenis (randen, lokale patro
nen) ten opzichte van de pu
re helderheidsvergelijking wordt 
gewogen. 0,2 is de standaard 
uit het originele 3DGS-paper en 
volstaat voor bijna alle scènes. 
Hoger (0,5+) bij fijne structuren 
zoals haar, vacht of vegetatie 
— daar helpt meer structuurge
wicht. Lager (0,0) maakt de trai
ning ongeveer 8-12% sneller, om
dat de SSIM- berekening in de 
shader wordt overgeslagen, maar 
kost detail bij scherpe randen. 
Wie geen goede reden voor een 
wijziging heeft, laat 0,2 staan.

I22 Render Scale-slider

WA A R

Inspector → Trainingsconfiguratie → GroupBox → 
Render Scale.

T E C H N I S C H

Slider 0,25–1,0 in stappen van 0,25, weergave als 
„100%“. Schaalt de trainings-rendering-resolutie re
latief aan de bronbeeld-grootte. Grootste hefboom 
op de performance: 50% reduceert GPU-tijd met 
ca. 75% (omdat 4× minder pixels), 25% met ca. 
94%. De gradient-drempel wordt automatisch mee
geschaald. Onder de slider verschijnt een live-reso
lutieweergave in MP (bijv. „2304×1296 (3,0 MP)”). 
Mocht de actuele waarde afwijken van de aanbevo
len, wordt in oranje schrift „— recommended: 50%“ 
ingeblend. De aanbeveling mikt op ~3 MP effectieve 
resolutie — het door Apple Silicon GPU’s meest ef
ficiënt verwerkbare bereik. 4K-bronbeelden krijgen 
bijv. automatisch 25% aanbevolen, FullHD-beelden 
100%. Een wijziging triggert aanvullend de buffer-
reallocatie.

E E N VO U D I G  G E Z E G D

Met welke resolutie de training 
rendert — één van de groot
ste performance-hefbomen. Vol 
(100%) geeft de beste kwaliteit, 
kost echter bij grote beelden veel 
GPU-tijd. Half (50%) spaart on
geveer 75% GPU-tijd, omdat vier 
keer minder pixels worden bere
kend — perfect voor 4K-bronnen. 
Onder de slider zie je de effec
tieve resolutie in megapixels; de 
app mikt op rond 3 MP, omdat dat 
op Apple Silicon het efficiëntst 
loopt. Als je waarde daarvan af
wijkt, blendt de app een oranje 
„recommended“-hint in — mee
stal loont het die te volgen.
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Enhancements-sectie (I26–I29, I42–I44)

Afbeelding 12:  Crop alleen Enhancements-sectie — drie rijen: Post-Training Compactificati­
on (toggle aan), Viewport Scaling (segmented picker Off/MetalFX/Lanczos), Perceptual Loss 

(slider op „Off“). Elke rij met ondertitel verklaart functie

De Enhancements-sectie groepeert drie functies die beeldkwaliteit verbeteren zonder 
de kerntrainingsloop zelf te veranderen. De eerste twee (I26-I27) zijn post-training- 
resp. viewport-stadia: Compactification ruimt na het trainingseinde op, de Viewport-
Scaling is een pure viewport-renderer die de lopende training niet beïnvloedt. De 
Perceptual Loss (I29) is ondanks de sectie-toebehoorigheid een trainingsbestanddeel 
— hij wordt tijdens de training als extra loss-term geactiveerd, vandaar de scheiding van 
de viewport-toggles via een divider. Met v1.6 heeft de sectie bovendien een Outdoor-
groep (I42–I44: Sky Masking, Mid-Training Floater Cleanup, Reconstruct Sky Dome) — 
trainingsopties tegen sky-floaters die vroeger in het instellingenvenster stonden en nu 
hier per project zitten.
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I26 Post-Training Compactification-toggle

WA A R

Inspector → Enhancements → Post-Training Com
pactification.

T E C H N I S C H

Activeert de V443-post-processing: na afronding 
van de trainingsiteraties worden Gaussians met 
opacity onder 0,01 (1% zichtbaarheid) verwijderd. 
Empirisch reduceert dat de bestandsgrootte met 
~55-58% bij nul zichtbaar kwaliteitsverlies — om
dat deze Gaussians visueel toch niet bijdragen. 
De compactification loopt als GPU-compact-pass 
en duurt al naar gelang Gaussian-count seconden-
fracties tot enkele seconden. Beïnvloedt de trai
ningsperformance niet. Als deze toggle uit is, wor
den ook invisible Gaussians geëxporteerd — rele
vant alleen wanneer je het formaat voor een verdere 
training-stage wilt gebruiken (Continue Training), 
anders verspilling van geheugen.

E E N VO U D I G  G E Z E G D

Ruimt na de training Gaussi
ans op die je sowieso niet kunt 
zien (opacity onder 1%). Maakt 
de exportbestanden ongeveer de 
helft kleiner ( 55-58% grootte
reductie) zonder zichtbaar kwali
teitsverlies. Loopt als korte GPU-
pass na de laatste iteratie, duurt 
slechts seconden-fracties tot en
kele seconden. Zou praktisch al
tijd aan moeten zijn — de enige 
reden om dit uit te zetten, is 
wanneer je de training later via 
Continue Training wilt voortzet
ten en ook onzichtbare Gaussi
ans moet behouden. Bij normale 
export-workflows gewoon laten 
aanstaan.
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I27 Viewport Scaling-picker

WA A R

Inspector → Enhancements → Viewport Scaling 
(segmented picker met drie opties: Off, MetalFX, 
Lanczos).

T E C H N I S C H

Eén enkele segmented picker die de viewport-
upscaler kiest — de drie opties zijn wederzijds 
uitsluitend. Wanneer de trainings-resolutie (door 
I22 Render Scale) lager is dan de viewport-grootte, 
schaalt de gekozen modus de gerenderde frame op 
naar de weergavegrootte. Off = eenvoudig bilineair 
uitrekken. MetalFX = Apple’s ML-gebaseerde spati
al upscaler, de scherpste optie (het ML-model is 
op scherpe randen geoptimaliseerd), overhead ca. 
1-2 ms per frame op M3-GPU’s. Lanczos = Apple’s 
Metal Performance Shaders met 8-tap-sinc-resam
pling, klassiek zonder ML, minimale overhead (< 
0,5 ms), kwaliteit onder MetalFX, maar zonder ML-
typisch „gladstrijken“ van fijne lijnstructuren. De 
renderer- pipeline wordt bij omschakelen live geher
configureerd — direct zichtbaar, zonder herstart. 
Achtergrond: Vroeger waren dit twee aparte tog
gles (MetalFX + Lanczos), die tegelijk aan konden 
staan — een tegenstrijdige toestand waarin MetalFX 
stil over Lanczos heen ging. De picker verwijdert 
deze toestand; een eventueel uit oudere sessies 
geërfde „beide-aan”-toestand heelt zichzelf bij de 
volgende wissel naar MetalFX. Werkt alleen op het 
live-viewport, niet op gerenderde exports (orbit-
video, screenshots) — die worden in volle bronreso
lutie gerenderd.

E E N VO U D I G  G E Z E G D

Schept het live-beeld in het vie
wport scherper op — vooral nut
tig wanneer je met gereduceerde 
trainings-resolutie (Render Scale 
50%, zie I22) werkt. Drie stan
den waarvan er altijd maar één 
actief is: „Off“ rekt simpelweg 
de pixels uit, „MetalFX” gebruikt 
Apple’s machine-learning voor 
de scherpste randen (praktisch 
altijd de beste keuze), „Lanc
zos“ is het klassieke filter zon
der ML — neem dat als fallback 
mocht MetalFX in een scène lij
nen gladstrijken of artefacten 
tonen. Grijpt live in, zonder her
start. Werkt alleen in het live-vie
wport, niet op geëxporteerde or
bit-video’s of screenshots — die 
worden in volle bronresolutie ge
renderd. Anders dan vroeger kun 
je niet meer per ongeluk twee 
modi tegelijk kiezen.
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I29 Perceptual Loss-slider

WA A R

Inspector → Enhancements → Perceptual Loss.

T E C H N I S C H

Slider 0,0–0,2 in stappen van 0,01, weergave bij 
0,0 als „Off“, anders als „0,05” etc. Activeert een 
extra loss-term, die multi-geschaalde Gaussian-blur 
van de rendering met het ground-truth-beeld verge
lijkt (3 blur-schalen). Vangt structurele verschillen 
op die L1+SSIM alleen niet herkennen. V460-im
plementatie. Empirisch verbetert een waarde van 
0,05-0,1 de L1-score in sessies met enkele procent, 
kost echter ~5% trainingstijd (extra forward-pass 
door de blur-kernels). Boven 0,15 wordt de training 
instabiel en L1 verslechtert weer (loss-term domi
neert de optimalisatie). Werkt tijdens de training, 
niet in het post-processing — ondanks de positie in 
de „Enhancements“-sectie is dit dus geen pure op
waardering achteraf.

E E N VO U D I G  G E Z E G D

Een extra loss-aandeel dat struc
turele beeldgelijkenis over drie 
verschillende vervagingsstadia 
toetst. Helpt vooral bij scènes 
met fijne structuren zoals haar, 
stof of vegetatie, omdat hij pa
tronen vangt die L1+SSIM alleen 
niet zien. Kleinere waarden zijn 
veiliger — 0,05 tot 0,1 is de 
sweet spot, boven 0,15 wordt de 
training instabiel en de loss ver
slechtert weer. Op 0 (Off) is de 
functie volledig uit en kost niets; 
actief slokt hij ongeveer 5% trai
ningstijd op voor de extra for
ward-pass door de blur-kernels. 
Werkt ondanks „Enhancements“-
sectie direct tijdens de training, 
niet pas in het post-processing.
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I42 Sky Masking

WA A R

Inspector → Enhancements (Outdoor-
groep) → Toggle „Sky Masking“. Bound: 
AppState.trainingConfig.skyMaskingEnabled (per 
project, @DefaultFalse ). Default: false .

T E C H N I S C H

Activeert pre-training Apple-Vision-gebaseerde 
sky-pixel-segmentatie. Vóór de trainingsstart wordt 
voor elke invoercamera de lucht-regio via Apple-
Vision-Foreground-Mask geëxtraheerd (Sky = Back
ground) en als per-pixel-masker aan de betreffende 
camera toegewezen. Tijdens de training wordt de 
loss-bijdrage per pixel met het complement van 
het sky-masker vermenigvuldigd — sky-pixels dra
gen 0 bij aan de gradiënt, zodat Gaussians die 
in de lucht projecteren geen optimalisatie-signalen 
ontvangen en daarmee niet „dichter“ of „lichter” 
worden. Reduceert floaters (donkere klontjes in 
de lucht) bij outdoor/drone-scènes significant. Kost 
~3% L1-regressie bij klassieke 40K-training (zie 
memory/​dev_​outdoor-floater-reduction.md). Alleen 
zinvol bij outdoor-scènes met duidelijk herkenbare 
lucht; bij binnenscènes of witte achtergrond identi
ficeert de sky-segmentatie verkeerde gebieden en 
blokkeert valide loss-signalen. De waarde wordt nu 
per project opgeslagen (niet langer app-globaal) en 
volgt de preset / het scènebestand.

E E N VO U D I G  G E Z E G D

Bij outdoor-opnames met lucht 
in beeld ontstaan vaak zwar
te of gekleurde klontjes in 
de lucht — zogenaamde „floa
ters“. Deze optie herkent auto
matisch waar de lucht is en 
zegt tegen de training: „Laat 
de lucht met rust.” Werkt zeer 
goed bij dronevluchten en land
schapsscènes. Bij binnenruim
tes of donkere achtergronden 
kan het het beeld verslechte
ren — dus alleen inschakelen 
als echte lucht zichtbaar is. 
Details: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Mid-Training Floater Cleanup

WA A R

Inspector → Enhancements (Outdoor-groep) → 
Toggle „Mid-Training Floater Cleanup“. Bound: 
AppState.trainingConfig.floaterCleanupEnabled 
(per project, @DefaultFalse ). Default: false .

T E C H N I S C H

Schakelt bij Classic-40K-training (voorinstelling „P4 
Quality“) twee extra density-control-passes in: bij 
iteratie 20.000 en bij iteratie 30.000. Beide pas
ses doorzoeken alle Gaussians op drie criteria: (a) 
zeer lage opacity (standaard 0,005), (b) zeer kleine 
screen-space-grootte, (c) geen loss-bijdragen in de 
laatste 1.000 iteraties. Gaussians die alle drie voor
waarden vervullen, worden gepurged. Effect: ~5–
15% minder Gaussians aan het einde van de trai
ning, zichtbaar minder donkere klontjes in de lucht 
bij drone-/outdoor-scènes. Kost ~1–3% L1-regressie 
bij close-up-binnenscènes, daarom niet als stan
daard geactiveerd. De twee cleanup-iteraties (20K, 
30K) zijn hard gedefinieerd en kunnen momenteel 
niet via UI worden aangepast; bij kortere trainingen 
(bijv. P2 Preview 5K) heeft de toggle geen effect, 
omdat de iteratiemarkeringen nooit worden bereikt. 
Nieuw: De toggle is alleen nog bedienbaar wanneer 
het actieve preset de Classic-densifier gebruikt 
(densificationStrategy == .classic). Bij MCMC 
of Hybrid wordt hij disabled en verschijnt een in
line-hint, omdat deze strategieën dode Gaussians 
sowieso zelf afhandelen (MCMC via relocation, Hy
brid via gecombineerde reloc-/noise-logica) — de 
handmatige cleanup- passes zouden daar werkings
loos resp. contraproductief zijn. Code-referentie: 
RadianceKitApp.swift, General-tab. Details: memory/​
dev_​outdoor-floater-reduction.md.

E E N VO U D I G  G E Z E G D

Tijdens de training ontstaan 
soms „dode“ Gauss-punten die 
niets meer aan de beeldkwali
teit bijdragen, maar wel geheu
gen innemen. Deze optie ruimt 
twee keer tijdens een lange trai
ning (bij 20K en 30K iteraties) 
op en verwijdert deze lijken. Bij 
outdoor-scènes met lucht is dat 
bijzonder zinvol, omdat zich daar 
de meeste floaters verzamelen. 
Bij kleine trainingen of close-ups 
van meubels eerder niet nodig. 
De schakelaar laat zich alleen in
schakelen wanneer je preset de 
Classic-densifier gebruikt — bij 
MCMC- of Hybrid-presets is hij 
grijs (met korte uitleg), omdat 
die hun dode punten zelf oprui
men.
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I44 Reconstruct Sky Dome

WA A R

Inspector → Enhancements (Outdoor-groep) 
→ Toggle „Reconstruct Sky Dome“. Bound: 
AppState.trainingConfig.skyDomeEnabled (per pro
ject, @DefaultFalse ). Default: false .

T E C H N I S C H

Activeert de pre-training-sky-dome-projectie 
(V549e MVP). Na SfM en vóór de trainingsstart 
wordt voor elke invoercamera het in S7 gedeel
de Apple-Vision-sky-masker uit het beeld geëxtra
heerd, de sky-pixels worden met de camera-intrin
sics geprojecteerd op een virtueel boloppervlak 
(standaardradius 8× scènradius). Op deze bol wor
den ~5.000 nieuwe Gaussians geïnitialiseerd met 
kleur-gemiddelden uit de geprojecteerde sky-pixels, 
zeer grote schaal (1,0 in scène-eenheden) en begin-
opacity 0,95. Deze 5.000 Gaussians zijn geen sky-
masker in klassieke zin — ze worden getraind zoals 
alle andere, maar door de hoge begin-opacity in 
een dunne schaal gehouden. Resultaat: bij 360°-
novel-views in outdoor/drone-scènes verschijnen in 
plaats van donkere confetti-klontjes daadwerkelijke 
luchtkleur en wolkstructuren. De waarde wordt over 
herstarts onthouden. Alleen zinvol bij outdoor-scè
nes met minstens 360°-camera-dekking; bij pure 
object-captures zonder zichtbare lucht heeft het 
geen effect. Status: experimenteel, bredere A/B-va
lidatie over verdere outdoor-sets staat nog open.

E E N VO U D I G  G E Z E G D

In plaats van dat de training 
probeert de lucht uit de paar 
zichtbare pixels te „raden“ (wat 
tot floaters leidt), projecteert Ra
dianceKit de luchtpixels recht
streeks op een virtuele bol rond 
de scène, voordat de training 
start. Wanneer je dan de afge
werkte scène in 360° draait, zie 
je echte lucht in plaats van zwar
te klontjes. Werkt alleen bij out
door-opnames waarin daadwer
kelijk lucht in beeld is. Bij woon
kamerscans of studio-opnames 
levert het niets op.
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Metrics-sectie (I30–I38)

Afbeelding 13:  Crop alleen Training Metrics-sectie na voltooide training op bouquet (5K 
iteraties, 2.991 Gaussians finaal) — tabel met trainingmetrics (Iteration, Loss, SSIM Loss, 

Combined Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Terwijl een training loopt, toont de metrics-sectie negen live-waarden uit de trai
ningsloop. Vóór de start van een training is de sectie leeg („Start training to see live 
metrics“). Alle waarden worden elke ~30 iteraties geactualiseerd (update-frequentie 
van de -stream). De sectie is read-only — geen element is klikbaar of veranderbaar. 
Voor diepere analyse de JSONL-trainings-logs onder ~/​Documents/​RadianceKit/​Logs/​ 
raadplegen (script python3 scripts/​analyze_​logs.py best 5).
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I30 Iteration

WA A R

Inspector → Metrics → Iteration. Read-only.

T E C H N I S C H

Weergave in het formaat „4523 / 40000″ — actuele 
iteratie boven totaal geplande iteraties. Telt syn
chroon mee met de trainingsloop die de waarden 
elke ~30 iter pushed. De tweede getalwaarde komt 
overeen met de Max-Iterations-waarde op het start
moment; hij verandert niet meer, ook al verstelt 
de gebruiker de stepper daarna — de lopende 
run gebruikt zijn eigen snapshot-kopie. Wanneer de 
app via het training-menu iteraties bovenop schuift 
(Continue Training +5K/+10K/+20K), neemt de noe
mer toe.

E E N VO U D I G  G E Z E G D

Waar de training momenteel 
staat. „4523 / 40000″ betekent: 
4523 van 40.000 stappen zijn 
door, dus ongeveer 11% klaar. 
De linker getalwaarde telt secon
degewijs op; mocht hij minuten
lang stilstaan, hangt de training 
vast — meestal een wijzing op 
GPU- throttling of een concur
rerende app. De rechter waarde 
komt overeen met de Max-Iterati
ons-waarde (I18) bij de trainings
start en verandert niet meer, ook 
al verstel je de stepper later. 
Bij Continue Training (+5K/+10K/
+20K) groeit hij met de extra 
stappen mee.

I31 Loss

WA A R

Inspector → Metrics → Loss. Read-only.

T E C H N I S C H

Float-waarde met zes decimalen (bijv. „0,024385″). 
Meet de gecombineerde L1+SSIM-loss (mix gecon
troleerd via I21 SSIM Weight) plus optioneel Percep
tual Loss (I29) en andere regularizers. Schaal is 
niet absoluut, maar scène-afhankelijk — vereist voor 
de meeste vergelijkingen dezelfde dataset. Typische 
eindwaarden bij goede configuraties: - Classic Qua
lity 40K iters: 0,022–0,025 (Horse, Truck, Garden) - 
MCMC Full 200K iters: 0,024–0,028 - Outdoor dro
ne 30K: 0,030–0,060 (geometrie-bepaald slechter) 
- Indoor apartments: 0,018–0,025

Waarden boven 0,10 na 5K iteraties duiden op SfM-
problemen (slechte cameraposes) — afbreken en 
SfM opnieuw berekenen.

E E N VO U D I G  G E Z E G D

Hoever het gerenderde beeld nog 
afwijkt van het origineel — ge
combineerd uit L1, SSIM en even
tueel Perceptual Loss. Kleiner 
is beter. Onder 0,03 is meestal 
echt goed, onder 0,05 nog oké, 
outdoor-scènes liggen geome
trie-bepaald eerder bij 0,03-0,06. 
Boven 0,10 na meerdere duizen
den iteraties is een waarschu
wingssignaal — meestal ligt het 
aan de camerareconstructie (SfM 
heeft niet schoon geklapt). De 
schaal is niet absoluut, maar 
scène-afhankelijk; vergelijkingen 
alleen binnen dezelfde dataset 
maken. Wanneer het getal plot
seling naar boven springt, is 
meestal een gradient-explosion-
event gebeurd.
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I32 Learning Rate

WA A R

Inspector → Metrics → Learning Rate. Read-only.

T E C H N I S C H

Wetenschappelijke-notatie-weergave (bijv. 
„1,60e-04″). Actuele leerratio voor de position-pa
rameters (3DGS heeft zes onafhankelijke LR’s voor 
position, SH-DC, SH-rest, opacity, scale, rotation 
— weergegeven wordt hier de position-LR als repre
sentatieve grootheid). Standaard-aanvangswaarde 
1,6e-4, die via een exponentieel verval tot ~1,6e-6 
aan het trainingseinde afzakt. Het verval is via 
het LR-schedule-veld in de Trainings- configuratie 
(T-veld in hfd. 6) aanpasbaar. Wanneer de LR onge
woon hoog blijft (bijv. 1e-3 of meer na 10K iteraties), 
kan dat op een verkeerd geladen configuratie wij
zen.

E E N VO U D I G  G E Z E G D

Hoe groot de optimalisatie-stap
pen momenteel zijn — concreet 
de leerratio voor de Gaussian-
posities. Start bij 1,60e-04 en 
daalt exponentieel tot ongeveer 
1,60e-06 aan het trainingsein
de („1,60e-06″ = 0,0000016). 
Het verloop loopt automatisch, 
je hoeft hier niets te justeren. 
Wanneer de waarde na 10.000+ 
iteraties nog steeds groter is 
dan 1e-3, werd waarschijnlijk 
een verkeerde config geladen 
— training afbreken en voorin
stelling opnieuw kiezen. Intern 
heeft 3DGS zes onafhankelijke 
leerratio’s (position, SH-DC, SH-
rest, opacity, scale, rotation); 
hier zie je alleen de position-LR 
als plaatsvervanger.

I33 SH Degree

WA A R

Inspector → Metrics → SH Degree. Read-only.

T E C H N I S C H

Geheel getal 0-3. Spherical-harmonics-graad voor 
de kleurrepresentatie. Begint bij 0 (alleen de DC-
component, d.w.z. richtings-onafhankelijke kleur per 
Gaussian — dus slechts één RGB-constante) en 
stijgt in de loop van de training progressief 
naar 3. De standaard-schedule heft de graad bij 
1000/2000/3000 iteraties met 1 op. SH-3 komt 
overeen met 48 kleur-coëfficiënten per Gaussian (3 
RGB-channels × 16 SH-basisfuncties). Hogere SH-
graad = meer richtings-afhankelijke reflectie (glan
zende oppervlakken zien er onder verschillende 
kijkhoeken correct anders uit), maar ook meer ge
heugen en langzamere training.

E E N VO U D I G  G E Z E G D

Hoe complex de kleurweergave 
per Gaussian momenteel is. Start 
bij 0 (slechts één richtings-on
afhankelijke kleur per punt) en 
wordt stapsgewijs naar 3 opge
trokken — typisch bij iteratie 
1000, 2000 en 3000. Trap 3 be
tekent 48 kleur-coëfficiënten per 
Gaussian en staat richtings-af
hankelijke reflecties toe, dus dat 
glanzende oppervlakken vanuit 
verschillende kijkhoeken correct 
anders eruitzien. Hoef je niet ac
tief aan te raken, de schedule 
loopt automatisch. Hogere graad 
kost meer geheugen en vertraagt 
de training licht — maar dat is de 
prijs voor realistische glanslich
ten.
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I34 Gaussians

WA A R

Inspector → Metrics → Gaussians. Read-only.

T E C H N I S C H

Actuele aantal Gaussians in het model, geformat
teerd met locale-separator (bijv. „524.318″). Groei: 
- Classic: start bij de SfM-init-punten (typisch 
50K-300K), groeit door clone/split tot kort voor 
Densify Until, daarna statisch tot trainingseinde 
(modulo pruning) - MCMC: sample-punten worden 
toegevoegd tot het MCMC-cap, daarna alleen nog 
relocation

Gezonde eindwaarden: - Classic Quality: 
400K-700K (Horse 524K, Garden 800K) - MCMC 
Full: exact op de cap (standaard 150K, met auto-
scale multiplier × SfM-count al naar gelang scène 
500K-1,5M)

Bij MCMC valt het getal naar < 60% van de cap → 
anomalie (collapse-indicator, wijst op te agressieve 
regularizers).

E E N VO U D I G  G E Z E G D

Hoeveel Gaussian-punten het 
3D-model momenteel heeft. 
Groeit tijdens de training tot 
Densify Until (I20) is bereikt; 
daarna blijft het getal praktisch 
constant. Meer punten = meer 
detail, maar ook groter bestand 
en langzamere rendering in het 
viewport. 500.000 Gaussians is 
een typische middelwaarde voor 
Classic-Quality op een middel
grote scène; MCMC Full landt af
hankelijk van auto-scale (I17) bij 
500K tot 1,5M. Wanneer het getal 
bij MCMC plotseling onder 60% 
van de cap valt, is dat een collap
se-indicator — meestal te agres
sieve regularizers.

I35 GPU Memory

WA A R

Inspector → Metrics → GPU Memory. Read-only.

T E C H N I S C H

Schatting van het Gaussian-buffer-geheugenver
bruik als Gaussian-count × 616 bytes (geformat
teerd in memory-stijl). 616 bytes is de empirische 
grootte van een volledig uitgeruste Gaussian (posi
tion, scale, rotation, opacity, SH-coëfficiënten graad 
3, gradient- accumulator). De weergave erkent niet 
de renderer-overhead (tile-buffer, sort-buffer, bac
kward-buffer) — de reële GPU- geheugenbehoefte 
ligt typisch 2-3× boven deze waarde. Bij 500K 
Gaussians: weergegeven ~290 MB, reëel ~700 MB. 
Bij 1,5M Gaussians: weergegeven ~880 MB, reëel 
~2,5 GB. Op M3 Max met 64+ GB Unified Memory 
onkritisch, op M3 Pro met 18 GB al een limiet.

E E N VO U D I G  G E Z E G D

Een schatting hoeveel GPU-ge
heugen de Gaussians zelf inne
men — rond 616 bytes per punt. 
Het werkelijke GPU-verbruik is 
2-3× hoger dan weergegeven, 
omdat de renderer nog eigen 
tile-, sort- en backward-buffers 
erbij legt. Bij een MacBook met 
16-18 GB Unified Memory zou je 
onder 500K Gaussians moeten 
blijven; met M3 Max of Studio 
(64+ GB) kun je rustig 1,5M en 
meer rijden. Wanneer de training 
plotseling crasht of het systeem 
swapt, is meestal hier de grens 
bereikt — Render Scale (I22) om
laag of Densify Until (I20) ver
minderen.
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I36 Speed

WA A R

Inspector → Metrics → Speed. Read-only.

T E C H N I S C H

Iteraties-per-seconde met één decimaal („24,3 it/
s“). Berekend door de trainer als glijdend gemiddel
de over de laatste ~100 iteraties. Typische waarden: 
- Quick voorinstelling (1K iters): 80-120 it/s (kort, 
geen steady-state) - Classic 20K @ 1,0 Render Sca
le (Truck-scène, M3 Max): 25-35 it/s - Classic 20K 
@ 0,5 Render Scale: 80-120 it/s - MCMC 200K @ 
0,5 Render Scale: 25-50 it/s (langzamer vanwege 
relocation) - Bij 1M+ Gaussians en volle resolutie: < 
10 it/s

Dalende speed in de loop van de training is normaal 
— meer Gaussians = meer compute per iteratie. 
Plotselinge inzinkingen (bijv. van 30 → 5 it/s) duiden 
op GPU-thermal-throttling of concurrerende apps.

E E N VO U D I G  G E Z E G D

Hoe snel de training loopt, in ite
raties per seconde. Staat typisch 
bij 20-50 it/s, bij gereduceerde 
render scale (50%) en kleine scè
nes ook eens 80-120 it/s. Daalt in 
de loop van de training heel na
tuurlijk, omdat meer Gaussians 
= meer werk per iteratie. Plot
selinge inzinkingen (bijv. 30 → 
5 it/s) duiden op GPU- thermal-
throttling of concurrerende apps 
— browser-tabs met video, Ti
me-Machine-backup, photos-in
dexing. App in de voorgrond hou
den en achtergrondprogramma’s 
sluiten helpt vaak. Bij 1M+ Gaus
sians en volle resolutie zijn onder 
10 it/s normaal.

I37 Elapsed

WA A R

Inspector → Metrics → Elapsed. Read-only.

T E C H N I S C H

Reeds verstreken tijd als „4:23″ (m:ss) of „1:23:45″ 
(h:mm:ss). Format-switch vanaf 1 uur. Meet alleen 
de pure trainingstijd, niet de voorafgaande fasen 
(SfM-berekening, beeld- import). Bij pauze/hervat
ten loopt de klok door — is dus wall-clock, geen 
CPU-tijd.

E E N VO U D I G  G E Z E G D

Hoe lang de training al loopt, als 
pure stopwatch (wall-clock-tijd). 
Format is „m:ss“ tot een uur, 
daarna „h:mm:ss”. Niet „CPU-
tijd“, maar „hoe lang wachten we 
al” — dus ook pauzetijden tellen 
mee. Meet alleen de pure trai
ningsfase, niet de voorafgaande 
SfM-berekening of de beeldim
port. Behulpzaam ter vergelijking 
met de ETA (I38) — wanneer 
Elapsed duidelijk boven de oor
spronkelijke ETA uitschiet, is de 
training ergens trager geworden 
dan gepland.
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I38 ETA

WA A R

Inspector → Metrics → ETA. Read-only.

T E C H N I S C H

Geschatte resttijd als „17:42″ of „1:12:35″. Bereke
ning: (Max Iterations − actuele iteratie) / iteraties-
per- seconde. Toont „–“ wanneer de speed momen
teel nul is (helemaal aan het begin of bij pauze). 
De schatting wordt niet aan de typische vertraging 
tegen het trainingseinde aangepast — vooral bij 
MCMC en Classic met grote Densify-Until-waarden 
neigt de training ertoe langzamer te worden, omdat 
steeds meer Gaussians in het beeld komen. Reëel 
blijft het typisch 10-20% boven de aanvangs-ETA.

E E N VO U D I G  G E Z E G D

Hoe lang er voorspelbaar nog 
te wachten is — berekend uit 
de resterende iteraties en de 
actuele speed (I36). Een grove 
schatting: als de Mac plotseling 
langzamer wordt (meer Gaussi
ans vanaf densify-fase, thermal-
throttling, andere apps), kan het 
langer duren dan weergegeven. 
De app rekent de typische ver
traging tegen het trainingseinde 
niet in, daarom landt het echte 
einde meestal 10-20% boven de 
aanvangs-ETA. Plus 15% inreke
nen, dan klopt het meestal. Toont 
„–“ wanneer de speed momen
teel 0 is (trainingsaanvang of 
pauze).
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Loss-chart-sectie (I39–I41)

Afbeelding 14:  Crop alleen Loss History-sectie na voltooide training — Current 0,0064, Min 
0,0035 (groen), blauw verloop van 0,027 (iteratie 1) tot 0,0035 (iteratie 5K) met karakteris­

tieke knik rond iter 200, daaronder Gaussian Count-Chart oranje

De Loss-Chart-sectie visualiseert het trainingsverloop over de tijd. Hij bestaat uit twee 
charts: een Loss-Curve-Chart (groot, boven, blauw) en een Gaussian-count-chart (klei
ner, onder, oranje). Beide worden live tijdens de training opgebouwd en persisteren tot 
de volgende trainingstart. Vóór de eerste training is het gebied leeg („Loss curve will 
appear during training“). De charts zijn pure SwiftUI-path-drawings (geen Swift-Charts-
framework), zodat ze ook bij 100K+ punten vloeiend renderen.
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I39 Current Loss (weergave)

WA A R

Inspector → Loss-Chart → linker labelgebied „Cur
rent: 0,0287″. Read-only.

T E C H N I S C H

Float-waarde van het laatste loss-samplepunt, ge
formatteerd met vier decimalen. Identiek aan I31 
(Loss in de Metrics-sectie), alleen hier compacter 
geformatteerd. Bron is de Loss- history — een lijst 
die per ~30 iteraties een entry krijgt. Alleen eindige 
waarden worden in de lijst opgenomen — NaN/infi
nity (zeer zelden, bij een gradient-explosion-bug) 
worden gefilterd.

E E N VO U D I G  G E Z E G D

De actuele loss-waarde in korte
re schrijfwijze dan in de Metrics-
sectie (vier decimalen). Inhoude
lijk identiek aan I31, maar hier zit 
de weergave direct bij de loss-
chart en geeft je bij het obser
veren van de curve de exacte 
numerieke waarde. Wordt zoals 
alle live-metrics elke  30 itera
ties geactualiseerd. NaN- of infi
nity- waarden (extreem zeldzaam 
bij gradient-explosion-bugs) fil
tert de app automatisch eruit. 
Nuttig om bij het kijken naar het 
diagram niet naar de andere sec
tie te hoeven springen.

I40 Min Loss (weergave)

WA A R

Inspector → Loss-Chart → rechter labelgebied „Min: 
0,0245″ (groen). Read-only.

T E C H N I S C H

Minimum van alle ooit geziene loss-waarden van de 
actuele trainings-run. Wordt live uit de loss-history 
herberekend — geen separate persistentie. Wordt 
met groene schrift weergegeven, omdat „Min“ = 
„best so far”. De gestreepte groene lijn aan de on
derste chart-rand markeert deze Y-positie visueel. 
Bij Continue-Training- sessies start de min-tracking 
opnieuw — de oude history wordt in de UI door de 
nieuwe vervangen (niet aangehangen). Wanneer de 
actuele training slechter loopt dan de voorgaande, 
kan de Min-weergave dus groter zijn dan het voor
gaande eindresultaat.

E E N VO U D I G  G E Z E G D

De laagste loss-waarde die de
ze training tot dusver heeft ge
zien — groen weergegeven, om
dat „best so far“. De gestreep
te groene lijn aan de onderste 
chart-rand markeert deze positie 
ook visueel. Wanneer de actuele 
curve momenteel duidelijk daar
boven ligt, is er met geluk nog 
een verbetering; meestal is Min 
echter het eindresultaat-indica
tor dat jou later interesseert. Bij 
Continue-Training- sessies start 
de min-tracking opnieuw, omdat 
de oude history in de UI door 
de nieuwe wordt vervangen — de 
min-waarde kan daardoor slech
ter ogen dan het voorgaande 
eindresultaat.
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I41 Gaussian Count Chart

WA A R

Inspector → Loss-Chart → tweede chart eronder 
(oranje). Read-only.

T E C H N I S C H

Lijndiagram van het Gaussian-aantal over de trai
ningsiteraties. Bron: de Gaussian-count-history (lijst 
van (iter, count)-paren, gevuld door de trainer elke 
~30 iter). Y-schaal dynamisch tussen minimum en 
maximum van de history. Bij Classic- strategie ziet 
de curve er typisch zo uit: gestaag stijgend tot Den
sify Until, daarna vlak (met kleine pruning-schom
melingen). Bij MCMC: steile stijging tot cap, daarna 
horizontale lijn (relocation houdt de getalwaarde 
constant). Wanneer de curve daalt ondanks actie
ve training, pruned de densification te agressief — 
aanwijzing voor verkeerde defaults of een bekende 
MCMC-collapse-bug (v1.4.4-hotfix-thema).

E E N VO U D I G  G E Z E G D

Hoe het aantal Gaussians zich 
over de trainingstijd ontwikkelt 
— het kleinere oranje chart on
der de loss-curve. Bij Classic-
strategie stijgt de lijn gestaag, 
tot Densify Until (I20) is bereikt, 
daarna blijft hij vlak met klei
ne pruning-schommelingen. Bij 
MCMC schiet hij steil naar de cap 
omhoog en blijft daarna horizon
taal, omdat relocation het getal 
constant houdt. Wanneer de cur
ve ondanks actieve training plot
seling naar beneden knikt, is de 
densification te agressief bij het 
prunen — klassiek teken voor 
de MCMC-collapse-bug uit v1.4.4. 
Dan helpt app-update of een wis
sel terug naar Classic.

Hoe lees je de loss-curve?

De Loss-Chart is het belangrijkste diagnose-tool in de Inspector — geen andere indica
tor toont zo direct of de training nuttig voortgaat of vasthangt. De typische gezonde 
vorm is een snelle daling in de eerste 1000-3000 iteraties (van ~0,15 naar ~0,05), ge
volgd door een langzame, gelijkmatige daling tot het trainingseinde (op 0,020-0,030). 
Logaritmisch oogt de curve daarbij als een gladde diagonaal.

Wat betekent een plateau bij de loss? Wanneer de curve over meerdere duizenden 
iteraties vlak blijft, zijn er twee mogelijke interpretaties: (a) training is „geconvergeerd“ 
— de loss kan niet meer significant dalen, omdat het model zo goed is als het met de 
gegeven data en settings kan zijn. Dat is gewenst; dat is „klaar”. (b) Training „hangt“ — 
de loss kan eigenlijk nog dalen, maar de optimalisatie stagneert (lokaal minimum, leer
ratio te klein, densification uit). Onderscheiden: wanneer de loss-waarde in een typisch 
goed bereik ligt (0,020-0,030 bij indoor/object, 0,040-0,060 bij outdoor) en de curve 
sinds 5K iteraties vlak is, is het geconvergeerd. Wanneer de waarde duidelijk hoger is 
dan bij vergelijkbare scènes (bijv. 0,08), hangt het.

Let op Gaussian-plateau ≠ Loss-plateau. Een plateau in het Gaussian-aantal betekent 
niet „training is klaar“. Het betekent slechts dat de densification is opgehouden nieuwe 
punten toe te voegen — ofwel omdat bereikt is (Classic) ofwel omdat het MCMC-cap 
vol is. De training loopt daarna verder en verfijnt alleen nog de bestaande punten. Het 
eigenlijke „klaar”-signaal lees je aan de loss-curve en aan de iteratieweergave (I30), 
niet hier.

Vuistregel voor afbreken: Wanneer de loss-curve na 5000+ iteraties boven 0,08 ligt 
en nauwelijks nog daalt, is met hoge waarschijnlijkheid de SfM-reconstructie scheef. 
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Training afbreken, in hoofdstuk 9 nakijken of het gekozen SfM-backend bij de scène 
past, evt. naar COLMAP/Native overschakelen, dan opnieuw starten. Beter 10 minuten in 
betere SfM investeren dan 2 uur training met slechte camerauitlijning.

Wanneer naar de Inspector grijpen?

Snelreferentie: welke sectie + welke controls voor welk typisch use-case?
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Common-Task Sectie Control-ID’s

Kleuren van de voltooide Splat 
ontzadigen

Look L1 (Saturation)

Naald-/confetti-Splats ronden Look L2 (Splat length)

Gaterige wolk vullen / Splats 
vergroten

Look L3 (Splat size)

Verre „far-confetti“ bij orbits 
uitfaden

Look L4 (Fade far region)

Look-aanpassingen verwerpen Look L5 (Reset finishing)

Voorgefabriceerde setup laden Presets I7 (regel aanklikken)

Eigen setup opslaan Presets I1 → I2 → I4

Setup met collega’s delen Presets I5 (Export) resp. I6 (Import)

SfM-backend wisselen (bijv. 
omdat Apple-PG te instabiel)

Trainingsconfigura
tie

I12 (zie hfd. 9)

Videoframes zonder EXIF-
brandpuntsafstand verwerken

Trainingsconfigura
tie

I13 (FOV Override)

COLMAP-performance: GLO
MAP in plaats van klassiek

Trainingsconfigura
tie

I14

Van Classic naar MCMC over
schakelen

Trainingsconfigura
tie

I15

Training langer laten lopen Trainingsconfigura
tie

I18 (Max Iter) + I20 (Densify 
Until) — gekoppeld via I19

GPU-tijd halveren Trainingsconfigura
tie

I22 (Render Scale op 50%)

Trainingskwaliteit +6% (MCMC) Trainingsconfigura
tie

I16 (MCMC Quality)

Outdoor-scène met veel SfM-
punten

Trainingsconfigura
tie

I17 (Auto-scale by scene)

COLMAP-pad inrichten / wisse
len

Trainingsconfigura
tie

I23 / I24 / I25

Exportbestanden kleiner maken Enhancements I26 (altijd aan laten)

Viewport scherper zonder meer 
trainingstijd

Enhancements I27 (Viewport Scaling → Me
talFX)

MetalFX strijkt te veel glad → 
alternatief

Enhancements I27 (Viewport Scaling → Lanc
zos)

Laatste beetje detail bij fijne 
structuren

Enhancements I29 (Perceptual Loss 0,05-0,1)

Training bewaken Metrics I30 (voortgang), I36 (tempo), 
I38 (resttijd)

Kwaliteit vroeg inschatten Metrics I31 (Loss < 0,05 na 5K = goed)Verdenking op SfM-probleem Metrics + Loss-
Chart

I31 + I39 (Loss > 0,08 na 5K → 
SfM opnieuw)

Convergence vs stuck onder
scheiden

Loss-Chart I39 + I40 (Loss-plateau lezen)Densification-probleem her
kennen

Loss-Chart I41 (Gaussian-curve daalt → 
bug)66 / 230
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H O O F D S T U K

Hoofdstuk 3 — Instellingen

Het instellingenvenster opent via RadianceKit → Instellingen… of de standaardtoets
combinatie ⌘, . Het bevat twee tabbladen: General en AI Helpers. Anders dan de 
Inspector-waarden uit hoofdstuk 2 werken de instellingen uit dit venster app-globaal 
(over alle projecten heen) — ze worden gepersisteerd en overleven app-herstarts. Het 
General-tabblad groepeert drie inhoudelijke secties: Interface, Viewport en Training. 
(De drie Outdoor-Floater-toggles — Sky Masking, Mid-Training Floater Cleanup, Recon
struct Sky Dome — die hier vroeger stonden, zijn met v1.6 verhuisd naar de Enhance
ments-sectie van de Expert-Inspector, waar ze nu per project worden opgeslagen; 
zie hoofdstuk 2, I42–I44.) Het AI-Helpers-tabblad schakelt de on-device-machine-
learning-helpers (Vision, CoreML) voor SfM- en trainings-voorverwerking aan.

Eerdere bedieningselementen voor het gezamenlijk activeren of deactiveren van alle AI-
helpers bestaan in de huidige versie niet meer — overeenkomstig worden ze hier niet 
gedocumenteerd. Ook het eerdere „Coming Soon“-gedeelte voor nog niet uitgeleverde 
helpers werd verwijderd en wordt hier niet meer genoemd.
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General-tabblad

Afbeelding 15:  Instellingen → General-tabblad met gebruikersinterface, weergavevenster, 
training en experimentele sectie
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S1 Default Mode

WA A R

Instellingen → General → Interface → Default Mode-
keuze. Bound:. Default: .simple .

T E C H N I S C H

Bepaalt in welke van twee UI-modi de app na de 
volgende start opent. „Simple Mode“ is de bege
leide wizard-workflow in vier stappen (Import → 
Processing → Preview → Export, gedocumenteerd in 
hoofdstuk 10 onder Z1–Z4), „Expert Mode” de klas
sieke drie-paneel-layout met navigator, 3D-viewport 
en Expert-Inspector uit hoofdstuk 2. De waarde 
wordt over herstarts onthouden. Identiek effect als 
het menu Mode → Simple Mode (⌘1) / Mode → Expert 
Mode (⌘2), behalve dat het menu de lopende sessie 
omschakelt, terwijl deze keuze de standaard voor 
toekomstige sessies vastlegt. Beide modi grijpen op 
dezelfde projecttoestand — projecten, camera’s en 
trainingsconfiguratie blijven bij de moduswissel be
houden. Modusspecifieke toolbar-knoppen worden 
meteen opnieuw gerenderd.

E E N VO U D I G  G E Z E G D

Hier kies je met welke interfa
ce RadianceKit bij de volgende 
start opstart. „Simple Mode“ is 
de beginnersmodus: vier heldere 
stappen, vooraf ingestelde voor
instellingen, nauwelijks opties. 
„Expert Mode” is de volledige 
gereedschapskist-layout met al
le regelaars die je in hoofdstuk 
2 ziet. Je kunt op elk moment 
via het menu „Mode“ heen en 
weer schakelen, zonder dat beel
den of trainingsvoortgang verlo
ren gaan.

S2 Language

WA A R

Instellingen → General → Interface → Language-
keuze. Bound:. Default: .system  (volgt de macOS-
taal).

T E C H N I S C H

Kiest de weergavetaal van de gehele app-UI, onaf
hankelijk van de macOS-systeemtaal. RadianceKit is 
in 17 talen gelokaliseerd ( de , en , pl , en-AU , 
ar-SA , plus 12 andere). Bij „System“ volgt de 

app de macOS-taal. Bij een expliciete keuze wordt 
de taalinstelling over herstarts onthouden; volledige 
werking vereist meestal een app-herstart, omdat 
lokalisatie-bundles alleen bij de start worden gela
den. Alle 298 gedocumenteerde lokalisatie-sleutels 
in het project worden meegenomen, inclusief alle 
teksten in sub-views en hulp-tooltips.

E E N VO U D I G  G E Z E G D

Mocht je Mac op Engels draai
en, maar wil je liever de Neder
landse RadianceKit-interface (of 
omgekeerd), stel je dat hier in. 
De meeste teksten wisselen met
een. Sommige dialogen verschij
nen pas na een app-herstart in 
de nieuwe taal.
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S3 Viewport Background

WA A R

Instellingen → General → Viewport → Background-
keuze. Bound:. Default: .darkGray  (RGB 0,1, 0,1, 
0,1).

T E C H N I S C H

Stelt de standaard achtergrondkleur voor het 3D-
viewport in. Drie opties: „Dark Gray“ (RGB 0,1, 0,1, 
0,1 — standaard), „Black” (0, 0, 0) en „White“ (1, 
1, 1). De instelling persisteert de standaard voor 
nieuwe projecten en sessies over herstarts en actu
aliseert tegelijk de lopende Metal-renderer onmid
dellijk. Identieke opties zitten in het menu Viewport 
→ Background (M21, M22, M23), maar de instellin
gen-keuze legt de standaard vast, terwijl het menu 
de lopende weergave omschakelt. Belangrijk voor 
screenshots en demo-video’s: witte achtergronden 
laten groene/blauwe floaters sterker uitkomen, don
kere achtergronden zijn beter voor schone render-
opnames.

E E N VO U D I G  G E Z E G D

De kleur achter je 3D-modellen 
in het voorbeeldvenster. Donker
grijs is standaard en past bij de 
meeste scènes. Wit is goed voor 
screenshots, zwart komt edeler 
over bij render-opnames. Je kunt 
de kleur op elk moment via het 
menu „Viewport → Background“ 
voor de lopende scène omscha
kelen — deze instelling legt al
leen vast welke kleur bij de vol
gende keer openen weer actief 
moet zijn.

S4 Auto-Rotate After Training

WA A R

Instellingen → General → Viewport → Toggle „Auto-
Rotate After Training“. Bound:. Default: false .

T E C H N I S C H

Start direct na het einde van de training een conti
nue turntable-rotatie van de viewport-camera om 
het scènecentrum (standaardrotatiesnelheid ~0,3 
rad/s). Praktisch nuttig voor demosessies, A/B-ver
gelijkingen en om vanuit 360°-zicht direct te beoor
delen of „floaters“ aan de scènerand zijn ontstaan. 
Effect is visueel identiek aan het menu Viewport → 
Toggle Auto-Rotation (M16, ⌘⌥T), behalve dat de 
toggle hier het gedrag automatisch na het einde van 
de training start, in plaats van handmatig. Laat zich 
later op elk moment via het menu of door te klikken 
in het viewport (wat de rotatie pauzeert) onderbre
ken. Heeft geen invloed op trainingsperformance — 
de rotatie loopt pas wanneer de training klaar is.

E E N VO U D I G  G E Z E G D

Indien geactiveerd, draait de 3D-
scène automatisch zodra de trai
ning klaar is — zoals een carrou
sel. Mooi als je bij nachtelijke 
training ‘s ochtends het resultaat 
al in beweging ziet, zonder zelf te 
hoeven klikken. Bij lange sessies 
waarin je de training alleen moni
tort, laat het liever uit.
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S5 Live Preview Interval

WA A R

Instellingen → General → Trai
ning → Live Preview-keuze. Bound: 
AppState.trainingConfig.livePreviewInterval. 
Default: 0  (Off).

T E C H N I S C H

Bepaalt met welke iteratie-afstand de lopende trai
nings-snapshot in het 3D-viewport wordt geren
derd. Vier discrete waarden: 0 („Off“), 50, 250, 
1000 iteraties. Bij actieve live preview kopieert de 
trainer de Gaussian-buffer vanuit de GPU naar een 
aparte render-buffer en triggert een viewport-re
draw. Bij „Off” wordt het viewport pas na voltooiing 
van de training geactualiseerd. Performancekosten: 
elke 50 iteraties ~5–10% langzamer op M3 Ultra, 
elke 250 iteraties ~1–2% langzamer, elke 1000 ite
raties onmeetbaar. Memory-overhead constant ~2 
GB voor de snapshot-buffer, onafhankelijk van het 
interval. De waarde dient als standaard voor nieuwe 
trainingen; na trainingsstart toont de trainings-in
spector de werkelijke live-waarde van deze training. 
Bij interval 50 is de visuele indruk een vloeiend 
„opgroeien“ van de puntenwolk, bij 1000 oogt het 
schokkerig.

E E N VO U D I G  G E Z E G D

Terwijl de training loopt, kun je 
kiezen hoe vaak het 3D-aanzicht 
wordt geactualiseerd. „Off“ be
tekent: geen actualisatie tijdens 
de training (het snelst). „Every 
50 Iterations” laat bijna in real
time zien hoe je scène ontstaat 
(iets langzamer). Voor rustig toe
kijken bij kleine trainingen is 
„Every 250″ een goed compro
mis.
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S6 Throttle Delay

WA A R

Instellingen → General → Training → Throttle-keuze. 
Bound: AppState.trainingConfig.throttleDelayMs. 
Default: 0  (Off).

T E C H N I S C H

Voegt tussen trainingsiteraties een kunstmatige ver
traging in milliseconden in. Vier discrete waarden: 
0 („Off“), 2 („Light”), 5 („Moderate“), 10 („Eco”). 
Doel: bij langere trainingen (meerdere uren) wordt 
de GPU anders voor 100% belast, wat tot merkbaar 
tragere systeem-UI leidt (muisaanwijzer hapert, an
dere apps worden traag). De throttle-vertraging 
geeft de GPU pauzes waarin andere taken kunnen 
worden uitgevoerd. Performancekosten zijn aan
zienlijk: bij 5 ms throttle duurt een typische 40K-
training circa 50–80% langer dan zonder throttle. In 
performance-modus „Eco“ (10 ms) is de vertraging 
per iteratie langer dan de iteratie zelf — factor 2–
3× langzamer. Bij actieve throttle verschijnt onder 
de keuze een opmerking: „Throttle is on. Training 
will be slower than usual.” De app zelf reageert niet 
merkbaar beter — alleen andere apps profiteren.

E E N VO U D I G  G E Z E G D

Als je Mac tijdens een lange 
training te heet wordt of ande
re programma’s te traag worden, 
schakel hier een rem in. „Off“ 
geeft de GPU vol gas (het snelst). 
„Light” maakt een kleine pauze 
tussen elke stap (iets langzamer, 
maar systeem reageert beter). 
„Eco“ is de sterkste rem — goed 
voor nachtelijke trainingen op 
een MacBook, die niet te heet 
mogen worden.
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AI-Helpers-tabblad

Afbeelding 16:  Instellingen → AI-Helpers-tabblad met hoofdschakelaar en sub-toggles
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S11 AI Helpers enabled (Master)

WA A R

Instellingen → AI Helpers → eerste sectie → Toggle 
„AI Helpers enabled“. Bound:. Default: true .

T E C H N I S C H

Hoofdschakelaar over alle AI-Helpers-functies in de 
pipeline. Als uit, slaat de import- en SfM-pipeline al
le ML-gebaseerde voorverwerkingsstappen volledig 
over — geen Apple-Vision-aanroep, geen CoreML-
model-load, geen NPU-wakeup. Als aan, worden 
de individuele sub-toggles (S12–S13) geraadpleegd. 
De waarde wordt over herstarts onthouden. Werkt 
op de volgende stappen: (a) frame-quality-pre-
check vóór SfM (S12), (b) loop-closure-detectie 
(S13). Belangrijk: bij uit zijn de twee sub-toggles 
gedeactiveerd en visueel grijs. Footer-opmerking 
benadrukt dat alle AI-helpers strikt on-device draai
en — geen beeld-upload, geen cloud-verwerking. 
Privacy-garantie komt door het gebruik van uitslui
tend Apple-Vision-framework (lokaal op de Neural 
Engine) en CoreML-modellen, die rechtstreeks in de 
app-bundle staan.

E E N VO U D I G  G E Z E G D

De hoofdschakelaar voor alle 
functies die KI/machine-learning 
intern gebruiken. Standaard is 
„aan“, omdat de helpers veel tijd 
besparen, zonder dat je beelden 
de Mac verlaten. Als je ze volledig 
uit wilt hebben (bijv. om stroom 
te sparen of omdat je Mac geen 
NPU heeft), zet ze hier uit — dan 
worden de twee sub-opties hier
onder automatisch grijs en doen 
niets meer.
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S12 Frame quality check

WA A R

Instellingen → AI Helpers → Available-sectie → Tog
gle „Frame quality check“. Bound:. Default: true .

T E C H N I S C H

Activeert de frame-quality-screener (fase 3.11), die 
vóór de SfM-aanroep elke geïmporteerde frame 
analyseert. Pipeline-stappen per frame: (a) Laplaci
an-variance-filter uit Apple Vision (blur-detectie — 
drempel ~150), (b) histogram-gebaseerde over-/on
derbelichtings-check (drempel: >5% pixel bij 0 of 
255), (c) blank-frame-detectie (standaarddeviatie < 
5 over alle pixels). Frames die alle drie checks 
doorstaan, gaan direct door. Frames die minstens 
één check falen, openen een modaal bevestigings
dialoogvenster dat elke problematische frame met 
thumbnail en motivatie toont en vraagt of hij moet 
worden verwijderd. Belangrijk: geen automatische 
verwijdering — het dialoogvenster is altijd verplicht, 
de gebruiker behoudt de laatste beslissing. Perfor
mance: ~50 ms per frame op M3 Ultra, loopt 
parallel. Bij uit worden alle frames ongecontroleerd 
aan SfM doorgegeven. Bij gedeactiveerde master 
(S11) is deze toggle visueel grijs en zonder wer
king. Uitgeleverde status volgens memory: SHIPPED 
2026-05-23.

E E N VO U D I G  G E Z E G D

Vóór de eigenlijke training be
kijkt de app elke foto: is hij wa
zig? volledig donker of wit? leeg? 
Zo ja, vraagt hij je of je het 
beeld wilt weggooien — hij ver
wijdert nooit automatisch iets. 
Dat spaart later veel uren, om
dat een enkele totaal wazige foto 
soms de hele training kapot kan 
maken. Standaard is „aan“, om
dat de moeite bijna nul is en het 
nut groot.
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S13 Loop closure detection

WA A R

Instellingen → AI Helpers → Available-sectie → 
Toggle „Loop closure detection“. Bound:. Default: 
true .

T E C H N I S C H

Activeert de Apple-Vision-Feature-Print-gebaseer
de loop-closure-detectie. Voor elke geïmporteerde 
frame wordt een ~768-dimensionale feature-vector 
berekend, die een neurale embedding van de beel
dinhoud voorstelt. Vervolgens worden alle feature-
prints paarsgewijs via cosine-similarity vergeleken. 
Paren met similarity > 0,85 en afstand in frame-
index > 50 (dus niet-naburige frames) worden als 
„loop-closure-kandidaten“ geïdentificeerd en in een 
sidecar-JSONL-bestand in de projectmap geschre
ven. Informational only — de geïmporteerde beeld
sequentie wordt niet gewijzigd. Doel: geeft de SfM-
solver (in het bijzonder COLMAP) een hint dat deze 
frames in de 3D-ruimte samen-cluster horen. Voor 
native SfM is de sidecar-informatie momenteel al
leen documenterend; COLMAP gebruikt de hints in
tern via custom matches-file (handmatige integratie 
mogelijk, niet automatisch gekoppeld). Performan
ce: ~200 ms per frame op M3 Ultra, loopt parallel. 
Bij uit worden geen feature-prints gegenereerd. Bij 
gedeactiveerde master (S11) visueel grijs.

E E N VO U D I G  G E Z E G D

Wanneer je tijdens het fotografe
ren om een object heen loopt en 
uiteindelijk weer bij het begin
punt aankomt, helpt het de com
puter enorm om dat te weten. 
Deze optie herkent automatisch 
welke van je foto’s „bijna van
uit dezelfde locatie“ zijn opgeno
men, en schrijft dat in een klein 
hulpbestand. SfM-tools (vooral 
COLMAP) kunnen deze informatie 
gebruiken om een schonere 3D-
reconstructie te leveren. Stan
daard is „aan”, omdat het zonder 
jouw toedoen draait en niets aan 
je beelden verandert.

Inspector-spiegel-instellingen

De overige instellingen-items (S17–S33) uit de inventaristabel zijn spiegelingen uit de 
Expert-Inspector en in hoofdstuk 2 (Inspector-Controls I12–I29) gedocumenteerd. Ze 
verschijnen niet fysiek in het instellingenvenster, maar werden in de inventaris alleen 
daarom opgenomen, omdat ze via TrainingConfig -properties lopen die per gepersis
teerd worden en in zoverre formeel het karakter van instellingen hebben. Voor inhoude
lijke uitleg zie daar.
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Wanneer wat?

Instelling Reikwijdte Persistentie

S1 Default Mode App-globaal App-herstart

S2 Language App-globaal App-herstart

S3 Viewport Back
ground

App-globaal (standaard) + runtime App-herstart

S4 Auto-Rotate Af
ter Training

App-globaal App-herstart

S5 Live Preview In
terval

Standaard voor nieuwe trainingen App-herstart

S6 Throttle Delay Standaard voor nieuwe trainingen App-herstart

S11 AI Helpers 
Master

App-globaal App-herstart

S12 Frame quality 
check

App-globaal App-herstart

S13 Loop closure 
detection

App-globaal App-herstart

App-globaal = werkt op alle projecten. Standaard voor nieuwe trainingen = werkt alleen 
op de volgende aangelegde training, lopende sessies blijven ongewijzigd. Huidige trai
ning = werkt direct op de lopende trainingsconfiguratie, persisteert echter niet zonder 
expliciete re-import.
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H O O F D S T U K

Hoofdstuk 4 — Hulpvensters

Naast het hoofdvenster (3D-viewport plus Inspector) beheert RadianceKit zeven verde
re vensters, die alle via het Help-menu worden geopend. De lijst is van boven naar 
onder: User Guide (⌘?), Keyboard Shortcuts (⌘/), Open Training Logs… (opent geen 
app-venster, maar de Finder; daarom hier niet verder behandeld), Manage Storage…, 
Pareto Dashboard… (⇧⌘D), Holdout Analysis… (⇧⌘H), BayesOpt Console… (⇧⌘B). 
Drie daarvan — Dashboard, Holdout, BayesOpt — zijn zelfstandige analyse-tools. Ze 
hebben elk een eigen view-model-stack, lezen of schrijven JSON-bestanden op schijf, 
en er bestaat voor elk een CLI-argument waarmee je het venster meteen bij de app-
start op een bepaald bestand kunt laten wijzen ( --dashboard-dir , --holdout-file , 
--bayesopt-autorun ).

De vier eenvoudige vensters (User Guide, Keyboard Shortcuts, Manage Storage, plus 
de submenu-items Open Training Logs / Open Exports Folder) krijgen per bedienings
element een korte vermelding. De drie analysevensters zijn uitvoeriger gedocumenteerd 
— elk met een inleiding die uitlegt wat je in het venster ziet, wanneer je het moet 
openen en hoe je het weergegeven beeld interpreteert.

Aan het einde van het hoofdstuk staat een kruisverwijzings-sectie naar de Inspector van 
het hoofdvenster: wat je in de live-loss-chart en in de Gaussian-count-weergave tijdens 
een lopende training zinvol kunt aflezen.
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User Guide (W1–W4)

Afbeelding 17:  User-Guide-venster met zijbalk links en gerenderde Markdown-inhoud rechts

Wat het is: Een ingebouwd hulpvenster dat de bij de app meegeleverde 
guide_<taal>.md  rendert. De taal wordt uit de instellingen (tab General → Language) 

of, als daar „System“ staat, uit de macOS-taalvoorkeuren afgeleid. Layout is klassiek: 
links zijbalk met alle koppen, rechts de fließtekst.

WANNEER OPENEN  Wanneer je een snelle herinnering aan een afzonderlijk punt nodig 
hebt — dus als trefwoord-vervanging. De uitvoerige referentie is deze handleiding; het 
ingebouwde hulpvenster is eerder wat een --help  op de commandoregel zou zijn. Het 
wordt bij elke app-release meegeactualiseerd, maar inhoudelijk oppervlakkiger gehou
den.
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W1 NavigationSplitView (zijbalk + detail)

WA A R

Help → User Guide (⌘?)..

T E C H N I S C H

Tweekoloms-layout met smalle zijbalk (minstens 
180 pt breed) voor de inhoudsboom en een scroll
baar detailgebied voor de eigenlijke Markdown-in
houd. Het venster heeft een minimumgrootte van 
700 × 500 pt. Bij het eerste openen laadt het 
venster de passende guide_<lang>.md  uit de app-
bundle (fallback guide_en.md ), parset hem in blok-
records (koppen H1–H4, paragrafen, lijsten, tabel
len, scheidslijnen) en extraheert apart de koppen
structuur voor de zijbalk. Inline-formatting (bold, 
italic, code-span) wordt via de ingebouwde Mark
down-engine gerenderd. De taal wordt uit de app-
instellingen gelezen, met het speciale geval Chinees 
( zh-Hans ) en Braziliaans Portugees ( pt-BR ), die 
als volle locale-tags behouden worden, omdat zich 
deze varianten van zh resp. pt onderscheiden.

E E N VO U D I G  G E Z E G D

De ingebouwde hulptekst, links 
de themalijst, rechts de inhoud. 
Taal stelt zich automatisch in op 
je systeem-instellingen. Werkt 
offline, is echter bewust slechts 
een korte versie — de volledige 
referentie is deze handleiding.

W2 List (kop-zijbalk)

WA A R

Linker kolom in het User-Guide-venster..

T E C H N I S C H

Lijst over alle H2- en H3-koppen van het actuele 
Markdown-document. H2-items verschijnen zonder 
inspringing met medium schriftgewicht, H3-items 
met 16 pt inspringing links en gereduceerde fo
reground-stijl. H4 en dieper worden genegeerd, 
omdat de diepte de zijbalk anders onoverzichte
lijk maakt. Anker-ID’s worden uit de koptekst per 
slugificatie gegenereerd (lowercase + spaties naar 
streepjes + filtering op letters/numbers/dashes — 
hetzelfde algoritme dat GitHub voor zijn Markdown-
ankers gebruikt, zodat ook externe URL’s naar de 
docs potentieel naar hetzelfde anker zouden lan
den). De lijst gebruikt de native macOS-stijl.

E E N VO U D I G  G E Z E G D

De navigatiebalk aan de linker
kant. Tik op een item en je 
springt naar de sectie.
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W3 Button (kop → ankersprong)

WA A R

Per zijbalkregel een knop..

T E C H N I S C H

Elk zijbalk-item is een knop die het actuele anker 
zet, optisch echter zoals een lijstregel oogt. Een 
observervariabele triggert dan de scroll-sprong naar 
het bijbehorende anker met een zachte animatie 
over 0,3 s. Na de sprong wordt de ankerwaarde ge
reset, zodat de volgende klik op hetzelfde anker op
nieuw vuurt (anders zou de observer niet opnieuw 
uitlossen, omdat de waarde niet is veranderd).

E E N VO U D I G  G E Z E G D

Klik leidt je naar de passende 
plek in de tekst rechts.

W4 ScrollView (detail-inhoud)

WA A R

Rechter kolom..

T E C H N I S C H

Scrollbaar, verticaal stapelend inhoudsgebied met 
lazy rendering, omdat langere guides gemakkelijk 
meer dan 200 Markdown-blokken kunnen hebben — 
een niet-lazy variant zou ze alle tegelijk instantiëren. 
Elk blok krijgt een eigen ID, ofwel het kop-anker 
(voor springbare H1–H3) of een index-placeholder. 
Maximumbreedte is 720 pt, padding 32 horizontaal / 
24 verticaal, zodat lange regels een goed leesbare 
layout behouden. Tabellen worden cel-voor-cel met 
horizontale stacks en scheidslijnen gerenderd; inli
ne- code door de ingebouwde Markdown-engine. 
Echte codeblokken worden momenteel als paragraaf 
behandeld — een bekende beperking van het hulp
venster.

E E N VO U D I G  G E Z E G D

De eigenlijke hulptekst. Scroll
baar, goed leesbare breedte, hel
dere typografie.
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Keyboard Shortcuts (W5–W6)

Afbeelding 18:  Keyboard Shortcuts venster — vijf groepen Navigation/Views/Capture/Editor/
Training met hotkey-kolom links en beschrijving rechts

WAT DE AFBEELDING TOONT  Statische referentielijst in vijf secties. Navigation: Mouse 
Drag (Orbit/Fly), Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (Fly-Through-
beweging), Q/E (Up/Down), F (Toggle Orbit/Fly), Double-click (Re-center), Cmd+Scroll 
(FoV-Adjust). Views: R (Reset Camera), T (Auto-Rotation), P (Camera Playback), B 
(Background-Cycle), 0–9 (spring naar Training-Cam 1=10%/5=50%/0=last), Left/Right 
Arrow (Prev/Next Cam). Capture: S (Screenshot to Desktop), V (Turntable-Video), C 
(Copy Camera Info). Editor: Tab (Edit-modus), Click/Drag (Paint-Select), Option+Click 
(Deselect), X / Delete (selectie verwijderen), Cmd-Z (laatste verwijdering ongedaan), 
[ / ] (penseelgrootte kleiner/groter), Esc (selectie opheffen). Training: Start, Pause/
Resume, Cancel, Continue +5K/+10K/+20K via de menu-shortcuts in M9–M14.

Wat het is: Een simpel statisch overzicht van alle toetscombinaties — Navigation, 
Views, Capture, Editor, Training. Inhoud is hardgecodeerd in, geen Markdown-loading.
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WANNEER OPENEN  Wanneer je naar de snelste manier zoekt iets in het viewport te doen. 
WASD-fly-through, R voor camera-reset, B voor background-cycling — alle staan hier.

W5 ScrollView (inhoudsgebied)

WA A R

Help → Keyboard Shortcuts (⌘/)..

T E C H N I S C H

Een eenvoudig scroll-gebied met een verticale lijst 
erin. Padding 20 rondom, geen zijbalk-navigatie
boom (de lijst is kort genoeg). Inhoud is in vijf 
secties gegroepeerd (Navigation, Views, Capture, 
Editor, Training). Per toetscombinatie een regel met 
vertaalbare tekst in beide kolommen. Linker kolom 
(toetscode) gefixeerd op 180 pt breedte, zodat de 
beschrijvingen rechts verticaal aligned blijven. Geen 
interactie behalve scrollen — klikken op een regel 
lost niets uit, de toetscombinaties zijn echte toet
senbord-modifiers in het menu en op het viewport.

E E N VO U D I G  G E Z E G D

Tabel van alle shortcut-toetsen. 
Statisch cheatsheet om snel na 
te slaan.

W6 VStack (shortcut-secties)

WA A R

Binnen de ScrollView..

T E C H N I S C H

Linksgebonden gestapelde secties met 16 pt af
stand. Binnen de vijf secties elk heading + re
gelreeks. Headings gebruiken een secundaire sub
headline-stijl — bewust geen title-format, omdat de 
secties niet navigeerbaar hoeven te zijn. Inhoud is 
bewust vlak (geen disclosure, geen search, geen 
filter), zodat de component op elke macOS-versie 
ongewijzigd loopt en het bestand leesbaar blijft.

E E N VO U D I G  G E Z E G D

De groepering van toetsen op 
functie (Navigation, Views, Editor 
enzovoorts).
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Manage Storage (W7–W12)

Afbeelding 19:  Manage Storage venster — header toont „693 items · 16,74 GB total“, tabel 
met export-PLY-bestanden gesorteerd op datum, telkens formaat-pill + bestandsnaam + 

grootte + datum

WAT DE AFBEELDING TOONT  Tabelweergave van alle door RadianceKit beheerde bestan
den. Header telt 693 items, 16,74 GB totale grootte. Toolbar boven: „Show in Finder“ + 
„Refresh”. Elke regel: PLY-icoon, bestandsnaam (bijv. training_​20260527T211321Z.ply), 
exportdatum, grootte (varieert 7 KB tot 218 MB), loep-icoon (reveal) en prullenbak-
icoon (move to trash). Bestanden zijn op datum gesorteerd, nieuwste boven. In deze 
demo-opname domineren PLY-exports, omdat veel met --benchmark  is gewerkt.

Wat het is: Een disk-usage-overzicht voor alles wat RadianceKit onder ~/​Documents/​
RadianceKit/​ neerlegt — logs, exports, scenes, capture-bundles (van de iOS-compan
ion), imports (staging-kopieën van de invoerbeelden). Per item een grootte in bytes en 
twee knoppen: „in de Finder tonen“ en „naar de prullenbak verplaatsen”. Is GEEN auto
matisch opruimen — de app verwijdert zelf niets; jij beslist per item.

WANNEER OPENEN  Wanneer de schijf vol raakt. Vooral de logs verzamelen zich (één 
JSONL per trainingspoging, plus de _​qualityMetrics.json); de exports natuurlijk ook 
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(PLY 100% rauwe data, één per export). Ook nuttig na een crash, wanneer de imports-
staging-map nog oude kopieën van de invoerbeelden heeft rondslingeren (zie „disk-
pressure incident“ in dev_​v549f-needle-reduction.md).

W7 Knop „Show in Finder“

WA A R

Header rechtsboven in het Storage-Browser-ven
ster..

T E C H N I S C H

Opent de gehele RadianceKit-directory (~/​
Documents/​RadianceKit/​) in de Finder, zodat je de 
mappenstructuur direct kunt zien en ook met de 
Finder zelf kunt manipuleren. De actie opent een 
nieuw Finder-venster en wisselt niet naar de app-
sandbox-container — ~/​Documents/​RadianceKit/​ is 
de regulier voor apps toegankelijke Documents-do
main, geen sandboxed-container-pad.

E E N VO U D I G  G E Z E G D

Opent de map in de Finder, zodat 
je zelf met de bestanden kunt 
hanteren.

W8 Knop „Refresh“

WA A R

Header, naast de Finder-knop..

T E C H N I S C H

Triggert een achtergrond-scan, die op een gebrui
ker-geïnitieerde asynchrone task loopt, zodat het 
scannen van grote mappenbomen de UI niet blok
keert. Het eigenlijke walken gaat elke bekende 
submap (Logs, Exports, Scenes, Captures, Imports) 
door en genereert per direct child een storage-
entry. Per entry wordt de recursieve grootte bepaald 
— bij voorkeur het werkelijke schijfverbruik (inclusief 
APFS-hardlinks-sharing) met fallback op de logi
sche bestandsgrootte.

E E N VO U D I G  G E Z E G D

Leest de lijst opnieuw, mocht je 
tussendoor in de Finder iets heb
ben verwijderd of toegevoegd.
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W9 List (storage-items)

WA A R

Hoofdinhoud onder de header..

T E C H N I S C H

Lijst met per regel deze layout: categorie- specifie
ke SF-symbol-icoon (document voor logs, upload-
pijl voor exports, kubus voor scenes, tray voor 
imports), naam + ondertitel (kind-label + gefor
matteerde wijzigingsdatum), bytes-counter rechts 
(rechtsgebonden, monospaced), reveal-knop (loep-
symbool), trash-knop (prullenbak). Sortering: pri
mair op kind (Scenes eerst, dan Exports, Logs, 
Captures, Imports, Other), secundair op wijzigings
datum aflopend (nieuwste boven). Wanneer de scan 
nog loopt, toont de plek in plaats daarvan een 
„Scanning…“-voortgang. Wanneer niets gevonden, 
een lege-staat-weergave met tray-icoon.

E E N VO U D I G  G E Z E G D

Lijst van al je RadianceKit-data, 
gesorteerd op type en actuali
teit. Per entry zie je grootte en 
kun je direct verwijderen.

W10 Row-knop „Reveal in Finder“

WA A R

Per regel, loep-symbool rechts..

T E C H N I S C H

Opent de Finder en selecteert het specifieke item 
(bestand of map). Verschil met W7: W7 opent 
de root-directory; W10 markeert precies deze ene 
entry. Praktische workflow: identificeer een grote 
entry, klik op de loep, kopieer hem dan bijvoorbeeld 
naar een extern volume.

E E N VO U D I G  G E Z E G D

Springt in de Finder direct naar 
deze entry, zodat je hem snel 
vindt.
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W11 Row-knop „Move to Trash“

WA A R

Per regel, prullenbaksymbool rechts naast de loep..

T E C H N I S C H

Triggert de bevestigingsdialoogbox (W12). Pas 
na bevestiging loopt de macOS-standaardoperatie 
„naar de prullenbak verplaatsen“ (dus omkeerbaar, 
geen directe verwijdering). Na succesvolle trash 
wordt de entry uit de lijst verwijderd en de totale-
bytes-counter geactualiseerd. Bij fouten wordt een 
modale foutdialoog ingeblend.

E E N VO U D I G  G E Z E G D

Verplaatst de entry naar de prul
lenbak. Dialoog vraagt vooraf na.

W12 ConfirmationDialog (verwijder-bevestiging)

WA A R

Wordt door W11 getriggerd, weergegeven als ma
cOS-sheet..

T E C H N I S C H

Standaard bevestigingsdialoog met dynamische titel 
„Delete <name>?“ en een message-regel die expli
ciet erop wijst dat de entry in de prullenbak landt 
en daaruit herstelbaar is (totdat de prullenbak wordt 
geleegd). Twee knoppen: „Move to Trash” als de
structieve actie (rood weergegeven) en „Cancel“ 
met automatische Esc-binding. De dialoog is non-
modaal in die zin dat hij alleen dit venster blokkeert, 
niet de hele app — dat is macOS-standaard voor 
omkeerbare verwijderingen.

E E N VO U D I G  G E Z E G D

Veiligheidsbevraging vóór het 
verwijderen. „Move to Trash“ is 
omkeerbaar — zolang de prullen
bak niet is geleegd.
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Pareto Dashboard (W13–W22)

Afbeelding 20:  Pareto Dashboard — lege toestand vóór report-import

Lege toestand (na het eerste openen) — empty state met call-to-action „Open Reports 
Folder…“. De datapunten verschijnen zodra trainingsreports zijn geladen, zie volgende 
shot.

Afbeelding 21:  Pareto Dashboard met 129 geladen benchmark-reports — Gaussians vs 
PSNR met Pareto-front, scene/strategy/Mip-filter

WAT DE AFBEELDING TOONT  Header-toolbar toont „129 reports of 129″ (alle reports in de 
gekozen map succesvol geparset — 21 extra bestanden konden vanwege ouder formaat 
niet worden geparset, zie hint-lijst rechts). Assen: X-as-keuze op Gaussians , Y-as-
keuze op PSNR (dB) . Scatter-plot: groene punten = Classic-strategy, blauwe punten 
= MCMC. De gestreepte Pareto-front-lijn loopt langs de best bereikte PSNR-waarden 
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en plateaut rond PSNR≈30 dB vanaf ca. 500K Gaussians. Filter-chips rechts: 7 scenes 
(bicycle, bonsai, family, flowers, kitchen, stump, truck), 2 strategies (classic, mcmc), 3 
Mip-Splatting-opties (All, On, Off). Momenteel zijn alle filters open, vandaar het dichte 
punten-cluster.

Wat het is: Een multi-run-vergelijkingstool. Heb je in het verleden meerdere scènes of 
dezelfde scène met verschillende voorinstellingen getraind — elk van die trainingsruns 
produceert (als je --benchmark  hebt meegegeven of via de benchmark-functie hebt 
aangeroepen) een JSON-report-bestand dat onder meer finale PSNR, SSIM, LPIPS, 
Gaussian-count en wallclock-tijd bevat. Het dashboard leest een gehele map van zulke 
reports tegelijk in en plot ze als 2D-scatter met selecteerbare assen. Aanvullend wordt 
de Pareto-front (de verzameling niet-gedomineerde punten) als gestreepte lijn ingete
kend.

WANNEER OPENEN  Nadat je minstens drie of vier trainingsreports hebt aangelegd. 
Met minder punten is de frontier-lijn niet veelzeggend. Typische use-case: je hebt 
geprobeerd een outdoor-scène te reconstrueren, en hebt opeenvolgend P3 Balanced 
(Classic), P4 Quality (Classic), P7 MCMC Quality en P9 Outdoor (tuned) doorlopen — nu 
wil je weten welke configuratie de beste PSNR per seconde trainingstijd levert of welke 
de minste Gaussians nodig heeft voor gegeven PSNR.

HOE INTERPRETEREN  Beide assen zijn vrij kiesbaar (X-as:,, psnr , ssim , lpips , …; Y-
as net zo). De Pareto-front-logica in ParetoFront2D.indices weet voor elke metriek of 
„kleiner = beter“ (bijv. LPIPS, Loss, Time) of „groter = beter” (PSNR, SSIM) — de lijn 
loopt dus afhankelijk van as-keuze van linksonder naar rechtsboven of van linksboven 
naar rechtsonder, altijd langs de beste bereikte combinatie. Een punt is Pareto-optimaal 
als GEEN ander punt in BEIDE dimensies minstens even goed is (dus geen ander domi
neert hem). Pareto-optimale punten liggen op de lijn, andere punten rechts/erboven 
(afhankelijk van as-oriëntatie) ervan. Punten OP de lijn zijn de echte kandidaten voor 
„beste voorinstelling“; punten VER van de lijn zijn verspilde trainingstijd.

FILTER-CHIPS  Je kunt de selectie beperken tot een bepaalde scène (mocht je bijv. alleen 
outdoor-runs willen vergelijken), tot een bepaalde strategie (Classic of MCMC), of tot 
Mip-Splatting aan/uit (relevant na fase Q1.5, waarin Mip als opt-in advanced flag blijft).

 Je hebt drie reports voor „truck“-scène onder ~/​Documents/​RadianceKit/​Reports/​: 
Run A (P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23,4), Run B (P7 MCMC, 200K iter, 
150K Gs, 693 s, PSNR 24,6), Run C (P9 Outdoor, 100K iter, 1,25M Gs, 312 s, PSNR 
25,8). Zet X-as op trainingTime, Y-as op PSNR. Run B ligt rechtsboven, Run C nog 
verder rechtsboven, Run A linksonder. De Pareto-front verbindt A en C — beide niet-
gedomineerd. Run B is „lost” (C is beter in Time EN PSNR). Inzicht: voor „truck“ loont 
de MCMC-standaard niet; ofwel snel+ok (A) ofwel lang+zeer goed (C). Configuratie uit 
C als eigen voorinstelling opslaan (Inspector → I1 Save Preset).

Volgende actie: Beste configuratie als voorinstelling opslaan. Concreet: bekijk de 
Pareto-punten (hover toont PSNR/SSIM/LPIPS/Gs/Time in de tooltip), beslis welke je qua 
time-vs-quality-trade-off het beste past, open het bijbehorende report (bestandsnaam 
bevat run-timestamp), kopieer diens trainingsconfiguratie in een nieuwe run of bewaar 
hem na de volgende trainingssessie als voorinstelling via de Inspector.
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W13 Knop „Open Reports Folder…“

WA A R

Toolbar linksboven..

T E C H N I S C H

Opent een map-selectiedialoog met de oproep „Se
lect a folder containing benchmark .json reports“. 
Na bevestiging loopt een achtergrondtask die alle 
.json -bestanden in de map sequentieel parset. 

Foutieve reports (kapot JSON, verkeerd schema) 
worden verzameld en onder in de zijbalk getoond 
als „N file failed to parse” — geen crash. Wanneer 
een tweede klik plaatsvindt terwijl een eerste load 
nog loopt, wordt de vorige task afgebroken, zodat 
niet twee resultaten tegelijk in de state schrijven.

Ook via CLI: --dashboard-dir /​pad/​naar/​reports 
laadt de map meteen bij de app-start.

E E N VO U D I G  G E Z E G D

Kiest de map waarin je ben
chmark-reports staan. Stan
daardpad is ~/​Documents/​
RadianceKit/​Reports/​. Laadt 
dan alle JSON’s tegelijk in.

W14 Picker „X-Axis“

WA A R

Boven het chart, links..

T E C H N I S C H

Menu-picker met alle beschikbare metriek-assen 
van de dashboard-module (PSNR, SSIM, LPIPS, 
Gaussian-count, trainingstijd enzovoort). Standaard 
is Gaussian-count. Bij wisseling wordt het gehover
de punt teruggezet, omdat een tot dan toe gehigh
lighte positie in het oude assen-coördinatensysteem 
na aswisseling geen zin meer heeft. Picker is op 
inhoudsbreedte begrenst, zodat hij niet over de hele 
breedte trekt.

E E N VO U D I G  G E Z E G D

Welke metriek op de horizontale 
as moet staan. Gebruikelijk „trai
ningstijd“ of „Gaussian-aantal”, 
omdat dat de „kosten“ zijn die je 
wilt vergelijken.
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W15 Picker „Y-Axis“

WA A R

Boven het chart, naast X-Axis..

T E C H N I S C H

Identiek aan W14, alleen dat de standaard PSNR 
is. De as-keuze wordt onafhankelijk opgeslagen, 
dus kan de gebruiker ook onzin-combinaties kiezen 
(X=PSNR, Y=PSNR — zou alle punten op een diago
naal werpen). Zulke combinaties worden echter niet 
afgevangen; bewuste beslissing, omdat een verge
lijking „SSIM vs PSNR“ zeker interessant is om te 
zien hoe consistent de metrieken zich gedragen.

E E N VO U D I G  G E Z E G D

Wat op de verticale as staat. Nor
maal „PSNR“ of „SSIM” als kwali
teitsmaatstaf.

W16 Toggle „Show Pareto Front“

WA A R

Rechts naast de assen-pickers..

T E C H N I S C H

Standaard macOS-toggle. Wanneer actief, wordt in 
het Pareto-chart aanvullend op de punten-wolk een 
lijn met de berekende 2D-Pareto-front getekend. 
Stijl: gestreept (streefpatroon 4–4), grijs halfdoor
zichtig, lijndikte 1,5 pt. De Pareto-berekening loopt 
op de hoofdthread — bij het typische aantal reports 
(≤ ~50) is dat probleemloos snel. Als de toggle uit 
is, wordt de lijn weggelaten, zodat alleen de naakte 
punten staan.

E E N VO U D I G  G E Z E G D

Toont de lijn die door de „tot dus
ver beste“ punten loopt. Mocht 
de lijn je in de weg zitten (bijv. 
omdat je alleen de afzonderlijke 
trades wilt vergelijken), schakel 
hem uit.
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W17 Chips „Scene“-filter

WA A R

Rechter zijbalk in het dashboard-venster..

T E C H N I S C H

Filter-chips voor elke in de geladen reports voorko
mende scène. Eigen flow-layout dat chips in meer
dere regels automatisch herschikt zodra de breedte 
is uitgeput. Actieve chips krijgen de accentachter
grond, inactieve een neutrale standaard-material-
achtergrond. Meervoudige selectie is mogelijk (set-
semantiek); wanneer geen chip geselecteerd is, gel
den alle scènes als „doorgelaten“ — d.w.z. de set-
logica is „lege selectie = alles”, niet „lege selectie = 
niets“.

E E N VO U D I G  G E Z E G D

Klik op een scènenaam filtert 
de punten op alleen deze scène. 
Meervoudige selectie mogelijk. 
Leeg = alle scènes.

W18 Chips „Strategy“-filter

WA A R

Onder scene-filter in de zijbalk..

T E C H N I S C H

Net als W17, maar voor trainingsstrategieën — ty
pisch de twee waarden „classic“ en „mcmc”, afge
leid uit het strategy-veld van de benchmark-report-
JSON’s. Behulpzaam wanneer je reports van beide 
strategieën hebt gemengd en alleen één soort wilt 
zien (bijv. „alleen MCMC-runs tonen, omdat ik Clas
sic al heb uitgesloten“).

E E N VO U D I G  G E Z E G D

Filter op klassiek of MCMC. Stan
daard zijn beide actief.
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W19 Chips „Mip-Splatting“-filter

WA A R

Onder strategy-filter in de zijbalk..

T E C H N I S C H

Driewaardige filter (in plaats van set zoals W17/
W18): „All“ / „On” / „Off“. Achtergrond: Mip-Splat
ting werd in fase Q1.5 als experimentele multi-
schaal-verbetering geëvalueerd en het finale verdict 
was „geen leuke win doorlopend; behouden als 
opt-in flag”. Wanneer je Mip-on/off-vergelijkingen 
maakt, wil je vaak zeer scherp scheiden kunnen. 
Vandaar het toegewijde ternaire filter met de toe
standen „alles doorlaten“, „alleen Mip aan”, „alleen 
Mip uit“. De zijbalk-sectie wordt alleen ingeblend 
wanneer er minstens één Mip-report EN minstens 
één niet-Mip-report in de dataset zit (anders heeft 
het filteren geen zin).

E E N VO U D I G  G E Z E G D

Wanneer je Mip-Splatting aan/uit 
wilt vergelijken, hier driedelig fil
ter. Anders negeren.

W20 ChipButton (filter-toggle, all/on/off)

WA A R

Helper-component, wordt in W17/W18/W19 ge
bruikt..

T E C H N I S C H

Minimalistische knop-wrapper. Inhoud: label- tekst 
met caption-schriftgrootte en padding 10 horizon
taal / 5 verticaal. Achtergrond conditioneel: bij actief 
→ app-accentkleur met witte tekst; anders neutrale 
standaard-material-achtergrond met zwarte tekst. 
Vorm is een capsule (pilachtig). Plain-button-stijl, 
zodat het capsule- material niet door een systeem-
border wordt overlapt.

E E N VO U D I G  G E Z E G D

De ronde filter-knoppen zelf. Op
tisch zoals een iOS-tag.
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W21 Chart (Pareto-scatter)

WA A R

Middengebied van het dashboard..

T E C H N I S C H

Swift-Charts-diagram met twee lagen: 1. een punt 
per report — positie uit de gekozen X- en Y-
metrieken, kleur op strategy, symbool op Mip-sta
tus. Symboolgrootte normaal 80, gehighlighted 200 
(wanneer de ID overeenkomt met het momenteel 
gehoverde report).
2. een lijn voor de Pareto-front, alleen wanneer de 

toggle aan is.

Chart-overlay: een transparant rechthoek regi
streert muisbeweging; per frame wordt de eucli
disch dichtstbijzijnde puntpositie in het plot-frame 
bepaald en het gehoverde report geactualiseerd, 
mits de afstand onder 24 px ligt (anders terugge
zet). Zo krijg je de tooltip zonder klikken — hoveren 
volstaat.

E E N VO U D I G  G E Z E G D

Het eigenlijke scatterdiagram. 
Elk punt is een trainingsrun. Ho
ver voor detail-tooltip.

W22 Tooltip (hover-detail)

WA A R

Onder het chart, ingeblend bij hover..

T E C H N I S C H

Horizontale stack: scènenaam (headline), strategy-
tag (caption), scheidslijn, dan PSNR/SSIM/LPIPS/Gs/
Time-metrics elk in een kleine verticale groep (la
bel + monospaced waarde). Mocht Mip geactiveerd 
zijn, aanvullend een „Mip“-capsule-tag in accent
kleur. Achtergrond halfdoorzichtige blur, afgerond 
rechthoek met 8 pt radius. Wordt alleen ingeblend 
wanneer de muis daadwerkelijk over een punt is. 
Verdwijnt automatisch bij verlaten.

E E N VO U D I G  G E Z E G D

De detailkaart onderaan, wan
neer je met de muis over een 
punt gaat. Toont alle kwaliteits
metrieken en de run-configuratie 
in één keer.
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Holdout Analysis (W23–W29)

Afbeelding 22:  Holdout Analysis — lege toestand vóór het laden van een transforms.json

Lege toestand met empty-state en call-to-action „Open transforms.json…“. Accepteert 
NeRF-Studio- en Instant-NGP-formaat.

Lege toestand (na het eerste openen) — de camera-markers verschijnen zodra een 
transforms.json  is geladen, zie volgende shot.

Afbeelding 23:  Holdout-globe met 100 NeRF-Blender-Mic-camera’s, 5 folds à 20 camera’s, 
angular-strategy actief

WAT DE AFBEELDING TOONT  Header toont geladen bestand (transforms_​train.json) en 
cam-count („100 cameras“). Linker zijbalk: strategy-picker met twee opties — Angular 
(longitudinal) actief (richt folds op lengte-/breedte-sectoren op de sfeer uit, zodat 
elke test-fold geometrisch dicht is) vs Linear (round-robin) (volgorde-gebaseerd, alle 
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k-de frames als testset). k-folds-slider staat op 5, test-fold-picker op fold 1. Export-
knop genereert een fold-assignment.json voor Nerfstudio/Instant-NGP. Middenpaneel: 
3D-globe-projectie van alle 100 camera’s — groene punten = train, rode punten = actu
ele test-fold (Fold 1 met 20 camera’s). Rechter zijbalk (Angular Correlation): per fold 20 
cams + Mean Nearest Angle (Fold 1: 7,9°, Fold 2: 7,8°, Fold 3: 7,7°, Fold 4: 7,0°, Fold 
5: 6,3°) — kleinere waarde betekent dat de camera’s binnen deze fold dicht bij elkaar 
liggen, dus de holdout-split ruimtelijk coherent is.

Wat het is: Een 3D-visualizer voor je camera-opstelling met cross-validation-logica. 
Je laadt een transforms.json  (het standaardformaat van Nerfstudio / Instant-NGP 
voor cameraposes), de app leest alle camera’s, projecteert hun kijkrichtingen op een 
eenheidsbol en toont ze als kleine bol-markers op een virtuele globe. Vervolgens deelt 
hij de camera’s in k  folds op (volgens gekozen strategie: angular of linear), markeert 
het trainingsaandeel groen en het testaandeel (holdout) rood, en berekent per fold een 
angular-correlation-score die je zegt hoe ver de test-fold in de kijkhoek-ruimte van de 
trainingsfold ligt.

WANNEER OPENEN  Wanneer je holdout-evaluatie wilt doen — dus: hoe goed generaliseert 
je model op niet-geziene kijkhoeken? Standaard in de training is „every-8th view als 
holdout“ (Mip-NeRF360-conventie), maar dat is een zeer lineaire opdeling. Wanneer 
je beelden bijvoorbeeld tijdelijk geclusterd zijn (eerst één kant van het object, dan 
de andere), dan is „every-8th” niet representatief — een willekeurige sequentiepositie 
landt in de test, maar al haar buren zijn in het trainen, dat is te eenvoudig. Met „angular“ 
stratificeer je in plaats daarvan over de kijkhoek-ruimte: elke fold bevat camera’s uit alle 
gebieden van de orbit, zodat de test werkelijk generalisatiegaten test.

HOE INTERPRETEREN  Angular vs Linear: - Angular (standaard): deelt de camera’s op 
longitudinale hoek (φ-coördinaat om de Y-as) op in k  gelijke sectoren. Fold 0 zijn 
camera’s met φ ∈ [0°, 360/k°), fold 1 de volgende, enzovoort. Voordeel: elke fold dekt 
een deeluitsnede van de orbit; de test-fold is ruimtelijk compact maar breed over de 
wereld-dataset verdeeld. Goed voor klassieke orbit-opnames. - Linear (round-robin): 
fold-index = (image_index modulo k). Dat is de simpele „every-k-de“-opdeling. Werkt 
wanneer de beeldvolgorde GEEN ruimtelijke bias heeft (bijv. willekeurig gesorteerde 
drone-opnames). Werkt slecht wanneer de beelden tijdelijk clusteren.

In de 3D-globe zie je direct: groene punten (training) en rode punten (test). Wanneer 
de rode punten alle in één hoek clusteren, is de holdout slecht (geen goede generalisa
tietest). Wanneer ze gelijkmatig tussen de groene liggen, is hij goed. De angular-corre
lation-score per fold (rechter zijbalk, in graden) zegt aanvullend: kleinere waarde = de 
test is dicht bij de training (elke test-camera heeft een nabije trainingscamera, lichte 
test); grotere waarde = de test ligt ver van de training (hardere generalisatie).

 Je hebt je truck-scène met 251 beelden opgenomen, exporteert via menu-item M33 
(Export SfM transforms.json) een nerfstudio-file. Open het holdout-venster (⇧⌘H), 
laad de JSON via „Open transforms.json…“, bekijk de globe. k=5 (standaard) geeft je 5 
folds. Klik op „Fold 3” — zie of de rode markers redelijk gelijkmatig zijn. Zo ja: „Export 
fold-assignment.json“, leg het geëxporteerde bestand in de reports-map, en bij de 
volgende trainings-run met --benchmark  (of de bijbehorende Inspector-instellingen) 
wordt precies deze fold-opdeling als test-holdout gebruikt — in plaats van de standaard 
„every-8th”.

96 / 230



R A D I A N C E K I T Hoofdstuk 4 — Hulpvensters

W23 Knop „Open transforms.json…“

WA A R

Toolbar linksboven..

T E C H N I S C H

Opent een bestand-selectiedialoog die op JSON- 
bestanden beperkt is. Na bevestiging laadt de hol
dout-module het bestand. De loader parset zowel 
het nerfstudio-formaat (camera-intrinsics plus lijst 
van frames met beeldpad en transform-matrix) als 
het instant-ngp-formaat (gelijke opbouw). Per fra
me wordt de kijkrichting uit de transform-matrix 
geëxtraheerd (z-as van de camera-lokale basis) en 
opgeslagen. Wanneer het parsen mislukt, wordt een 
foutmelding in het statusgebied getoond.

Ook via CLI: --holdout-file /​pad/​naar/​
transforms.json start het venster direct met gela
den bestand.

E E N VO U D I G  G E Z E G D

Laadt je cameraposes-JSON. 
Standaard zijn Nerfstudio- en In
stant-NGP-exports. RadianceKit 
zelf kan transforms.json via me
nu → Export → SfM exporteren.

W24 Picker „Strategy“ (angular/linear)

WA A R

Linker zijbalk, boven..

T E C H N I S C H

Radio-picker met twee opties: Angular en Linear. 
Strategy-wissel triggert automatisch een herbere
kening van de folds. De kijkrichtingen zijn een lijst 
van 3D-eenheidsvectoren op de sfeer; de angular-
strategie projecteert ze op de longitudinale hoek φ 
en sorteert, de lineaire strategie maakt gewoon een 
modulo-opdeling over de frame-index.

E E N VO U D I G  G E Z E G D

Angular voor gelijkmatige orbit-
opnames (standaard, veilig), Li
near alleen wanneer je beelden 
niet ruimtelijk clusteren.
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W25 Slider „k Folds“

WA A R

Linker zijbalk, midden..

T E C H N I S C H

Slider van 3 tot 10, stapgrootte 1. Bij wijziging wordt 
de fold-berekening automatisch opnieuw aangesto
ten, zodat de folds-lijst, de train/test-indices en de 
per-fold-score meteen opnieuw worden berekend. 
De gekozen waarde wordt als monospaced-digit-
tekst rechts naast het label getoond.

Vuistregel: k=5 is standaard (geeft je 20% test per 
fold, dat is gebruikelijk voor cross-validation). k=10 
wanneer je heel veel data hebt en meer folds voor 
statistische betekenis nodig hebt. k=3 wanneer je 
weinig data hebt.

E E N VO U D I G  G E Z E G D

Hoeveel folds in de opdeling. 5 is 
standaard en past vrijwel altijd.

W26 Picker „Test Fold“

WA A R

Linker zijbalk, onder de k-slider..

T E C H N I S C H

Menu-picker. Opties zijn dynamisch 0..<k, label 
„Fold 1″ tot „Fold N“ (dus 1-indexed in de UI, 0-
indexed intern). Mocht de eerder gekozen index ≥ k 
zijn (bijv. omdat je k van 10 naar 5 hebt verminderd), 
wordt hij automatisch op 0 teruggezet. De gekozen 
test-fold wordt in de globe rood weergegeven, alle 
andere groen.

E E N VO U D I G  G E Z E G D

Welke fold momenteel de test-
fold is. Je kunt doorklikken en 
ziet hoe elke afzonderlijke fold in 
de globe oogt.
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W27 Knop „Export fold-assignment.json“

WA A R

Linker zijbalk, onderaan..

T E C H N I S C H

Opent een save-dialoog met standaard- bestands
naam fold-assignment.json. Na bevestiging co
deert de holdout- module de actuele opdeling in 
een JSON-schema (per-frame fold- toewijzing plus 
strategy-metablok). Dit bestand kan vervolgens bij 
de volgende training met --benchmark  worden 
meegegeven, zodat dezelfde holdout voor de finale 
metriek-analyse wordt gebruikt. Schrijffouten wor
den als fouttekst getoond; succes in groene tekst 
als „Saved to (filename)“.

E E N VO U D I G  G E Z E G D

Slaat de actuele train/test-opde
ling op als JSON. Dit bestand 
kun je dan bij de training direct 
meegeven, zodat dezelfde test
set weer wordt gebruikt.

W28 SCNView (3D-cameraglobe)

WA A R

Middenpaneel in het holdout-venster..

T E C H N I S C H

SceneKit-globe-view. De scène bestaat uit: een 
wireframe-bol (radius 1,0, 36 segmenten, donker
grijs), drie gekleurde asuitsteeksels (rood/groen/
blauw voor X/Y/Z, elk 1,2 lang), en per camera een 
kleine marker-bol (radius 0,03) op de bijbehorende 
kijkrichtingspositie op de eenheidsbol (licht buiten, 
zodat die niet IN de wireframe-bol verdwijnt). De 
markers worden bij elke fold-wijziging NIET opnieuw 
gebouwd — rebuild is alleen dan nodig, wanneer 
de framelijst verandert (dus een nieuwe JSON 
wordt geladen). In plaats daarvan loopt per update 
een in-place-actualisatie van de material- kleuren: 
rood voor test-indices, groen voor training, lichtgrijs 
wanneer geen van beide. Zo blijven slider-ticks per
formant zelfs bij N > 1000 camera’s.

De camera-controle is geactiveerd — je kunt met de 
muis de globe roteren, zoomen, pannen. Belichting 
zorgt ervoor dat de markers niet plat ogen. Achter
grond is donkergrijs.

E E N VO U D I G  G E Z E G D

De 3D-globe met de camerapo
sities. Groen = training, rood = 
test, lichtgrijs = niet toegewezen 
(komt niet voor, alle camera’s ho
ren ergens bij). Met de muis kun 
je de globe roteren en zoomen.
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W29 FoldCard (Tap to Select Fold)

WA A R

Rechter zijbalk, „Angular Correlation“-sectie..

T E C H N I S C H

Per fold een kaart-view — afgerond rechthoek met 
6 pt radius, padding 10, verticale layout met twee 
regels (boven „Fold N“ + camera-aantal, onder 
„Mean nearest angle:” + waarde in graden). Achter
grondkleur conditioneel: actieve fold = accentkleur 
halfdoorzichtig, inactieve = neutrale standaard-ma
terial. Tikken kiest de fold, en de globe kleurt zich 
live om.

De „Mean nearest angle“-score is de gemiddelde 
kleinste hoek per test-camera tot de dichtstbijzijnde 
trainingscamera (in radiaal intern berekend, in gra
den in de UI getoond).

E E N VO U D I G  G E Z E G D

Per fold een kleine kaart rechts 
met aantal camera’s en de ge
middelde afstand tot de dichtst
bijzijnde trainingscamera. Klik 
daarop kiest deze fold als test.

BayesOpt Console (W30–W39)

Afbeelding 24:  BayesOpt-Console — lege toestand vóór trial-start

Lege toestand met search-space-picker (RadianceKit defaults (6-dim)), trial-budget-
slider (standaard 40), random-seed (42) en drie lege panelen voor convergence-chart, 
trial log en search-space-parameter-lijst.

Lege toestand (na het eerste openen) — convergence-chart en trial-tabel vullen zich 
zodra een run is gestart, zie volgende shot.
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Afbeelding 25:  BayesOpt-Console na 40 trials — convergence-chart stijgt steil tot trial 15, 
Best Value 0,9943, trial log met init/bo/restart-tags

WAT DE AFBEELDING TOONT  Status rechtsboven „Finished — best 0,9943 after 40 trials“. 
Linker zijbalk: search-space-picker op RadianceKit defaults (6-dim), trial-budget 
40, random seed 42. Parameter-lijst toont de zes te tunen hyperparameters met 
hun waardebereiken: mipSmoothing3DScale [0.05, 0.5], mipFilter2DVariance [0.1, 
0.6], densifyGradThreshold [5e-07, 5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale 
[1e-05, 0.0001], mcmcRelocationInterval [50, 200]. Midden: convergence-chart (X 
= trial-index 1–40, Y = objective value 0–1) — grijze punten = initial-samples (LHS), 
blauwe punten = BayesOpt-acquisition, oranje punten = restart-trials (#22 en #31). 
Beste-waarde-lijn stijgt steil tot trial ~7, daarna nog slechts marginale verbetering tot 
trial 15, vanaf daar vlak plateau bij 0,99+. Rechter zijbalk: trial-log #1–#34 met score + 
tag (init/bo/restart). Save-Best-Config-knop rechtsboven schrijft bayesopt-best.json .

Wat het is: Een Bayes-optimalisatie-console voor hyperparameter-zoeken. Bayes-opt 
is een automatische methode die probeert met zo weinig mogelijk experimenten het 
optimale punt van een onbekende functie te vinden — typisch: „welke combinatie van 
mcmcMaxGaussians, capMultiplier, ssimWeight en gradThreshold levert de beste PSNR 
voor mijn scèneklasse?“ In plaats van een grid van 6^4 = 1296 trials probeert Bayes-opt 
ongeveer 40–100 geïnformeerde trials en komt daarmee dicht bij het optimum.

Belangrijk: De actueel in de app uitgeleverde versie voert de optimalisatie niet uit 
tegen echte trainingsruns (dat zou dagen duren), maar tegen een synthetische demo-
objective — een multimodaal landschap met hill-climbing-karakter plus lichte noise. 
Dat is bewust zo: het venster moet je het gedrag van de optimizer tonen (convergentie
verloop, sample-punten, best-so-far) en je de search-space-definities laten begrijpen. 
Voor echte trainings-gedreven BayesOpt-runs (zoals in fase Q7 voor de scene-class-
voorinstellingen uitgevoerd) wordt een aparte offline CLI-workflow gebruikt; het venster 
is de live-UI-variant.

WANNEER OPENEN  Drie use-cases: 1. Je wilt begrijpen hoe BayesOpt werkt — start dan 
een demo-run en observeer de convergence-chart. 2. Je plant een nieuwe scèneklasse 
(bijv. „aquaria“ of „antiek meubilair”), waarvoor de ingebouwde 10 voorinstellingen niet 
perfect passen. Definieer mentaal een zoekruimte, test hem hier met de „Bowl demo“ 
of „Densify”-voorinstelling, exporteer dan de best-config als JSON en gebruik hem als 
startpunt voor een echte trainingsrun. 3. Je wilt de in het RKBayesOpt-package gedefi
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nieerde standaard-search-spaces (Mip-subset, RadianceKit defaults) inspecteren — die 
worden in het parameter-paneel van de linker zijbalk opgesomd.

HOE INTERPRETEREN  - Convergence-chart (middenkolom): Y = beste tot dusver bereikte 
objective-functie-waarde. X = trial-index. Aanvankelijk steil stijgend (BayesOpt probeert 
de initial-samples willekeurig, sommige ervan zijn gelukkig), daarna toenemend vlak, 
omdat de dicht-bij-optimum-regio is uitgeput. Wanneer de lijn 20+ trials lang vlak 
blijft, kun je de run stoppen — verdere trials brengen niets meer. De afzonderlijke 
punten in het chart zijn de individuele trial-waarden (dus niet „best so far“), gekleurd 
op fase: grijs = initial sample, blauw = BayesOpt-acquisition, oranje = restart. - Trial-
tabel (rechterkolom): #1, #2, #3, … met elk waarde en fase-tag. De tot dusver beste 
trial is met een gele ster gemarkeerd. Uit de tabel kun je de best-trial identificeren en 
zijn parameter-waarden later bij de export bekijken. - Search-space-inspector (linker 
zijbalk): toont voor de gekozen voorinstelling alle parameternamen en hun zoekbereiken 
[lo, hi] . Wanneer je bij voorinstelling „RadianceKit defaults (6-dim)” staat, zie je bijv. 

„densifyGradThreshold [5e-7, 5e-6]“ — dus log-uniform tussen deze twee waarden.

 Kies voorinstelling „RadianceKit defaults (6-dim)“, trial-budget 40, seed 42. Klik 
„Start”. Observeer: de eerste 8 trials zijn grijs (initial samples, LHS-Latin-Hypercube), 
de volgende blauw (BayesOpt-geacquireerd). De convergence-chart wordt steil tot trial 
~15, daarna vlakt hij af. Bij trial ~30–40 stabiliseert de beste waarde zich. Klik „Save 
Best Config“ — een bayesopt-best.json  wordt opgeslagen met de voorinstellings
naam, trial-index, waarde en de gedecodeerde parameter-waarden. Deze JSON kun je 
dan handmatig in je voorinstellingsdefinitie overnemen.

W30 Knop „Start“

WA A R

Toolbar links, in idle/finished-state..

T E C H N I S C H

Reset de trial-lijst, wisselt in de running-state, ge
nereert een nieuwe run-ID (voor stale-detection bij 
meervoudige start-klikken) en genereert een verse 
pause-gate. Vervolgens start een achtergrond-task 
die de optimizer als asynchroon stream uitvoert. Ini
tial-samples-grootte volgt uit min(8, budget /​ 4 
+ 1) — dus typisch 8 Latin-Hypercube-samples bij 
budget ≥ 28, minder bij klein budget. Trial-updates 
worden incrementeel ontvangen en in de lijst aange
hangen. Stale-run-protection: wanneer ondertussen 
een tweede start-klik de run-ID opnieuw zet, wor
den updates uit de oude run verworpen.

Primary-action-stijl voor de prominente knop-look.

E E N VO U D I G  G E Z E G D

Start een verse optimalisatie-run 
met de actuele zoekruimte, bud
get en seed.
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W31 Knop „Pause“

WA A R

Toolbar links, in running-state..

T E C H N I S C H

Zet de pause-gate actief en wisselt in de paused-
state. Het eigenlijke effect: de runner wacht in een 
50-ms-polling-loop voordat hij de volgende objecti
ve-functie evalueert. Dat betekent: een momenteel 
lopende trial wordt afgemaakt (hij is immers synthe
tisch en duurt slechts microseconden), maar geen 
verder trial wordt aangestoten. Zodra Resume loopt, 
gaat het verder waar gestopt werd.

E E N VO U D I G  G E Z E G D

Houdt de run stil. Actuele bere
kening loopt nog af, dan pauzeert 
het.

W32 Knop „Stop“

WA A R

Toolbar links, in running- en paused-state..

T E C H N I S C H

Breekt de runner-task af, nullt de referentie, lost de 
pause-gate (mocht hij nog paused zijn), en wisselt 
naar de finished-state (wanneer trials bestaan) of 
idle-state (wanneer geen). De reeds berekende tri
als blijven in de lijst zichtbaar — stop verwijdert ze 
niet. Destructieve knop-rol toont de knop in rood, 
omdat hij de run afbreekt.

E E N VO U D I G  G E Z E G D

Breekt de run definitief af. Trials 
blijven zichtbaar, je kunt de best-
config toch exporteren.

W33 Knop „Resume“

WA A R

Toolbar links, in paused-state..

T E C H N I S C H

Lost de pause-gate en wisselt in de running-state 
terug. De runner-task loopt al (hij wacht immers in 
de polling-loop); zodra de loop merkt dat de pauze 
is opgeheven, loopt hij verder en start het volgende 
trial.

E E N VO U D I G  G E Z E G D

Zet een gepauzeerde run voort.
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W34 Knop „Save Best Config“

WA A R

Toolbar rechts, altijd zichtbaar (maar disabled wan
neer geen bestTrial aanwezig)..

T E C H N I S C H

Opent een save-dialoog met standaard- bestands
naam bayesopt-best.json , op JSON beperkt. Na 
bevestiging wordt een payload-dictionary gebouwd: 
voorinstellingsnaam, trial-index, waarde (objective-
score), parameter (dictionary van de gedecodeer
de parameter- namen → waarden). De decodering 
projecteert de genormaliseerde zoekruimte-coördi
naten in [0,1]^d terug naar het origineel-waarde
bereik (met log-uniform/linear/integer-schalen over
eenkomstig). JSON-output is pretty-printed en met 
gesorteerde keys. Bij schrijffout wordt (in de actuele 
demo-versie) stilzwijgend genegeerd — geen error-
UI, omdat dat een demo-pad is.

De knop blijft grijs zolang geen trial is gelopen.

E E N VO U D I G  G E Z E G D

Slaat de parameter-waarden van 
het tot dusver beste trial op als 
JSON. Je kunt deze waarden dan 
handmatig in je voorinstellings
configuratie overnemen.

W35 Picker „Search Space“-voorinstelling

WA A R

Linker zijbalk, boven..

T E C H N I S C H

Menu-picker met vier voorinstellingsopties: - „Ra
dianceKit defaults (6-dim)“ — de volledige stan
daard-zoekruimte met alle Q7-hyperparameters. - 
„Mip subset (2-dim)” — alleen mipSmoothing3DScale 
[0.05, 0.5] log-uniform en mipFilter2DVariance 
[0.1, 0.6] linear. Nuttig wanneer je Mip-Splatting 
voor een scèneklasse wilt tunen. - „densify-until + 
ssim-weight + grad-thresh“ — drie densify-relevan
te parameters (densifyGradThreshold log-uniform, 
ssimWeight  linear, densifyUntilIter  integer). 

- „Bowl demo (1-dim)” — pedagogische single-
parameter-zoekruimte voor „zo werkt BayesOpt“-
demo’s.

Terwijl een run actief is, kan de zoekruimte niet 
worden gewisseld (zou de optimizer in verwarring 
brengen).

E E N VO U D I G  G E Z E G D

Welke hyperparameter-
zoekruimte BayesOpt doorzoekt. 
Standaard is „RadianceKit de
faults“. Voor gerichte Mip-tu
ning-pogingen „Mip subset”. Om 
te begrijpen hoe BayesOpt werkt 
„Bowl demo“.
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W36 Slider „Trial Budget“

WA A R

Linker zijbalk, onder de search-space-picker..

T E C H N I S C H

Slider van 10 tot 200, stapgrootte 5. Standaard
40. Dat betekent: BayesOpt mag maximaal N trials 

maken. Daarvan zijn de

eerste paar initial samples (Latin-hypercube), de 
rest zijn echte BayesOpt-trials. Vuistregels voor de 
praktijk: een zoekruimte met d dimensies heeft on
geveer 10d tot 20d trials nodig voor een goed 
optimum. Bij 6-dim defaults dus 60–120, bij 2-dim 
Mip-subset 20–40, bij 1-dim bowl-demo 10–20.

Tijdens de run is de slider gedeactiveerd.

E E N VO U D I G  G E Z E G D

Hoeveel optimalisatiepogingen 
maximaal. Meer pogingen = bete
re oplossing, maar kost meer tijd. 
40 is goede standaard voor de 
demo-objective.

W37 Slider „Random Seed“

WA A R

Linker zijbalk, onder de budget-slider..

T E C H N I S C H

Slider van 1 tot 100, stapgrootte 1. Standaard
42. De seed wordt zowel aan de initiële Latin-hy

percube-samples als

ook aan de noise-component van de demo-ob
jective doorgereikt. Reproduceerbaarheid: dezelfde 
seed + dezelfde zoekruimte + hetzelfde budget 
geeft exact identieke trial-sequentie. Nuttig voor 
„krijgen alle collega’s dezelfde run wanneer ze de 
demo nabouwen?“. Tijdens de run gedeactiveerd.

E E N VO U D I G  G E Z E G D

Stuurt de willekeurigheidsgene
rator. Zelfde seed = zelfde run — 
om te reproduceren.
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W38 Chart (Convergence)

WA A R

Middenkolom van het venster..

T E C H N I S C H

Swift-Charts-diagram met twee lagen: 1. een lijn 
voor „best-value-so-far“ per trial — een mono
toon stijgende of gelijkblijvende curve in accent
kleur. 2. een punt per trial met de individuele 
objective-waarde, gekleurd op fase. Symboolgroot
te 40. Drie fase-labels: „init” (grijs), „bo“ (blauw), 
„restart” (oranje).

Een kleine legende toont de fasekleuren linksboven. 
Wanneer de trial- lijst leeg is (vóór de eerste start), 
wordt in plaats daarvan een empty- state-weergave 
met chart-icoon en hint „Press Start to begin a Bay
esOpt run.“ ingeblend.

E E N VO U D I G  G E Z E G D

Het verloopchart. De doorlopen
de lijn is „beste tot dusver 
gevonden oplossing“; de pun
ten zijn de individuele pogingen. 
Wanneer de lijn voor lange tijd 
vlak blijft, heeft BayesOpt het 
optimum gevonden.

W39 Table (Trial Log)

WA A R

Rechterkolom van het venster..

T E C H N I S C H

Scroll-gebied met lazy gestapelde trial- regels. Per 
regel een horizontale stack: trial-nummer (3-digit 
monospaced, links), waarde (monospaced, rechts
gebonden, 70 pt breed), fase- tag (capsule, gevuld 
met fasekleur bij 25% opacity), optioneel een gele 
ster wanneer dit trial het momenteel beste is. Een 
auto-scroll-mechanisme springt automatisch naar 
het einde, zodra een nieuwe trial erbij komt — zodat 
je het live-verloop aan de schermbodem kunt mee
lezen, zonder zelf te scrollen.

E E N VO U D I G  G E Z E G D

De tabel van alle pogingen. Waar
de, fase, ster voor de beste. 
Scrollt automatisch mee, nieuwe 
trials verschijnen onderaan.

Hoofdvenster: lossverloop en Gaussian-count (I39–I41, 
kruisverwijzing)

Drie van de Inspector-weergaven in het hoofdvenster verdienen een eigen uitleg, omdat 
ze tijdens een lopende training continu te zien zijn en er belangrijke vuistregels zijn over 
wanneer het verloop gezond oogt. De weergaven staan in de Inspector onder de „Loss 
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Chart“-sectie (zie hoofdstuk 2 — Inspector) en vullen de holdout-analyse uit het Aux-
venster boven aan.

Wanneer is de loss-curve gezond? Een gezonde loss-curve toont drie fasen: (1) war­
mup — de eerste 200–500 iteraties valt de loss steil van hoog (typisch 0,15–0,25 voor 
L1+SSIM-gecombineerd afhankelijk van scène) op ongeveer de helft. Wanneer de loss 
in deze fase NIET valt, is meestal de invoer verkeerd (beelden kapot, SfM-poses slecht, 
aantal initial Gaussians te klein). (2) densification — tussen ~500 en densifyUntilItera
tion (klassiek 15K, MCMC tot 20K of 25K) valt de loss verder, vaak met kleine sprongen 
naar beneden wanneer densify-operaties nieuwe Gaussians invoegen en de optimizer 
ze benut. De Gaussian-count stijgt in deze fase. (3) refinement — daarna loopt de loss 
in een vlakker wordende staart. Typische eindwaarden: Tanks-&-Temples Truck met P4 
Quality landt bij L1 ≈ 0,023, Horse met Full Classic V546 bij L1 ≈ 0,0230, outdoor-Mip-
NeRF360-scènes vaak slechter (0,04–0,07).

Wat betekent een plateau? Een plateau (loss-curve verloopt horizontaal over meerde
re duizenden iteraties) heeft twee interpretaties: (a) het model is geconvergeerd, verde
re training brengt niets meer — dat is het goede geval. (b) het model is stuck (lokaal 
minimum, slechte gradiëntinformatie, een cap aan de buffer-limit) — het slechte geval. 
Beide ogen in het chart identiek. Onderscheid: bekijk de Gaussian-count. Wanneer hij 
ook vlak is EN dicht bij de MCMC-cap (bijv. 150K van 150K bij .fullMCMC ), ben je aan 
de limiet — ofwel cap verhogen ofwel plateau accepteren. Wanneer de Gaussian-count 
nog groeit, maar de loss niet valt, is dat stuck.

Wanneer afbreken vs verder trainen? Vuistregel: 10K iteraties lang geen verbetering 
van de min-loss → afbreken, verdere iteraties zijn verspild. Daarvoor: kun je via Cmd+T 
(Training-menu → Continue Training → +5K iterations) nog een verlenging aanhangen, 
mocht je grensgevallen-verbetering zien. Let op: bij MCMC is het plateau vaak echt — 
het cap is de natuurlijke grens.

Gaussian-count-plateau is GEEN „klaar“-signaal. Het betekent slechts dat MCMC 
het cap heeft bereikt of dat Classic densification uitgeput is. De echte „klaar”-vraag 
stelt pas de holdout-analyse — PSNR/SSIM/LPIPS op een onafhankelijke testset, geana
lyseerd in het holdout-venster (W23–W29) of via --benchmark -flag.

PSNR/holdout is de waarheid, loss slechts proxy. De loss is een relatieve metriek: hij 
valt terwijl je model zich aan de trainings-views aanpast. Een lage loss betekent echter 
niet automatisch goed model — wanneer het model de trainingsbeelden uit het hoofd 
heeft geleerd (overfitting), zou de loss klein zijn, maar de PSNR op niet-geziene views 
(holdout) zou slecht zijn. Vandaar: voor de finale kwaliteitsbeoordeling altijd op holdout-
metrics kijken, niet op end-loss alleen.

Vuistregel-box

• User Guide en Keyboard Shortcuts zijn statische hulp — bij trefwoordvragen snel, 
voor diepte de hier voorliggende handleiding gebruiken.

• Manage Storage openen zodra de schijf onder 10% vrije ruimte valt. Logs en imports-
staging zijn de gebruikelijke boosdoeners.
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• Pareto Dashboard pas na minstens drie of vier trainingsreports zinvol. X-as = kosten 
(Time / Gs), Y-as = kwaliteit (PSNR / SSIM). Pareto-front toont de efficiënte combina
ties.

• Holdout Analysis gebruiken voordat je PSNR-benchmarks met anderen publiceert — 
verzekert je dat je testset werkelijk representatief is.

• BayesOpt Console is primair een leer- en inspectietool voor zoekruimte-definities. 
Voor echte trainings-gedreven hyperparameter-tuning de offline CLI-workflow ge
bruiken.

• Loss-plateau en Gaussian-count-plateau zijn afzonderlijk te interpreteren. Cap-limit is 
geen „klaar“-signaal. Echte kwaliteit meet alleen holdout-PSNR.

• 10K iteraties zonder min-loss-verbetering → training stoppen.
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H O O F D S T U K

Hoofdstuk 6 — Trainingsconfiguratie

Afbeelding 26:  Preview-voorinstelling als JSON geëxporteerd + in TextEdit getoond — vel­
den id/name/category/version/createdAt/description, trainingConfig met alle relevante para­
meters (maxIterations 5000, densifyUntilIteration 3500, ssimWeight 0,20, renderScale 0,50, 
strategy classic, cameraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, 

opacityResetInterval 3000, minOpacity 0,005, zes bool-toggles)

WAT DE AFBEELDING TOONT  Een typische voorinstelling-JSON-export. Top-level-velden: 
id  (UUID), name , (classic | mcmc | sceneClass | custom), (schemaversie), (time

stamp), (vrije tekst). Geneste -object bevat de voor reproduceerbaarheid kritieke para
meters — bij import wordt het gehele blok in de TrainingConfig -structuur gedeseriali
seerd, en defaults uit de app-versie vullen de velden die in de JSON ontbreken (bijv. na 
app-update). Wie een voorinstelling aan een andere Mac doorgeeft, stuurt gewoon dit 
JSON-bestand over.

De TrainingConfig -structuur is het hart van elke trainingsrun in RadianceKit. Hij ver
zamelt elke parameter die de training beïnvloedt — van het maximale iteratie-aantal via 
de acht leerratio’s tot aan de speciale velden voor MCMC, Mip-Splatting, het curriculum 
en de scene-aware cap-logica. Je bewerkt hem in de zijbalk in het gebied trainingscon
figuratie-sectie (Expert View), slaat hem op als voorinstelling of geeft hem als JSON-
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export aan een andere Mac door. Bij de training wordt precies dit object bevroren en 
aan het GPU-backend gegeven.

Dit hoofdstuk is referentiemateriaal voor power users en scriptauteurs. Het somt alle 81 
publieke velden, de 9 statische voorinstellingen en de ene publieke methode op. Bron
bestand is TrainingConfig.swift — bij twijfel geldt het daar opgeslagen doc-comment 
en de initializer-default als source-of-truth.

O P M E R K I N G  ·  U I  V S  VO O R I N S T E L L I N G / C L I

Slechts 12 van de 81 velden hebben een directe schuifregelaar, toggle of picker 
in de Inspector (sandboxed App-Store-build): T1, T2, T17, T20, T22, T38, T56–
T58, T60, T61, T73. De overige 69 velden worden via de gekozen voorinstelling 
(hoofdstuk 7) ingesteld en kunnen alleen per CLI-flag (zie hoofdstuk 5) recht
streeks worden overschreven. Deze scheiding is opzettelijk: defaults blijven stabiel 
en productie-beproefd, power users hebben desondanks een ontsnappingsluik. 
Mocht een veld je in het bijzonder interesseren: kijk eerst in hoofdstuk 2 (Inspec
tor) en hoofdstuk 5 (CLI) na of je het zonder JSON-knutselen bereikt.

Inhoudsopgave:

1. Iteratie (T1–T2)
2. Learning Rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH-graad-progressie (T21)
6. Performance (T22–T25)
7. Diagnose en puntenwolk-voorbereiding (T26–T30)
8. Regularisatie (T31–T37)
9. Refinement (T38–T44)

10. Sky-Dome (T45–T48)
11. Adam + LR-schedule (T49–T55)
12. Post-processing + Apple AI (T56–T60)
13. MCMC-densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Adaptive densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. Statische voorinstellingen (TP1–TP9)
18. Methode:
19. Welk veld waarvoor? (cheatsheet)
20. Gevaarlijke velden
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Iteratie (T1–T2)

T1 maxIterations

D E TA I L S

Default: 30.000 (initializer), 35.000 ( .full ), 
200.000 ( .fullMCMC ) Range: 1.000 – 500.000 (UI-
slider), geen harde bovengrens in de logica Defined 
in:

T E C H N I S C H

Totaal aantal trainingsiteraties dat het backend 
doorloopt. Eén iteratie betekent een forward-render 
van een afzonderlijke trainingscamera, een back
ward-pass over alle loss-componenten (L1 + SSIM + 
optionele regularisaties + sky-mask) en een Adam-
optimizer-stap. Dit getal werkt direct in op de 
andere schedules: position-leerratio volgt een cosi
ne-annealing-curve van 0 tot ofwel T1  zelf ofwel 
tot T49 positionLRScheduleEndIteration; densifi
cation stopt bij T2 densifyUntilIteration; MCMC-
noise-decay eindigt bij T69 mcmcNoiseDecayEnd; SH-
graad-upgrades gebeuren op de drie in T21  gede
finieerde merken. Bij klassieke densification ligt de 
empirisch bepaalde sweet spot bij 20.000–35.000 
iteraties (sessies 1–32, V546-tests), bij MCMC bij 
60.000–200.000 (V534). Een drastische verhoging 
boven de in voorinstellingen opgeslagen waarden 
brengt zelden extra kwaliteit — Adam-momentum 
verzadigt, en zonder LR-decay-eind stagneert de 
loss. Omgekeerd leidt onderschrijding van ~5.000 
tot onvolledig geconvergeerde geometrieën (densi
ty-control heeft te weinig tijd om te klonen/splitsen).

E E N VO U D I G  G E Z E G D

Hoe lang de app rekent. Meer 
iteraties = beter resultaat, maar 
op een gegeven moment niet 
meer merkbaar beter, daarvoor 
veel langer. De voorinstellingen 
zijn zo gekozen dat je zonder 
na te denken een goede waarde 
hebt: Quick 1.000, Preview 5.000, 
Balanced 20.000, Quality 35.000, 
MCMC Quality 200.000. Als je er 
zelf aan draait, geldt: bij MCMC 
mag je gerust hoog (100.000–
200.000), bij Classic niet boven 
40.000 — brengt dan niets meer.
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T2 densifyUntilIteration

D E TA I L S

Default: 15.000 (initializer), 5.000 ( .full ), 
160.000 ( .fullMCMC ) Range: 0 – Defined in:

T E C H N I S C H

Iteratie vanaf waar de densification stopt. Tot hier 
worden Gaussians via de in T11–T16  (Classic) 
of T67–T70  (MCMC) geparametriseerde regels ge
klond, gesplitst en gepruned; daarna blijft het Gaus
sian-aantal constant en worden alleen nog posi
ties, rotaties, schalen, opacities en SH-coëfficiënten 
geoptimaliseerd (refinement-fase). In het originele 
3DGS-paper ligt de waarde bij 50% van T1 , in 
RadianceKits .full -voorinstelling bij slechts ~14% 
(5.000 van 35.000) — gevolg van de V310/V338-
experimenten die aantoonden dat na 5.000 iteraties 
verdere densificatie het resultaat eerder verslech
tert (meer floaters, meer geheugengebruik, geen 
kwaliteitswinst). MCMC daarentegen laat de reloca
tion tot 80% van T1  lopen (V504b), omdat MCMC 
geen schadelijke floaters produceert. Wordt T2  te 
klein gekozen (< 1.000), ontstaan te weinig Gaussi
ans; te groot bij Classic (> 50% van T1 ) leidt 
tot overgrowth en RGB-saturation-outliers (zie out
door-overtraining-findings).

E E N VO U D I G  G E Z E G D

Tot wanneer de app nieuwe 
Gaussians mag genereren. Daar
na wordt alleen nog verfijnd 
wat er al is. Bij klassieke trai
ning met 35.000 iteraties is hier 
5.000 de juiste waarde — alles 
daarboven maakt de scène wazi
ger. Bij MCMC is het 80% van 
de totale iteraties (dus 160.000 
bij 200.000-run). Als je Quali
ty-voorinstelling wijzigt, laat dit 
veld liever met rust.
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Learning Rates (T3–T10)

T3 positionLearningRate

D E TA I L S

Default: 0,00016 Range: 1e-7 – 1e-3 (aanbevolen) 
Defined in:

T E C H N I S C H

Adam-leerratio voor de XYZ-positie van elke Gaus
sian aan het begin van de training (iteratie 0). Volgt 
een cosine-annealing-curve en daalt in de loop van 
de training tot T4 positionLearningRateFinal. De 
default 0,00016 komt uit het originele 3DGS-paper 
(Kerbl et al. 2023) en is in RadianceKit ook bij ver
hoging van de beeldresolutie niet te schalen — de 
positie beweegt zich in het wereldcoördinatensys
teem, niet in pixelruimte. Een duidelijke verhoging (> 
0,0005) bewerkt dat Gaussians over lange afstan
den springen en de loss instabiel wordt; waarden 
duidelijk daaronder (< 0,00005) leiden ertoe dat 
verkeerd geïnitialiseerde puntenwolken nooit hun 
plek vinden. V414 testte een verdubbeling van de 
init-waarde → 16,8% slechtere L1-loss; de V544a-
tunings bevestigden de paper-default als optimaal. 
Let op: bij .fullMCMC  laten we deze waarde bewust 
op de default — MCMC heeft constante leerratio’s 
nodig voor zijn relocation-logica, daarom brengt het 
tunen hier niets.

E E N VO U D I G  G E Z E G D

Hoe snel de splat-punten zich 
in de ruimte mogen bewegen. 
De standaardwaarde is zeer goed 
gejusteerd en heeft eigenlijk 
geen wijziging nodig. Alleen wan
neer splats in beeld „rondzwe
ven“ of een hele hoek ontbreekt 
omdat zich daarheen niets be
weegt, zou de leerratio een punt 
zijn om aan te draaien — maar 
dan klopt typisch al eerder iets 
anders niet (cameraposes, initië
le puntenwolk).
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T4 positionLearningRateFinal

D E TA I L S

Default: 0,0000016 (initializer + paper), 0,000016 
( .full , .fullMCMC  — 10× hoger) Range: 0 – De­
fined in:

T E C H N I S C H

Eindwaarde van de position-LR-cosine-anne
aling-curve. Bereikt wordt hij ofwel bij 
T1 maxIterations  ofwel, indien gezet, bij T49 
positionLRScheduleEndIteration. De RadianceKit-
.full -voorinstelling gebruikt 0,000016 — dus 10× 

hoger dan de paper-default 0,0000016. V420-ex
perimenten toonden dat 0,5× van de eindwaarde 
(0,000008) de loss met 6,4% verslechtert; V414 
toonde dat 2× init-waarde hem met 16,8% verslech
tert. De hoge eindwaarde is geen trade-off, maar 
bewuste keuze: bij te sterk verval verliezen de 
Gaussians tijdens de refinement-fase hun vermogen 
om zich op nieuw bijgekomen densification-kandi
daten in te stellen. Via de V431/V433-uitbreiding 
kan de schedule-fase worden verkort ( T49 < T1 ), 
zodat T4  al vóór het trainingseinde wordt bereikt 
en de rest van de training bij constante mini-
LR loopt — typische configuratie: T49 = 20.000 , 
T1 = 35.000 , refinement dus op 0,000016 voor 

15.000 iteraties.

E E N VO U D I G  G E Z E G D

Hoe langzaam de position-leer
ratio aan het einde van de 
training wordt. We hebben dat 
bewust minder agressief inge
steld dan het originele paper 
— splats kunnen tot het einde 
nog een beetje wiebelen, dat 
maakt ze scherper. Wanneer je 
daaraan draait: hoger = onrusti
gere splats aan het einde, lager 
= splats kunnen zich niet meer 
aanpassen wanneer nieuwe op
duiken.
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T5 shDCLearningRate

D E TA I L S

Default: 0,0025 (initializer + paper), 0,005 ( .full  
en alle MCMC-voorinstellingen — 2×) Range: 
0,0001 – 0,05 Defined in:

T E C H N I S C H

Adam-leerratio voor het DC-aandeel (degree 0, dus 
constante albedo) van de spherical-harmonic-kleur. 
SH-DC komt overeen met de richtingsonafhanke
lijke grondtoon van een Gaussian, in zekere zin 
de „basiskleur“. De V176- en V188-experimenten 
vonden 2× hoger dan de paper-default optimaal 
— snellere kleur-convergentie, juist omdat bij korte 
training (, 5.000 iteraties) de SH-DC anders niet 
in vorm komt. Anders dan de geometrische LR’s 
heeft SH-DC geen verval; de leerratio blijft over 
alle iteraties constant (of volgt slechts het optionele 
extended-phase-verval uit T51 ). V416 testte een 
verviervoudiging op 0,01 → 6,4% slechtere loss bij 
beta2=0,99-Adam.

E E N VO U D I G  G E Z E G D

Hoe snel de grondkleur van elke 
splat zich aanpast. De waarde 
verandert men vrijwel nooit zelf 
— de voorinstellingen hebben de 
juiste waarde. Hoger zou sneller 
gaan, kan echter tot instabiele 
kleuren leiden.
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T6 shRestLearningRate

D E TA I L S

Default: 0,000125 (initializer + paper), 0,00025 
( .full  en MCMC — 2×) Range: 0,000001 – 0,005 
Defined in:

T E C H N I S C H

Adam-leerratio voor de SH-coëfficiënten van hoge
re orde (degree 1, 2, 3 — dus de view-direction-
afhankelijke kleurdelen die voor glanslichten, reflec
ties en zachte schaduw zorgen). 20× kleiner dan 
T5  per paper-conventie, omdat deze coëfficiënten 

kwadratisch in aantal groeien (3 voor degree 1, 5 
voor degree 2, 7 voor degree 3 → in totaal 15 
floats per Gaussian) en zonder kleinere leerratio 
het beeld zouden oververzadigen. Wordt in twee 
stappen vrijgegeven — tot het eerste merkpunt in 
T21 shDegreeUpgradeIterations is alleen degree 0 
actief (dus alleen T5 ), daarna 1, later 2, ten slotte 
3. Lage waarden hier zijn vooral belangrijk op scè
nes met veel diffuse belichting; bij zeer glanzende 
oppervlakken (autolak, water) loont draaien niet — 
de SH-representatie op zich is begrensd.

E E N VO U D I G  G E Z E G D

Hoe snel de richtingsafhankelijke 
kleureffecten (reflecties, glans) 
leren. Standaard zeer klein, om
dat anders alles glanst. De waar
de laat men beter staan — wie 
glanslichten beter wil krijgen, is 
eerder met MCMC en langere 
trainingstijd beter gediend dan 
met deze LR.
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T7 opacityLearningRate

D E TA I L S

Default: 0,05 (initializer + paper), 0,1 ( .full , 
MCMC — 2×) Range: 0,001 – 1,0 Defined in:

T E C H N I S C H

Adam-leerratio voor de logit-opacity van elke Gaus
sian. De app slaat opacity op als onbegrensde 
float-waarde en transformeert hem met sigmoid in 
[0, 1]; de LR werkt in de logit-space. De paper-
default 0,05 is na V50-tests (Best Single-Run L1 
0,1664) hersteld, V71 revertete V67′s 0,025. De 
V188-verdubbeling op 0,1 maakt het pruning effici
ënter — dode Gaussians vallen sneller onder de 
T14 pruneOpacityThreshold. V418 toonde: 0,05 met 
beta2=0,99-Adam is 7,1% slechter dan 0,1 — de 
wisselwerking met de Adam-configuratie is niet tri
viaal. Lage waarden (< 0,01) leiden ertoe dat „dead“ 
Gaussians eindeloos rondzwerven en geheugen ver
bruiken; te hoge waarden (> 0,5) kunnen tot opaci
ty-explosion leiden, daarom wordt de logit-waarde 
in de optimizer op [−15, 3] geclampt (zie notitie 
„Opacity Explosion Prevention” in CLAUDE.md).

E E N VO U D I G  G E Z E G D

Hoe snel splats doorzichtig of 
ondoorzichtig worden. Belangrijk 
voor het opruimen — splats die 
niets bijdragen, moeten snel ver
dwijnen, zodat geen sluier ont
staat. Standaardwaarde past, al
leen profs veranderen hem.
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T8 opacityLearningRateFinal

D E TA I L S

Default: 0,0 (= „geen verval“) Range: 0 of 0,001 – 
Defined in:

T E C H N I S C H

Optioneel cosine-decay-eindwaarde voor de opaci
ty-LR (V427). Wanneer 0,0, is decay gedeactiveerd 
en blijft de opacity-LR over de gehele training con
stant bij T7 . V427 testte een decay 0,1 → 0,01 — 
resultaat 11,5% slechtere loss; reverted, vandaar de 
default „uit“. De hypothese achter het veld: in de 
refinement-fase zou constante opacity-LR tot oscil
latie kunnen leiden, zodat splats die al de juiste 
maat transparantie hebben bereikt, door willekeu
rige gradiënt-schommelingen weer worden verscho
ven. Empirisch bevestigt zich dat niet — de logit-
clamping-logica vangt dat toch af. Het veld blijft be
schikbaar voor toekomstige experimenten; ook zeer 
lange MCMC-runs (> 500K iteraties) zouden ervan 
kunnen profiteren.

E E N VO U D I G  G E Z E G D

Of de opacity-leerratio tegen het 
einde kleiner moet worden. Stan
daard: nee. We hebben het ge
probeerd, was slechter, laten het 
gedeactiveerd. Blijf bij 0.

T9 scaleLearningRate

D E TA I L S

Default: 0,005 (initializer + paper), 0,01 ( .full , 
MCMC — 2×) Range: 0,0001 – 0,1 Defined in:

T E C H N I S C H

Adam-leerratio voor de drie schaalcomponenten 
van elke Gaussian in de log-space (RadianceKit 
slaat log(scale) op, zodat schalen positief blijven). 
De paper-default 0,005, in RadianceKit verdub
beld op 0,01 voor betere scale-convergentie bij 
de geoptimaliseerde leerratio-configuraties. V423-
experiment: 0,005 met beta2=0,99-Adam → 18,7% 
slechtere loss en zichtbaar te weinig Gaussians 
(density-control kon niet klonen, omdat de scale-
updates te traag waren). Schaal stuurt de uitbrei
ding van elke Gaussian — te snel leren leidt tot 
„needle“-Gaussians (extreem lange dunne splats, 
zie T34 scaleRatioPruneThreshold), te traag leren 
laat splats te compact blijven en density-control 
moet te vaak splitsen.

E E N VO U D I G  G E Z E G D

Hoe snel de vorm van de splats 
zich aanpast. Standaard is goed. 
Als je dat omhoog draait, krijg je 
gerust „naald“-splats — extreem 
lange dunne druppels die het 
beeld laten floaten.
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T10 rotationLearningRate

D E TA I L S

Default: 0,001 (initializer + paper), 0,002 ( .full , 
MCMC — 2×) Range: 0,0001 – 0,05 Defined in:

T E C H N I S C H

Adam-leerratio voor de vier quaternion-componen
ten van elke Gaussian. De quaternion wordt in elke 
optimizer-stap na de Adam-update opnieuw genor
maliseerd (L2-norm = 1) — anders zou de covarian
tiematrix gedegenereerd raken. RadianceKit verdub
belt de paper-default in de Quality-voorinstellingen, 
omdat rotation ten opzichte van scale / position 
kleinere absolute gradient-magnitudes heeft (op de 
eenheidssfeer blijft elke stap kort) en zonder 2× zou 
de rotation in het 35.000-iteratie-window duidelijk 
onder-geconvergeerd zijn. V188 gedocumenteerd. 
Op NeRF-Blender-scènes (Lego, Chair) werkt rotati
on bijzonder in — de randen van de objecten richten 
zich pas na 5.000–10.000 iteraties correct uit.

E E N VO U D I G  G E Z E G D

Hoe snel de splats leren te draai
en — dus op het oppervlak van 
een object in de juiste oriëntatie 
komen. Standaard past. Anders 
uitgedrukt: wanneer splats eruit
zien als scheef liggende blokken 
in plaats van zich aan het opper
vlak aan te smelten, is eerder 
de trainingstijd te kort, niet deze 
leerratio te laag.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

D E TA I L S

Default: 0,000002 (initializer, gekalibreerd voor 
0,5× resolutie), 0,0000011 ( .full , gekalibreerd 
voor 1,0×), 0,000004 ( .quickTest , gekalibreerd 
voor 0,25×), 2e-7 ( .fullClassicPaper ) Range: 
1e-8 – 1e-3 (resolutie-afhankelijk) Defined in:

T E C H N I S C H

Drempelwaarde voor de L2-norm van de scherm
ruimte-geprojecteerde gradiënt dMean2D , waarbo
ven een Gaussian voor klonen of splitsen wordt 
gemarkeerd. De absolute waarde hangt direct 
af van de trainingsresolutie — dMean2D  schaalt 
ongeveer als 1/resolutie² (meer pixels = kleine
re per-pixel-gradiënten). Daarom heeft elke T22 
trainingRenderScale-trap een gekalibreerde drem
pel nodig: 0,25× → 4e-6, 0,5× → 2e-6, 1,0× → 5e-8 
… 1,1e-6 ( .full ). De paper-default 0,0002 is NDC-
genormaliseerd en in RadianceKits wereld-ruimte-
pipeline niet direct vergelijkbaar. Met de in V440 
ingeschakelde T52 adaptiveDensifyThreshold-vlag 
kan de waarde tijdens runtime uit de p98 van de 
actuele gradiëntverdeling worden berekend — maar 
V440 testte dat op echte scènes en produceerde 
63 K Gaussians (catastrofaal pruning-verlies); de 
vlag blijft uit. Q5 (T77–T79) levert een alternatie
ve adaptive-logica via rolling median. Gevaarloos 
is dit veld niet — halvering genereert 2–4× meer 
Gaussians (geheugendruk, OOM-risico); verdubbe
ling kan de scène onder-densificeren.

E E N VO U D I G  G E Z E G D

Hoe gevoelig de app is wanneer 
hij moet beslissen of een splat 
te weinig wordt weergegeven en 
vermenigvuldigd moet worden. 
Lage waarde = gevoeliger = meer 
splats. Hoger = minder splats. 
Dat is een van de gevaarlijkste 
waarden überhaupt: te laag en 
de Mac loopt vol miljoenen splats 
geheugen en crasht eventueel. 
Laat het veld met rust, of ver
ander het alleen in stappen van 
10%.
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T12 densifyFromIteration

D E TA I L S

Default: 500 Range: 100 – 5.000 Defined in:

T E C H N I S C H

Eerste iteratie vanaf waar densification actief wordt. 
Daarvoor gebeurt slechts „naakt“ leren op de initi
ële SfM-puntenwolk, zonder dat nieuwe Gaussians 
worden gegenereerd. De default 500 komt uit het 
3DGS-paper en geeft de initialisatie tijd om te 
stabiliseren — als al vanaf iteratie 0 wordt gedensifi
ceerd, klonen verkeerd geplaatste SfM-punten zich 
veelvoudig voordat ze überhaupt hun juiste plek 
vinden. V349 testte 1000 → licht slechtere loss; de 
default is optimaal.

E E N VO U D I G  G E Z E G D

Wanneer de app voor het eerst 
begint splats te klonen. Daarvoor 
leert hij alleen de reeds aanwezi
ge punten. 500 is de standaard
waarde — geeft de app genoeg 
tijd om zich eerst even te ori
ënteren voordat hij vermenigvul
digt.

T13 densifyInterval

D E TA I L S

Default: 100 (initializer, MCMC), 200 ( .full ) Ran­
ge: 50 – 1.000 Defined in:

T E C H N I S C H

Hoeveel iteraties tussen twee densification-stap
pen liggen. In paper-default 100 — elke 100 
iteraties wordt de lijst van densify-kandidaten ge
ëvalueerd, geklond/gesplitst en tegelijk de lijst 
van prune-kandidaten (sigmoid(opacity) < T14 
pruneOpacityThreshold) verwijderd. V112-tests von
den 200 als optimaal voor .full  — dat ontlast 
de GPU, omdat minder reorganisatie-passes lopen, 
en geeft elke Gaussian meer tijd om zich na 
een kloon-actie te stabiliseren. V417 testte 100 
met beta2=0,99 → 5,8% slechter (957 K Gaussi
ans, overdensificatie). Bij MCMC wordt hetzelfde 
veld als relocation-interval geïnterpreteerd; zie T67 
mcmcRelocationInterval voor de MCMC-specifieke 
logica.

E E N VO U D I G  G E Z E G D

Hoe vaak de app naar nieuwe 
splats kijkt. 100 = vaak, 200 = 
gemiddeld. Hoger betekent: elke 
splat heeft langer tijd zich in te 
richten voordat opnieuw wordt 
vermenigvuldigd. Dat is goed. Tot 
50 verlagen kan de GPU perma
nent bezighouden zonder dat het 
noemenswaardig beter wordt.
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T14 pruneOpacityThreshold

D E TA I L S

Default: 0,005 (initializer, paper, MCMC), 0,001 
( .full ) Range: 0,0001 – 0,1 Defined in:

T E C H N I S C H

Sigmoid-opacity-drempel waaronder een Gaussian 
bij de volgende densification-step wordt verwijderd. 
Werkt samen met T7 opacityLearningRate en de 
logit-clamp-logica in de optimizer. V393 verlaagde 
de default van 0,005 naar 0,001 in .full  — ge
volg: splats die slechts onder exotische kijkhoeken 
een rol spelen, blijven langer behouden en dragen 
aan het SH-detail bij. V394 testte 0,0001 → licht 
slechter (te weinig geprunet, geheugen verspild). 
Belangrijk: density-control moet ALTIJD prunen, ook 
wanneer de buffer-capaciteit door andere maatre
gelen al vol is (zie „Density Control Must Always 
Prune“ in CLAUDE.md) — anders accumuleren dode 
Gaussians en de count bevriest.

E E N VO U D I G  G E Z E G D

Wanneer een splat als „doorzich
tig genoeg“ geldt, om te worden 
verwijderd. 0,005 is de paper-
standaard, wij hebben in Quality 
0,001 — dus we geven splats lan
ger een kans. Dat maakt zacht 
licht en zwakke schaduwen be
ter weergeefbaar. Hoger zetten 
(boven 0,01) laat het splat-aantal 
snel dalen — kan zinvol zijn bij 
geheugenkrapte, maar kost de
tail.

T15 opacityResetInterval

D E TA I L S

Default: 3.000 (initializer + paper), 100.000 
( .full  = effectief gedeactiveerd), 200.000 
( .fullMCMC  = gedeactiveerd) Range: 1.000 – 
100.000+ Defined in:

T E C H N I S C H

Elke hoeveel iteraties wordt de opacity van alle 
Gaussians teruggezet op een lage waarde (~0,01) 
— een maatregel uit het 3DGS-paper om „bevroren“ 
splats opnieuw te beoordelen. V194 toonde dat met 
RadianceKits warmup + stochastic-trainings-setup 
+ 2× leerratio’s de opacity-reset 5,5% kwaliteit kost 
en de logit-clamp de reset-functie al afdekt. Van
daar in .full  praktisch gedeactiveerd (100.000 > 
35.000 = nooit getriggerd). V421 testte reset elke 
3.000 met beta2=0,99 → 4,9% slechter; reverted. 
Bij .fullClassicPaper  (Q1.5-A, paper-getrouwe 
test) is het bewust weer op 3.000 gezet — dat was 
een van de hefbomen waarmee de paper-magnitu
de-Gaussian-budgetten moesten worden bereikt.

E E N VO U D I G  G E Z E G D

Elke hoeveel iteraties de app de 
zichtbaarheid van alle splats op 
„bijna onzichtbaar“ terugzet — 
een soort reset-knop voor de 
opacity. Bij ons gedeactiveerd 
(waarde zo hoog dat het nooit 
gebeurt), omdat andere mecha
nismen het overbodig maken. Al
leen bij paper-getrouwe experi
menten aanzetten.
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T16 maxScreenSize

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 (off) of > 0 
Defined in:

T E C H N I S C H

Maximale schermruimte-grootte (in geprojecteerde 
pixels) die een Gaussian mag bereiken voordat ze 
gedwongen wordt gesplitst. De waarde is op 0 
gezet (V48 testte en reverted) — RadianceKits den
sity-control gebruikt in plaats daarvan de wereld-
ruimte-schaal-drempel uit de dMean2D -logica. Blijft 
in de veldcatalogus opgenomen, omdat toekomsti
ge experimenten met Mip-Splatting (T74–T76) of 
scènespecifieke splatting-strategieën ervan zouden 
kunnen profiteren. Activering (waarde > 0, bijv. 20) 
zou zeer groot geworden splats op het scherm 
dwingen zich te delen — relevant bij grote, gladde 
wandvlakken waar één enkel reuzensplat te weinig 
detail biedt.

E E N VO U D I G  G E Z E G D

Begrenzing hoe groot een afzon
derlijke splat op het scherm mag 
worden. Bij ons uit. Aangezet 
zou het bewerken dat reusach
tige platte splats (bijv. op een 
muur) gedwongen in meerdere 
kleine worden ontleed. Laat uit, 
tenzij uitdrukkelijk experimenten 
daarmee.
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Loss (T17–T20)

T17 ssimWeight

D E TA I L S

Default: 0,2 (initializer + paper + .full ), 0,05 (alle 
MCMC-voorinstellingen) Range: 0,0 – 1,0 Defined 
in:

T E C H N I S C H

Gewicht van het D-SSIM-aandeel in de gecombi
neerde loss-functie loss = (1 - λ) * L1 + 
λ * D-SSIM, waarbij λ = T17 . De 3DGS-paper-
default 0,2 is voor Classic-densification optimaal — 
V383 testte 0,3 → 28,9% slechter, V373b bevestig
de 0,2 als sweet spot. Voor MCMC werd in V521b/
V534 onafhankelijk vastgesteld: 0,05 is optimaal, 
omdat MCMC door zijn stochastische exploratie een 
sterker L1-signaal-aandeel nodig heeft — hogere 
SSIM-gewichten zouden de relocation-beslissingen 
verwateren. SSIM is duidelijk duurder te berekenen 
dan L1 (lokale 11×11-windows over het hele beeld); 
RadianceKit gebruikt een MPS-versnelde implemen
tatie die onder 1 ms per 1080p-beeld blijft. Q7-
BayesOpt-sweeps vonden scènespecifieke optima 
tussen 0,05 ( .outdoorPreset : 0,082) en 0,171 
( .indoorPreset ).

E E N VO U D I G  G E Z E G D

Hoe belangrijk de app naast „el
ke pixel klopt“ ook „structuren 
zijn vergelijkbaar” vindt. 0,2 is 
de standaard en levert een goed 
beeld. Lager = pixelnauwkeuri
ger, maar kan zachtere overgan
gen krijgen. Hoger = meer struc
tuurgelijkenis, maar details wor
den zachter. Laat de voorinstel
lingen beslissen.
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T18 ssimWeightRefinement

D E TA I L S

Default: 0,0 (= „geen wissel, behoud ssimWeight“) 
Range: 0 of 0 – 1,0 Defined in:

T E C H N I S C H

Optionele SSIM-waarde voor de refinement-fase na 
T2 densifyUntilIteration. V428 testte 0,2 → 0,3 
in refinement → 16% slechtere loss (zowel L1 als 
SSIM verslechterden); reverted, vandaar default 0,0. 
De hypothese achter het veld was dat na de densi
fication — wanneer geen nieuwe Gaussians meer 
ontstaan — een sterker SSIM-aandeel de structure
le scherpte zou maximaliseren. Empirisch onjuist: 
SSIM-gewicht verhogen betekent indirect L1-ge
wicht verlagen, en L1 is het duidelijk veelzeggende
re signaal in de finale-refinement-fase. Het veld 
blijft beschikbaar voor toekomstige experimenten 
met perceptual loss (T60) of edge-loss (T19), waar 
een refinement-specifieke loss-compositie zinvol 
zou kunnen zijn.

E E N VO U D I G  G E Z E G D

Speciaal-instelling voor de twee
de trainingsfase (verfijning na 
splat-vermenigvuldiging). Bij 0,0: 
dezelfde SSIM-weging als daar
voor. Draaien brengt empirisch 
niets, daarom uit.
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T19 edgeLossWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,001 – 
1,0 Defined in:

T E C H N I S C H

V437-experimenteel-loss: gewicht van een Sobel-
gradient-domain-L1-loss die de beeldranden di
rect vergelijkt (ground-truth-Sobel vs render-Sobel) 
aanvullend op L1+SSIM. Hypothese: randinformatie 
is een perceptuele hoeksteen van beeldkwaliteit en 
een expliciete term zou Gaussians moeten aanmoe
digen om randen beter te treffen. Testresultaten: 
gewicht 0,1 → 11% slechtere loss, 0,01 → quality-
neutraal maar 10% langzamer. De Sobel-pass kost 
een extra MPS-forward op ground-truth en ren
der. Vandaar permanent gedeactiveerd. Toekomsti
ge use-case: scènes met harde kunstmatige randen 
(architectuur, meubilair, renderings) zouden kunnen 
profiteren — Q7-scene-class-voorinstellingen heb
ben dat echter niet gepickt, maar in plaats daarvan 
het SSIM-gewicht geschaald.

E E N VO U D I G  G E Z E G D

Experimentele toevoeging die 
randen extra belangrijk neemt. 
Brengt empirisch niets. Blijft uit.
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T20 skyMaskingEnabled

D E TA I L S

Default: false (initializer en alle voorinstellingen) 
Range: boolean Defined in:

T E C H N I S C H

Schakelt sky masking in. Daarbij wordt 
in elk beeld via Apple Vision Frame
work (VNGenerateForegroundInstanceMaskRequest) 
de sky-regio uitgemaskeerd, en de loss in dit gebied 
op nul gezet. Doel: outdoor-scènes lijden vaak er
aan dat blauwe/grijze/witte sky-pixels de app ertoe 
brengen Gaussians precies daar te plaatsen — wat 
als „floater“ wordt waargenomen. Zonder sky-mask 
zou de loss in dit gebied nooit nul zijn, omdat 
de hemel in het beeld licht varieert en de app 
eindeloos probeert dat met splats na te bouwen. 
De vision-mask wordt eenmaal per camera vóór de 
training berekend en in RAM gehouden. Wordt ty
pisch samen met T45 skyDomeEnabled  geactiveerd 
(UI-logica in de settings-view). Bij binnenscènes of 
synthetische renderings gedeactiveerd laten — de 
mask zou daar ten onrechte plafonds of muren als 
„sky” herkennen.

E E N VO U D I G  G E Z E G D

Schakelt een speciaalmodus voor 
buitenopnames aan: de hemel 
wordt bij de training genegeerd, 
zodat niet wordt geprobeerd hem 
met splats na te bouwen. Aanbe
volen voor elke buitenscène. Bij 
binnen of bij 3D-renderings uit 
Blender uit laten.
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SH-graad-progressie (T21)

T21 shDegreeUpgradeIterations

D E TA I L S

Default: [1_​000, 2_​000, 3_​000] (initializer), 
[2_​000, 5_​000, 8_​000] ( .full , MCMC), 
[1_000, 2_000]  ( .preview  — degree 3 over

geslagen) Range: [Int] , elke waarde in 
[0, maxIterations] , monotoon stijgend Defined 

in:

T E C H N I S C H

Iteraties waarop de actieve SH-graad van 0→1, 1→2, 
2→3 wordt opgeschakeld. Vóór het eerste merk
punt zijn alleen de DC-componenten actief (dus T5 
shDCLearningRate), na het eerste merkpunt de DC + 
3 degree-1-coëfficiënten, na het tweede merkpunt 
+ 5 degree-2-coëfficiënten, na het derde merkpunt 
alle 15 coëfficiënten. De geheugenbehoefte per 
Gaussian groeit daarbij in stappen — 4 floats → 
16 floats → 36 floats → 64 floats. De Quality-
voorinstellingen vertragen de upgrades ten opzichte 
van initializer-defaults (V228), omdat de geometrie 
eerst moet stabiliseren voordat de kleurdetails met 
hun hogere frequentie erop komen. V384 testte 
[1K, 2K, 3K]  voor .full  → 9,3% slechter — be

vestigt de vertraging. .preview  kapt bij degree 2, 
omdat degree 3 in 5.000 iteraties niet convergeert 
en alleen optimizer-capaciteit verbruikt. Q6 (T80–
T81) biedt een alternatieve curriculum-logica die 
deze lijst dynamisch overschrijft.

E E N VO U D I G  G E Z E G D

Op welke punten in de training de 
app leert dat kleuren vanuit ver
schillende kijkhoeken er anders 
kunnen uitzien (glanslichten, re
flecties). Pas laat — zodat eerst 
de vorm klopt, dan de kleur. De 
waarden in de voorinstellingen 
zijn zo ingesteld dat dat goed 
werkt. Niets aan veranderen, be
halve als je precies weet waarom.
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Performance (T22–T25)

T22 trainingRenderScale

D E TA I L S

Default: 1,0 (initializer, .full , MCMC, scene-
class), 0,5 ( .preview ), 0,25 ( .quickTest ) Range: 
0,05 – 2,0 (typisch 0,25, 0,5, 1,0) Defined in:

T E C H N I S C H

Renderresolutie bij de training relatief aan de origi
nele resolutie van de trainingsbeelden. Bij 0,5 wordt 
elk beeld op 50% breedte × 50% hoogte herrekend 
(dus 25% van de pixels) en de Gaussian-rendering 
vindt plaats in deze kleinere resolutie. Reduceert 
zowel geheugen- als rekenkosten kwadratisch. Be
langrijk: T11 densifyGradThreshold moet bij de ge
kozen resolutie passen — de gradient-magnitudes 
schalen met 1/resolutie², daarom heeft .quickTest  
(0,25×) een veel hogere drempel (4e-6) dan .full  
(1,0×, 1,1e-6). RadianceKit waarschuwt bij zeer gro
te beelden en past automatisch aan — 3-MP-doel
resolutie. Bij extreme 4K-invoerbeelden zou 0,5 of 
zelfs 0,25 zinvol zijn, anders loopt elke Mac ook 
alleen in CPU-compaction.

E E N VO U D I G  G E Z E G D

Hoe groot de beelden bij de trai
ning zijn. 1,0 = origineel, 0,5 = 
half zo groot. Halve grootte = 
vier keer sneller, maar fijnste 
details ontbreken. De voorinstel
lingen kiezen de juiste waarde; 
bij extreem grote invoerbeelden 
(boven 12 megapixels) schakelt 
de app automatisch terug.

T23 resolutionWarmupScale

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,1 – 
Defined in:

T E C H N I S C H

V133-optimalisatie: train de densification-fase (iter 
0 tot T2 ) in een lagere resolutie dan de refi
nement-fase. V308 heeft hem voor .full  weer 
uitgeschakeld, omdat bij T22 = 1,0  en cosine-
annealing de time-win marginaal was en kwaliteit 
minimaal leed. Blijft in de veldcatalogus, omdat hij 
bij 4K-invoer en lange trainingsruns weer zinvol zou 
kunnen worden — Q6 Curriculum (T80) heeft een 
vergelijkbare logica overgenomen, daar is hij echter 
aan de LR-schedule gekoppeld. Wanneer geacti
veerd en T80 curriculumResolutionRamp eveneens 
true, wint Q6 en overschrijft deze waarde.

E E N VO U D I G  G E Z E G D

Speciaal-feature: in de eerste 
trainingshelft met kleinere beel
den leren, in de tweede met 
grote. Spaart tijd. Uit, omdat de 
nieuwere Q6-variant dat beter 
oplost.
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T24 tileSize

D E TA I L S

Default: 16 Range: 8, 16, 32 Defined in:

T E C H N I S C H

Grootte van de rasterisatie-tiles in pixels. De 
Gaussian-Splatting-rendering is tile-gebaseerd: het 
beeld wordt in 16×16-pixel-tegels opgedeeld, elke 
tegel verzamelt de voor haar relevante Gaussians, 
sorteert ze op diepte en blendt ze in. 16 is de 
door vrijwel alle 3DGS-implementaties gebruikte 
standaard en in de RadianceKit-Metal-kernels hard
gecodeerd; een wijziging van deze waarde zou 
recompilatie van de shaders eisen en is in de huidi
ge stand niet effectief. Blijft als veld, mocht een 
toekomstige engine-versie tile-size dynamisch on
dersteunen.

E E N VO U D I G  G E Z E G D

Interne renderparameter. Stan
daard 16, niet veranderen.

T25 throttleDelayMs

D E TA I L S

Default: 0 (initializer, .full , MCMC, scene-class), 
0 ( .preview ) Range: 0 – 100 Defined in:

T E C H N I S C H

Kunstmatige vertraging tussen trainingsiteraties in 
milliseconden. 0 = volle snelheid (standaard). Hoge
re waarden maken de Mac tijdens de training „bruik
baarder“, doordat GPU/CPU regelmatig ademruimte 
krijgen — de bedieningsgemak van andere apps 
stijgt, de trainingstijd echter lineair met de vertra
ging. Typische waarden: 1–2 ms („licht” throttling, 
+5% trainingstijd, Mac voelt responsiever aan), 5 
ms („middelzwaar“, +15% trainingstijd), 10+ ms 
(„Eco”, potentieel dubbele trainingstijd). Wordt in 
de Inspector onder „performance“ geboden, is ech
ter niet in de standaardweergave — zie backlog 
dev_ux-backlog.md  die voorstelt hem uit de Expert 

View te verwijderen, omdat verkeerd begrepen hij 
de trainingstijd dramatisch verlengt.

E E N VO U D I G  G E Z E G D

Hoeveel milliseconden pauze 
de app tussen trainingsstappen 
maakt. 0 = geen pauze, zo snel 
mogelijk. Hogere waarden maken 
de Mac tijdens de training beter 
bruikbaar — maar de training 
duurt dan ook langer. Op een M3 
Ultra of Mac Studio kun je dat op 
0 laten; op een MacBook Air zou 
2 of 5 een goede waarde zijn.
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Diagnose en puntenwolk-voorbereiding (T26–T30)

T26 depthDistortionWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,0001 
– 0,05 Defined in:

T E C H N I S C H

V366-experimenteel: gewicht van een depth-distor
tion-regularisatie-loss. Bestraft Gaussians die langs 
een render-straal weliswaar diep gestaffeld zijn, 
maar conceptueel tot hetzelfde oppervlak behoren 
— dat moedigt geconcentreerde diepteverdelingen 
aan en reduceert floaters. Tests: 0,01 → 4,5% slech
ter, 0,001 → 8,1% slechter. Het theoretische voor
deel — multi-view-consistentie verbeteren — slaat 
zich niet in de L1-loss neer, omdat de hypothese im
pliciet aanneemt dat de SfM-geometrie correct is en 
de Gaussians alleen „gestapeld“ moeten worden. In 
de praktijk is de SfM-puntenwolk meestal de zwak
ste component, niet de stapeling. Blijft beschikbaar 
voor multi-view-datasets met bijzonder schone po
ses (synthetic, Mip-NeRF 360 met ground truth).

E E N VO U D I G  G E Z E G D

Experimentele feature ter vermij
ding van meerdere splats achter 
elkaar op dezelfde plek. Niet ge
activeerd, omdat de tests niets 
hebben opgeleverd.

T27 singleViewOverfit

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Diagnose-vlag: wanneer true, wordt in elke training
siteratie verplicht camera-index 0 gebruikt in plaats 
van een willekeurig uit de camera-pool. Doel: wan
neer het model niet eens één enkele view kan 
overfitten (sprich, de loss op view 0 ook na 10.000 
iteraties niet tegen nul gaat), is in de forward/back
ward-pass een fundamentele bug. Deze schakelaar 
werd tijdens de ontwikkeling van de Metal-shaders 
en de differentiable-rasterizer-kernels intensief ge
bruikt — V42–V47-fase. Vandaag alleen nog als sa
nity check beschikbaar wanneer iemand backend-
code heeft gewijzigd en een regression test wil 
doen. Via CLI met --single-view .

E E N VO U D I G  G E Z E G D

Testmodus voor ontwikkelaars. 
Zij kunnen daarmee controleren 
of de app überhaupt uit ÉÉN 
beeld kan leren. Voor normale 
gebruikers irrelevant, altijd uit 
laten.
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T28 maxCameras

D E TA I L S

Default: 0 (= „alle camera’s gebruiken“) Range: 0 
of 1 – N Defined in:

T E C H N I S C H

Diagnose-limiet uit V43: train alleen met de eerste 
N camera’s, negeer alle andere. Doel oorspronkelijk: 
hypothese testen dat te veel camera’s gradient-
conflicten genereren (te veel tegenstrijdige loss-
signalen voor dezelfde Gaussian). Testresultaat: 
geen systematisch voordeel bij kunstmatige beper
king — meer-frames brengen praktisch altijd meer 
kwaliteit. Blijft als CLI-flag ( --max-cameras N ) voor 
gerichte experimenten, bijv. „werkt de training op 
de eerste 100 beelden van een 1.500-beelds-drone
vlucht?“ In de UI niet geëxposeerd.

E E N VO U D I G  G E Z E G D

Diagnose-veld voor ontwikke
laars — alleen de eerste N 
beelden gebruiken, rest nege
ren. Normale gebruiker heeft 
niet nodig, waarde op 0 = alle 
beelden. Meer beelden = beter 
resultaat (zie feedback_​more-
frames-better.md).

T29 maxInitialPoints

D E TA I L S

Default: 0 (= „alle SfM-punten gebruiken“) Range: 
0 of 1.000 – 200.000+ Defined in:

T E C H N I S C H

V54-beveiliging: limiteert het aantal initiële SfM-
punten waarmee de training start. Dichte COLMAP-
reconstructies kunnen > 60.000 punten produceren, 
wat bij grote initial-schalen tot 200–300 Gaussians 
per pixel-overlap leidt — dat maakt een „nevelveld“ 
waarin de training niet convergeert. Subsampling op 
~16.000 punten (hard-cap-logica in de trainings-
engine) brengt de initial-dichtheid op het niveau dat 
het referentie-3DGS gebruikt, en reduceert overlap 
dramatisch. Wordt bij zeer dichte SfM’s automatisch 
ingesteld; via CLI met --max-points N .

E E N VO U D I G  G E Z E G D

Hoeveel begin-punten uit de 
camerareconstructie worden ge
bruikt. Bij zeer dichte recon
structies (meer dan 60.000) li
miteert de app automatisch op 
16.000 — anders is er te veel ne
vel aan het begin. Je hoeft dat 
niet in te stellen; de app regelt 
het.
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T30 cameraClusterOutlierMultiplier

D E TA I L S

Default: 10,0 (alle voorinstellingen — nooit over
schreven) Range: 1,0 – 100,0 Defined in:

T E C H N I S C H

Multiplicator voor het camera-cluster-outlier-filter, 
ingevoerd in fase 3.10 A.1. Vóór de training berekent 
de trainings-engine het centroid van alle camerapo
sities en de maximale afstand van een camera tot 
het centroid. SfM-punten waarvan de afstand tot 
het centroid multiplier × maxCameraDistance over
schrijdt, worden als outlier verworpen. Default 10× 
bewaart het gedrag van vóór fase 3.10. Een subtie
le bug: tighter SfM (camera’s dichter bij elkaar) → 
kleiner → kleinere drempel → meer punten worden 
als outlier verworpen. Looser SfM → grotere drem
pel → minder punten verworpen. Dit is een van de 
oorzaken van de fase-3.9-funnel-vs-training-anti-
correlatie: betere SfM kan downstream tot slechtere 
training leiden, omdat te veel initial-punten worden 
gekild. Het veld ligt als CLI-override (--camera-
cluster-outlier-multiplier) voor de A.3-sweeps; 
in de UI niet geëxposeerd. Waarden onder 5 zijn 
over het algemeen te restrictief, boven 20 zonder 
effect.

E E N VO U D I G  G E Z E G D

Speciaal-filter dat punten uit de 
reconstructie verwerpt die ver 
weg van de camera-wolk liggen. 
10 = de app is gul, behoudt 
vrijwel alles. Verhogen kan zin
vol zijn, wanneer ver verwijder
de punten (bergen in de verte) 
in beeld eruitzien als zwevende 
klontjes. Lager zetten alleen in 
noodgeval — verlies daarbij de
tail in de verte.
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Regularisatie (T31–T37)

T31 coarseToFineBlurRadius

D E TA I L S

Default: 0 (= gedeactiveerd) Range: 0 of 1 – 10 
Defined in:

T E C H N I S C H

V369-experimenteel: box-blur-radius die aan het 
begin van de densification-fase op het ground-
truth-beeld wordt toegepast en lineair tot het einde 
van de densification ( T2 ) op 0 wordt verminderd. 
Hypothese: coarse-to-fine-training — eerst grove 
structuren leren, dan details — zou stabielere geo
metrie moeten leveren. Tests: r=3 → 9,6% slechter, 
r=1 → 5,1% slechter. De reden voor het mislukken: 
de densification beslist op basis van beelddomein-
gradiënten, en bluren reduceert juist de signalen 
die voor „hier moet geklond worden“ belangrijk zijn. 
Blijft in de veldcatalogus voor toekomstige tests met 
ander density-control-schema.

E E N VO U D I G  G E Z E G D

Experimentele „eerst-grof-dan-
gedetailleerd“-modus. Heeft 
niets gebracht, blijft uit.

T32 scaleRegWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,0001 
– 0,05 Defined in:

T E C H N I S C H

V370-experimenteel: L1-regularisatie op wereld-
ruimtelijke schaal. Bestraft Gaussians die te groot 
worden — voorkomt „mega-splats“ die hele wand
vlakken met één Gaussian afdekken. Tests: 0,01 
→ 200% slechtere loss (2 M Gaussians, totale 
explosie), 0,001 → 214% slechter. De reden: scale-
regularisatie komt met density-control in conflict 
— kleinere schalen betekenen, meer Gaussians wor
den nodig, dus splitst density-control vaker, wat op 
zijn beurt meer gradiëntinspanning betekent. Disa
bled, maar gedocumenteerd voor Mip-Splatting-ex
perimenten (T74): in deze context zou een schaal-
ondergrens zinvol kunnen zijn.

E E N VO U D I G  G E Z E G D

Regularisatie die splats dwingt 
klein te blijven. Heeft in tests 
splat-explosies veroorzaakt (mil
joenen splats). Niet activeren.
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T33 anisotropyRegWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,0001 
– 0,05 Defined in:

T E C H N I S C H

V445-experimenteel: penalty op de max(scale)/
min(scale)-verhouding, moet extreem langgerekte 
„needle“-Gaussians voorkomen die als floater wor
den waargenomen. Tests: 0,01 → 69% slechter, 
0,001 → 15% slechter. De reden: regularisatie 
dwingt splats richting „ronde” vorm, wat op een 
vlak oppervlak (muur, tafel, vloer) precies verkeerd 
is — daar is een vlakke, brede Gaussian efficiënter 
dan een bolvormige. Disabled. V549f bood met T34 
scaleRatioPruneThreshold een alternatieve, gerich
tere benadering die eveneens werd reverted.

E E N VO U D I G  G E Z E G D

Regularisatie die te lange dunne 
splats bestraft. Klinkt zinvol, was 
in tests echter slechter. Uit.

T34 scaleRatioPruneThreshold

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 5,0 – 
100,0 (typisch 10,0 – 30,0) Defined in:

T E C H N I S C H

Experimenteel post-training-pruning dat elke Gaus
sian verwijdert waarvan de max(scale)/min(scale)-
verhouding de hier ingestelde lineaire drempel over
schrijdt. Doelt op extreem langgerekte „needle/
disc“-floaters die door regularisatie alleen niet kun
nen worden geëlimineerd. In de test verwijderde 
het pruning floaters zoals gehoopt, maar tegelijk 
ook zinvolle vlakke splats op muren en vloeren — 
het beeld werd gatiger. Vandaar standaard uit, de 
CLI-flag (--scale-ratio-prune N) blijft voor gerich
te experimenten beschikbaar. Aanbevolen waarden 
mocht men het toch willen testen: 30 (zeer conser
vatief, verwijdert alleen extreme outliers), 10 (agres
sief, kost detail).

E E N VO U D I G  G E Z E G D

Poging om heel langgerekte 
splats na het training uit te filte
ren. Was in tests netto-negatief 
— floater weg, maar ook detail 
weg. Uit.
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T35 opacityRegWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,0001 
– 0,05 Defined in:

T E C H N I S C H

V446-experimenteel: binary-cross-entropy-penalty 
die opacity tegen 0 of 1 trekt (dus weg van „half-
transparant“). Hypothese: scherpere opacity-verde
ling zou beeldhelderheid verbeteren. Test met T33 
gecombineerd → regularisatie kost kwaliteit, beide 
gedeactiveerd. Disabled. Let op: in 1.4.3-beta dook 
een bug op die juist dit veld in een default-waarde-
wijziging (initializer = 0,01) had, wat tot mass-ex
tinction van het Gaussian-aantal (460 K → 5 in één 
iteratie) leidde. Sinds 1.4.4 vast op 0,0 als default 
verankerd.

E E N VO U D I G  G E Z E G D

Regularisatie die splats ofwel he
lemaal transparant of helemaal 
solide maakt. Brengt niets, kan 
zelfs gevaarlijk worden (1.4.3-
bug mass-extinction). Laat op 0.

T36 opacityDecayFactor

D E TA I L S

Default: 0,0 (initializer = gedeactiveerd), 0,9995 
( .full , .classicBalanced  — HTGS-standaard) 
Range: 0 (off) of 0,95 – 1,0 Defined in:

T E C H N I S C H

V546-implementatie van het HTGS-schema (hiërar
chische time-gating, Eurographics 2025): elke T37 
opacityDecayInterval iteraties wordt de sigmoid-
opacity van elke Gaussian met deze factor ver
menigvuldigd. 0,9995 × 100 toepassingen levert 
~95%-verblijf per densification-fase — een lichte 
maar gestage neerwaartse druk op alle opacities, 
die zwak bijdragende Gaussians betrouwbaar tegen 
de T14 pruneOpacityThreshold laat zakken. Het re
sultaat: 14% betere L1-loss op Horse Full (3-trial-
avg V546) ten opzichte van V438 zonder verval. 
Alleen tijdens densification-fase actief (tot T2 ), 
daarna loopt de training zonder verval verder, zo
dat de in refinement gevestigde opacities stabiel 
blijven. Bij MCMC niet gebruikt (MCMC heeft eigen 
mechanismen via T67 mcmcRelocationInterval + 
T68 mcmcDeadOpacityThreshold).

E E N VO U D I G  G E Z E G D

„Zacht verbleken“ van alle splats 
over de trainingstijd. Maakt in
actief geworden splats sneller 
transparant, zodat ze bij het 
opruimen weggaan. Was de be
langrijkste quality-hefboom van 
de V546-update: 14% beter. 
In Quality-voorinstelling inge
bouwd. Zelf draaien niet aanbe
volen, omdat exact getarreerd.
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T37 opacityDecayInterval

D E TA I L S

Default: 50 Range: 10 – 500 Defined in:

T E C H N I S C H

Iteratie-interval waarin T36 opacityDecayFactor 
wordt toegepast. HTGS-paper-default 50, in .full  
gelaten. Lange intervallen (>200) heffen het effect 
deels op, omdat tussen twee toepassingen genoeg 
gradient-updates plaatsvinden, dat opacity weer 
stijgt. Kortere intervallen (<20) maken decay te 
agressief. Alleen in densification-fase actief.

E E N VO U D I G  G E Z E G D

Hoe vaak het „verbleken“ wordt 
toegepast. 50 = elke 50 iteraties 
een beetje verbleek-stap. Past.

Refinement (T38–T44)

T38 gradientAccumulationSteps

D E TA I L S

Default: 1 (= „één view per Adam-stap“) Range: 1 – 
8 Defined in:

T E C H N I S C H

V424-feature: aantal views waarvan de gradiënten 
worden geaccumuleerd voordat een Adam-update 
wordt uitgevoerd. Bij > 1  loopt de app op een 
apart, „unfused“ backward-project-pad dat de gra
diënten in een aparte buffer optelt; de finale toe
passing schaalt met 1/N om de magnitude constant 
te houden. V424 testte 2-view → kwaliteit-neutraal, 
maar 10% langzamer (omdat unfused-pad duurder 
is dan fused-pad). Reverted voor .full , maar voor 
MCMC bewust gebruikt — .fullMCMC  loopt met, 
maar V544a-tests toonden dat met de quality-gap 
tot Classic op 5% slinkt (in plaats van 11%). In initi
alizer-default 1, in de actuele voorinstelling 1, blijft 
CLI-flag ( --accum-steps N ).

E E N VO U D I G  G E Z E G D

Hoeveel beelden de app bekijkt 
voordat zij de splats aanpast. 1 
= elk beeld afzonderlijk. Hoger = 
meerdere beelden tegelijk bekij
ken en dan een gemiddelde toe
passen. Brengt in het standaard
geval niets; bij MCMC kan 2 een 
beetje helpen.
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T39 testViewIndices

D E TA I L S

Default: []  (= leeg, alle views worden voor trai
ning gebruikt) Range: Set<Int> , willekeurige deel
verzameling van de camera-indices Defined in:

T E C H N I S C H

V546-feature: set van camera-indices die NIET voor 
training worden gebruikt, maar als holdout voor 
PSNR/SSIM/LPIPS-analyse worden gespaard. Wordt 
automatisch ingesteld wanneer de --benchmark -
CLI-flag actief is: dan elke achtste view, beginnend 
bij index 0 (LLFF-standaard, identiek aan de Mip-
NeRF-360- en 3DGS-paper-conventies). Zonder 
benchmark leeg — de training gebruikt alle views. 
Voorzichtig: het handmatig instellen van dit veld 
zonder begrip van de indices kan de benchmark 
onbruikbaar maken (bijv. wanneer alle indices boven 
N worden gezet, terwijl er slechts N-50 views zijn 
→ geen holdouts → geen analyse). Bij eigen voorin
stelling-export wordt testViewIndices niet gepersis
teerd, omdat het scène-afhankelijk is en anders 
tussen verschillende datasets zinloze waarden zou 
achterlaten.

E E N VO U D I G  G E Z E G D

Welke beelden bij de training 
„uitgespaard“ worden om ze la
ter voor kwaliteitsmeting te ge
bruiken. Je stelt dat niet zelf in; 
de --benchmark -flag doet dat 
automatisch (elk achtste beeld is 
test). Wanneer je eigen indices 
instelt: gevaarlijk, kan de bench
mark vervalsen.
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T40 refinementPruneInterval

D E TA I L S

Default: 0 (= gedeactiveerd) Range: 0 of 100 – 
5.000 Defined in:

T E C H N I S C H

V425-feature: elke N iteraties tijdens de refinement-
fase (na T2 ) wordt een extra prune-pass laten 
lopen die Gaussians met sigmoid(opacity) < T41 
refinementPruneOpacityThreshold verwijdert. Doel: 
tijdens densification zijn er regelmatige density-
control-calls, daarna niet meer — Gaussians waar
van opacity verder zakt, blijven echter in de buffer. 
V425 testte en reverted: het extra pruning cor
releerde met V426 (two-phase densification, even
eens in 0-Gaussians-cascade-failure afgebroken). 
Disabled. CLI-flag beschikbaar voor experimenten; 
mocht geactiveerd, zijn 1.000 of 2.000 zinvolle 
waarden.

E E N VO U D I G  G E Z E G D

Extra opruimen tijdens de verfij
ningsfase. Brengt niets, blijft uit.

T41 refinementPruneOpacityThreshold

D E TA I L S

Default: 0,0 (= „gebruik T14 “) Range: 0 of 0,001 – 
0,1 Defined in:

T E C H N I S C H

V425b: aparte opacity-drempel voor refinement-pr
uning. Na densification hebben de meeste Gaussi
ans een duidelijk hogere opacity bereikt (> 0,001), 
zodat de standaard-T14 pruneOpacityThreshold te 
slap zou zijn. Wanneer T40  actief, bepaalt dit veld 
de eigen drempel. Bij 0,0 wordt T14  verder ge
bruikt. Alleen relevant wanneer T40 > 0.

E E N VO U D I G  G E Z E G D

Drempel voor het extra refine
ment-opruimen (zie T40). Beide 
velden niet actief, dus irrelevant.
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T42 midTrainingCompactificationIterations

D E TA I L S

Default: []  (= gedeactiveerd) Range: 
[Int] , waarden in (densifyUntilIteration, 
maxIterations) Defined in:

T E C H N I S C H

V549-feature: expliciete iteratie-punten tijdens 
de refinement-fase waarop een compactification-
pass loopt (verwijdert sigmoid(opacity) < 0,01 + 
outlier-scale-Gaussians, dezelfde logica als T56 
postTrainingCompactification). Doel: lange refi
nement-fasen kunnen confetti-/floater-accumulatie 
tonen waarvan SH dan op view-specifieke arte
facten overfit. Typische configuratie mocht ge
activeerd: [10000, 20000, 30000] voor 40K 
Classic. MAAR: V549-A/B-tests op family-data
set toonden in alle configuraties slechtere L1: 
[10K,20K,30K]@0.01  → −48% count maar +36% 

L1; [20K,30K]@0.005  → −44% count maar +45% 
L1; [20K,30K]@0.001  → −17% count maar +87% 
L1. Vandaar disabled. CLI-flag --mid-compact 
"10000,20000" beschikbaar mocht men de visuele 
floater-tradeoff (minder confetti in viewport) verkie
zen boven de loss-regressie.

E E N VO U D I G  G E Z E G D

Tussentijdse opruimacties tij
dens de training. In tests heeft 
het opruimen het eindresul
taat slechter gemaakt (weliswaar 
minder floaters, maar ook min
der detail). Uit, kan via CLI wor
den aangezet mocht floaters je 
meer storen dan een wat waziger 
beeld.
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T43 frustumCullEnabled

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V549b-feature: na training worden alle Gaussians 
verwijderd die buiten de vereniging van alle trai
nings-camera-frusta liggen. Zulke Gaussians wer
den nooit door het loss-signaal beperkt en zijn 
altijd floaters. Bijzonder effectief voor scènes waar
in de novel-view achter of naast het camerapad 
ligt (bijv. achterzijde van een lineaire dronevlucht) 
— de floaters daar worden in de trainingsfase 
nooit zichtbaar, bij later bewegen in de 3D-viewer 
echter wel. V549b A/B op dronevluchten positieve 
resultaten, vandaar als opt-in beschikbaar. Default 
false, omdat bij object-captures met volle orbit-
coverage de frustum-vereniging de hele scène om
vat en de feature niets verwijdert — wordt in 
instellingen onder „floater reduction“ geboden en 
ook in Q9 Outdoor-voorinstelling impliciet via T44 
frustumCullExpansion getest (Q7-BayesOpt heeft 
het echter niet geactiveerd, omdat outdoor-sky-do
me hetzelfde probleem beter oplost).

E E N VO U D I G  G E Z E G D

Speciaal-filter voor dronevluch
ten of lineaire opnames: na de 
training worden splats verwij
derd die in geen camera „gezien“ 
zijn. Optioneel inschakelbaar in 
de instellingen. Bij eenvoudige 
object-opnames overbodig.

T44 frustumCullExpansion

D E TA I L S

Default: 1,1 Range: 1,0 – 2,0 Defined in:

T E C H N I S C H

NDC-marge voor T43 frustumCullEnabled. 1,0 zou 
exact aan de beeldrand snijden, wat wankele splats 
aan de beeldrand te zeer zou kappen. 1,1 = 10% 
padding boven de exacte camera-framing uit — 
geeft wat tolerantie voor randpixels die in een licht 
verschoven novel-view toch zichtbaar zouden kun
nen worden. Waarden > 1,2 maken de cull praktisch 
onwerkzaam, omdat het uitgebreide frustum veel 
meer ruimte omvat.

E E N VO U D I G  G E Z E G D

Hoe streng het hierboven be
schreven filter inkort. 1,1 = een 
beetje veiligheidsafstand tot de 
beeldrand. Laat de waarde.
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Sky-Dome (T45–T48)

T45 skyDomeEnabled

D E TA I L S

Default: false (initializer + alle voorinstellingen be
halve P9 Outdoor) Range: boolean Defined in:

T E C H N I S C H

V549e-feature: vóór trainingstart wordt een bol
vormige puntenwolk gegenereerd (Fibonacci-sphere 
met T46  sample-points), in een radius van T47 
skyDomeRadiusMultiplier × scene_​extent om het 
scènecentrum geplaatst en met de kleuren uit de 
sky-gemaskeerde pixels van alle trainings-camera’s 
(zie T20 skyMaskingEnabled) geïnitialiseerd. Deze 
sky-dome-Gaussians worden aan het begin van de 
Gaussian-buffer ingevoegd en tijdens training „be
vroren“ (positie/scale/rotation-gradiënten = 0, alleen 
SH en opacity blijven optimaliseerbaar). Effect: in 
plaats van zwarte „confetti”-gebieden in de verte 
ziet de gebruiker in novel-views een echte hemel. 
V549e-MVP werkt op drone- en landschapsscènes 
zeer goed; in P9 Outdoor-voorinstelling default-on. 
Bij binnenscènes uit laten — de sphere zou zinloos 
buiten de ruimte hangen.

E E N VO U D I G  G E Z E G D

Schakelt een kunstmatige „he
melkoepel“ om de scène in. 
Maakt buitenopnames veel mooi
er: in plaats van zwarte klontjes 
aan de beeldrand toont de app 
de echte hemel. Verplicht voor 
dronevluchten en landschappen, 
zinloos voor binnenruimtes.
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T46 skyDomeSampleCount

D E TA I L S

Default: 5.000 Range: 1.000 – 50.000 (typisch 
2.000 – 10.000) Defined in:

T E C H N I S C H

Aantal Fibonacci-sphere-sample-punten op de sky-
dome-sphere. Hogere waarden → dichtere sky-do
me (beter bij grote resoluties en veel zichtbare he
mel), maar meer geheugengebruik. 5.000 is sweet 
spot voor 4K-renderings; bij lagere resoluties vol
staat 2.000–3.000. De punten worden op cosine-
distance tot elke training-camera-view-vector met 
de respectieve sky-gemaskeerde pixels geïnitiali
seerd — sample-points waarvan de view-cone geen 
camera ziet, blijven met lage opacity-initiële waarde 
achter, worden echter in de training niet gewijzigd 
(bevroren).

E E N VO U D I G  G E Z E G D

Hoe dicht de kunstmatige hemel 
is. 5.000 punten volstaan nor
maal. Meer = betere overgang 
vanuit de verte, maar kost wat 
geheugen.

T47 skyDomeRadiusMultiplier

D E TA I L S

Default: 30,0 (initializer + meeste voorinstellingen), 
59,0 (P9 Outdoor, Q7-BayesOpt-optimum) Range: 
5,0 – 200,0 Defined in:

T E C H N I S C H

Radius van de sky-dome-sphere relatief tot de 
scène-uitbreiding (= gemiddelde afstand tussen ca
meraposities). 30 = de bol heeft de 30-voudige 
diameter van de camera-wolk. Te klein (< 5) → sky-
dome interfereert met de scène zelf (bijv. een sky-
dome-splat landt in de voorgrond); te groot (> 100) 
→ float32-precisieverlies op de sky-dome-posities, 
wat render-glitches in de verte uitlokt. Q7-BayesOpt 
op Bicycle (Mip-NeRF 360) vond 59,0 als scènespe
cifiek optimum voor outdoor — dat duidt erop dat 
de standaard 30,0 voor diepe landschappen te klein 
is en de sky-dome-pixels in de beeldrandgebieden 
zichtbaar als „muur“ renderen.

E E N VO U D I G  G E Z E G D

Hoe ver weg de kunstmatige he
melkoepel moet zijn. 30 = be
hoorlijk ver. Bij grote landschap
pen is 50–60 beter (outdoor-
voorinstelling doet dat automa
tisch). Te klein zou zijn alsof men 
klontjes direct voor de lens had.
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T48 frozenGaussianCount

D E TA I L S

Default: 0 (= geen bevroren Gaussians) Range: 0 
of 1 – T46  Defined in:

T E C H N I S C H

Aantal Gaussians aan het begin van de buffer 
waarvan positie/scale/rotation-gradiënten in de op
timizer op nul worden gezet — ze blijven over 
de gehele training ruimtelijk star. Density-control 
mag ze niet klonen, splitsen of prunen. Gebruikt 
voor sky-dome-injection (zie T45 ): wanneer sky-
dome aan is, wordt dit veld automatisch op T46 
skyDomeSampleCount ingesteld. Handmatig instellen 
is mogelijk (bijv. om een vooraf geplaatste punten
wolk uit een LiDAR-scan te bevriezen), maar in de 
UI niet direct toegankelijk. Belangrijk: de eerste N 
Gaussians in de buffer zijn altijd de bevroren — 
de volgorde in de buffer beslist, niet een expliciete 
index.

E E N VO U D I G  G E Z E G D

Hoeveel splats aan het begin vast 
zijn en zich niet mogen bewegen. 
Wordt automatisch op het sky-
dome-aantal ingesteld, wanneer 
sky-dome aan is. Zelf draaien 
hoef je niet.

Adam + LR-schedule (T49–T55)

T49 adamResetIteration

D E TA I L S

Default: 0 (= gedeactiveerd) Range: 0 of 100 – De­
fined in:

T E C H N I S C H

V430-feature: iteratie waarop de Adam-optimizer-
momentum-accumulatoren (m1, m2) op nul worden 
teruggezet. Bias-correctie daarna loopt met (iter 
- adamResetIteration) in plaats van met iter . 
V430 testte reset bij 5.000 (na densification-einde) 
→ 12,8% slechtere loss. Reden: het Adam-momen
tum dat zich tijdens densification heeft opgebouwd, 
draagt informatie over de typische gradient-magni
tudes bij en versnelt de refinement-fase. Het weg
gooien kost de eerste ~500 iteraties refinement aan 
convergentie. Disabled. Blijft CLI-flag voor onder
zoeksexperimenten.

E E N VO U D I G  G E Z E G D

Reset-knop voor het inter
ne Adam-optimalisator-„geheu
gen“. Heeft in tests geschaad, 
blijft uit.
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T50 positionLRScheduleEndIteration

D E TA I L S

Default: 0 (initializer = „gebruik maxIterations“), 
20.000 ( .full  — cosine eindigt bij 20K ondanks 
maxIter=35K), 30.000 ( .fullClassicPaper ) Ran­
ge: 0 of 1.000 – Defined in:

T E C H N I S C H

V431-feature: iteratie waarop de cosine-annealing-
curve voor position-LR zijn minimum bereikt. Wan
neer 0, is dat identiek aan T1 maxIterations . 
Wanneer > 0, loopt de schedule tot deze waarde en 
blijft daarna bij T4 positionLearningRateFinal con
stant. Dat staat een „extended refinement phase“ 
met minimale maar constante leerratio toe — ver
fijnt posities langzaam zonder nieuw verval. .full  
doet dat (schedule-einde bij 20K, training loopt tot 
35K), V434c/V434d bevestigden: 15K en 25K beide 
ongeveer gelijk, 20K minimaal optimaal. Wordt in 
combinatie met T51  verder gebruikt om ook de 
niet-position-LR’s in de extended phase te wijzigen.

E E N VO U D I G  G E Z E G D

Wanneer de app stopt met de 
position-leerratio verder te verla
gen. Wanneer lager dan de maxi
male iteratie, loopt daarna met 
constante mini-ratio — dat ver
fijnt zeer langzaam maar zeer 
stabiel. In Quality-voorinstelling 
ingebouwd, hoef niet aan te 
draaien.

T51 extendedPhaseLRDecay

D E TA I L S

Default: 0,0 (= gedeactiveerd, constante LR’s) Ran­
ge: 0 of 0,01 – 1,0 Defined in:

T E C H N I S C H

V433-feature: minimale multiplicator voor de niet-
position-LR’s (scale, rotation, opacity, SH) in de 
„extended phase“ — d.w.z.: nadat T50  is bereikt en 
position-LR al bij T4  is. Wanneer 0,1, worden sca
le/rotation/opacity/SH op hun beurt cosine-decayed 
van 1,0 (= hun standaard-LR) naar 0,1× van hun 
standaard. Wanneer 0,0 (default), blijven ze con
stant. V457 testte volle verval (0,0 = decay-tot-nul) 
tegen geen-verval en vond: avg 0,0400 (2 runs) = 
zelfde loss als V438 zonder verval. Gedrag schoner 
met verval, maar niet meetbaar beter. Vandaar disa
bled. Blijft in de CLI als --nonpos-lr-scale F.

E E N VO U D I G  G E Z E G D

In de late verfijningsfase ook 
kleur- en vorm-leerratio’s kleiner 
maken. Maakt de training „sta
bieler“, maar empirisch niet be
ter. Uit.
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T52 adaptiveDensifyThreshold

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V440-experimenteel: wanneer true, berekent de 
app in elke densification-stap de p98 van de actue
le gradiëntverdeling en gebruikt het als dynamische 
drempel (geclampt op minstens 0,5× van de ge
configureerde waarde uit T11 , zodat het niet te 
veel uitwijkt). Hypothese: automatische aanpassing 
aan actuele scènefase zou density-control robuus
ter maken — bijv. aan het begin strenger pruning, 
later slapper, of omgekeerd. V440 testte en rever
tete: catastrofale drop tot 63 K Gaussians (mass-
pruning, omdat de p98 in de eerste iteraties ex
treem hoog is en dan vrijwel niets de drempel over
schrijdt). De vaste drempel is al goed gekalibreerd, 
dynamische aanpassing schaadt meer dan ze nut 
heeft. Q5 (T77) biedt een alternatieve adaptive-
logica via rolling median die het probleem omzeilt.

E E N VO U D I G  G E Z E G D

Adaptieve variant van de densi
fy-drempel. In tests catastrofaal 
(splat-aantal naar 63K gecrasht). 
Uit. Q5 heeft een betere variant 
daarvan.

T53 mergeAfterDensification

D E TA I L S

Default: false (initializer), true ( .full , 
.classicBalanced , .fullClassicPaper ) Range: 

boolean Defined in:

T E C H N I S C H

V438-feature: aan het einde van de densification-
fase (iter T2 ) wordt een eenmalige merge-pass uit
gevoerd die dicht bij elkaar liggende Gaussians met 
vergelijkbare scale en kleur samenvoegt. Reduceert 
het Gaussian-aantal met typisch 5–15% zonder 
zichtbaar kwaliteitsverlies. Doel: na intensief klonen 
ontstaan clusters van quasi-identieke Gaussians die 
niets nieuws bijdragen — het merging geeft optimi
zer-capaciteit voor andere gebieden vrij. Standaard 
in Classic-Quality-voorinstellingen. Bij MCMC niet 
gebruikt, omdat MCMC door zijn relocation-logica 
zulke clusters helemaal niet laat ontstaan.

E E N VO U D I G  G E Z E G D

Aan het einde van de splat-ver
menigvuldigingsfase klones die 
vrijwel identiek zijn, samenvat
ten. Reduceert datahoeveelheid 
zonder zichtbaar effect. Stan
daard in Quality-voorinstelling 
aan.
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T54 densifyPhase2FromIteration

D E TA I L S

Default: 0 (= gedeactiveerd) Range: 0 of T2  – T1  
Defined in:

T E C H N I S C H

V426-experimenteel: maakt een tweede densifica
tion-fase mogelijk die na de refinement-pauze bij 
deze iteratie start en tot T55  loopt. Hypothese: na 
een refinement-fase hebben de gradient-accumula
toren stabielere magnitudes en kunnen preciezer 
zeggen welke gebieden nog extra Gaussians nodig 
hebben. V426 testte en revertete: two-phase den
sification viel in 0-Gaussians-cascade-failure (met 
V425 refinement-pruning gecombineerd vernietigde 
het de buffer). Disabled. CLI-flag beschikbaar voor 
experimenten.

E E N VO U D I G  G E Z E G D

Tweede vermenigvuldigingsron
de na pauze. Heeft in tests het 
splat-bestand vernietigd. Uit.

T55 densifyPhase2UntilIteration

D E TA I L S

Default: 0 Range: 0 of T54  – T1  Defined in:

T E C H N I S C H

Einde van de V426-two-phase-densification. Alleen 
relevant wanneer T54 > 0 . Beide velden samen 
disabled.

E E N VO U D I G  G E Z E G D

Einde van de tweede vermenig
vuldigingsronde (zie T54). Beide 
uit.
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Post-processing + Apple AI (T56–T60)

T56 postTrainingCompactification

D E TA I L S

Default: true (in alle production-voorinstellingen), 
false ( .quickTest , .preview ) Range: boolean 
Defined in:

T E C H N I S C H

V443-feature: na trainingseinde worden Gaussi
ans met sigmoid(opacity) < 0,01 hard verwij
derd (ze dragen praktisch niet meer bij aan 
het beeld). Reduceert Gaussian-count met typisch 
58% en export-bestandsgrootte met 55% zon
der zichtbaar kwaliteitsverlies. Standaard in pro
duction-voorinstellingen actief — het eindresultaat 
moet zo compact mogelijk kunnen worden uit
geleverd. In .quickTest  uit, omdat een diagno
se-run sowieso niet wordt geëxporteerd. Anders 
dan T42 midTrainingCompactificationIterations 
(V549) vindt de compactification pas aan het einde 
plaats — refinement kan tot dan alle Gaussians ge
bruiken.

E E N VO U D I G  G E Z E G D

Opruimen na de training: bijna 
onzichtbare splats worden ver
wijderd. Maakt de exportbestand 
circa half zo groot zonder kwali
teitsverlies. Verplicht-feature, uit 
laten alleen in diagnose-runs.

T57 metalFXUpscaling

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V444-feature: activeert Apple’s MetalFX Spatial 
Upscaler in plaats van bilineaire interpolatie in 
de 3D-viewer-output. Wanneer trainingsresolutie < 
viewport-grootte (bijv. training op 0,5×, viewport-
weergave in volle resolutie), kan MetalFX een duide
lijk scherper beeld leveren. Verandert live in het 
viewport, geen retraining nodig. Sluit zich met T58 
mpsLanczosScaling uit — MetalFX heeft voorrang. 
Aanbeveling: inschakelen wanneer het beeld in de 
viewer „wazig“ oogt ten opzichte van het verwachte 
detail.

E E N VO U D I G  G E Z E G D

Apple-ML-gebaseerde beeldver
scherping in de 3D-viewer. Helpt 
wanneer je in een lagere resolu
tie hebt getraind en het resultaat 
in volledig beeld toont. Live-tog
gle, probeer uit.
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T58 mpsLanczosScaling

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V444-feature: MPSImageLanczosScale voor view
port-schaling in plaats van bilineaire interpolatie. 
Lanczos is een klassiek sinc-gebaseerd resampling-
procedé dat duidelijk scherpere resultaten dan bili
neair levert met minimale overhead. Live-toggle. 
Wordt door T57  overschreven wanneer beide aan.

E E N VO U D I G  G E Z E G D

Klassiek verscherpingsprocedé 
voor de 3D-viewer (Lanczos). Me
talFX (T57) is ML-gebaseerd en 
meestal beter; Lanczos is een 
minder agressief alternatief.

T59 livePreviewInterval

D E TA I L S

Default: 50 (initializer en meeste voorinstellingen) 
Range: 0 (off) of 10 – 5.000 Defined in:

T E C H N I S C H

Hoe vaak tijdens de training de 3D-viewer met de 
actuele Gaussians wordt geactualiseerd. 50 = elke 
50 iteraties een nieuwe render in de viewer — goed 
genoeg om de voortgang te observeren zonder de 
training te vertragen. 0 = viewer wordt helemaal 
niet geactualiseerd (achtergrond-training, max snel
heid). Typische aanpassing: bij .quickTest  omlaag 
naar 10 (men wil elke stap zien), bij lange MCMC-
runs hoog naar 500–2000 (update-overhead in to
taal merkbaar).

E E N VO U D I G  G E Z E G D

Hoe vaak het 3D-voorbeeld tij
dens de training wordt geactua
liseerd. 50 = elke 50 iteraties. 
Hoger = minder vaak = iets snel
ler, maar je ziet zeldzamer voort
gang. 0 = geen voorbeeld (voor 
maximale snelheid).
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T60 perceptualLossWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd) Range: 0 of 0,001 – 
0,5 Defined in:

T E C H N I S C H

V444-future-feature: gewicht van een perceptueel 
loss-term via MPSGraph (VGG-achtig klein net
werk). Zou structurele en texturele gelijkenis op een 
hoger semantisch niveau dan L1+SSIM erkennen — 
typisch in onderzoekspipelines waar „pixel-perfect“ 
minder belangrijk is dan „ziet er realistisch uit”. 
Implementatie nog uitstaand (code-stub aanwezig, 
maar forward-pass niet geïmplementeerd). Default 
0,0. Blijft in de veldcatalogus voor toekomstige acti
vering; CLI-flag --percep-weight F  gereserveerd.

E E N VO U D I G  G E Z E G D

Gepland feature dat met KI-
hulp „natuurlijk ogend“ beoogt 
in plaats van „pixelgenauw”. Nog 
niet klaar geïmplementeerd.

MCMC-densification (T61–T73)

T61 densificationStrategy

D E TA I L S

Default: .classic  (initializer + Classic-voorinstel
lingen), .mcmc  (alle MCMC-voorinstellingen + sce
ne-class) Range: .classic  of .mcmc  Defined in:

T E C H N I S C H

Kiest tussen Classic-densification (klon/split/prune, 
Kerbl et al. 2023) en MCMC-densification (Stochas
tic Gradient Langevin Dynamics met relocation, 
Kheradmand et al. NeurIPS 2024). Bij .classic  
worden T11–T16  geëvalueerd, bij .mcmc  de 
T62–T73 . Let op bij wissel: Classic defaults en 

MCMC defaults zijn totaal anders gekalibreerd — 
wie de picker in de Expert View flipt zonder een 
passende voorinstelling te laden, riskeert 1.4.3-bug-
style mass-extinction (460 K → 5 in één iteratie, 
omdat MCMC-OpacityReg op 0,01 de Classic-opa
cities killt). Vandaar de MCMC-init defaults opzette
lijk „weichgespoeld“ (alle reg-waarden 0,0).

E E N VO U D I G  G E Z E G D

Welk algoritme voor het ver
menigvuldigen van de splats 
wordt gebruikt. Classic = oor
spronkelijke methode (snel, veel 
splats). MCMC = nieuwere me
thode (langzamer, veel minder 
splats, daarvoor compacter). De 
voorinstellingen kiezen het juis
te. Zelf alleen omschakelen wan
neer je ook de passende voorin
stelling (P5–P7 of P8–P10) laadt.
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T62 mcmcMaxGaussians

D E TA I L S

Default: 150.000 (initializer + .fullMCMC  
+ .mcmcBalanced ), 100.000 ( .mcmcPreview ), 
1.500.000 ( .fullMCMCMip  — Mip-Splatting-variant 
met 10× budget), 1,19 M ( .renderPreset ), 1,25 M 
( .outdoorPreset ), 670 K ( .indoorPreset ) Ran­
ge: 0 (= „gebruik buffer-capaciteit“) of 10.000 – 
5.000.000 Defined in:

T E C H N I S C H

Harde bovengrens voor het aantal Gaussians bij 
MCMC-strategie. Het aantal groeit gestaag met 
T70 mcmcGrowthRate  (typisch 5%) per relocation-

stap tot dit cap. V473/V531 vonden 150 K als 
sweet spot — boven 200 K verdunt de splat-
kwaliteit (te veel kleine, redundante Gaussians), 
onder 100 K blijft de scène onder-gedensificeerd. 
Bij zeer grote scènes (bijv. 1.545-foto-dronevlucht 
met 158 K SfM-init) is 150 K te laag — vandaar 
de 1.4.5-uitbreiding T72 mcmcCapMultiplier + T73 
mcmcAutoScaleByScene. Q7-BayesOpt vond scène
specifieke optima tussen 670 K (Indoor) en 1,25 M 
(Outdoor). Bij waarde 0 gebruikt de engine de volle
dige buffer-capaciteit als cap.

E E N VO U D I G  G E Z E G D

Maximaal aantal splats bij MCMC. 
150.000 is de standaard en vol
staat voor de meeste scènes. 
Outdoor- en render-voorinstel
lingen (P8, P9) gaan naar 1+ mil
joen voor detail-rijkere scènes. 
Hoger zetten kan detail brengen, 
kost geheugen; lager is eerder 
een noodrem.
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T63 mcmcNoiseScale

D E TA I L S

Default: 0,00005 (5e-5 = paper-default) Range: 
1e-6 – 1e-3 Defined in:

T E C H N I S C H

Multiplicator voor de Gauss’sche ruis die in elke 
MCMC-iteratie aan de positie van elke Gaussian 
wordt toegevoegd (SGLD-logica). Hoger = meer ex
ploratie (Gaussians wandelen meer, vinden potenti
eel betere plekken), lager = meer exploitatie (Gaus
sians blijven waar ze al goed zijn). V467 en V536 
bevestigden 5e-5 als optimaal — 1e-5/2e-5 te wei
nig exploratie, 1e-4 te veel (splats lopen uiteen). 
Wordt over de trainingstijd cosine-decayed tot T69 
mcmcNoiseDecayEnd — aan het einde van het decay-
bereik is ruis effectief 0 en de Gaussians converge
ren.

E E N VO U D I G  G E Z E G D

Hoeveel willekeurig „wiebelen“ 
de app de splats toestaat, zodat 
ze zelf de beste plek vinden. 
Standaardwaarde is optimaal ge
test. Wanneer je dat omhoog 
draait, worden de splats onrus
tig.

T64 mcmcOpacityRegWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd in RadianceKit De
faults, paper: 0,01) Range: 0 of 0,001 – 0,05 Defi­
ned in:

T E C H N I S C H

MCMC-specifieke L1-penalty op opacity. Paper-de
fault 0,01 (drukt ongebruikte Gaussians tegen nul, 
maakt ze voor relocation beschikbaar). V464b toon
de echter: zonder reg is het in RadianceKit meet
baar beter (sessie 28 bevestigd). Reden: de met T68 
mcmcDeadOpacityThreshold gedefinieerde pruning-
criterium volstaat alleen — een extra L1-penalty 
dwingt ook waardevolle, lage-opacity-Gaussians te 
sterven. Vandaar default 0. Let op: in 1.4.3-beta-
build was de initializer-default ten onrechte 0,01, 
wat in de mass-extinction-bug resulteerde (zie T61-
uitleg); sinds 1.4.4 op 0,0 vastgezet.

E E N VO U D I G  G E Z E G D

MCMC-specialregularisatie. Uit, 
omdat het andere MCMC-mecha
nisme (drempel in T68) dat al af
dekt. Op 0 laten.
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T65 mcmcScaleRegWeight

D E TA I L S

Default: 0,0 (= gedeactiveerd, paper: 0,01) Range: 
0 of 0,001 – 0,05 Defined in:

T E C H N I S C H

MCMC-specifieke L1-penalty op de scale-eigen
waarden. Paper-default 0,01. V464b: zonder reg 
beter, zelfde motivering als T64. Disabled in alle Ra
dianceKit-MCMC-voorinstellingen. Let op zoals bij 
T64: 1.4.3-bug.

E E N VO U D I G  G E Z E G D

Zoals T64, maar voor splat-groot
te. Uit.

T66 mcmcRelocationInterval

D E TA I L S

Default: 100 (initializer + alle MCMC-voorinstellin
gen, paper-standaard), 155 (P9 Outdoor — Q7-Bay
esOpt-optimum) Range: 50 – 500 Defined in:

T E C H N I S C H

Iteratie-interval waarin MCMC dode Gaussians (sig
moid(opacity) < T68 mcmcDeadOpacityThreshold) 
naar nieuwe posities relociert. V537 testte 50 
(te disruptief, loss schommelt) en 200 (marginaal 
slechter, MCMC verliest reactievermogen). 100 is 
optimaal. Q7-BayesOpt op Bicycle vond 155 als 
scènespecifiek optimum voor outdoor — de iets 
langere intervallen geven Adam meer tijd, nieuw 
geplaatste Gaussians te integreren, voordat de vol
gende reloc-event ze onder druk zet.

E E N VO U D I G  G E Z E G D

Elke hoeveel iteraties MCMC de 
dode splats ergens anders heen 
verplaatst. 100 is standaard. Zelf 
aan draaien hoef je niet — Out
door-voorinstelling heeft al de 
optimale waarde.
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T67 mcmcWarmupIterations

D E TA I L S

Default: 500 Range: 100 – 5.000 Defined in:

T E C H N I S C H

Aantal initial-iteraties waarin nog geen MCMC-relo
cation plaatsvindt. Pas na deze warmup begint de 
reloc-logica. Doel: in de eerste iteraties zijn de opa
city-waarden nog niet ingeklemd — als direct met 
reloc gestart, zouden Gaussians op de verkeerde 
plekken geplaatst worden en moeten meteen weer 
worden bewogen, wat Adam-momentum vernietigt. 
Paper-default 500. RadianceKit neemt deze waarde 
over, omdat V464b toonde dat het robuust is.

E E N VO U D I G  G E Z E G D

Hoeveel iteraties MCMC eerst 
„mag aankomen“ voordat hij be
gint splats te verplaatsen. 500 is 
standaard en past.

T68 mcmcDeadOpacityThreshold

D E TA I L S

Default: 0,005 (initializer, paper-standaard), 0,01 
( .fullMCMC  en alle MCMC-voorinstellingen — 
V535-optimum) Range: 0,001 – 0,05 Defined in:

T E C H N I S C H

sigmoid(opacity)-drempel waaronder een Gaussian 
als „dood“ geldt en voor relocation in aanmerking 
komt. V535 vond 0,01 als optimaal (0,005 margi
naal, 0,02 slechter). Hoger = agressievere reloc 
(meer Gaussians worden bewogen), lager = voor
zichtiger. 0,01 komt ongeveer overeen met „0,5% 
visuele zichtbaarheid”. P10 Indoor gebruikt via Q7-
BayesOpt 0,0142 als optimum.

E E N VO U D I G  G E Z E G D

Vanaf welke doorzichtigheid een 
splat als „dood“ geldt, zodat 
MCMC hem ergens anders heen 
schuift. 0,01 is optimaal in onze 
tests. Zelf aan draaien hoef je 
niet.
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T69 mcmcNoiseDecayEnd

D E TA I L S

Default: 0 (initializer = „geen verval“), 160.000 
( .fullMCMC  = 80% van 200K), 96.000 
( .mcmcBalanced  = 80% van 120K), 40.000 
( .mcmcPreview ) Range: 0 of 1.000 – Defined in:

T E C H N I S C H

Iteratie waarop het T63 mcmcNoiseScale -ruis volle
dig op nul wordt gedempt (cosine-verval van iter 
0 tot hier). V497c/V502 vonden 80% van maxIterati
ons optimaal — geeft MCMC genoeg exploratie-tijd, 
maar laat de laatste 20% ter convergentie zonder 
ruis. 0 = constante ruis over alle iteraties (zelden 
zinvol, MCMC kan dan niet convergeren).

E E N VO U D I G  G E Z E G D

Wanneer het willekeurige „wie
belen“ van de splats ophoudt. 
In de MCMC-voorinstellingen bij 
80% van de totale iteraties — 
eerst exploratie, dan convergen
tie. Laat de waarde.

T70 mcmcGrowthRate

D E TA I L S

Default: 0,05 (paper-standaard = 5%) Range: 0,01 
– 0,2 Defined in:

T E C H N I S C H

Groeisnelheid van het MCMC-populatie-tar
get per relocation-stap. De logica: bij el
ke reloc-event wordt de doel-populatiegroot
te met (1 + growthRate)  verhoogd, tot T62 
mcmcMaxGaussians (of de per T72/​T73 geschaalde 
variant) is bereikt. V512/V522 vonden 0,05 als opti
maal — hogere waarden leiden tot te snelle groei 
(Gaussians worden ingevoegd voordat het Adam-
momentum ze kan integreren), lagere tot onder-ge
densificeerde scènes aan het einde.

E E N VO U D I G  G E Z E G D

Hoe snel het splat-aantal bij 
MCMC groeit. 5% per stap is opti
maal. Laat de waarde.
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T71 mcmcSigmoidK

D E TA I L S

Default: 100,0 Range: 10,0 – 500,0 Defined in:

T E C H N I S C H

Sigmoid-sharpness-parameter voor de MCMC-noi
se-attenuatie. In de SGLD-stap wordt de per-Gaus
sian-ruis gedempt — hoog-opake Gaussians (waar
van de logit positief is) krijgen exponentieel minder 
ruis dan laag-opake. K = 100 is scherp, d.w.z. de 
overgang van „vol-noise“ naar „geen-noise” gebeurt 
zeer snel rond opacity 0,5. V484–V487 vonden K 
= 100 optimaal — kleinere waarden (10–50) laten 
ook hoog-opake Gaussians mee-wiebelen (vernie
tigt geconvergeerde Gaussians), grotere (> 500) 
maken de overgang kunstmatig hard en dode Gaus
sians worden helemaal niet meer bewogen.

E E N VO U D I G  G E Z E G D

Specialeparameter die bepaalt 
hoe scherp MCMC tussen „door
zichtig genoeg om te verplaat
sen“ en „solide, niet aanraken” 
onderscheidt. Standaardwaarde 
is optimaal. Niet aan draaien.

T72 mcmcCapMultiplier

D E TA I L S

Default: 3,0 (initializer + .fullMCMC ), 2,0 
( .mcmcPreview ), 2,5 ( .mcmcBalanced ), 2,98 (P8 
Render), 5,32 (P9 Outdoor), 1,76 (P10 Indoor) Ran­
ge: 0 (= gedeactiveerd) of 1,0 – 10,0 Defined in:

T E C H N I S C H

1.4.5-feature: scène-adaptieve cap-schaling. Wan
neer T73 mcmcAutoScaleByScene true is, wordt 
het effectieve cap als berekend (geclampt aan 
buffer-capaciteit). Achtergrond: bij grote scènes 
(bijv. 1.545-foto-dronevlucht → 158 K SfM-init) is 
T62 = 150.000  te laag — density-control zou hele

maal niet kunnen groeien. Met multiplier 3,0 wordt 
de cap bij dit voorbeeld op 474 K geschaald (158 K 
× 3,0). Q7-BayesOpt vond scènespecifieke optima: 
Outdoor profiteert van hoge multiplier (5,32 → ~830 
K cap bij 156 K bicycle-init), Indoor stelt zich tevre
den met 1,76 (muren verzadigen sneller). Volledige 
resolutie van het cap zie -methode.

E E N VO U D I G  G E Z E G D

Multiplicator die de splat-cap au
tomatisch aan de scène-grootte 
aanpast. Grote scène = meer 
beginpunten = hoger cap. Stan
daard 3× past voor de mees
te scènes; Outdoor-voorinstel
ling gaat op 5× (grote dieptebe
reiken), Indoor op 1,76× (muren 
beperken sowieso).
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T73 mcmcAutoScaleByScene

D E TA I L S

Default: true (initializer + alle MCMC-voorinstellin
gen) Range: boolean Defined in:

T E C H N I S C H

1.4.5-feature: master-switch voor de scene-aware 
cap-logica (zie T72 +). Wanneer false, wordt uit
sluitend T62 mcmcMaxGaussians als cap gebruikt 
(terug naar 1.4.4-gedrag). Standaard aan, omdat 
de mass-extinction-problemen bij grote scènes uit 
1.4.3 anders terugkeren. Handmatig deactiveren al
leen wanneer je expliciet een hard cap wilt instellen 
— bijv. om een 150 K-variant te trainen waarvan de 
eindgrootte planbaar is.

E E N VO U D I G  G E Z E G D

Schakelt de automatische aan
passing van het splat-cap aan 
de scène-grootte aan. Standaard 
aan. Uit laten alleen wanneer je 
zelf precies een bepaald splat-
aantal wilt hebben.

Mip-Splatting (Q1.5) (T74–T76)

Status: Q1.5 werd op 2026-05-25 na 14 autonome iteraties + overnight-1,5M-
confidence-check als „closed no-win“ verworpen (max Δ@2× = +0,27 dB, originele 
gate eiste ≥ +1,5 dB gemiddelde over 0,5×/2×, FAILT op 0/11 pair-scenes). De vel
den blijven opt-in voor onderzoeksexperimenten; alle production-voorinstellingen 
hebben. Zie verdict: docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md.
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T74 useMipSplatting

D E TA I L S

Default: false (alle production-voorinstellingen), 
true ( .fullMCMCMip  — onderzoeks-sibling) Range: 
boolean Defined in:

T E C H N I S C H

Activeert Mip-Splatting (Yu et al. CVPR 2024): 3D-
smoothing-filter + 2D-filter + α-compensatie die de 
per-Gaussian-frequentie op de Nyquist-grens van 
de dichtste trainings-camera-sampling-snelheid be
grenst. Theoretisch doel: eliminatie van aliasing bij 
rendering in off-training-schalen (0,5× of 2× van de 
trainingsresolutie). In de preprocess- en backward-
projection-shaders geactiveerd, functioneel correct 
geverifieerd in Q1.5-D-test. Maar: de originele ac
ceptatie-gate (Δ@1× ≥ +0,3 dB EN avg(Δ@0,5×, 
Δ@2×) ≥ +1,5 dB) werd op geen van 11 pair-sce
nes bereikt. Maximaal waargenomen: family 750K 
classic Δ@2× = +0,270 dB. Outdoor-scènes (Truck, 
Flowers) toonden zelfs verslechtering 1× en 0,5×. 
Hypothese: 3D-smoothing concurreert met MCMC-
relocation bij high-Gs. Veld blijft voor toekomstige 
multi-scale-re-eval met correcte Mip-NeRF-360-
methodology (zie O3-backlog in benchmark-pad).

E E N VO U D I G  G E Z E G D

Aliasing-filter uit een 2024-pa
per. Theoretisch tof, praktisch 
heeft hij in onze tests niets ge
bracht en soms zelfs geschaad. 
Blijft beschikbaar voor experi
mentators, maar wij raden hem 
niet aan. Uit laten.

T75 mipSmoothing3DScale

D E TA I L S

Default: 0,2 (paper-default) Range: 0,05 – 1,0 De­
fined in:

T E C H N I S C H

3D-smoothing-scale-parameter (Yu et al. §3.3, pa
per-default 0,2). Groter = meer wereld-ruimte-glad
maak per Gaussian (= meer anti-aliasing, maar ook 
meer blur in de default-schaal), kleiner = scherper 
maar gevoeliger voor aliasing. Wordt alleen geraad
pleegd wanneer T74 useMipSplatting = true. In 
Q1.5-tests niet verder geoptimaliseerd — de A/B-
gate heeft al met paper-default 0,2 verloren, verde
re sweeps zouden zinloos zijn.

E E N VO U D I G  G E Z E G D

. Als je Mip niet hebt ingescha
keld, irrelevant.
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T76 mipFilter2DVariance

D E TA I L S

Default: 0,3 (= exact het V242-legacy-gedrag) 
Range: 0,1 – 1,0 Defined in:

T E C H N I S C H

2D-Mip-filter-variantie die aan de Σ_2D-diagonaal 
wordt toegevoegd (variantie direct, niet gekwadra
teerd). 0,3 is exact de V242-legacy-waarde die vóór 
Mip-Splatting hardgecodeerd in de kernel zat. Wan
neer T74 useMipSplatting = false, negeert de 
kernel deze waarde volledig en schrijft het hardge
codeerde 0,3 — zodat de baseline niet kan regrede
ren (Codex-round-1-S3-1-garantie). Wanneer, wordt 
de hier ingestelde waarde gebruikt. Blijft in de veld
catalogus voor Mip-sweeps.

E E N VO U D I G  G E Z E G D

Verdere Mip-Splatting-parame
ter. Bij Mip-uit: irrelevant.

Adaptive densification (Q5) (T77–T79)

T77 adaptiveDensification

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Q5-feature: rolling-median-tracker als alternatief 
voor de vaste T11 densifyGradThreshold. Wanneer 
true, wordt in elke densify-stap de actuele drem
pel met median(laatste N avgGrad-samples) × 
T79 adaptiveDensifyMultiplier overschreven. N = 
T78 adaptiveWindow . Strikter dan V440 p98 (de 

catastrofale 63 K-pruning-val), median + 2× zit 
ongeveer op het p70–p80 van de gradiëntverde
ling in steady state. Q5-tests: alleenstaand FAIL 
0/3 scènes, maar samen met Q6 (zie T80/T81) 
PASS 1/3 scènes — het bundel Q5+Q6 werd op 
2026-05-25 als opt-in gepasseerd en is via CLI 
--adaptive-densify  activeerbaar. Q6 is daarbij de 

„carrier“ van de kwaliteitswinst, Q5 draagt eerder bij 
aan stabiliteit.

E E N VO U D I G  G E Z E G D

Zelflerende densify-drempel. In 
plaats van een vast ingestelde 
gevoeligheid past de app zich 
aan de scène aan. Alleen getest 
niet beter, met het curriculum uit 
Q6 samen echter wel. Beide sa
men inschakelen of beide uit.
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T78 adaptiveWindow

D E TA I L S

Default: 1.000 Range: 100 – 10.000 Defined in:

T E C H N I S C H

Rolling-median-window in densification-events 
(NIET iteraties — elke T13 densifyInterval-stap le
vert een sample). Default 1.000 — bij betekent dat 
de laatste 100.000 trainingsiteraties bijdragen aan 
de median, dus typisch de gehele trainingshistorie 
tot hier. Vroege fase (vóór T78  samples): tracker 
returns nil → fallback naar vaste drempel T11 . Al
leen relevant wanneer.

E E N VO U D I G  G E Z E G D

Hoeveel oude densify-stappen 
in de median voor T77 invloei
en. Standaard 1000 is goed. Al
leen relevant wanneer Q5-adap
tive aan.

T79 adaptiveDensifyMultiplier

D E TA I L S

Default: 2,0 Range: 1,0 – 4,0 Defined in:

T E C H N I S C H

Multiplicator op de rolling-median voor de adaptieve 
drempel. Default 2,0 komt ongeveer overeen met 
p70–p80 van de typische gradiëntverdeling. Lager = 
agressievere groei (meer klones), hoger = strenger 
(minder klones). Q5-tests in range 1,5–3,0 — 2,0 
beste default. Alleen relevant wanneer.

E E N VO U D I G  G E Z E G D

Factor voor T77/T78. Standaard 
2,0 = strenger dan de typische 
median. Niet aan draaien.
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Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Q6-feature: trainings-resolutie start bij 0,5× en 
wisselt bij T50 positionLRScheduleEndIteration /​ 
2 (of T1 maxIterations /​ 2, mocht T50 
niet ingesteld) naar T22 trainingRenderScale. 
Gebruikt de in Q1.5.1 ontwikkelde resize/​
restoreImageBuffers-infrastructuur. Overschrijft 
T23 resolutionWarmupScale wanneer geactiveerd. 
Q6 is als „carrier van de kwaliteitswinst“ in het 
Q5+Q6-bundel gepasseerd (zie T77) — de stapsge
wijze resolutie-verhoging geeft de app tijd om grove 
geometrie op de lagere resolutie te vinden voordat 
hij naar de fijne detailarbeid overgaat. Via CLI: --
curriculum-resolution.

E E N VO U D I G  G E Z E G D

„Eerst grof, dan fijn“ voor de trai
ningsresolutie. Halve resolutie in 
de eerste helft, dan volle resolu
tie. Helpt in bepaalde scènes, in 
andere niet — het beste samen 
met T81 inschakelen.

T81 curriculumSHProgression

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Q6-feature: overschrijft 
T21 shDegreeUpgradeIterations met [maxIter/​4, 
maxIter/​2, maxIter*3/​4], verdeelt dus de SH-up
grades gelijkmatig over de trainingstijd in plaats 
van ze front-to-load. Hypothese: stabiele geometrie 
wordt vóór color-detail-explosie gevestigd, wat de 
view-direction-afhankelijke glans-effecten preciezer 
positioneert. Q5+Q6 samen PASS 1/3 scènes, Q6 
als carrier van de winst (Q5 alone FAIL). Via CLI: 
--curriculum-sh .

E E N VO U D I G  G E Z E G D

„Eerst vorm, dan kleur“ — de 
glans-effecten worden pas laat 
in de training vrijgegeven, zodat 
de splats eerst hun positie en 
grootte vinden. Met T80 samen 
inschakelbaar; alleen brengt het 
niet zoveel.

Statische voorinstellingen (TP1–TP9)

Hier alleen de structurele verschillen met de initializer-default. De volle marketing-
beschrijving van de elf UI-voorinstellingen P1–P11 vind je in hoofdstuk 7.
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TP1 .preview

D E TA I L S

Diagnose-/voorbeeld-voorinstelling voor systemen 
≥ 10 GB RAM. Overrides ten opzichte van initializer: 
- 30.000 → 5.000 - 15.000 → 3.500 (70% van maxI
ter) - 1.6e-6 → 1.6e-5 (10× hoger, minder agressief 
verval) -,,,, elk 2× (V176) - 3.000 → 100.000 (effec
tief uit, V172: reset vernietigt korte trainingen) - 
[1K, 2K, 3K]  → [1K, 2K]  (V182: degree 3 con

vergeert in 2K iter niet) - 1,0 → 0,5

E E N VO U D I G  G E Z E G D

elke willekeurige initial-beoorde
ling van een nieuw geïmporteer
de beeldreeks — 2–3 min wacht
tijd, vervolgens volstaat het re
sultaat voor een binaire vraag 
„loont quality-run?“.

TP2 .full

D E TA I L S

Production-Quality Classic. Overrides: - 30.000 → 
35.000 (V550: 40K-tests Truck-overtraining +10,7% 
Gs bij −1,3% L1) - 15.000 → 5.000 (V310 sweet 
spot, V338 7K worse) - Alle LR’s 2× (V188) - 
1.6e-6 → 1.6e-5 (V45 10×) - 2e-6 → 1.1e-6 (V335) 
- 100 → 200 (V112) - 0,005 → 0,001 (V393) - 
3.000 → 100.000 (V194 disabled, V421 confirmed) 
- [1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 delayed) 
- 0,0 → 0,9995 (V546 HTGS, 14% verbetering) - 
50 (ongewijzigd, V546) - false → true (V438) - 0 
→ 20.000 (V431) - true (V443, al initializer-default 
voor .full )

E E N VO U D I G  G E Z E G D

elke standaard-foto-opname (ob
ject, kleine ruimte, beeldhouw
werk) met < 500 beelden. De in 
V546 aangekondigde 14% loss-
verbetering ten opzichte van 
V438 werd 3-trial-gemiddeld op 
Horse Full bevestigd.

TP3 .fullClassicPaper

D E TA I L S

Q1.5-A-test-sibling van TP2, paper-getrouwe Clas
sic. Overrides ten opzichte van TP2: - 35.000 → 
30.000 (paper-standaard) - 5.000 → 15.000 (paper: 
50% van maxIter) - 1.6e-5 → 1.6e-6 (paper-default) 
-,, terug op paper defaults (0,05, 0,005, 0,001) - 
1.1e-6 → 2e-7 (gekalibreerd voor ~1-2M Gs op Bicy
cle) - 200 → 100 (paper) - 0,001 → 0,005 (paper-
default) - 100.000 → 3.000 (paper §5.2, risico — kan 
V194-regressie triggeren) - 0,9995 → 0,0 (paper 
heeft geen verval) - 20.000 → 30.000 (cosine loopt 
op 100% van maxIter)

E E N VO U D I G  G E Z E G D

Q1.5-onderzoeksexperimenten 
die paper-magnitude-Gaussian-
budgetten (1–2 M) voor Mip-
Splatting-tests nodig hebben. 
Na Q1.5-„closed no-win“-verdict 
blijft de voorinstelling voor ad
vanced users toegankelijk, maar 
is niet productie-aanbevolen.
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TP4 .fullMCMC

D E TA I L S

Production-Quality MCMC. Overrides ten opzichte 
van initializer: - 30.000 → 200.000 (V534, MCMC 
heeft 5× meer iter dan Classic nodig) - 15.000 
→ 160.000 (V504b 80% van maxIter) - 1.6e-6 → 
1.6e-5 - LR-schedule zoals TP2 (alle 2×) - 0,2 
→ 0,05 (V521b/V534: MCMC heeft sterker L1-sig
naal nodig) - [1K, 2K, 3K]  → [2K, 5K, 8K]  - 
.classic  → .mcmc  - 150.000 (in initializer al, 

in voorinstelling bevestigd) - 5e-5 (V467/V536 opti
maal) - 0,005 → 0,01 (V535 optimaal) - 0 → 160.000 
(80% van maxIter, V497c/V502) - 3,0 (in initializer 
al) - true (in initializer al) - 3.000 → 200.000 (effec
tief uit, MCMC gebruikt reloc in plaats van reset)

E E N VO U D I G  G E Z E G D

web-uitlevering, object-captures 
met detail-eisen, dronevluchten 
(ook al is dan P9 Outdoor nog be
ter). 71% minder Gaussians dan 
Classic bij vergelijkbare L1.

TP5 .fullMCMCMip

D E TA I L S

Q1.5-D-test-sibling van TP4, met Mip-Splatting + 
paper-magnitude-MCMC-budget. Overrides ten op
zichte van TP4:
• mcmcMaxGaussians 150.000 → 1.500.000 (10×, 

paper-magnitude)
• useMipSplatting false → true (Mip-on)

E E N VO U D I G  G E Z E G D

Alle andere velden identiek aan 
TP4. Q1.5 D-PASS op Bicycle 
2026-05-24 (breekt 12-iter-mul
ti-scale-FAIL-streak). Q1.5-eind
uitspraak 2026-05-25 toch clo
sed-no-win — Mip-Splatting-
winst niet reproduceerbaar over 
11 pair-scenes. Voorinstelling 
blijft opt-in.

TP6 .classicBalanced

D E TA I L S

Mid-Tier Classic. Overrides ten opzichte van TP2: - 
35.000 → 20.000 (V149: 20K = 30K bij 33% minder 
tijd) - 20.000 → 0 (cosine loopt op maxIter = 20K, 
geen extended phase)

E E N VO U D I G  G E Z E G D

Standaardgevallen met kortere 
wachttijd. V149 als sweet spot 
geïdentificeerd.
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TP7 .mcmcPreview

D E TA I L S

MCMC-diagnose. Overrides ten opzichte van TP4: 
- 200.000 → 60.000 (V494b) - 160.000 → 48.000 
(80%) - 150.000 → 100.000 (V473b) - 160.000 → 
40.000 (V494b) - 3,0 → 2,0 (1.4.5: preview = lighter 
scaling)

E E N VO U D I G  G E Z E G D

snel een MCMC-resultaat zien om 
te beoordelen of TP4 of een sce
ne-class-voorinstelling loont.

TP8 .mcmcBalanced

D E TA I L S

Mid-Tier MCMC. Overrides ten opzichte van TP4: 
- 200.000 → 120.000 (V518) - 160.000 → 96.000 
(80%) - 160.000 → 96.000 (80%) - 3,0 → 2,5 (tus
sen Preview 2,0 en Full 3,0)

E E N VO U D I G  G E Z E G D

MCMC zonder de volle 200K-run. 
~120 K iteraties is een goed 
compromis tussen kwaliteit en 
wachttijd.

TP9 .quickTest

D E TA I L S

Pure functietest. Overrides ten opzichte van initiali
zer: - 30.000 → 1.000 - 15.000 → 500 - 2e-6 → 
4e-6 (gekalibreerd voor 0,25× resolutie) - 100 → 50 
- 3.000 → 100.000 (uit, omdat veel te kort) - 1,0 → 
0,25

E E N VO U D I G  G E Z E G D

Sanity-check „start de training 
überhaupt zinvol?“. Duur < 30 
s op M3 Ultra. Ziet er gegaran
deerd wazig uit.

Methode:

Signature: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Defined in:

 Enige source-of-truth voor de vraag „hoeveel Gaussians mag MCMC maximaal laten 

groeien?“. Berekent zich uit drie invoeren: de geconfigureerde T62 mcmcMaxGaussians 
(met mass-extinction-floor 150.000, mocht 0), de (aantal SfM-init-punten) en de (voor
af gealloceerde Gaussian-buffer-grootte). Logica:

1. base = T62 > 0 ? T62: 150_​000 (de mass-extinction-floor beschermt tegen initia
lizer-default-bugs zoals het 1.4.3-mass-extinction-incident)

2. Mocht T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) anders

3. Mocht bufferCapacity > 0 : return min(scaled, bufferCapacity)
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4. Anders return scaled

Voorbeeld: Bicycle (Mip-NeRF 360, 194 fotoframes) → SfM-init ~156 K punten, 
T62 = 150.000 , T72 = 5,32 ,, buffer-capaciteit 8 M. Resolved cap = min(8M, 
max(150K, ceil(156K × 5.32))) = min(8M, 830K) = 830 K. Dat is het effectieve groei-
cap waaraan de MCMC-relocation-logica zich houdt.

EENVOUDIG GEZEGD  Berekent het werkelijke maximale splat-aantal bij MCMC. Neemt 
je instelling, kijkt hoeveel punten je scène in het begin heeft, en schaalt met de 
multiplier , mocht de automatische aanpassing aan zijn. Zo past de cap zich aan de 

scène aan in plaats van voor een kleine en een gigantische scène dezelfde waarde af te 
dwingen. Je hoeft de methode niet zelf aan te roepen — de training gebruikt hem intern.

Welk veld waarvoor? (cheatsheet)

Doel Velden om aan te draaien

Meer detail in de 
verte

T62 mcmcMaxGaussians hoog, T72 mcmcCapMultiplier 5+

Meer detail alge
meen (Classic)

T1 maxIterations  hoog (≤ 40K), T2 densifyUntilIteration ≤ 
14% van T1

Floaters in dron
evluchten reduce

ren

T43 frustumCullEnabled aan, T20 skyMaskingEnabled aan, 
T45 skyDomeEnabled  aan

Mooi hemel in bui
tenscènes

T45 skyDomeEnabled  aan, T47 skyDomeRadiusMultiplier 30–
60

Kleiner exportbe
stand

Strategie .mcmc  (T61), T56 postTrainingCompactification aan, 
T62 mcmcMaxGaussians ≤ 200K

Snellere training T22 trainingRenderScale 0,5, T1 maxIterations  halveren — 
maar niet beide!

Betere glanslichten T21 shDegreeUpgradeIterations met [2K, 5K, 8K]  (geen ear
ly-front-load), MCMC + 200K iter

Mac responsief 
houden

T25 throttleDelayMs 5–10 (kost ~15% trainingstijd)

Live-voorbeeld va
ker

T59 livePreviewInterval omlaag naar 10–20

Zachtere overgan
gen bij schaduwen

T17 ssimWeight  wat hoger (0,15–0,25), maar niet boven 0,3

Binnenruimtes 
compact houden

P10 Indoor-voorinstelling (, T72 = 1,76 )
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Gevaarlijke velden

Deze velden kunnen bij verkeerde configuratie tot OOM, app-crash, mass-extinction 
van de Gaussians of onbruikbare benchmark-data leiden. Met voorzichtigheid behande
len:

• T11 densifyGradThreshold — een halvering kan 2–4× zoveel Gaussians genereren, 
wat snel het GPU-geheugen doet barsten. Ook te letten op: moet bij de T22 
trainingRenderScale passen (1,0× → 1e-6, 0,5× → 2e-6, 0,25× → 4e-6).

• T72 mcmcCapMultiplier — bij grote scènes met > 200 K SfM-init-punten en multiplier 
> 5 ontstaat een resolved-cap van miljoenen Gaussians. Op 36-GB-RAM-Macs OOM 
mogelijk. Outdoor-voorinstelling 5,32 werkt alleen omdat Mip-NeRF-360-Bicycle 156 
K init-punten heeft → 830 K cap.

• T39 testViewIndices — handmatig instellen kan de benchmark onbruikbaar maken 
(alle indices > N → geen holdouts). Laat de --benchmark -flag dat instellen.

• T64 mcmcOpacityRegWeight en T65 mcmcScaleRegWeight — In 1.4.3-beta op 0,01 inge
steld, wat tot mass-extinction leidde (460 K → 5 Gaussians in één iteratie). Sinds 
1.4.4 op 0,0 vastgezet, maar handmatig verhogen kan het probleem reproduceren.

• T15 opacityResetInterval — wanneer niet 100.000+ (effectief uit) en de training 
korter dan 10.000 iteraties is, vernietigt de reset de convergentie. .preview  heeft 
het daarom op 100.000 ondanks maxIterations = 5.000.

• T54/​T55 densifyPhase2* — two-phase densification is in tests in 0-Gaussians-casca
de afgebroken. Laat beide op 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, kan op sommige outdoor-
scènes zelfs PSNR verslechteren. Default off, opt-in alleen voor onderzoek.

Mocht een veld op deze lijst staan en je wilt het wijzigen, maak vooraf een back-up van 
je actuele voorinstelling (export als JSON) en overweeg of je het resultaat reproduceer
baar kunt meten — anders weet je achteraf niet of je een verbetering of verslechtering 
hebt teweeggebracht.
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H O O F D S T U K

Hoofdstuk 7 — Ingebouwde 
kwaliteitsvoorinstellingen

Afbeelding 27:  Voorinstellingen-sectie met alle vier groepen uitgeklapt — CAPTURE CLASS 
(4 voorinstellingen: Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo/
Object), CLASSIC (5 voorinstellingen: Quick/Preview/Balanced/Quality/Ultra Detail), MCMC 
(3 voorinstellingen, opmerking „No threshold tuning“), HYBRID (1 voorinstelling: Balanced 

(Hybrid))

WAT DE AFBEELDING TOONT  Voorinstellingen-sectie in de Inspector, alle vier groepen uit
geklapt. CAPTURE CLASS met de vier gecureerde real-world-voorinstellingen (Drone / 
Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo / Object) — dat is de 
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primaire groep en in de beginnersmodus de enige zichtbare. CLASSIC met Quick (1K 
iters), Preview (5K iters, actieve selectie met blauw vinkje), Balanced (20K iters), Quali
ty (35K iters) en Ultra Detail (35K iters). MCMC met ondertitel „No threshold tuning“ — 
MCMC heeft geen densify-until-threshold nodig: Preview (60K iters, 100K Gaussians), 
Balanced (120K, 150K), Quality (200K, 150K). HYBRID met de Balanced (Hybrid) (20K 
iters, 150K Gaussians). Footer-action-row: Save…, Export…, Import…

Een voorinstelling is een voorbereide configuratie voor de training. RadianceKit levert 
dertien ingebouwde voorinstellingen in vier groepen: vier Capture-Class-voorinstellin
gen (P9–P12) — gecureerde, op echt community-materiaal met het oog gevalideerde 
recepten voor reële opname-soorten (drone, 360°-rondgang, foto-object) en de primai
re as sinds v1.6 —, vijf Classic-voorinstellingen (P1–P5: Quick/Preview/Balanced/Quality/
Ultra Detail), drie MCMC-voorinstellingen (P6–P8) en één Hybride-voorinstelling (P13), 
die de Classic- en MCMC-strategieën combineert. De vroegere „Scene-Class“-voorin
stellingen (Render/3D, Outdoor, Indoor, in fase Q7 academisch tegen Mip-NeRF-360- 
en NeRF-Blender-scènes getuned) zijn in v1.6 als zichtbare groep teruggetrokken — de 
met het oog op echt footage gevalideerde Capture-Class is nu de primaire as; de Q7-
getunede configuraties blijven alleen nog intern behouden. Je kiest de voorinstellingen 
in de zijbalk in het gedeelte Voorinstellingen of in de beginnersmodus bij de import. 
De + -knoppen openen dialogen om ernaast eigen voorinstellingen aan te maken — de 
dertien ingebouwde laten zich niet verwijderen, maar wel dupliceren.

In de Expert View verschijnen de voorinstellingen gegroepeerd op opname-soort en 
strategie (Capture Class / Classic / MCMC / Hybride). Een klik op een item schrijft de 
opgeslagen trainingsconfiguratie naar de huidige toestand. Dat is geen snapshot — als 
je daarna aan schuifregelaars draait, verandert de toestand, maar de voorinstelling zelf 
blijft ongewijzigd; een gekleurde markering toont dan „modified“.

Welke voorinstelling wanneer de juiste is, hangt vooral af van scènetype en hardware. 
De drie tabellen aan het einde van het hoofdstuk vatten dat samen.

168 / 230



R A D I A N C E K I T Hoofdstuk 7 — Ingebouwde kwaliteitsvoorinstellingen

P1 — Quick

WA A R

Inspector → Voorinstellingen-sectie → Groep „Clas
sic“ → Item „Quick”. UUID-suffix …001 .

T E C H N I S C H

Diagnose-voorinstelling met 1.000 iteraties, klassie
ke (adaptieve) densification-strategie en een trai
nings-resolutieschaal van 0,25× (invoerbeeld wordt 
vóór de training tot 25% verkleind). Niet bedoeld 
voor het uitleveren van een scène, maar om snel 
vast te stellen of de setup (cameraposes, punten
wolk, beeldreeks) überhaupt zinvolle beweging in 
de losswaarden laat zien. Op een M3 Ultra typisch 
onder de 30 seconden op 50–200 beelden. De 
kleine resolutie verhult echte beeldkwaliteit, maar 
houdt geheugengebruik en renderkosten zeer laag. 
Wordt ook automatisch als standaard gekozen bij de 
eerste start, als het systeem minder dan 10 GB RAM 
heeft.

E E N VO U D I G  G E Z E G D

Snelle functietest. Beelden erin, 
een krappe halve minuut wach
ten, kijken of de ruwe omtrek 
van de scène verschijnt. Als het 
beeld in de viewer eruitziet als 
een wazige vlek — klopt, dat 
hoort zo. Zie je daarentegen al
leen donkere stippen of een to
taal vervormde vorm, dan zijn 
waarschijnlijk de cameraposes 
verkeerd (zie hoofdstuk 9). Voor 
een toonbaar resultaat heb je 
daarna minstens P2 of P3 nodig.

P2 — Preview (Classic)

WA A R

Inspector → Voorinstellingen-sectie → Groep „Clas
sic“ → Item „Preview”. UUID-suffix …002 .

T E C H N I S C H

5.000 iteraties Classic-densification, 0,5× resolu
tieschaal, dubbele leerratio’s ten opzichte van de 
standaard. Densification (klonen + splitsen) is gedu
rende de eerste 2.500 iteraties actief, daarna alleen 
nog pruning. Standaardvoorinstelling voor systemen 
met ≥ 10 GB RAM. Op een M3 Ultra typisch 90 
seconden tot 3 minuten voor een 200-beeldsscène. 
Levert een bruikbare indruk van de geometrie en de 
camera-pose, maar texturen zijn zichtbaar zachter 
— de 0,5× render-resolutie kan daarna niet direct 
worden omzeild door opnieuw te trainen met P3 of 
P4, omdat de leerratio’s passend bij de halve reso
lutie zijn gekalibreerd.

E E N VO U D I G  G E Z E G D

De standaard voor „even snel be
kijken“. Als je net nieuwe beelden 
hebt geïmporteerd en wilt zien of 
de scène überhaupt reconstru
eerbaar is, is dat de juiste stap. 
Ongeveer 2–3 minuten wachttijd, 
daarna kun je in de 3D-viewer 
roteren en beoordelen of de aan
schaf van verdere trainingsruns 
zinvol is. Pas wanneer het voor
beeldresultaat al goed eruitziet, 
loont Balanced of Quality.
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P3 — Balanced (Classic)

WA A R

Inspector → Voorinstellingen-sectie → Groep „Clas
sic“ → Item „Balanced”. UUID-suffix …005 .

T E C H N I S C H

20.000 iteraties Classic-densification op volle 
beeldresolutie. Densification loopt over de eerste 
15.000 iteraties, vanaf iter 3.000 met een densify-
interval van 100. Empirisch de „sweet spot“ uit 
de gedocumenteerde trainingssessies: bij klassieke 
densification op Horse Full en Truck stabiliseert 
de L1-loss zich tussen iter 18.000 en 22.000, een 
langere training brengt onder Quality (P4) geen sig
nificante verbetering meer. Op een M3 Ultra typisch 
30–60 seconden op 200 beelden, 5–8 minuten op 
1.000+ beelden.

E E N VO U D I G  G E Z E G D

Het „goede compromis“. De 
meeste scènes zien er hiermee al 
goed uit, zonder dat je een uur 
hoeft te wachten. Als je het eind
resultaat ergens wilt tonen (soci
ale media, website, een klantde
mo), is dat vaak voldoende. Pas 
wanneer je in het splat-model 
wilt inzoomen of details van de 
oppervlaktetextuur nodig hebt, 
loont de sprong naar P4 Quality 
of P7 MCMC.

P4 — Quality (Classic)

WA A R

Inspector → Voorinstellingen-sectie → Groep „Clas
sic“ → Item „Quality”. UUID-suffix …003 .

T E C H N I S C H

35.000 iteraties Classic-densification met V546-
„Opacity Decay“ (HTGS, Eurographics 2025): na 
elke densify-cyclus vermenigvuldigt de opacity van 
alle bestaande Gaussians zich met een factor < 
1,0, wat inactief geworden Gaussians bij het pr
uning betrouwbaar verwijdert en daarmee bij iden
tiek iter-aantal 14% betere L1-loss dan de klas
sieke 35.000-run bereikt. SSIM-loss is geactiveerd 
( ssimWeight=0.05 ). Op een M3 Ultra typisch 2–4 
minuten op 200 beelden. Levert op NeRF-Blender 
(Lego, Chair, Drums) finale L1 ≈ 0,023 — beste 
Classic-variant in de 560+ gedocumenteerde expe
rimenten. Let op: heeft ~3–5 GB GPU-geheugen 
nodig; op 8 GB-systemen is P3 de veilige keuze.

E E N VO U D I G  G E Z E G D

De beste klassieke variant. Le
vert scherpe textuur en fijne 
geometrie, vooral op objectop
names (een beeldhouwwerk, een 
stoel, een vaas). Bij grote out
door-scènes of ruimtes merk 
je daarentegen nauwelijks nog 
een verschil met Balanced — 
daar loont de overstap naar een 
MCMC-voorinstelling (P6–P8) of 
een Capture-Class-voorinstelling 
(P9–P12) meer dan de sprong van 
P3 naar P4. Wie het absolute 
maximum van de Classic-familie 
wil, neemt P5 Ultra Detail.
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P5 — Ultra Detail (Classic)

WA A R

Inspector → Voorinstellingen-sectie → Groep „Clas
sic“ → Item „Ultra Detail”. UUID-suffix …008 .

T E C H N I S C H

Rond 35.000 iteraties Classic-densification — de 
winnaar van de held-out-run van de Quality-Matrix 
(2026-06-10). Op alle drie geteste Mip-NeRF-360-
scènes verslaat Ultra Detail de ingebouwde MCMC-
„Quality“-voorinstelling (P8) bij vergelijkbare wall-
clock-tijd met circa +0,94 dB PSNR. Daarmee is het 
de sterkste Quality-voorinstelling van de Classic-
groep en de scherpste Classic-variant die Radian
ceKit uitlevert. Op een M3 Ultra typisch in hetzelfde 
tijdsbestek als P4 Quality (2–5 minuten op 200 
beelden), maar heeft iets meer GPU-geheugen no
dig; op 8 GB-systemen blijft P3 de veilige keuze.

E E N VO U D I G  G E Z E G D

De scherpste Classic-trap en de 
held-out-winnaar van onze kwali
teitstests: op reële scènes circa 
een decibel beter dan de MCMC-
„Quality“-variant — bij vergelijk
bare wachttijd. Als je maxima
le detailgetrouwheid met de be
proefde klassieke densification 
wilt en genoeg GPU-geheugen 
hebt, is dat de eerste keuze. Vol
staat het geheugen niet of heb je 
een zo klein mogelijk exportbe
stand nodig, blijf dan bij P4 Qua
lity of een MCMC-voorinstelling.

P6 — Preview (MCMC)

WA A R

Inspector → Voorinstellingen-sectie → Groep 
„MCMC“ → Item „Preview”. UUID-suffix …006 .

T E C H N I S C H

60.000 iteraties MCMC-densification (3DGS-
MCMC, NeurIPS 2024) met een cap van 100.000 
Gaussians. MCMC vervangt de heuristische clone/
split-logica door Markov-Chain-Monte-Carlo-relo
catie: dode Gaussians worden via sigmoid-gewogen 
sampling-diepten opnieuw geplaatst, wat een ge
controleerd en reproduceerbaar aantal Gaussians 
oplevert. De cap dekt het maximale aantal hard bij 
100K — dat spaart geheugen en rendertijd, maar 
kost detail. Op een M3 Ultra typisch 5–8 minuten 
op 200 beelden. Geschikt als „MCMC-functietest“ 
— helpt te beoordelen of een overstap van Classic 
naar MCMC zinvol is, voordat je in P7 of P8 meer tijd 
investeert.

E E N VO U D I G  G E Z E G D

Zoals P2 Preview, maar met de 
nieuwere MCMC-methode. Levert 
vaak iets compactere, gelijkmati
ger verdeelde splat-wolken dan 
de Classic-variant. Voor een eer
ste bekijking van een scène vol
staan de 5–8 minuten meestal. 
Als het voorbeeldresultaat je be
valt, is de volgende stap P7 
(Balanced) of direct P8 (Quality 
MCMC).
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P7 — Balanced (MCMC)

WA A R

Inspector → Voorinstellingen-sectie → Groep 
„MCMC“ → Item „Balanced”. UUID-suffix …007 .

T E C H N I S C H

120.000 iteraties MCMC met een cap van 150.000 
Gaussians. De middelste MCMC-trap — bijna het 
finale Gaussian-aantal van P8 Quality, maar slechts 
60% van de iteraties. Empirisch ligt de L1-loss in de 
gedocumenteerde trainingssessies bij 0,026–0,028 
op Horse Full, tegenover P8 met 0,0246 — dus 
circa 7% hoger, maar wel halve wachttijd. Op een 
M3 Ultra typisch 8–15 minuten op 200 beelden. Ge
bruikt een methode die de effectieve Gaussian-cap 
schaalt op de puntendichtheid van de invoer-SfM-
puntenwolk (zie T75 in hoofdstuk 6).

E E N VO U D I G  G E Z E G D

MCMC met behoorlijke detail
diepte, maar zonder de lange vol
ledige run van P8. Voor de mees
te scènes volstaat dat, vooral 
als je een MCMC-run in het 
tijdsbestek van een lunchpauze 
wilt proppen. Als geheugen krap 
is (bijvoorbeeld op M-processors 
met slechts 16 GB), blijf hier 
— P8 heeft meer GPU-geheugen 
nodig.

P8 — Quality (MCMC)

WA A R

Inspector → Voorinstellingen-sectie → Groep 
„MCMC“ → Item „Quality”. UUID-suffix …004 .

T E C H N I S C H

200.000 iteraties MCMC met een cap van 150.000 
Gaussians, SSIM-loss 0,05, MCMC-noise-decay 
over 80% van de iteraties. Best-single-run-L1 in de 
560+ experimenten: 0,0238 op Horse Full, gemid
deld over 3 trials 0,0246 (tegenover P4 0,0230 op 
dezelfde scène). MCMC levert daarbij 71% minder 
Gaussians (150K vs ~524K) — doorslaggevend als 
je het resultaat op het web wilt uitleveren, omdat 
de kleinere wolk duidelijk kleinere exportbestanden 
produceert. Trainingstijd op een M3 Ultra typisch 
20–35 minuten op 200 beelden; op 1.000+ beel
den-sets eerder 1–2 uur. Beste keuze als maximale 
beeldkwaliteit bij minimale eindgrootte gewenst is.

E E N VO U D I G  G E Z E G D

De beste MCMC-variant. Levert 
zeer schone, compacte splat-
wolken — ideaal als je het resul
taat later als web-3D-viewer wilt 
insluiten of als bestand wilt ver
sturen (het bestand is kleiner 
dan bij P4 Quality bij vergelijk
bare optische kwaliteit). Heeft 
daarvoor wel geduld nodig — op 
grote opnames meer dan een 
uur wachttijd. Plan dat eerder als 
„nachtelijke-snit“-run.
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Afbeelding 28:  CAPTURE CLASS-groep uitgeklapt met alle vier gecureerde real-world-
voorinstellingen — Drone / Aerial (MCMC, 40K iters, Cap 1,5 M), 360° Walkaround (MCMC, 

40K, Cap 1,5 M), 360° Walkaround (High Detail) (Hybride, 40K, Cap 1,5 M, opt-in) en Photo / 
Object (Hybride, 40K, Cap 1,5 M). Deze groep staat helemaal bovenaan en is in de begin­

nersmodus de enige zichtbare.

WAT DE AFBEELDING TOONT  Inspector met de CAPTURE CLASS-groep uitgeklapt — de 
primaire voorinstellings-groep sinds v1.6, in de beginnersmodus de enige getoonde. 
Elk item is een op echt community-materiaal met het oog gevalideerd recept voor 
een concrete opname-soort (drone, 360°-rondgang, foto-object), niet een tegen een 
academisch testset geoptimaliseerde waarde. Selectie per klik schrijft de opgeslagen 
trainingsconfiguratie naar de huidige toestand.
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P9 — Drone / Aerial

WA A R

Inspector → Voorinstellingen-sectie → Groep „Cap
ture Class“ → Item „Drone / Aerial”. UUID-suffix 
…010 .

T E C H N I S C H

Capture-Class-voorinstelling voor lucht- en drone-
orbits van gebouwen en landschappen. MCMC-den
sifier, 40.000 iteraties, cap 1,5 mln. Gaussians, 
SSIM-loss 0,5 plus edge-aware-term 0,1. Doorslag
gevend is de anisotropie-penalty met gewicht 0,003 
bij een ratio-drempel van 6 — de „spaghetti-killer“ 
tegen de typisch naaldvormige artefacten die dro
nefootage produceert. Gevalideerd op een echte 
DJI-4K-dronevlucht over het Pensford-viaduct (met 
het oog gecontroleerd, niet alleen metrisch).

E E N VO U D I G  G E Z E G D

Voor opnames vanuit de lucht — 
dronevluchten om een gebouw, 
over een landschap, langs een 
gevel. De krachtige anisotropie-
penalty ruimt de naald- resp. 
spaghettivormige artefacten op, 
die dronemateriaal graag produ
ceert. Als je materiaal vanaf de 
grond is opgenomen, past eerder 
Photo / Object of een Classic-
voorinstelling.

P10 — 360° Walkaround

WA A R

Inspector → Voorinstellingen-sectie → Groep „Cap
ture Class“ → Item „360° Walkaround”. UUID-suffix 
…011 .

T E C H N I S C H

Capture-Class-voorinstelling voor 360°-walka
round-video’s. MCMC-densifier, 40.000 iteraties, 
cap 1,5 mln. Gaussians, SSIM-loss 0,5 plus edge-
aware-term 0,1, zachte anisotropie-penalty (gewicht 
0,001 bij ratio-drempel 15). Personen- en lucht-
masker zijn actief. De voorinstelling verwacht een 
360°-equirect-video, die intern op circa 90° brede 
perspectief-crops wordt geherprojecteerd, voordat 
de training start. Gevalideerd op 8K-360°-rondgan
gen met selfie-stick (Monument-scène, met het oog 
gecontroleerd).

E E N VO U D I G  G E Z E G D

Voor 360°-rondgang-video’s — je 
loopt met een 360°-camera of 
selfie-stick door een ruimte of 
om een object heen. RadianceKit 
ontleedt het bol-panorama zelf 
in normale kijkhoeken en mas
keert voorbijgangers en lucht 
weg. Voor maximale scherpte 
op hetzelfde materiaal probeer 
aanvullend de High-Detail-vari
ant (P11).
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P11 — 360° Walkaround (High Detail)

WA A R

Inspector → Voorinstellingen-sectie → Groep „Cap
ture Class“ → Item „360° Walkaround (High Detail)”. 
UUID-suffix …013  (opt-in).

T E C H N I S C H

Opt-in-Capture-Class-voorinstelling voor 360°-wal
karound-video’s met maximaal detail. Hybride-den
sifier (klassiek abs-gradiënt-klonen/splitsen
1. MCMC-noise + relocatie), 40.000 iteraties, cap 

1,5 mln. Gaussians,

anisotropie-penalty 0,0015 bij ratio-drempel 15, 
SSIM-loss 0,2 en edge-aware-term 0 — het ge
lockte „r50″-screen-split-recept. Op 360°-materi
aal verslaat het de standaard-MCMC-voorinstelling 
„360° Walkaround“ (P10) bij PSNR, LPIPS en zicht
bare confetti, en dat met circa een derde van 
het splat-aantal. Staat doelbewust opt-in naast de 
standaard-360-voorinstelling, totdat het op meer 
scènes is gevalideerd.

E E N VO U D I G  G E Z E G D

Het scherpere alternatief voor 
de standaard-360-voorinstelling 
(P10): meer detail, minder con
fetti, duidelijk kleiner bestand. 
Staat doelbewust ernaast in 
plaats van het te vervangen — 
tot nu toe op een handvol scènes 
bevestigd. Als je 360°-rondgang 
netjes is opgenomen, probeer 
dan deze voorinstelling eerst en 
vergelijk het resultaat met P10.

P12 — Photo / Object

WA A R

Inspector → Voorinstellingen-sectie → Groep „Cap
ture Class“ → Item „Photo / Object”. UUID-suffix 
…012 .

T E C H N I S C H

Capture-Class-voorinstelling voor object-orbits uit 
scherpe losse foto’s (geen video). Hybride-t1-den
sifier (met relocatie), 40.000 iteraties, cap 1,5 mln. 
Gaussians, SSIM-loss 0,5 plus edge-aware-term 
0,1, zachte anisotropie-penalty (gewicht 0,001 bij 
ratio-drempel 15), Opacity Decay 0,9995 elke 50 
iteraties, geen masking. Gevalideerd op 163 hoog
resolutie-41-MP-foto’s van een skelet (met het oog 
gecontroleerd). Weinig views (tot ongeveer 600) 
blijven daarbij onder de hybride-collapse-drempel.

E E N VO U D I G  G E Z E G D

Voor objectopnames uit scher
pe losse foto’s — je omcirkelt 
een beeldhouwwerk, een model, 
een product met de camera en 
maakt foto’s in plaats van vi
deo. Geen masking, omdat scher
pe foto’s meestal een schone 
achtergrond hebben. Voor video-
bronnen neem in plaats daarvan 
een 360°- of Drone-voorinstel
ling.
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P13 — Gebalanceerd (Hybride)

WA A R

Inspector → Voorinstellingen-sectie → Groep „Hy
bride“ → Item „Gebalanceerd (Hybride)”. UUID-suf
fix …009 .

T E C H N I S C H

20.000 iteraties met de hybride densificatiestrate
gie: klassieke gradiëntgestuurde clone/split plaatst 
capaciteit waar de loss die nodig heeft, MCMC-
SGLD-ruis blijft verkennen, en dode Gaussians wor
den gerelocaliseerd in plaats van bij het prunen ver
loren te gaan. Opacity-decay (V546) vervangt opa
city-resets; een anisotropie-penalty (gewicht 0,001, 
ratio-drempel 15) houdt naaldvormige splats in 
toom. De Gaussian-cap schaalt mee met de scène 
(150K basis, scene-aware ×3,0). Gevalideerd op vijf 
scènes tegen puur MCMC bij hetzelfde budget: ge
middeld +0,45 dB PSNR bij 20–30% minder Gaussi
ans (stonehenge +1,23, family +0,82, garden +0,47 
dB). Op een M3 Ultra typisch 5–10 minuten bij 200 
beelden.

E E N VO U D I G  G E Z E G D

Een sterke eerste keuze voor 
een eindresultaat: scherper de
tail dan de MCMC-voorinstellin
gen bij een vergelijkbaar com
pact bestand, in een fractie 
van de P8-trainingstijd. Heb je 
maar tijd voor één kwaliteits
run en past geen van de Cap
ture-klassen duidelijk, begin dan 
hier. De Classic-voorinstellingen 
blijven beter voor snelle tests, 
en de Capture-Class-voorinstel
lingen (P9–P12) zijn eerste keuze 
als je scène duidelijk bij een van 
die opname-soorten past.
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Wanneer welke voorinstelling?

Scenario Eerste test Hoofdrun

Functietest nieuwe beel
den, < 30 s

P1 Quick —

Object-orbit uit scherpe 
losse foto’s

P2 Preview P12 Photo / Object

Enkel-object-scan (vi
deo), < 500 foto’s

P2 Preview P4 Quality of P8 Quality 
MCMC

360°-walkaround-video P6 Preview MCMC P10 360° Walkaround 
(scherp: P11 High Detail)

Lucht-/drone-orbit, land
schap

P6 Preview MCMC P9 Drone / Aerial

Web-uitlevering (klein, 
compact)

P2 P8 Quality MCMC (kleinste 
bestand bij volle kwaliteit)

Scherp detail in weinig 
tijd, compacte export

P2 of P6 P13 Gebalanceerd (Hybri­
de)

Maximale detailgetrouw
heid, Classic-strategie

P3 of P6 P5 Ultra Detail

Print, marketing, volledig 
detail

P3 of P6 P4 Quality (Classic) of P5 
Ultra Detail
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Snelvergelijking

178 / 230



R A D I A N C E K I T Hoofdstuk 7 — Ingebouwde kwaliteitsvoorinstellingen

Voor
instel

ling

Stra
tegie

Iters Max-
Gs

Render-
schaal

Typische tijd (200 beelden, 
M3 Ultra)

Q-Sweep

P1 Quick Classic 1.000 ∞ 0,25× ~30 s —

P2 
Preview

Classic 5.000 ∞ 0,5× 2–3 min —

P3 
Ba
lan
ced

Classic20.000 ∞ 1,0× 30–60 s —

P4 Qua
lity

Classic35.000 ∞ 1,0× 2–4 min V546 
HTGS

P5 
Ul
tra 
De
tail

Classic~35.000 ∞ 1,0× 2–5 min Ma
trix Δ+0,94 

dB

P6 
Preview 
MCMC

MCMC60.000 100 
K

1,0× 5–8 min —

P7 
Ba
lan

ced MCMC

MCMC120.000 150 
K

1,0× 8–15 min —

P8 Qua
lity MCMC

MCMC200.000 150 
K

1,0× 20–35 min V544a

P9 Dro
ne / 
Ae
rial

MCMC40.000 1,5 
M

1,0× 10–25 min Oog / 
via

duct

P10 360° 
Wal

karound

MCMC40.000 1,5 
M

1,0× 10–25 min Oog / 
mo
nu

ment

P11 360° 
Wal

karound 
(High 
De
tail)

Hybri
de

40.000 1,5 
M

1,0× 10–25 min Oog 
(opt-
in)

P12 Pho
to / 
Ob
ject

Hybri
de

40.000 1,5 
M

1,0× 10–25 min Oog / 
ske
let

P13 
Ge
ba

lanceerd 
(Hy
bri
de)

Hybri
de

20.000 150 
K

1,0× 5–10 min Ma
trix Δ+0,45 

dB
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Eigen voorinstellingen

Via de knop Save… in de voorinstellingen-sectie (I1 in hoofdstuk 2) sla je de huidige 
trainingsconfiguratie op als eigen voorinstelling. Eigen voorinstellingen zijn niet „Built-
in“ en laten zich hernoemen, exporteren (als JSON), via drag-and-drop delen, duplice
ren en verwijderen. De dertien ingebouwde voorinstellingen P1–P13 blijven door de 
verwijderknop onaangetast.

Vuistregel: Als je aan een voorinstelling iets verandert dat je nog vaker wilt gebruiken 
— Sky-Dome aan, hoger SSIM-gewicht voor een bepaalde scèneklasse, afwijkende iter-
aantallen — sla die variant dan op als eigen voorinstelling. Zo weet je bij de volgende 
run meteen dat het een van de standaard afwijkende configuratie is.
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H O O F D S T U K

Hoofdstuk 8 — Exportformaten

Afbeelding 29:  Exportformaat-keuze in de beginnersmodus — zes formaatkaarten

Afbeelding 30:  Exportformaat-rooster live na 5K-iter-training op flowers-boeket — alle zes 
kaarten met dynamische groottelijke berekening (PLY 742 KB geselecteerd, SPZ 74 KB, glTF 
708 KB, .splat 96 KB, Orbit Video ~Zero KB, Web Viewer 133 KB), Export History rechts met 

reeds opgeslagen PLY

Wat de afbeelding toont (2.991 Gaussians, SH degree 3, een synthetisch Blender-
boeket als IP-clean testset): De groottelijke aanduidingen onder elke formaatkaart 
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worden live uit de actuele Gaussian-count en formaat-overhead berekend — niet hard-
gecodeerd. Uit 2.991 Gaussians (SH degree 3) ontstaan zo 742 KB PLY, 74 KB SPZ 
(factor ~10× kleiner door kwantisatie), 708 KB glTF (met KHR_​gaussian_​splatting-
extension, daardoor bijna PLY-equivalent), 96 KB .splat (gecomprimeerd 24-byte-per-
Gaussian-formaat). Orbit Video toont „~Zero KB“, omdat de grootte pas na de MP4-
encoding bekend is. Web Viewer (133 KB) bundelt een zelfstandig HTML-bestand 
met ingebedde WebGL-viewer en gecomprimeerde splat-data — groter dan puur .splat 
vanwege de viewer-overhead. Export-History rechts toont reeds voltooide PLY-export 
(„training_20260527T211321Z.ply, 743 KB, 23:13”) met formaat-pill en reveal-in-Fin
der-actie.

Een voltooide training levert een Gaussian-cloud — een verzameling van enkele 
honderdduizenden tot miljoenen 3D-Gauss-verdelingen, die samen de scène reconstru
eren. RadianceKit kent tien manieren om deze cloud naar de harde schijf te schrijven. 
Zes daarvan zijn pure 3D-dataformaten (PLY, Compressed PLY, SPZ, SOG, glTF, .splat), 
één bundelt de cloud samen met een kant-en-klare HTML-viewer (Web Viewer), één 
rendert een MP4-bestand uit een orbit-cameravlucht (Orbit Video), en twee expor
teren geen Gaussian-inhoud, maar slechts het SfM-resultaat (cameraposes en grove 
puntenwolk) voor hergebruik in andere trainingspipelines (transforms.json + COLMAP-
Workspace).

Welk formaat wanneer het juiste is, hangt af van het doel. Voor de archivering van 
de volle gegevens zonder kwaliteitsverlies neem je PLY. Voor web-viewer op je eigen 
pagina volstaat meestal .splat of de ingebouwde web-viewer. Wanneer het bestand 
minimaal moet zijn, loont SPZ of SOG. Voor hergebruik van het SfM-resultaat in 
Nerfstudio, Postshot of Brush zijn transforms.json en de COLMAP-workspace de juiste 
wegen.

Alle exportfuncties zitten in het menu „Export“ en in de beginnersmodus op de laatste 
wizard-stap. De meeste formaten zijn volledig sandbox-conform en werken in de App-
Store-versie. Alleen SOG vereist een externe binary ( cwebp ), die in de App-Store-build 
niet verplicht aanwezig is — details zie E4.
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E1 — PLY (.ply)

WA A R

Menubalk → Export → 3D Formats → Export PLY… 
(⌘E). Beginnersmodus: wizard-stap Export → for
maatkaart „PLY“. Grootte: typisch 100% (referentie
waarde). Compatibel met: SuperSplat, PolyCam, 
alle 3DGS-viewers.

T E C H N I S C H

PLY is het canonieke opslagformaat voor 3D Gaus
sian Splatting. RadianceKit schrijft een binair little-
endian-bestand met de gestandaardiseerde 3DGS-
property-layout: per Gaussian driecomponentige 
positie, drie altijd op nul gezette normalen, drie DC-
SH-coëfficiënten ( f_dc_0..2 ) voor de basis-RGB-
kleur, vervolgens tot 45 verdere SH-coëfficiënten 
( f_rest_0..44 ) in de door het Kerbl-2023-paper 
gedefinieerde getransponeerde channel-major-or
dening (eerst alle R-kanaal-coëfficiënten, dan alle 
G, dan alle B), gevolgd door logit-opacity (rauwe 
pre-sigmoid-waarden), drie log-space-schalen en 
een wxyz-quaternion-rotatie. De maximaal geëxpor
teerde SH-graad wordt op het minimum van user-
wens en daadwerkelijk geleerde graad geclampt; 
standaard is 3 (45 rest-coëfficiënten). Vóór het 
schrijven wordt de payload-grootte in 64-bit-inte
ger berekend, om overflow bij extreem grote clouds 
te vangen. Het bestand wordt atomair geschreven, 
wat bij grote clouds kortstondig de dubbele schijf
ruimte gebruikt.

E E N VO U D I G  G E Z E G D

Dit is het „originele bestand“. 
Grootste bestand, hoogste com
patibiliteit, geen verlies. Als je 
niet weet welk formaat je moet 
nemen, neem PLY — dat opent 
in bijna elke 3DGS-tool. Voor 1 
miljoen Gaussians is dat afhan
kelijk van SH-graad tussen 200 
en 800 MB. Als het bestand te 
groot wordt, bekijk E2 (gecompri
meerd PLY) of E3 (SPZ).
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E2 — Compressed PLY (.ply)

WA A R

Menubalk → Export → 3D Formats → Export 
Compressed PLY…. Beginnersmodus: formaatkaart 
„Compressed PLY“. Grootte: ca. 10–20% t.o.v. 
PLY (5- tot 10-voudige compressie). Compati­
bel met: SuperSplat, PlayCanvas-engine, webgeba
seerde viewers.

T E C H N I S C H

De PlayCanvas-variant van het PLY-formaat met 
chunked kwantisatie. De Gaussians worden in 
chunks van 256 gegroepeerd. Per chunk worden 
min/max-bounds voor positie, schaal en kleur apart 
in de header opgeslagen; de afzonderlijke Gaus
sians refereren aan hun waarden relatief aan de
ze bounds en worden op 32 bit gecomprimeerd: 
positie en schaal met 11-10-11-bit-packing, rota
tie als 2-10-10-10-bit „smallest-three“-quaternion, 
kleur als 8-8-8-8-RGBA. Hogere SH-coëfficiënten 
worden met slechts 8 bit per component gekwan
tiseerd ( shCoeffCount * 3  uchar per Gaussian). 
Het formaat zelf is nog steeds ASCII-header-PLY 
en daarmee in principe valideerbaar met PLY-tools, 
maar de vertex-properties zijn als uint -velden 
gedeclareerd. SH-graad is standaard 0 (geen rest-
coëfficiënten), om de compressie te maximaliseren 
— hogere SH-graden kunnen expliciet worden geko
zen.

E E N VO U D I G  G E Z E G D

De ruimtebesparende PLY-vari
ant. Identieke engine-compatibi
liteit als de normale PLY, maar 
5 tot 10 keer kleiner. SuperSplat 
en PlayCanvas lezen het native. 
Voor web-deployment vrijwel al
tijd beter dan normale PLY. Het 
kwaliteitsverlies door de kwan
tisatie is visueel meestal niet 
waarneembaar, zolang de scène 
niet extreem hoogfrequente de
tails bevat.
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E3 — SPZ (.spz)

WA A R

Menubalk → Export → 3D Formats → Export SPZ…. 
Beginnersmodus: formaatkaart „SPZ“. Grootte: ca. 
10% t.o.v. PLY (90% kleiner). Compatibel met: Ni
antic Scaniverse, Niantic Spatial Fields, MetalSplat
ter.

T E C H N I S C H

Niantic’s SPZ-v2-formaat. Posities worden als 24-
bit-fixed-point gepakt (dat levert ca. 0,25 mm 
resolutie op), schalen als 8-bit-kwantisatie in de 
log-ruimte, rotaties als 8-bit-smallest-three (in v2 
worden alleen xyz opgeslagen, w wordt in de deco
der uit de quaternion-norm afgeleid), opacities als 
gesigmoidiseerde 8-bit-waarden. DC-SH wordt met 
een SPZ-specifieke pack-formule (dc_​raw * 0.15 
* 255 + 0.5 * 255) opgeslagen, hogere SH-
bands met 5 bit (band 1) resp. 4 bit (band 2-3) 
per coëfficiënt. De gehele gepakte binair-blob wordt 
vervolgens met standaard-gzip (RFC 1952) gecom
primeerd, wat een gzipped-container-formaat met 
magic bytes 1f 8b  oplevert. RadianceKit roept 
hiervoor de systeem- gzip  aan, omdat Apple’s in
gebouwde zlib-API proprietary Apple-framing gene
reert, wat niet compatibel zou zijn met de SPZ-rea
ders in Spatial Fields of MetalSplatter. De systeem-
gzip  blijft ook binnen de macOS-sandbox spawn

baar.

E E N VO U D I G  G E Z E G D

Het kleinste standaard-bestand. 
Als je Scaniverse van Niantic 
kent — dat is het formaat 
dat de app gebruikt. Erg klein, 
zeer laad-vriendelijk voor mobie
le apps. In Niantic’s eigen cloud-
viewer (Spatial Fields) direct 
bruikbaar. Ongeveer 90% kleiner 
dan een PLY met dezelfde gege
vens, daarbij voor de meeste scè
nes optisch nauwelijks te onder
scheiden.
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E4 — SOG (.sog)

WA A R

Menubalk → Export → 3D Formats → Export SOG…. 
Beginnersmodus: formaatkaart „SOG“. Grootte: ca. 
5–6% t.o.v. PLY (15- tot 20-voudige compressie — 
de kleinste optie). Compatibel met: PlayCanvas-
engine, SuperSplat-editor.

T E C H N I S C H

„Spatially Ordered Gaussians“ — een PlayCanvas-
formaat dat de cloud GPU-ready in meerdere 
lossless-WebP-beelden opslaat. Eerst worden alle 
Gaussians via 3D-Morton-code (30-bit Z-order, 10 
bit per as) ruimtelijk gesorteerd, wat de beelden 
later cache-locality in de renderer bezorgt. Vervol
gens worden posities met symmetrische log-trans
formatie (voor betere dynamiek-omvang) op 16-bit-
waarden gekwantiseerd en in twee RGBA-beelden 
gesplitst ( means_l.webp  voor de onderste 8 bits, 
means_u.webp  voor de bovenste). Rotaties worden 

als smallest-three met 3×8-bit plus 2-bit-mode in 
een RGBA-beeld gecodeerd (mode komt in alpha als 
252 + largest ). Schalen en DC-SH worden met 

elk een 256-entry-codebook gekwantiseerd (per
centielgebaseerd over alle waarden verdeeld), de 
indexen komen in scales.webp  en sh0.webp . De 
vijf beelden plus een meta.json  met codebooks en 
bounds worden in een ZIP-bestand gepakt (custom-
encoder, omdat de sandbox de systeem- zip  blok
keert) en met de extensie .sog  opgeslagen.

Let op sandbox: SOG is de enige formaatoptie 
die een externe binary vereist. De WebP-encoder-
fase roept cwebp  uit /​usr/​local/​bin/​cwebp of /​
opt/​homebrew/​bin/​cwebp aan. Als geen cwebp-bina
ry wordt gevonden, valt de code terug op ruwe 
PNG-encoding — maar: PNG-fallback werkt niet 
in SuperSplat. In de App-Store-versie evalueer de 
beschikbaarheid aan de hand van de build-variant; 
in de developer-variant moet cwebp via Homebrew 
zijn geïnstalleerd ( brew install webp ).

E E N VO U D I G  G E Z E G D

Het kleinste 3DGS-formaat über
haupt, duidelijk kleiner dan SPZ. 
Maar: heeft de cwebp -tool op 
je Mac nodig, omdat Radian
ceKit zelf niet alle beeldforma
ten kan genereren. Installeer het 
eenmaal met Homebrew, dan 
loopt alles. In de App-Store-ver
sie eventueel niet volledig func
tioneel — als bij export PNG 
in plaats van WebP naar buiten 
komt, kun je het bestand niet di
rect in SuperSplat openen. Wie 
zonder Homebrew werkt, neemt 
in plaats daarvan SPZ (E3).
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E5 — glTF (.glb)

WA A R

Menubalk → Export → 3D Formats → Export glTF…. 
Beginnersmodus: formaatkaart „glTF“. Grootte: ver
gelijkbaar met PLY. Compatibel met: glTF-viewers 
met KHR_​gaussian_​splatting-extension (Khronos-
draft-standaard).

T E C H N I S C H

Schrijft een zelf-onderhoudend .glb -binair be
stand (geen apart bin-bestandsaanhangsel) volgens 
de KHR_​gaussian_​splatting-extension-specificatie. 
Posities worden als reguliere glTF- POSITION -ver
tex-data (float3) opgeslagen, alle andere attributen 
(rotatie als float4, scale als float3, opacity als 
float, SH-coëfficiënten als float3 × shCoeffCount) 
zitten in extra vertex-attributen en worden via 
de extension gerefereerd. Belangrijk: glTF gebruikt 
een rechtshandig Y-up-coördinatensysteem, COL
MAP/3DGS werkt Y-down/Z-forward. De exporter 
past daarom een 180-graden-rotatie om de X-as toe 
— posities worden met (x, -y, -z)  herschreven, 
quaternions worden naar (w, x, -y, -z)  aange
past. Dat levert een geometrisch correcte, handige 
(niet spiegelverkeerde) weergave in glTF-viewers 
op. JSON- en binary-chunks worden naar 4-byte-
alignment gepad, zoals door de GLB-standaard ver
eist.

E E N VO U D I G  G E Z E G D

Het officiële Khronos-standaard
formaat voor 3D-data, in de verse 
uitbreiding voor Gaussian splats. 
Voordeel: glTF is in alle grote 3D-
engines verspreid (Babylon.js, 
Three.js, Unity, Unreal). Nadeel: 
de uitbreiding is in 2026 nog in 
draft-stadium, veel viewers kun
nen die nog niet aan. Zinvol 
vooral wanneer je splat-data in 
een bestaande glTF-pipeline in
tegreert of een viewer schrijft 
die al glTF-bekwaam is.
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E6 — Splat (.splat)

WA A R

Menubalk → Export → 3D Formats → Export .splat…. 
Beginnersmodus: formaatkaart „.splat“. Grootte: 
exact 32 bytes per Gaussian. Compatibel met: 
gsplat.js, webgebaseerde viewers (antimatter15-re
ferentie), de meeste browser-3DGS-demo’s.

T E C H N I S C H

Het antimatter15- .splat -formaat — 32 bytes per 
Gaussian, geen header, geen indirectie. Layout per 
entry: 3 × float32 positie (wereld-coördinaten), 3 × 
float32 scale (exp-getransformeerd vanuit de log-
space van de interne buffer), 4 × uint8 RGBA-kleur 
(DC-SH-coëfficiënt met SH_C0 = 0.282...  ge
schaald en op [0,255] geclampt), 4 × uint8 quater
nion (w,x,y,z, genormaliseerd en als 128 + 128*q  
in het byte-bereik gecodeerd). Alleen DC-SH wordt 
opgeslagen — hogere SH-banden worden verwor
pen. Dat maakt het formaat extreem compact, maar 
kost de view-afhankelijke kleurveranderingen die 
bij reflecties of speculaire highlights optreden. De 
schrijfvolgorde is exact de index-volgorde van de 
cloud (geen ruimtelijke sortering), web-viewers zo
als gsplat.js  renderen daarvan uit.

E E N VO U D I G  G E Z E G D

Het formaat van voorkeur als je 
de splat in een eigen web-vie
wer met gsplat.js  wilt tonen. 
Zeer compact (32 bytes/Gaussi
an), maar geen hogere SH-graad 
— dus geen glanzende reflec
ties of fijne kleurveranderingen 
afhankelijk van kijkhoek. Voor de 
meeste webtoepassingen geen 
probleem, omdat DC-kleur volle
dig volstaat en de ontbrekende 
view-afhankelijkheid nauwelijks 
opvalt.
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Afbeelding 31:  Web Viewer geopend in Firefox — bouquet-splat gerenderd met omringen­
de camera-marker-bollen, browser-tab-bar bovenaan zichtbaar, geen CDN-/server-setup 

nodig. Zelfstandig flowers-01.html  direct vanuit de Finder per dubbelklik in de 
standaardbrowser geopend — het ingebedde WebGL2-programma rendert de Gaussian-
cloud onmiddellijk, zonder netwerk of server. De zwarte markers rond het boeket zijn de 

trainingscamera’s, optioneel in te schakelen. Muis-drag roteert, scroll zoomt.
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E7 — Web Viewer (.html)

WA A R

Menubalk → Export → Media → Export Web Vie
wer…. Beginnersmodus: formaatkaart „Web Viewer“. 
Grootte: splat-data base64-gecodeerd (≈ 4/3 over
head) + ca. 5 KB HTML/JS-shell. Compatibel met: 
elke moderne browser met WebGL2 (alle desktops, 
iOS 15+, Android 5+).

T E C H N I S C H

Bundelt de Gaussian-cloud samen met een volledig 
inline geschreven WebGL2-renderer in een enkel 
.html -bestand. Er zijn geen CDN-afhankelijkhe

den, geen WASM, geen tweede bestand. De cloud 
wordt intern eerst als .splat -binary gecodeerd 
(zelfde 32-byte-logica als E6), vervolgens base64-
ingebed, vervolgens met atob  in de browser gede
codeerd. De ingebouwde renderer doet zijn eigen 
WebGL2-sortering, muis-orbit-besturing en CPU-
sortering per frame; de gehele JS-code (shader, 
wiskunde, loop) is in de output-HTML te zien. De 
assen-conventie aan de opslag-tot-renderer-grens 
is exact dezelfde als in E5: positie (x, -y, -z) , 
quaternion (w, x, -y, -z) . Optioneel kan een 
branding-overlay worden ingeschakeld (free-tier-
schakelaar). Omdat alles inline is, werkt het bestand 
ook direct vanaf het file:/​/​-protocol — geen lokale 
webserver nodig om te testen.

E E N VO U D I G  G E Z E G D

Een enkel HTML-bestand dat je 
iemand per e-mail kunt sturen 
of op een website kunt inslui
ten. Dubbelklik in de Finder, en 
de browser toont je scène met 
muis-rotatie. Geen upload naar 
een cloud nodig, geen twee
de bestand, geen server. Ideaal 
voor klantpresentaties, portfolio, 
e-mailbijlagen. Nadeel: het be
stand wordt door de base64-co
dering ongeveer een derde gro
ter dan een puur .splat  — 
voor zeer grote scènes loont 
daarom het apart hosten van het 
.splat -bestand samen met 

een standaard viewer.
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Afbeelding 32:  Enkel frame uit flowers-01.mp4 — boeket in profielrender, wit platform met 
camera-markers zichtbaar, zwarte achtergrond (standaard viewport-achtergrond, in instel­
lingen wijzigbaar). De camera cirkelt om de scène op een parametrische baan (elevation + 

afstand vast, yaw roteert), duur typisch 6–10 seconden bij 30 of 60 fps. Frameresolutie 
schaalbaar van 480p tot 8K via VideoPreset.
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E8 — Orbit Video (.mp4/.mov)

WA A R

Menubalk → Viewport → Record Turntable Video 
OF menubalk → Export → Media → Export Orbit Vi
deo…. Beginnersmodus: formaatkaart „Orbit Video“ 
met duur-schuif 3–30 s. Grootte: afhankelijk van 
duur, resolutie, bitrate. Compatibel met: alle plat
forms (H.264 en HEVC zijn Apple-standaard).

T E C H N I S C H

Rendert de Gaussian-cloud langs een parametri
sche orbit-cameravlucht en encodeert elk frame via 
AVAssetWriter naar een MP4- of MOV-bestand. De 
orbit-configuratie stuurt rotatiesnelheid (omwente
lingen), afstand, elevation, FOV, duur en ease-in/
out-factor. De orbit-video-export loopt door Radian
ceKits EIGEN ForwardPass met volledige SH-evalu
atie — pixel-identiek aan het in-app-viewport (WY
SIWYG). Per frame wordt de wereldaanpassingsma
trix (door de renderer berekend om de interne coör
dinaten naar de Y-up-orbit-wereld te draaien) met 
de camera vermenigvuldigd, vervolgens wordt een 
camera-conventie-flip (camFlip: orbit Y-up → COL
MAP Y-down) toegepast. Het offscreen-rendertar
get wordt via IOSurface naar een CVPixelBuffer voor 
de encoder gestreamd. De encoder ondersteunt 
H.264 en HEVC, instelbare bitrate en resolutie van 
480p tot 8K. Vóór de eerste frame wacht de rende
rer 200 ms, zodat de initiële splat-sortering voltooid 
is. Deze export is GPU-bound — bij 8K en miljoenen 
Gaussians ligt de rendertijd per frame in seconden, 
dus totale rendertijden van 10–30 minuten voor 6 s 
video mogelijk.

E E N VO U D I G  G E Z E G D

Een kant-en-klaar MP4-bestand 
met een rotatie om je scène. Per
fect voor sociale media, marke
ting, presentaties. Je kunt duur 
(3–30 seconden), draairichting 
en snelheid instellen. Het be
stand laat zich op YouTube, In
stagram, in PowerPoint en over
al elders direct insluiten. Loopt 
deels traag, omdat de app elke 
frame volledig moet renderen — 
voor een 8K-video kun je vijf tot 
dertig minuten inplannen, afhan
kelijk van het aantal Gaussians.
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E9 — SfM Transforms (transforms.json)

WA A R

Menubalk → Export → Photogrammetry → Export 
SfM (transforms.json)…. Grootte: typisch 1–10 KB 
(alleen poses + intrinsics, geen beelden, geen 
Gaussians). Compatibel met: nerfstudio, Brush, 
gsplat, OpenSplat, Meshroom, alle moderne feed-
forward 3DGS-trainers.

T E C H N I S C H

Schrijft het nerfstudio- transforms.json -formaat 
met een lijst van cameraposes plus gedeelde in
trinsics. Per camera wordt de view-matrix (Radian
ceKit-intern: world-to-camera in COLMAP-conven
tie) geïnverteerd, vervolgens worden de cameralo
kale Y- en Z-basisvectoren gespiegeld, om naar 
de nerfstudio-conventie (OpenGL-stijl, camera kijkt 
langs -Z , +Y  is boven) om te zetten. De fi
nale 4×4-matrix komt als row-major nested array 
van doubles in het transform_matrix -veld van 
elke frame. Intrinsics worden op het top-level op
geslagen (brandpuntsafstand x/y, hoofdpunt x/y, 
beeldbreedte/-hoogte, camera_​model = "OPENCV", 
plus de distortion-coëfficiënten k1, k2, p1, p2 ) 
— behalve wanneer de exporter meerdere verschil
lende intrinsics-sets herkent, dan worden ze per 
frame geschreven. Beeldpaden worden als images/​
<bestandsnaam> relatief aan het JSON-bestand ge
schreven; de gebruiker moet een sibling-images/​-
map met de trainingsfoto’s aanmaken.

E E N VO U D I G  G E Z E G D

Dit JSON-bestand beschrijft voor 
elke foto waar de camera stond 
en waarheen hij keek. Het be
stand alleen is klein en nutte
loos — het wordt samen met 
de originele beelden in een map 
gebruikt. Nerfstudio, Brush en 
enkele andere trainers lezen pre
cies dit formaat, en je kunt daar
mee je RadianceKit-SfM-resulta
ten aan een andere tool overdra
gen, zonder dat daar de camera-
reconstructie opnieuw hoeft te 
worden berekend. Spaart bij gro
te scènes uren.
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E10 — COLMAP Workspace (sparse/0/)

WA A R

Menubalk → Export → Photogrammetry → Export 
SfM (COLMAP Workspace)…. Grootte: drie binaire 
bestanden samen typisch 4–8 MB — points3D.bin  
domineert (één regel per 3D-punt van de sparse-
cloud), images.bin  en cameras.bin  zijn elk ruim 
onder 100 KB. Compatibel met: COLMAP zelf, 
Nerfstudio, Postshot, Meshroom, alle tools die een 
COLMAP-sparse/​-directory verwachten.

T E C H N I S C H

Schrijft de standaard COLMAP-sparse/​0/​-lay
out met drie binaire bestanden: cameras.bin , 
images.bin , points3D.bin . Formaatreferentie is 

de officiële COLMAP-documentatie. cameras.bin  
bevat de ontdubbelde intrinsics-lijst (camera’s met 
identieke intrinsics + beeldgrootte worden tot één 
enkele entry samengevat); het gebruikte came
ra-model is OPENCV  (model 4), met fx/fy/cx/cy 
plus de vier distortion-coëfficiënten k1/k2/p1/p2. 
images.bin  somt per beeld de pose als wxyz

-quaternion plus translatie op, gevolgd door de 
camera-ID en de bestandsnaam; geen 2D-3D-cor
respondenties worden opgeslagen. points3D.bin  
bevat de SfM-puntenwolk met positie, kleur (0-255 
RGB) en standaardwaarden voor reprojectie en 
track-lengte. Alles wordt in little-endian geschre
ven. Re-import in RadianceKit werkt via het Fi
le-menu → „Import COLMAP/Metashape Workspa
ce…“ (zie Q3 in het SfM-backend-hoofdstuk).

E E N VO U D I G  G E Z E G D

Het officiële COLMAP-formaat. 
Als je je training in Postshot, 
Nerfstudio of andere COLMAP-
compatibele software wilt voort
zetten, is dat de weg. Drie klei
ne bestanden plus je origine
le beelden, en het doelprogram
ma accepteert het alsof COLMAP 
zelf het bronprogramma was. 
Meer programma’s begrijpen dit 
dan het transforms.json-formaat 
(E9), tegelijk iets minder handig, 
omdat binair in plaats van tekst
gebaseerd.
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Welk formaat wanneer?

Doel Formaat

Web-viewer op eigen pagina E7 Web Viewer (.html)

Web-viewer met gsplat.js E6 Splat (.splat)

Pipeline-reuse in Postshot / Nerfstu
dio

E9 transforms.json + E10 COLMAP Workspace

SuperSplat-edit E1 PLY of E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Maximale compressie E4 SOG (cwebp vereist)

Marketing-/social-video E8 Orbit Video
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Snelvergelijking

For
maat

Extensie Sandbox Grootte (1M Gauss) Beste ge
bruik

E1 PLY .ply ja ~250 MB Archief, 
hoogste 

compatibili
teit

E2 Com
pressed 

PLY

.ply ja ~40 MB Web + Su
perSplat

E3 SPZ .spz ja (gzip-
spawn)

~40 MB Niantic + 
mobiel

E4 SOG .sog voor
waardelijk 
(cwebp)

~20 MB Maximale 
compressie

E5 glTF .glb ja ~250 MB Khronos-pi
peline

E6 Splat .splat ja ~32 MB gsplat.js 
web-viewer

E7 Web 
Viewer

.html ja ~45 MB Zelfstandig 
browser-be

stand

E8 Orbit 
Video

.mp4 / .mov ja variabel Social/mar
keting

E9 SfM 
Trans
forms

.json ja ~5 KB Pose-over
dracht

E10 
COLMAP Workspa

ce

Directory ja ~4–8 MB Pose-over
dracht bi

nair

Grootte-kolom zijn grove richtwaarden voor 1 miljoen Gaussians met SH-graad 3. Reële 
waarden variëren al naar gelang de comprimeerbaarheid van de scène; SH-graad 0 
reduceert PLY/glTF met factor 4.
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H O O F D S T U K

Hoofdstuk 9 — SfM-Backends

Afbeelding 33:  Expertmodus met Camera-Alignment-keuze in de Inspector (Apple Photo­
grammetry / Native (Beta))

Afbeelding 34:  Inspector met actief Native (Beta) — Camera-Alignment-keuze tweede optie 
geselecteerd, alle andere parameters van de trainingsconfiguratie ongewijzigd

WAT DE AFBEELDING TOONT  De Camera-Alignment-keuze in de Inspector is een seg
mented control met twee opties — Apple Photogrammetry (standaard voor App-
Store-builds, volledig sandbox-conform) en Native (Beta) (RadianceKit’s eigen 
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FAST+BRIEF+GLOMAP-pipeline-backend, ontwikkeld in fase 3.8/3.9, stand 2026-05). 
Native (Beta) is alleen voor orbit-opnames gevalideerd en sneller bij ≥1.000 frames dan 
Apple Photogrammetry, maar haalt de Phase-3-§5-kwaliteitsgrens (finalLoss ≤ 0,0115) 
nog niet — vandaar de Beta-tag. Externe SfM-resultaten uit Metashape, COLMAP of 
andere fotogrammetrische software kunnen aanvullend via het File-menu worden geïm
porteerd (Q3 COLMAP-tekstformaat, Q6 Workspace-Import) — de keuze verandert niet, 
maar de geïmporteerde poses vervangen het SfM-resultaat.

SfM staat voor Structure from Motion. Uit een verzameling overlappende foto’s recon
strueert de software voor elk beeld de positie en kijkrichting van de camera in een 
gemeenschappelijk 3D-coördinatenstelsel. Daarbij wordt een grove 3D-puntenwolk ge
genereerd, die de training met Gaussian Splatting initialiseert. Het SfM-resultaat is de 
invoer voor de eigenlijke training en is doorslaggevend voor de uiteindelijke beeldkwa
liteit.

RadianceKit biedt vijf SfM-routes: twee ingebouwde backends (Q1 Apple Photogram
metry, Q4/Q5 Native), twee import-paden uit externe tools (Q3 COLMAP-tekstformaat, 
Q6 binaire workspace-import) plus Q2 COLMAP-Binary, dat alleen in developer-builds 
buiten de App Store beschikbaar is. Welke de juiste is, hangt af van het scènetype (orbit 
rond een object, binnenruimte, dronevlucht) en van de vraag of externe software al een 
reconstructie levert.

Q1 — Apple Photogrammetry

WA A R

Expert View → Inspector → Trainingsconfiguratie → 
Camera Alignment-keuze, item „Apple Photogram
metry“.

T E C H N I S C H

Wrapt Apple’s ingebouwde Photogrammetry-frame
work dat oorspronkelijk voor Object Capture werd 
ontwikkeld. Apple extraheert intern features met 
een proprietary pipeline (stappen zijn niet open
baar gedocumenteerd), verifieert ze via multi-view-
matching en lost bundle-adjustment op de Apple-
Silicon Neural Engine + GPU op. Het backend is 
volledig App-Store-conform (geen externe binary, 
Sandbox=true, on-device), levert echter alleen ca
mera-poses plus een grove puntenwolk — geen 
diagnose-metrieken zoals tracklengte of reprojec
tiefout. Schaalt volgens Apple’s aanbeveling tot en
kele honderden beelden. Bij meer dan ~500 frames 
in lineaire dronevluchten of grote outdoor-scènes 
zijn reproduceerbaar crashes of stil verwerpen van 
afzonderlijke camera’s waargenomen.

E E N VO U D I G  G E Z E G D

Dit is de eenvoudigste route. 
Beelden erin, app rekent. Werkt 
zeer goed bij klassieke objects
cans — wanneer je om een meu
belstuk of beeldhouwwerk heen 
loopt en 50–200 foto’s maakt. Bij 
dronevluchten over landschap
pen of bij erg veel beelden (bo
ven 500) wordt Apple’s metho
de echter graag onstabiel. Voor 
zulke scènes het Native-backend 
(Q4/Q5) proberen of de camera’s 
in Metashape laten berekenen en 
via de workspace-import (Q6) in
laden.
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P OW E R - U S E R

Q2 COLMAP-Binary — spawnt het externe COLMAP-programma als subproces en 
is daarom in de App-Store-versie (sandbox) niet beschikbaar. Werkt alleen in 
developer-builds buiten de App Store. Voor de kwaliteit die COLMAP levert, is er in 
de App-Store-versie de workspace-import (Q3 of Q6): bereken de SfM in COLMAP 
of Metashape extern en laad het resultaat in.

Q3 — COLMAP-tekstformaat (Metashape / ETH3D)

WA A R

Menu „File → Import COLMAP / Metashape 
Workspace…“ (Cmd+⇧+I) OF drag-and-drop van 
een map met sparse/​0/​cameras.txt.

T E C H N I S C H

Leest de gestandaardiseerde COLMAP-tekstexport 
— drie tekstbestanden cameras.txt , images.txt , 
points3D.txt  in de submap sparse/​0/​ — en 

zet die om naar het interne SfM-resultaatmodel. 
Zelfde formaatdefinitie als de COLMAP-binaire ex
port, alleen als ASCII in plaats van binair. Wordt 
door Agisoft Metashape, RealityCapture, PolyCam 
en de ETH3D-benchmark in precies deze layout 
uitgevoerd. De parser deelt de camera-model-
herkenning met de binary-parser (alle gangbare 
modellen: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Robuust tegen 
commentaarregels en lege regels. Schaalt in tests 
tot ~1.400 camera’s (ETH3D Tunnel) zonder proble
men.

E E N VO U D I G  G E Z E G D

Als je al met Metashape, Reali
tyCapture of andere commercië
le foto-3D-software hebt gewerkt 
en het resultaat hebt geëxpor
teerd — die export kun je in 
RadianceKit direct laden, zonder 
dat de app zelf opnieuw hoeft te 
rekenen. Dat scheelt uren wacht
tijd. Laad gewoon de hele map 
via het File-menu of sleep hem in 
het venster.
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Q4 — Native SfM (incrementeel)

WA A R

Expert View → Inspector → Trainingsconfiguratie → 
Camera Alignment-keuze, item „Native (Beta)“. In
crementeel is de standaardmodus van dit backend 
— in de Inspector is er geen aparte mapper-keuze. 
Via de CLI kun je de modus expliciet instellen met 
--native-sfm  of --sfm-mapper incremental.

T E C H N I S C H

Eigen GPU-versnelde implementatie van 
de gehele SfM-pipeline: FAST+BRIEF-featu
res OF SuperPoint+LightGlue via CoreML 
(met --coreml-features ), gevolgd door Ham
ming-KNN-matching, RANSAC-fundamentaalmatrix, 
track-building, selectie van een initieel paar, two-
view-bootstrap (F→E plus DLT), greedy incremente
le mapper met PnP-registratie en multi-view-trian
gulatie en finale bundle-adjustment via Schur-redu
ced Levenberg-Marquardt met Huber-loss en analy
tische Jacobians via Cholesky-solve. Volledig App-
Store-conform: geen externe binary, Sandbox=true. 
Met de in fase 3.10 uitgeleverde R2-collapse-detec
tor: registreert de app minder dan 60% van de 
invoerframes of valt de points-per-camera-verhou
ding onder 13, dan wordt automatisch uitgeweken 
naar de globale mapper (Q5). Empirisch schoon op 
orbit-/turntable-scènes; op algemenere bewegingen 
(dronevlucht, binnenruimtes met complexe geome
trie) is het slagingspercentage lager — de detector 
vangt deze gevallen echter af. Schaalt betrouwbaar 
tot ~200 camera’s, hoger met aanzienlijk langere 
looptijd.

E E N VO U D I G  G E Z E G D

Apple’s sterke punten (App-Sto
re-compatibel, snel voor orbits) 
met aanvullende diagnose-waar
den. Werkt vooral goed wanneer 
je zoals voor een Object Cap
ture om een onderwerp heen 
loopt. Bij ingewikkeldere opna
men (dronevlucht of woonka
mer) herkent RadianceKit auto
matisch dat dit niet gaat luk
ken en springt over op de glo
bale methode. Gemarkeerd als 
„Beta“, omdat nog in beproe
ving — de standaardaanbeve
ling blijft Apple Photogrammetry 
voor eenvoudige objectscans en 
de workspace-import (Q3 of Q6) 
voor veeleisende outdoor-sets.
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Q5 — Native SfM (globaal)

WA A R

Wordt automatisch aangeroepen wanneer de incre
mentele mapper (Q4) de collapse-detector triggert 
(minder dan 60% van de invoerframes geregi
streerd of points-per-camera-verhouding onder 13). 
Handmatig forceerbaar alleen via CLI --sfm-mapper 
global. In de Inspector is de globale methode niet 
via een aparte keuze bereikbaar — de app beslist 
zelf wanneer hij omschakelt.

T E C H N I S C H

Globale variant van de native pipeline. Eerst feature-
extractie + matching zoals Q4, dan relatieve-pose-
schatting voor alle geverifieerde paren, vervolgens 
rotation-averaging (synchroniseert alle camerarota
ties in het wereld-coördinatensysteem) en translati
on-averaging (LSQR-gebaseerd op een matrix-vrije 
sparse-formulering, om integer-overflow bij grote 
camera-aantallen te vermijden). Schaalt in principe 
tot ~5.000 camera’s, in de praktijk kwaliteits-de
graded boven enkele honderden camera’s — de 
fase-3.8-§5-acceptatie-gate-meting op K-1351 le
verde finalLoss 0,07 op in plaats van de beoogde 
0,0115. Wordt als „fallback-tier“ gehanteerd: komt in 
actie wanneer de incrementele mapper degenereert, 
wordt zelf echter niet opnieuw op kwaliteit getoetst.

E E N VO U D I G  G E Z E G D

Het plan-B-pad voor de native 
engine. Wordt automatisch aan
geroepen wanneer het snellere 
incrementele pad faalt. Levert 
een bruikbaar resultaat, is echter 
bij zeer grote of moeilijke scènes 
meestal niet zo nauwkeurig als 
wat je uit Metashape of een ex
terne COLMAP-installatie krijgt. 
Als Native je standaardworkflow 
wordt, loont in zulke gevallen de 
omweg via de workspace-import 
(Q3 of Q6).
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Q6 — Metashape / COLMAP-tekst-workspace-import (fase Q7)

WA A R

File-menu → „Import COLMAP / Metashape 
Workspace…“ (Cmd+⇧+I). Drag-and-drop van een 
map met sparse/​0/​cameras.{bin,txt} en images/​.

T E C H N I S C H

Herkent automatisch of een via drag-and-drop 
of open-paneel geselecteerde map overeenkomt 
met een van de drie COLMAP-workspace-layouts 
(sparse/​0/​, sparse/​, of root) en of de reconstructie 
binair ( cameras.bin ) of tekst ( cameras.txt ) is. 
Het binaire pad gebruikt de COLMAP-binary-parser, 
het tekstpad de ETH3D-loader — beide produceren 
hetzelfde SfM-resultaatmodel en de rest van de 
pipeline (beelden importeren, MCMC-training star
ten) is agnostisch ten opzichte van de bron. De 
beelden worden via het app-sandbox-bookmark-
systeem security-scoped geopend, zodat de import 
ook in de App-Store-versie werkt. Specifiek voor 
het geval „Metashape-export zonder reconstructie 
opnieuw berekenen“ bedoeld. De in het File-menu-
item genoemde herkenning waarschuwt in de app-
log als de gekozen map geen herkenbare workspace 
is.

E E N VO U D I G  G E Z E G D

Specifiek de Metashape-gebrui
kersfunctie. Als je een licentie 
voor Metashape of RealityCaptu
re hebt en daar de camera-re
constructie hebt uitgevoerd, kun 
je de export-map gewoon hier 
naar binnen slepen en meteen 
met de training beginnen. Spaart 
bij grote scènes meerdere uren 
rekentijd uit, omdat RadianceKit 
het SfM dan niet zelf doet.
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Welk backend wanneer?

Scenario Aanbevolen backend

Objectscan, 50–200 foto’s Q1 Apple Photogrammetry

Grote outdoor / drone / 
>500 beelden

Q6 workspace-import (in Metashape of COLMAP berekenen, 
daarna inladen)

Metashape/RealityCaptu
re-export aanwezig

Q6 Import (geen SfM nodig)

ETH3D / academische 
COLMAP-tekstset

Q3 COLMAP-tekstimport

Strikt App-Store-conform 
+ orbit-scène

Q4 Native incrementeel

Q4 faalt Q5 Native globaal (automatisch)

ETH3D-benchmarkgege
vens

Q3 (autotest precomputed)

Snelvergelijking

Bac
kend

App-Store Sand
box

Externe binary Beste ge
bruik

Max 
~cams

Q1 Apple 
PG

✅ ✅ — Orbit-Ob
ject

~300

Q2 COL
MAP Bi

nary

❌ (alleen 
developer-

build)

— colmap/glomap Outdoor 
large

~5.000

Q3 COL
MAP-

tekstim
port

✅ ✅ — Bench rigs ~1.500

Q4 Nati
ve incre
mental

✅ ✅ — Orbit-Ob
ject

~200

Q5 Na
tive glo

baal

✅ ✅ — Q4-fall
back

~1.351

Q6 Workspa
ce-Im
port

✅ ✅ — Metasha
pe-Reuse

per bron
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H O O F D S T U K

Hoofdstuk 10 — Beginnersmodus

De beginnersmodus (Engl. Simple Mode, Cmd+1) is de begeleide workflow voor ieder
een die voor het eerst een 3D-Gaussian-Splatting-scène wil reconstrueren. In plaats 
van een zijbalk vol Inspector-velden te tonen, leidt de app je door vier stappen: eerst 
beelden of een video importeren en een kwaliteitsvoorinstelling kiezen, dan loopt de 
verwerking (SfM + training), vervolgens kan de afgewerkte scène in een 3D-voorbeeld 
worden bekeken, en tot slot wordt geëxporteerd naar het gewenste formaat. Een smalle 
voortgangsbalk aan de bovenrand van het venster toont op elk moment in welke stap 
je bent.

In vergelijking met de Expert-modus (Cmd+2), die alle bedieningsvelden tegelijk toont, 
blendt de beginnersmodus ongebruikte opties uit, geeft validatiewaarschuwingen bij 
te weinig of slechte beelden en biedt op elke stap alleen de knoppen aan die in de 
actuele toestand zinvol zijn. Je kunt op elk moment tussen beginners- en Expert-modus 
wisselen (Cmd+1 / Cmd+2), de gehele toestand — geïmporteerde beelden, gekozen 
voorinstelling, momenteel lopende training, afgewerkte puntenwolk — blijft behouden 
en is in de andere modus meteen beschikbaar.

Z1 — Import (beelden & voorinstelling kiezen)

Afbeelding 35:  Simple-Mode stap 1 — lege drop-zone vóór beeld-import, crumb-trail boven 
(Import → Frame Quality → Cameras → Training → Preview → Export), formaat-pills JPG/

PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP
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WAT DE AFBEELDING TOONT  Crumb-trail (Import actief) toont de vierstaps-workflow. Linker 
drop-zone met drie CTA’s: „Browse Files“ (NSOpenPanel), „Try Sample Scene” (gebun
delde demo), „Download Sample Photos (~427 MB)“ (Mip-NeRF360 flowers subset). 
Formaat-pills daaronder sommen alle geaccepteerde bestandstypen op. Rechts „Impor
ted Files” met teller „0 images“ en empty-state „No files imported yet”. Onderaan 
kwaliteit-picker (default: Preview) en „Start Processing“ (gedeactiveerd zolang geen 
beelden er zijn).

De eerste stap bestaat erin de app beeldmateriaal te geven. Per drag-and-drop in het 
grote gestreepte veld in het midden, per „Browse Files“-knop of per klik op de meege
leverde sample-scène. Rechts verschijnt een lijst van alle geïmporteerde beelden met 
resolutie en bestandsgrootte; onderaan in de zwevende werkbalk kies je het kwaliteits
voorinstelling en start je met „Start Processing” de pipeline. Validatiewaarschuwingen 
(rood bij < 3 of < 10 beelden, oranje bij 10–19) tonen of de app een zinvolle reconstruc
tie verwacht of niet.

C-01 ProgressIndicator (stap-weergave)

WA A R

Boven boven de workflow, altijd zichtbaar.

T E C H N I S C H

Toont een horizontale voortgangsbalk over de gehe
le pipeline (frame-quality → SfM → training) met 
stage-allocatie: frame-quality beslaat 0–5% (fase 
3.11, zeer kort), SfM beslaat 0–30% van de balk, 
training 30–100%. Daarnaast status-tekst en fase-
benoemde procent-weergave („SfM 41%“, „Training 
12.500/20.000”) zodat gebruikers niet de schijnbare 
terugval „41% SfM → 25% Training“ als fout lezen 
— de balk toont de gehele pipeline-voortgang, niet 
de sub-stage. ETA-berekening begint zodra genoeg 
trainings-tempo gemeten is (typisch na de eerste 
100 iteraties). Dezelfde weergave wordt ook in de 
Expert-modus boven de Inspector gebruikt.

E E N VO U D I G  G E Z E G D

De smalle balk helemaal bo
venaan is jouw kaart door de 
workflow. Hij vertelt je niet al
leen wat de app momenteel 
doet (camera’s uitlijnen, training 
loopt, …), maar ook hoe ver hij 
in totaal al is. De verdeling is 
opzettelijk zo dat de camerabe
rekening het eerste derde van 
de balk inneemt en de eigenlijke 
training de achterste twee derde 
— anders zou het lijken alsof 
de voortgang na SfM plotseling 
terug bij nul is. Je kunt dus rus
tig achterover leunen, een blik op 
de balk volstaat om de globale 
etappe te zien. De tekst daar
naast vertelt je of je momenteel 
in de SfM-fase (bijv. „SfM 41%“) 
of in de training (bijv. „Trai
ning 12.500/20.000”) zit, zodat 
de getallen niet verwarrend over
komen. Als je de ETA niet ziet, is 
de training gewoon nog te jong 
— de app schat pas zodra hij ge
noeg tempo gemeten heeft.
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C-03 DropZoneView (drag-and-drop-gebied)

WA A R

Linker kant van de import-stap, groot gestreept 
rechthoek met symbool. Wordt in de beginnersmo
dus met het label „Drop photos or a video here“ 
getoond.

T E C H N I S C H

Drop-gebied dat het symbool kort laat hopen en 
de achtergrond inkleurt, zodra drag-items boven 
het veld zweven. Accepteert JPG, PNG, TIFF, 
HEIC, MP4, MOV, PLY, SPZ, .splat, .radiancescene-
bundles en directories. Drop-routing op type: beel
den worden verzameld en gesorteerd doorgegeven, 
video’s triggeren het frame-sampling-pad, splat-be
standen openen direct het voorbeeld, scene-bund
les worden ingelezen. Directories worden geënume
reerd en alle aanwezige beelden geïmporteerd. Se
curity-scoped bookmarks voor sandbox-conforme 
toegang worden correct opgenomen en vrijgegeven. 
Niet-ondersteunde extensies worden als waarschu
wingsbanner gedurende 5 seconden getoond.

E E N VO U D I G  G E Z E G D

Het grote gestreepte veld is de 
hoofdbediening van de eerste 
stap. Sleep gewoon foto’s of een 
video erin, of een hele map — 
de app neemt alles wat ze kent 
en negeert de rest. Wanneer het 
veld blauw wordt en het sym
bool kort hopt, heeft de app 
de drag herkend. Laat los, en 
de import start direct: beelden 
gaan naar de lijst rechts, video’s 
triggeren automatisch de frame-
sampling-stap, en reeds getrain
de .ply / .spz / .splat  be
standen openen direct het voor
beeld. Mocht een formaat hele
maal niet passen (bijv. PDF of 
BMP), verschijnt een korte hint 
aan de bovenrand — de app slokt 
onbekend materiaal niet stilzwij
gend op.

C-05 Browse Files-knop

WA A R

Binnen de drop-zone, prominente knop.

T E C H N I S C H

Knop die de macOS-bestandsdialoog met meer
voudige selectie en de bestandstypen JPG, PNG, 
TIFF, MP4, MOV, mappen en het app-eigen scene-
formaat opent. Resultaat-URL’s zijn security-scoped 
en worden via dezelfde import-paden doorgeleid 
als drag-and-drop. Wanneer de gebruiker een map 
selecteert, wordt deze recursief op beelden geënu
mereerd.

E E N VO U D I G  G E Z E G D

Mocht drag-and-drop je onge
makkelijk zijn, klik gewoon op 
deze knop en navigeer in de 
macOS-bestandsdialoog naar je 
foto’s. Je kunt meerdere bestan
den tegelijk kiezen (Cmd-klik op 
de afzonderlijke beelden) of een 
hele map selecteren — de app 
doorzoekt de map dan recursief 
naar alle ondersteunde beeldty
pen. Dat is bijzonder praktisch 
wanneer je opnames in genest in 
submappen liggen (bijv. „shoot-
day1/“, „shoot-day2/”) — één klik 
op de hoofdmap volstaat. Functi
oneel doet de knop precies wat 
ook drag-and-drop doet; kies ge
woon de weg die je comfortabe
ler vindt.
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C-06 Try Sample Scene-knop

WA A R

Binnen de drop-zone, alleen zichtbaar wanneer de 
app-bundle de sample-scène bevat en nog geen 
beelden/splats geïmporteerd zijn.

T E C H N I S C H

Verschijnt alleen wanneer (a) een 
sample-scene.splat , .spz  of .ply  in de app-

bundle aanwezig is EN (b) nog geen beelden/video’s 
geïmporteerd en nog geen puntenwolk aanwezig is. 
Bij klik laadt de afgewerkte puntenwolk (bij voorkeur 
het kleinste formaat — .splat  ~3 MB, .spz  ~1,4 
MB, fallback .ply ) en stelt na 400 ms hardgeco
deerde camerawaarden uit de originele metadata 
van de bloemenscène in voor een esthetisch zinvol 
entree-perspectief.

E E N VO U D I G  G E Z E G D

Wanneer je de app voor het eerst 
start en gewoon eens wilt zien 
wat er uiteindelijk uitkomt — klik 
hier. Dat opent een kant-en-klaar 
getrainde bloemenscène die je 
meteen kunt draaien en expor
teren, zonder dat de app moet 
rekenen. De camera is ingesteld 
op een esthetisch zinvol entree-
perspectief, zodat je meteen iets 
moois ziet. Perfect om de 3D-
besturing en de export-stap risi
coloos uit te proberen voordat je 
op eigen opnames losgaat. Zodra 
je eigen beelden importeert, ver
dwijnt de knop automatisch — 
hij wordt alleen getoond zolang 
het project volledig leeg is.

C-07 Download Sample Photos-knop

WA A R

Binnen de drop-zone, naast „Try Sample Scene“; 
zelfde zichtbaarheidsvoorwaarden.

T E C H N I S C H

Triggert een download (repo github.com/​bkindler/​
radiancekit-sample-photos) die ca. 427 MB aan 
960 volresolutie-frames laadt en in de app voedt. 
Tijdens de download wordt de knop gedeactiveerd. 
De voortgang verschijnt in de bovenste progress-
bar als „Downloading X%“ in een eigen stage, om
dat deze stage zijn eigen 0–100%-schaal behoudt 
en niet overlapt met de latere SfM-stage.

E E N VO U D I G  G E Z E G D

Net als de sample-scène, maar 
met de ingangsfoto’s in plaats 
van met het afgewerkte resul
taat. Zo kun je de hele pipeli
ne eens zelf laten doorlopen en 
zien hoe lang SfM en training 
op jouw Mac werkelijk duren. De 
download is groot (ongeveer een 
halve DVD = 427 MB), maar ge
beurt slechts één keer — daarna 
zijn de foto’s lokaal en kun je 
de pipeline naar believen vaak 
met verschillende voorinstellin
gen opnieuw starten. Tijdens de 
download loopt, toont de boven
ste voortgangsbalk de actuele 
downloadstand in procenten, zo
dat je kunt inschatten wanneer 
het van start gaat. Tip: neem 
daarvoor het beste een snelle wi
fi of vast netwerk — de 427 MB 
trekken zich anders door.
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C-09 Quality Presets-picker

WA A R

Zwevende onderste werkbalk van de import-overlay, 
links naast de start-knop.

T E C H N I S C H

Bedieningselement met label „Quality“ groepeert 
de beschikbare voorinstellingen op categorie (Clas
sic / MCMC / Custom). Built-in voorinstellingen wor
den op categorie gegroepeerd; de sectie-headers 
zijn hardgecodeerd. Custom-voorinstellingen alleen 
zichtbaar wanneer er bestaan. Locked-state: voor
instellingen die niet in de free-lijst (Quick + Preview) 

liggen, krijgen een „🔒”-suffix aan de naam wanneer 
de user niet gekocht heeft; bij selectie springt de 
picker terug naar Preview en opent automatisch het 
purchase-sheet. Bij keuze wordt de voorinstelling 
toegepast, wat de gehele trainingsconfiguratie ver
vangt.

E E N VO U D I G  G E Z E G D

Hier kies je hoe nauwkeurig en 
hoe lang de app moet rekenen. 
„Quick“ en „Preview” zijn zon
der aankoop bruikbaar en leve
ren in een paar minuten een 
eerste resultaat — ideaal om te 
testen of je beelden überhaupt 
zinvol zijn. „Balanced“ en „Qua
lity” hebben de volledige versie 
nodig en leveren duidelijk scho
nere modellen, duren echter uren 
in plaats van minuten. MCMC 
is een andere strategie die met 
minder Gauss-splats toekomt — 
goed als je het model later com
pact wilt exporteren of op het 
web wilt zetten. Premium-voorin
stellingen herken je aan het klei
ne slot-symbool naast de naam; 
tik je er een aan zonder li
centie, springt de picker terug 
op Preview en het koop-sheet 
opent zich automatisch. Vuistre
gel: start altijd met Preview, be
kijk het resultaat, en beslis dan 
of een langere run loont.

C-10 Start Processing-knop

WA A R

Zwevende onderste werkbalk van de import-overlay, 
rechts naast de voorinstelling-picker.

T E C H N I S C H

Knop die grijs blijft zolang noch beelden noch een 
video geïmporteerd zijn. Bij klik start de pipeline 
en schakelt de stage-machine in de volgorde fra
me-quality → SfM → training om. De knop zelf 
heeft geen verdere status; een lopende verwerking 
verschijnt in plaats daarvan als apart verwerkings
scherm.

E E N VO U D I G  G E Z E G D

De „aan-de-slag“-knop. Zolang 
hij grijs is, ontbreken nog in
voerbeelden of een video. Zodra 
je foto’s binnengetrokken hebt, 
wordt hij actief en klik je erop 
om SfM en training na elkaar 
te starten. Vanaf daar neemt de 
app het gehele verloop over en 
land je automatisch op het ver
werkingsscherm (Z2). Je hoeft 
niets verder te klikken — pas na 
het einde van de training wisselt 
de app weer naar het voorbeeld 
(Z3). Mocht je je toch nog anders 
bedenken, kun je ook daarna nog 
op elk moment via Cancel afbre
ken.
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C-11 Video Sampling-slider

WA A R

Rechter beeldlijst, alleen zichtbaar wanneer een vi
deo (in plaats van beelden) geïmporteerd werd.

T E C H N I S C H

Schuifregelaar 0,5 fps – 30 fps in stappen van 
0,5. Bij wijziging wordt de frame-dichtheid geactua
liseerd en bovendien het aantal target-frames (min
stens 10) uit dichtheid en videolengte berekend. De 
schuifregelaar ligt buiten de beeldlijst, omdat lijst-
elementen muis-events van schuifregelaars zouden 
blokkeren. Onder de schuifregelaar staan de bere
kende target-frames („247 frames“) en de video
lengte („1m23s video”). Tooltip waarschuwt: „Dou
bling the density doubles the number of frames and 
increases SfM time by ~100%.“

E E N VO U D I G  G E Z E G D

Wanneer je in plaats van foto’s 
een video hebt geïmporteerd, be
slist deze schuifregelaar hoeveel 
afzonderlijke beelden de app uit 
de video moet halen. Meer beel
den = betere kwaliteit, maar line
air meer rekentijd. Voor een 30-
seconden-orbit-video zijn 5 fps 
(150 beelden) een goede start; 
bij 1-minuten-opnames volstaat 
vaak 3 fps volledig. Onder de re
gelaar toont de app live hoeveel 
frames bij de actuele instelling 
eruit komen — zo zie je meteen 
of je in het zinvolle bereik van 
ongeveer 100–300 beelden treft. 
Mocht het resultaat slecht wor
den, trek de regelaar naar rechts 
en probeer het opnieuw; het ver
dubbelen van de framerate ver
dubbelt echter grofweg ook de 
SfM-duur.

C-12 Clear All-knop

WA A R

Rechter beeldlijst, rechtsonder; alleen zichtbaar 
wanneer beelden geïmporteerd zijn.

T E C H N I S C H

Rode knop. Klik opent een bevestigingsdialoog met 
titel „Clear all imported files?“ en boodschap „N 
images will be removed.”. Bevestiging leegt alle 
geïmporteerde beelden/video’s, staging-directories, 
de puntenwolk, de trainings-status, het SfM-resul
taat en alle caches; de stage springt terug naar 
Import. Bij Cancel blijft alles behouden. De dialoog 
is als destructie-vrije default-pad geconfigureerd 
(destructieve knop rood gemarkeerd).

E E N VO U D I G  G E Z E G D

Wanneer je helemaal opnieuw 
wilt beginnen, klik hier. De be
vestigingsvraag verschijnt omdat 
het wissen alle actuele imports 
inclusief eventueel reeds bere
kende camera’s en trainingsre
sultaten verwerpt — je kunt 
het niet ongedaan maken. Zinvol 
wanneer je het gekozen beeld
materiaal volledig wilt uitwisse
len of een oud project wilt kwijt
raken voordat je een nieuw start. 
Let op: een afzonderlijk beeld er
uit nemen gaat via de lijst rechts 
(zie volgende punt), niet via deze 
knop. Je bestanden op de harde 
schijf worden daarbij niet verwij
derd — de app vergeet alleen zijn 
referenties.
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C-13 File List ForEach (afzonderlijke beeld verwijderen)

WA A R

Rechter beeldlijst, elk item.

T E C H N I S C H

Lijst over de geïmporteerde beelden met swipe-om-
te-verwijderen. Per beeld een regel met icoon, be
standsnaam, resolutie („1920 × 1080″) en bestands
grootte (geformatteerd KB/MB). Resolutie komt uit 
een metadata-cache die asynchroon uit de beeld-
headers wordt gevuld, zodat de interface niet 
blokkeert. De verwijder-actie biedt macOS-typische 
swipe-delete (trackpad-swipe links op een regel) 
plus toetsenbord-delete bij geselecteerde regel. 
Opmerking: het uitgebreide image-delete-pad met 
expliciete min-knop, backspace en Cmd-Z om on
gedaan te maken werd alleen in de Expert-modus 
in de Project Navigator toegevoegd — in de begin
nersmodus blijft het bij swipe-delete.

E E N VO U D I G  G E Z E G D

De lijst rechts toont elk geïm
porteerd beeld met resolutie en 
bestandsgrootte — praktisch om 
in één oogopslag te zien of je ge
mengd hoog-resolutie met laag-
resolutie materiaal hebt door el
kaar gegooid. Om een afzonder
lijk beeld eruit te nemen, swi
pe het met twee vingers naar 
links op het trackpad — zoals 
in iOS Mail — of selecteer het 
en druk op delete. De app verwij
dert het bestand zelf niet; het 
haalt het alleen uit het actuele 
project. Mocht je een echte min-
knop of Cmd-Z-ongedaan nodig 
hebben, wissel naar de Expert-
modus (Cmd+2), daar is het in 
de Project Navigator. In de begin
nersmodus blijft het bewust bij 
het eenvoudige swipe-patroon.
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C-15 Validation Warnings (3-traps-tier)

WA A R

Onder de beeldlijst, boven de Clear-All-knop.

T E C H N I S C H

Drie opeenvolgende drempels gebaseerd op het 
aantal geïmporteerde beelden (alleen actief wan
neer beelden aanwezig en geen video): - < 3 beel
den: rode banner (red octagon), tekst „At least 3 
images are required. Camera alignment cannot be 
computed from fewer images.“ - 3–9 beelden: rode 
banner, tekst „With fewer than 10 images, SfM often 
fails and the trained scene tends to overfit […]. 15–
20 images minimum recommended; 30+ for object 
captures.” - 10–19 beelden: oranje banner (warning 
triangle), tekst „Workable, but quality usually impro
ves with 20+ images and good coverage around the 
scene.“

Vanaf 20 beelden verdwijnt de banner. Drempel
waarden zijn hardgecodeerd en gebaseerd op empi
rische 560+ trainingsexperimenten.

E E N VO U D I G  G E Z E G D

De app bekijkt hoeveel beelden 
je hebt geïmporteerd en geeft je 
een gekleurde inschatting. Rood 
betekent: dat gaat met hoge 
waarschijnlijkheid niets worden 
— ofwel kan SfM geen camera’s 
berekenen ofwel het training 
overfit op te weinig materiaal. 
Oranje betekent: zou kunnen luk
ken, maar reken niet op top-kwa
liteit, omdat het algoritme tussen 
de beelden weinig overlap vindt. 
Geen banner betekent: goede 
voorwaarden, je hebt genoeg ma
teriaal. Wanneer je echt scho
ne modellen wilt, mik op min
stens 30–50 gelijkmatig verdeel
de opnames rond je onderwerp 
— gerust ook duidelijk meer bij 
buitenscènes of grote ruimtes. 
Je kunt ondanks waarschuwing 
starten, maar wees niet verbaasd 
wanneer SfM commentaarloos 
afbreekt of het model gatig oogt.
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C-16 COLMAP Workspace Detection

WA A R

Bij drop van een map — geen zichtbare knop, maar 
herkennings-logica.

T E C H N I S C H

Bij drop van een directory wordt gecontroleerd 
of daarin een van de drie canonieke workspace-
layouts aanwezig is: sparse/​0/​cameras.bin, sparse/​
cameras.bin of direct cameras.bin  in de root. 
Trefft dat toe, wordt de standaard-beeld-enumera
tie afgebroken en in plaats daarvan een modale 
alert geopend die de user vraagt of de bestaande 
reconstructie moet worden gebruikt of de beelden 
opnieuw door Apple Photogrammetry moeten wor
den gestuurd. Zelfde pad ook voor tekstformaat-
workspaces (cameras.txt) en ETH3D-exports. Zie 
hoofdstuk 9 backend Q6 voor details. Werkt in de 
beginnersmodus net als in de Expert-modus.

E E N VO U D I G  G E Z E G D

Mocht je al eens met Metashape, 
RealityCapture of COLMAP ge
werkt hebben en daar de came
raberekening al hebt laten lopen, 
kun je de exportmap gewoon 
hier naar binnen slepen. Radian
ceKit herkent aan de inhoud au
tomatisch dat het een COLMAP-
workspace is (het controleert 
op sparse/​0/​, cameras.bin  
enz.), en vraagt je of het de af
gewerkte berekening moet over
nemen of zelf opnieuw moet be
rekenen. Overnemen spaart bij 
grote scènes uren wachttijd, om
dat SfM volledig wordt overge
slagen — het training start met
een. Ook tekstformaat-workspa
ces (cameras.txt) en ETH3D-
exports worden herkend. Deze 
functie is in de beginnersmodus 
net als in de Expert-modus be
schikbaar; meer details staan in 
hoofdstuk 9 onder backend Q6.

Wanneer naar de volgende trap?

Je kunt op Start Processing klikken zodra (a) minstens één beeld of een video geïmpor
teerd is en (b) de validatie-banner oranje of verdwenen is. Bij rode banner laat de app je 
weliswaar toch starten, maar je kunt met hoge waarschijnlijkheid de verwerking meteen 
weer afbreken. Aanbevolen: minstens 20 beelden, scherp, met duidelijke overlap tussen 
opeenvolgende opnames, alle vanuit ongeveer dezelfde afstand tot het onderwerp. Kies 
vóór de start een voorinstelling die bij je tijdsbudget past — bij 30 beelden en Quick-
voorinstelling ben je in een paar minuten klaar, bij Quality duurt het eerder 1–2 uur.
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Z2 — Verwerking (SfM + training)

Afbeelding 36:  Z2 SfM-fase — stage-icoon „Structure from Motion“ met 41% in de grote 
cirkel, bovenste statusbalk bij „SfM 25%”, Cancel-knop rechtsonder

SfM-fase (camera’s worden uitgelijnd): Grote voortgangscirkel toont sub-stage-pro
gress (hier 41% van de lopende Apple-Photogrammetry-sessie). Status-tekst „Aligning 
cameras…“ linksboven. Crumb-trail markeert „Cameras” als actieve trap. Bovenste sta
tusbalk toont pipeline-totaalprogress (25%) — SfM beslaat de eerste helft van de 
balk. Zwevende wireframe-camera’s op de achtergrond duiden aan dat poses worden 
geschat.

Afbeelding 37:  Z2 trainingsfase — stage-icoon „Training Gaussians“ met 6%, live-metrics 
boven (Training: 400/5000 — Loss: 0,1642 — 138,7 it/s), ETA 33s, Pause/Cancel onder

Trainingsfase (Gaussians worden geoptimaliseerd): Sub-stage-icoon wisselt naar 
„Training Gaussians“, procent telt iteraties van de gekozen voorinstelling (hier 400 / 
5.000 voor Preview-voorinstelling = 8% van de stage). Live-metric-regel toont loss-
waarde (0,1642), iteraties-per-seconde (138,7 it/s) en ETA (33 s). Pipeline-totaalpro

213 / 230



R A D I A N C E K I T Hoofdstuk 10 — Beginnersmodus

gress klimt van 50% tot 100% gedurende deze fase. Pause-knop (in plaats van Cancel-
Only in SfM-fase) staat resume later toe; Cancel verwerpt het trainingsresultaat en 
keert terug naar Z1.

Zodra de pipeline loopt, blendt de app de import-overlay uit en toont een vlak-vullend 
verwerkingsscherm. In het midden loopt een grote voortgangscirkel (220 × 220 pixels) 
met stage-icoon, status-tekst en procent-getal; op de achtergrond visualiseert een 
discrete splat-animatie symbolisch de lopende berekening. Linksboven kan een info-
paneel worden ingeschakeld dat live-metrics uit training en SfM toont. Onderaan zijn 
Pause/Resume, Cancel en bij foutgevallen een retry-knop.

C-18 SplatTrainingView (achtergrond-animatie)

WA A R

Vlak-vullende achtergrond achter de voortgangscir
kel, uitgeblend bij annulering of fout.

T E C H N I S C H

Decoratieve animatie die afhankelijk van pipeline-
voortgang (0…1) een toenemend aantal kleine gea
nimeerde splat-deeltjes rendert. De bron is een be
rekende voortgangswaarde die SfM-fasen op 0–0,2 
afbeeldt en training op 0,2–1,0 (frame-quality op 0–
0,05). Daarmee „bouwen“ de splats zich zichtbaar 
op terwijl de training loopt. Uitsluitend decoratief 
— de weergave toont geen echte tussenresultaten 
van de actuele training (dat zou live-preview in de 
Expert-modus zijn). Bij annulering of failure wordt zij 
uitgeblend en alleen de status-cirkel blijft zichtbaar.

E E N VO U D I G  G E Z E G D

Op de achtergrond loopt een klei
ne animatie uit dansende punten 
zodat het scherm niet zo leeg 
oogt tijdens de berekening. Dat 
is niet je echte 3D-model — 
dat zie je pas na de training in 
stap Z3. De animatie heeft ech
ter dezelfde toonkleur, zodat je 
aan de ongeveer dichtheidsgraad 
kunt aflezen hoe ver de training 
gevorderd is. In het begin zijn 
slechts weinig punten zichtbaar, 
tegen het einde vult de ach
tergrond zich duidelijk dichter 
— een mooie visuele indicator 
naast de procent-weergave in de 
cirkel. Mocht de animatie je sto
ren (bijv. omdat je op de achter
grond ernaast wilt werken), kun 
je naar de Expert-modus wisse
len waar zij wegvalt.

214 / 230



R A D I A N C E K I T Hoofdstuk 10 — Beginnersmodus

C-19 Grote progress-cirkel

WA A R

Centraal op het verwerkingsscherm, 220 × 220 
pixels.

T E C H N I S C H

Twee over elkaar gerenderde ringen: buiten een 
gedempte track-ring, binnen een gevulde voort
gangsring met accent- of rode stroke (rood bij 
fout). Binnen de cirkel een stage-icoon (brein voor 
training, camera voor SfM, film voor video-frame-
extractie, sparkles voor frame-quality), stage-titel 
en het live geanimeerde procent-getal in 32-punt-
rounded-font. Het icoon pulseert zacht zolang de 
verwerking actief is. De weergave interpoleert op 
een 30-Hz-timer zacht in de richting van de actue
le echte voortgang — met constant-creep (0,0003/
frame) plus proportional-aandeel (4% van de gap) 
en een soft-ceiling dat op 80% van de volgende 
verwachte milestone zet (voor SfM uit een hardge
codeerde milestone-tabel). Zo lijkt de voortgang 
vloeiend, zelfs wanneer de echte SfM-updates pas 
elke paar seconden binnenkomen.

E E N VO U D I G  G E Z E G D

De grote cirkel in het midden is 
je hoofdaanzicht terwijl de app 
rekent. Hij vult zich zacht, zelfs 
als de echte berekenings-upda
tes pas elke paar seconden ko
men — dat geeft je het gevoel 
dat er iets gebeurt, in plaats van 
minutenlang naar een bevroren 
procent te staren. Het symbool in 
het midden wisselt, afhankelijk 
van of momenteel frames wor
den geëxtraheerd (film-icoon), 
camera’s worden uitgelijnd (ca
mera-icoon), of Gaussians wor
den getraind (brein-icoon). Het 
procent-getal heeft betrekking 
op de actuele deelstap — de ge
hele pipeline zie je in de smalle 
balk helemaal bovenaan. Bij een 
fout kleurt de ring rood in plaats 
van blauw, en het icoon pulseert 
niet meer, zodat je meteen merkt 
dat er iets mis is gegaan.

C-22 Info-knop (metrics inblenden)

WA A R

Linksboven op het verwerkingsscherm, 32 × 32 
pixels.

T E C H N I S C H

Simpele knop met material-achtergrond. Schakelt 
het info-paneel in of uit. Icoon wisselt tussen info-
cirkel-outline en info-cirkel-gevuld wanneer actief. 
Zachte fade-animatie. In de tooltip „Show detailed 
processing metrics“.

E E N VO U D I G  G E Z E G D

Standaard is het scherm bewust 
opgeruimd — alleen de grote 
voortgangscirkel, meer zie je in 
eerste instantie niet. Wanneer 
je als technisch geïnteresseer
de gebruiker preciezer wilt we
ten wat er gebeurt (welke itera
tie, hoe hoog de loss, hoeveel 
Gaussians), klik op het i-sym
bool linksboven. Een klein paneel 
klapt onderaan open en toont al
le live-waarden. Een nieuwe klik 
blendt het weer uit. De instel
ling is niet persistent — bij 
elke nieuwe trainingsrun is het 
paneel aanvankelijk weer uitge
blend, wat bewust zo gekozen is 
om beginners niet af te schrik
ken.

215 / 230



R A D I A N C E K I T Hoofdstuk 10 — Beginnersmodus

C-23 Info-paneel (live-metrics)

WA A R

Linksonder op het verwerkingsscherm, alleen zicht
baar wanneer showProcessingInfo == true.

T E C H N I S C H

Twee-kolommen paneel met ultra-thin-material-
achtergrond. Linker kolom: stage-specifieke info-
regels — voor SfM status-tekst en procent; voor 
training iteratie, gecombineerde loss, L1-loss, D-
SSIM-loss, Gaussian-count (oranje gekleurd), speed 
(it/s), elapsed-time, berekende ETA, SH-graad en 
learning-rate. Rechter kolom: status-tekst, time-in
fo-string, inline loss-chart (zie C-28) en een disco
verability-nudge (zie C-32). Alle waarden worden uit 
de trainings-status gelezen die bij elke trainings-
tick wordt geactualiseerd.

E E N VO U D I G  G E Z E G D

Het info-paneel toont alle live-
waarden die in de Expert-modus 
permanent in de Inspector-zij
balk zouden staan: actuele ite
ratie, loss-waarde (kleiner = be
ter), aantal Gaussians, snelheid, 
geschatte resttijd, SH-graad en 
learning-rate. Op de rechterkant 
loopt bovendien een piepkleine 
loss-curve mee, die je in één 
oogopslag verraadt of de trai
ning in de juiste richting loopt. 
Wanneer de training stroef oogt, 
helpt een blik hier — een loss 
die niet meer valt, of een ETA die 
niet meer daalt, wijst op proble
men. Wanneer de loss explodeert 
(plotseling reusachtig wordt) of 
NaN toont, is de training insta
biel geworden en een Cancel + 
Retry of overstap op een andere 
voorinstelling is zinvol.

C-25 Pause/Resume-knop

WA A R

Onderste navigatiebalk, alleen zichtbaar tijdens de 
trainingsfase (NIET tijdens SfM) en zolang de ver
werking loopt.

T E C H N I S C H

Bordered button. Roept afhankelijk van status Pause 
of Resume aan. Label wisselt tussen „Pause“ (met 
pause-icoon) en „Resume” (play-icoon). Tijdens de 
SfM-stap wordt de knop niet getoond, omdat Apple 
Photogrammetry geen pause-semantiek kent. De 
pause-toestand behoudt iteratie, Gaussian-status 
en optimizer-momentum volledig — Resume gaat 
verder waar eerder werd gestopt.

E E N VO U D I G  G E Z E G D

Terwijl de training loopt, kun je 
hem op elk moment stoppen en 
later voortzetten. Zinvol wanneer 
je tussendoor iets anders op de 
Mac wilt doen dat veel GPU no
dig heeft — bijv. videoschnit, ga
metest of een render-export uit 
een andere app. Klik Pause, doe 
je ding, klik Resume, de training 
loopt precies daar verder waar 
hij was. Iteratie-teller, Gaussian-
aantal en optimizer-momentum 
blijven daarbij volledig behou
den, de pause-state kost je niets 
aan kwaliteit. Tijdens de SfM-
fase is Pause niet beschikbaar 
— Apple Photogrammetry kent 
geen ophoud-functie, daar moet 
je in noodgeval met Cancel wer
ken.
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C-26 Cancel-knop

WA A R

Onderste navigatiebalk, zichtbaar terwijl de verwer
king loopt (SfM of training).

T E C H N I S C H

Rode bordered-button. Opent een bevestigingsdi
aloog met titel „Stop and discard progress?“, knop
pen „Discard Progress” (destructief) en „Keep Run
ning“ (Cancel). Bij bevestiging wordt het cancel-flag 
gezet, de trainings-task beëindigd, het SfM-subpro
ces indien nodig beëindigd en een summary-regel 
met annulerings-status in het JSONL-log geschre
ven. In tegenstelling tot Pause worden trainings-
buffer en status verworpen.

E E N VO U D I G  G E Z E G D

De annuleer-knop. In tegenstel
ling tot Pause is dat definitief — 
mocht je daarna opnieuw willen 
starten, loopt de verwerking van 
voren af aan, alle reeds getrain
de iteraties zijn verloren. Zinvol 
mocht je je in de voorinstelling 
vergist hebben, de training veel 
te langzaam loopt, of de app 
duidelijk vuilnis-resultaten pro
duceert en je niet wilt wachten. 
Vóór de daadwerkelijke annule
ring vraagt de app via een be
vestigingsdialoog nogmaals na, 
zodat je niet uit ongeluk uren re
kentijd verliest. Mocht je alleen 
kort onderbreken willen, neem 
liever Pause.

C-27 Retry-knop

WA A R

Onderste navigatiebalk, zichtbaar wanneer de pipe
line gefaald is (SfM-status start met „SfM failed“ of 
training in foutstand is).

T E C H N I S C H

Accent-knop. Start de gehele pipeline opnieuw. 
Vóór de start wordt gecontroleerd of er nog ge
ïmporteerde beelden/video’s aanwezig zijn. Eerdere 
foutlogs blijven in de JSONL-directory behouden; 
een nieuwe run schrijft een nieuwe logbestand met 
actuele timestamp.

E E N VO U D I G  G E Z E G D

Mocht SfM of training met een 
foutmelding afbreken, kun je het 
hier opnieuw proberen. Soms 
helpt dat omdat veel stappen 
(RANSAC, densification) toevals
aandelen hebben en een tweede 
aanloop kan slagen waar de eer
ste faalde. De gehele pipeline 
loopt dan opnieuw van voren af 
aan — SfM en training, in een 
verse JSONL-logbestand. Mocht 
ook de tweede poging mislukken, 
zijn meestal de invoerbeelden 
het probleem (te weinig, te wei
nig overlap, bewegingsonscherp
te, slecht licht); ga dan terug 
met Back en wissel je materiaal. 
Tip: kijk parallel in de training-
logs (Help → Open Training Logs), 
daar staat gedetailleerder waar 
het concreet vasthing.
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C-28 Inline loss-chart

WA A R

In het info-paneel, rechter kolom, alleen zichtbaar 
tijdens training met niet-lege history-geschiedenis.

T E C H N I S C H

Compact tekengebied (40 pixels hoog), tekent de 
loss-history als 1-pixel-lijn in accentkleur. Data 
wordt op eindige waarden gefilterd (NaN-bescher
ming voor onstabiele trainingen). Min/max worden 
over de gehele history berekend — het chart auto-
zoomt dus naar het waardebereik. De laatste loss-
waarde staat rechtsboven boven het chart. De his
tory zelf wordt in de app-toestand bij elke trainings-
tick opgebouwd (typisch elke 100 iteraties).

E E N VO U D I G  G E Z E G D

Een piepkleine loss-curve die je 
in één oogopslag toont of de trai
ning „convergeert“ (lijn valt naar 
rechts) of dat hij vastzit of explo
deert (lijn vlak of stijgt). Bij een 
gezonde training valt de lijn in 
het begin steil en vlakt dan af 
— dat is het verwachte verloop, 
vergelijkbaar met een halvering-
curve. Het chart zoomt automa
tisch op het actuele waardebe
reik, zodat ook kleine verbeterin
gen aan het einde van de trai
ning zichtbaar blijven. Wanneer 
de lijn plotseling omhoog schiet 
of vastloopt, is dat een goed sig
naal dat er iets mis loopt — ofwel 
het materiaal is problematisch 
ofwel een andere voorinstelling 
zou beter geschikt zijn. Het chart 
vind je in het info-paneel, dat je 
linksboven met het i-symbool in
blendt.
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C-32 Discoverability-nudge (Expert-Mode-hint)

WA A R

In het info-paneel, rechter kolom onder, alleen 
zichtbaar tijdens training EN in de beginnersmodus.

T E C H N I S C H

Kleine regel met oog-icoon en caption-tekst „Switch 
to Expert Mode (⌘2) for live splat preview“, in 
terughoudende toon en 10-punt-schrift. Geen inter
actief element, alleen hint. Reageert niet op klik — 
de user moet daadwerkelijk Cmd+2 drukken of het 
menu Mode → Expert Mode aanklikken.

E E N VO U D I G  G E Z E G D

Een discrete hint dat in de Ex
pert-modus tijdens de training 
de actuele tussenversie van je 
3D-model live in het viewport 
te zien is. In de beginnersmo
dus wordt dat opzettelijk uitge
blend om de interface rustig te 
houden — maar veel users we
ten helemaal niet dat deze func
tie bestaat, dus wijzen we hier 
zacht erop. Druk Cmd+2 en het 
training loopt op de achtergrond 
verder, terwijl je kunt toekijken 
hoe je model voor je ogen tot 
stand komt. Dat is ook een goed 
gereedschap om al na een paar 
duizend iteraties in te schatten 
of het resultaat iets wordt of dat 
je liever afbreekt en opnieuw be
gint. Cmd+1 brengt je op elk mo
ment weer terug naar het begin
ners-aanzicht.

Wanneer naar de volgende trap?

De app wisselt automatisch naar Z3 (voorbeeld), zodra de training succesvol is voltooid 
— je hoeft niets te klikken. De onderste navigatiebalk wisselt dan van Pause/Cancel naar 
een Back-knop (terug naar Import) en een Export-knop (vooruit naar Export). In het 
foutgeval (rode foutmelding, stage-icoon is X) verschijnt in plaats daarvan Retry, en je 
moet beslissen of je opnieuw start of met Back terug naar Import gaat om beeldmate
riaal te wijzigen.
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Z3 — Voorbeeld (3D-model draaien)

Afbeelding 38:  Simple-Mode preview-stap met 3D-viewer

Afbeelding 39:  Z3 preview na trainingseinde — Blender-bouquet gereconstrueerd, header 
toont „Training complete — 3.022 Gaussians in 13s“, Back- en Export-knoppen onder

WAT DE AFBEELDING TOONT  Crumb-trail markeert „Preview“ als actieve trap. Vlak-vullend 
3D-viewport rendert de kant-en-klaar getrainde bouquet-scène (synthetische Blender-
testset, 60-frame-subset uit 960 hemisferische cams). Header-statusbalk: „Training 
complete — 3.022 Gaussians in 13 s” — geeft finaal Gaussian-aantal en trainingstijd. 
Drag in het viewport roteert de camera (yaw/pitch); scroll-wheel zoomt langs de 
view-direction. „Back“-knop (linksonder) keert terug naar Z2 voor resume of re-run; 
„Export”-knop (rechtsonder, primary) navigeert verder naar Z4.

Na voltooiing van het training landt de app automatisch in het voorbeeld. Hier zie je je 
afgewerkte Gaussian-Splatting-model in een fullscreen-Metal-weergave en kun je het 
met muis en trackpad draaien, zoomen en pannen. Aan de bovenkant van het viewport 
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ligt een kleine overlay met camerabesturing en info — auto-rotatie, trainings-statistiek, 
reset-knop. Vóór de volgende stap (export) loont het, het model uit verschillende hoe
ken te controleren, om er zeker van te zijn dat de reconstructie schoon is.

C-36 SplatViewportView (3D-hoofdaanzicht)

WA A R

Fullscreen-achtergrond van de preview-stap.

T E C H N I S C H

Metal-gebaseerd 3D-viewport dat de afgewerkte 
puntenwolk rendert. De renderer is RadianceKits 
EIGEN ForwardPass-rasterizer — dezelfde die de 
splats ook al tijdens de training rendert — dus is het 
echte WYSIWYG (wat getraind wordt, wordt exact 
zo getoond en geëxporteerd). Tile-gebaseerde ren
dering-pipeline met order-independent transparen
cy. Wanneer de renderer niet kan worden geïniti
aliseerd (bijv. omdat Metal op het systeem niet 
beschikbaar is), verschijnt in plaats daarvan een 
zwarte achtergrond met „Metal not available“-tekst. 
De weergave negeert de safe-area, zodat het model 
tot aan de vensterkant reikt.

E E N VO U D I G  G E Z E G D

Het hoofdviewport. Hier zie je je 
afgewerkte 3D-model uit je foto’s 
gereconstrueerd, gerenderd op 
de GPU in realtime. Klik en sleep 
met de linker muisknop om te 
roteren. Scrollwheel of trackpad-
gebaar met twee vingers om te 
zoomen. Rechter muisknop of 
Cmd+drag om te pannen. Het 
model bestaat uit tien-duizen
den semi-transparante 3D-ellip
soïden („Gaussians“) die je scè
ne fotorealistisch reconstrueren 
— elke afzonderlijke heeft een 
positie, oriëntatie, vorm en kleur 
die het training heeft geleerd. In 
het zeldzame geval dat je Mac 
geen Metal ondersteunt, zie je in 
plaats daarvan een zwarte ach
tergrond met een hint-bericht — 
RadianceKit heeft dwingend een 
Metal-fähige GPU nodig.
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C-37 CameraControlsOverlay (besturings-overlay)

WA A R

Boven het viewport, zwevend.

T E C H N I S C H

Compacte UI-overlay met knoppen voor auto-rota
tie (turntable), reset-camera, achtergrond-selectie 
(Gray/Black/White), save-screenshot, toggle-info-
paneel. Bindt aan de camera-parameters (afstand, 
azimut, elevation, target, FOV) en stuurt het auto-
turntable. Tijdens de training (wanneer de user in 
de Expert-modus het viewport wil meelopen zien) 
toont de overlay aanvullend een compacte trai
nings-statusregel.

E E N VO U D I G  G E Z E G D

De kleine zwevende balk boven 
het model. Hier start je de auto-
rotatie (het model draait vanzelf, 
goed voor screenshots en korte 
demo’s), reset je de camera op 
de beginpositie (mocht je ver
dwaald zijn), wissel je de achter
grond (grijs voor neutraal, zwart 
voor maximaal contrast, wit voor 
lichte modellen), en maak je di
rect screenshots die onder  /Pic
tures worden opgeslagen. Prak
tisch wanneer je een bepaald 
detail vanuit een heel bepaalde 
hoek wilt tonen, zonder extra het 
hele model te exporteren. De au
to-rotatie is ook een goede test 
of het model vanuit alle kanten 
even goed oogt of dat er een 
„vuile kant“ is, ontstaan door 
ontbrekende opnames.

C-38 Export-knop (navigatiebalk)

WA A R

Onderste navigatiebalk in Z3.

T E C H N I S C H

Accent-knop met label „Export“ en share-icoon. Klik 
triggert de wissel naar Z4. Vooraf controleert de 
bovenliggende weergave of de volledige versie is 
ontgrendeld — mocht niet, wordt in plaats van de 
export-bühne het lock-aanzicht getoond (zie U-06).

E E N VO U D I G  G E Z E G D

Mocht je met het resultaat te
vreden zijn, klik Export en je 
belandt in de laatste stap waar 
je het formaat kiest en opslaat. 
Zonder gekochte volledige ver
sie beland je in plaats daarvan 
op een schermlock met unlock-
hint en koop-knop — de app wil 
je geen volledige versie in de 
schoenen schuiven, maar de ex
port is een van de premium-fea
tures. Zodra je de aankoop hebt 
afgerond, loopt de app direct in 
de ontgrendelde toestand verder 
en land je in de gewenste ex
port-bühne. Mocht je je toch nog 
anders bedenken, kom je via de 
Back-knop weer in het voorbeeld 
en kun je verder aan het model 
draaien.
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Wanneer naar de volgende trap?

Voordat je exporteert, draai het model eens helemaal rond en controleer: zijn alle gebie
den die je in je invoerbeelden hebt afgedekt aanwezig? Zijn er zwevende „floaters“ (vrij 
in de lucht zwevende Gauss-splat-wolken)? Oogt de achtergrond/hemel schoon of 
versmeerd? Zware problemen kunnen alleen door her-training worden gefixt — ofwel 
met meer beelden, andere voorinstelling, of in de Expert-modus met floater-reduction-
instellingen.

Z4 — Export (formaat kiezen & opslaan)

Afbeelding 40:  Simple-Mode export-stap met formaat-kaarten

Afbeelding 41:  Z4 export-kaarten — 6 formaten (PLY 742 KB geselecteerd, SPZ 74 KB, glTF 
708 KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB), export-history-zijbalk rechts met 

reeds geëxporteerde PLY
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WAT DE AFBEELDING TOONT  Crumb-trail markeert „Export“ als actieve trap. Linker kaarten-
grid „Choose Export Format” met alle zes opties: PLY (standaard-3DGS, 742 KB, met 
volle SH-coëfficiënten — hier voorgeselecteerd met blauw vinkje), SPZ (gecomprimeerd 
3DGS-formaat, ~90% kleiner dan PLY, 74 KB), glTF (met KHR_​gaussian_​splatting-
extension, 708 KB), .splat (web-viewer-compatibel via antimatter15, 96 KB), Orbit Video 
(360°-MP4 van de scène, live groottelijke berekening), Web Viewer (zelfstandig HTML 
met ingebedde 3D-viewer, 133 KB). Groottelijke aanduidingen worden live uit het actue
le Gaussian-count en formaat-overhead berekend. Rechts „Export History“ somt reeds 
voltooide exports op met formaat-pill, bestandsnaam en timestamp — klik reveals in 
Finder. Primary-CTA linksonder: „Export PLY (3DGS Standard)” met Gaussian-subtitle 
„2.991 Gaussians · SH degree 3″.

In de laatste stap kies je uit 6 export-formaten (PLY, SPZ, glTF, .splat, orbit-video, 
web-viewer) per 2-kolommen kaarten-grid, klik je Export en kies je opslaglocatie in de 
macOS-dialoog. Rechts loopt een history van alle voorgaande exports — bij de kaarten-
keuze wordt onder elke kaart meteen de geschatte bestandsgrootte getoond, zodat je 
bijv. SPZ verkiest mocht je naar het web willen (klein), en PLY mocht je in een andere 
software (SuperSplat, Postshot, Blender via plug-in) willen importeren (groot en volle
dig).

C-39 2-Column Format Grid

WA A R

Linker hoofdpagina van de export-stap.

T E C H N I S C H

Kaarten-raster met twee flexibele kolommen en 12 
punt afstand. Itereert over de in de beginnersmo
dus aangeboden formaten — een gefilterde deelver
zameling van de volle formatlijst die alleen de 6 
belangrijkste formaten bevat: PLY, SPZ, glTF, .splat, 
orbit-video, web-viewer. Compressed-PLY en SOG 
worden ALLEEN in de Expert-modus aangeboden.

E E N VO U D I G  G E Z E G D

Een kaarten-raster met de 6 for
maten die in de beginnersmodus 
relevant zijn: PLY (standaardfor
maat voor andere 3D-tools), SPZ 
(gecomprimeerde variant voor 
web), glTF (officiële web3D-stan
daard), .splat (voor antimatter15-
web-viewer), orbit-video (klaar 
MP4 om te tonen), en Web Viewer 
(zelfstandig HTML-bestand met 
ingebedde 3D-player). Daarmee 
dek je 90% van de toepassings
gevallen af. Mocht je een van de 
minder gangbare formaten nodig 
hebben (Compressed-PLY of SOG 
voor extreme compressie), wissel 
naar de Expert-modus, daar zijn 
alle 8 formaten beschikbaar. De 
compacte selectie hier is opzet
telijk, zodat beginners niet door 
de variëteit overweldigd raken.
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C-40 Format Card-knop

WA A R

Elke kaart in het grid.

T E C H N I S C H

Simpele knop met kaart-layout: icoon (bijv. docu
ment-zipper voor PLY, archiefdoos voor SPZ, video-
icoon voor orbit-video) boven, formaat-naam als 
headline, beschrijvings-caption (2-regelig ingekort), 
daaronder de geschatte bestandsgrootte (live uit 
formaat, Gaussian-count en SH-graad berekend en 
als KB/MB geformatteerd). Bij klik wordt het formaat 
geselecteerd. Geselecteerde kaart krijgt accent-
achtergrond, accent-border en een vinkje-icoon 
rechtsboven. Tooltip is de formaat-beschrijving.

E E N VO U D I G  G E Z E G D

Een kaart per formaat. Klik er een 
aan, hij wordt met accent-kleur 
en een vinkje gemarkeerd, en 
de export-knop daaronder past 
zijn tekst aan („Export PLY“, „Ex
port SPZ” enz.). Elke kaart toont 
een passend symbool, de naam, 
een twee-regelige korte uitleg en 
de geschatte bestandsgrootte bij 
je actuele trainingsresultaat. De 
grootte helpt je zinvol te kie
zen — mocht je het resultaat 
per e-mail willen sturen, neem 
de kleinste variant (meestal SPZ 
of .splat); mocht je in andere 3D-
software verder werken, neem de 
met de beste compatibiliteit (ty
pisch PLY). Bij het hoveren over 
een kaart toont de tooltip een 
uitvoerigere beschrijving, mocht 
je de verschillen tussen de for
maten onduidelijk vinden.

C-41 Video Duration-slider

WA A R

Onder het formaat-grid, alleen zichtbaar wanneer 
een video-formaat gekozen is (orbit-video of social-
video).

T E C H N I S C H

Schuifregelaar 3–30 seconden in 1-seconde-stap
pen, bindt aan de video-lengte in de app-toestand. 
Maximale breedte 300 pixels. Wordt alleen inge
blend wanneer een video-formaat geselecteerd is. 
Bij niet-video-formaten wordt de schuifregelaar vol
ledig uit de weergave verwijderd — geen dode ruim
te.

E E N VO U D I G  G E Z E G D

Mocht je een orbit-video als ex
port kiezen, kun je hier de leng
te bepalen. 3 seconden = zeer 
snelle draaiing, 30 seconden = 
langzame, rustige draaiing om je 
model. Voor sociale-media-reels 
(Instagram, TikTok) is meestal 6–
10 seconden ideaal — lang ge
noeg om het model te tonen, 
kort genoeg dat de kijkers niet 
afhaken. Bij presentaties of port
folio-video’s mag je gerust 15–
20 seconden nemen. De slider 
duikt alleen op wanneer een vi
deo-formaat geselecteerd is; bij 
bestandsformaten zoals PLY of 
SPZ zou hij zinloos zijn en is uit
geblend.
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C-42 Export-knop

WA A R

Onder het formaat-grid (en onder de duration-sli
der, mocht video gekozen).

T E C H N I S C H

Grote accent-knop. Label: „Export {formaat-naam}“, 
share-icoon. Bij klik wordt de macOS-save-dialoog 
met formaat-passende extensie en default-filename 
„scene.{ext}” geopend; bij bevestiging wordt de 
export aan de gekozen URL geschreven. Gedeacti
veerd wanneer geen trainingsresultaat aanwezig is 
of een export al loopt.

E E N VO U D I G  G E Z E G D

Klik, kies opslaglocatie in de 
macOS-dialoog, klaar — de app 
schrijft het bestand in het geko
zen formaat naar de geselecteer
de plek. Default-naam is „scene.
{extensie}“ (bijv. „scene.ply” of 
„scene.spz“), die kun je in de 
dialoog naar believen wijzigen 
voordat je opslaat. De knop is 
grijs zolang nog geen trainings
resultaat aanwezig is (zou hier 
nooit moeten gebeuren omdat 
je anders helemaal niet in de 
export-stap zou zijn) of een an
dere export al loopt. Zodra de 
export loopt, verschijnt daaron
der een voortgangsweergave; de 
app blijft bedienbaar, je kunt dus 
alvast de volgende export voor
bereiden.

C-43 Export Progress Bar

WA A R

Onder de export-knop, alleen zichtbaar terwijl een 
export loopt.

T E C H N I S C H

Voortgangsweergave met max-breedte 300 pixels, 
daaronder caption „Exporting… N %“. De waarde 
loopt van 0 tot 1 en wordt tijdens het schrijven ge
actualiseerd — bij PLY in chunks van 10.000 Gaussi
ans, bij SPZ eenmalig na kwantisatie, bij orbit-video 
in frame-intervallen.

E E N VO U D I G  G E Z E G D

Tijdens de export loopt, zie je 
hier de voortgang als smalle balk 
plus procent-weergave. PLY is 
meestal binnen seconden klaar 
omdat het bestand gewoon bi
nair wordt weggeschreven. SPZ 
heeft iets langer nodig omdat 
de data daarbij gekwantiseerd en 
gecomprimeerd worden. Orbit-
video is de meest tijdrovende ex
port — hier wordt elke afzonder
lijke frame opnieuw gerenderd; 
afhankelijk van resolutie en leng
te kan dat een minuut of langer 
duren. Tijdens de export blijft de 
app bedienbaar, je kunt dus al
vast het volgende formaat voor
bereiden of in het viewport ver
der klikken.
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C-44 Export Error Display

WA A R

Onder de progress-bar, alleen zichtbaar wanneer bij 
de laatste export een fout is opgetreden.

T E C H N I S C H

Rode regel met warning-icoon en fouttekst. Rode 
8%-achtergrond-opacity, afgeronde hoeken. Max-
breedte 400 pixels. Vaak voorkomende foutoorza
ken: SOG verwacht cwebp  in het system-PATH 
(niet App-Store-conform); schrijffout bij volle schijf
ruimte; sandbox-fout bij opslagdoelen buiten het 
toegestane gebied.

E E N VO U D I G  G E Z E G D

Mocht de export mislukken, ver
schijnt hier in rood een korte kla
re-taal-beschrijving van het pro
bleem. Meestal is de oorzaak 
voor de hand liggend — geen 
ruimte op de schijf, geen schrijf
rechten voor de doelmap, of een 
doellocatie buiten de sandbox-
toegestane gebieden. Specifiek 
bij het SOG-formaat komt het 
voor dat cwebp  in het systeem 
ontbreekt; in dat geval is SOG 
niet bruikbaar en moet je naar 
SPZ uitwijken. Mocht de foutmel
ding onduidelijk zijn, kijk in de 
log-directory (Help → Open Trai
ning Logs), daar staat uitvoeriger 
wat er mis is gegaan. In twijfel 
helpt het gewoon een andere op
slaglocatie te kiezen — bijv. het 
bureaublad.

C-46 Export History-lijst

WA A R

Rechter kant van de export-stap.

T E C H N I S C H

Lijst over de export-historie (persistent als JSON 
in de UserDefaults opgeslagen, na elke succesvol
le export onderhouden). Elke regel toont formaat-
badge (klein, accentkleurig), timestamp (HH:mm), 
bestandsnaam (1 regel ingekort) en geformatteerde 
bestandsgrootte. Klik op een regel opent Finder met 
geselecteerd bestand. Empty-state: „No exports 
yet“.

E E N VO U D I G  G E Z E G D

Een lijst van je voorgaande ex
ports — formaat, tijdstip, be
standsnaam, grootte, in chrono
logische volgorde. Klik een regel 
aan en het bestand wordt in 
Finder gemarkeerd weergegeven 
zonder dat je zelf door mappen 
moet navigeren. Praktisch wan
neer je een uur later nogmaals de 
laatste export nodig hebt en niet 
meer weet waar je het hebt op
geslagen — de history onthoudt 
dat. Mocht je nog nooit iets 
hebben geëxporteerd, staat hier 
een vriendelijke hint „No exports 
yet“. De lijst overleeft herstarts 
van de app omdat hij in de User
Defaults is opgeslagen.
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C-48 History Context Menu (rechtsklik)

WA A R

Rechtsklik op een history-regel.

T E C H N I S C H

Contextmenu op elke lijst-entry met twee acties: 
„Reveal in Finder“ (opent Finder met geselecteerd 
bestand, zoals de enkel-klik) en „Copy Path” (legt 
het volledige bestandspad als tekst in het klem
bord). Laatstgenoemde is nuttig voor drag-and-
drop in andere apps of om door te geven aan de 
commandoregel.

E E N VO U D I G  G E Z E G D

Rechtsklik op een history-en
try opent een klein menu met 
twee acties. „Reveal in Finder“ 
doet hetzelfde als een normale 
klik — opent Finder met gese
lecteerd bestand, zodat je het 
meteen ziet. „Copy Path” legt 
het complete bestandspad in het 
klembord, zodat je het bijv. in 
terminal-commando’s, in ande
re apps of in een notitie kunt 
invoegen. Vooral praktisch wan
neer je de export aan iemand 
wilt doorgeven of in een ander 
programma wilt openen dat per 
padinvoer werkt. Functioneel een 
klein, maar behulpzaam detail 
dat op Mac-typische bedienings-
patterns inzet.

Wanneer is de workflow voltooid?

Na een succesvolle export heb je je 3D-model als bestand op de schijf en de history 
toont een nieuwe entry. Er is geen „Done“-knop — je kunt naar believen veel exports 
in verschillende formaten aanhangen zonder opnieuw te trainen. Mocht je terug naar 
het voorbeeld willen (bijv. om nogmaals een camerapositie te controleren), gebruik de 
Back-knop in de onderste navigatiebalk. Mocht je een volledig nieuwe scène willen be
ginnen, ga via Back tot Z1 en gebruik daar Clear All, of File → New Project (Cmd+⇧+N).

Wissel naar Expert-modus

Druk op elk moment Cmd+2 of kies Mode → Expert Mode ( M8 ). De gehele toestand 
blijft behouden: geïmporteerde beelden, gekozen voorinstelling, lopend of afgewerkt 
training, afgewerkte puntenwolk, export-history, zelfs de actuele stage. In de Expert-
modus wordt in plaats van de vier-staps-bühne het volle Inspector-zijbalk getoond 
met alle ~150 bedieningsvelden. In het bijzonder: de Project Navigator (zie hoofdstuk 
2) biedt de uitgebreide beeld-operaties (min-knop, backspace-delete, Cmd-Z-undo, 
Quick-Look-voorbeeld), de live-preview in het viewport tijdens de training, en alle loss-, 
MCMC-, densification- en Mip-Splatting-parameters. Cmd+1 schakelt terug naar de 
beginnersmodus — ook dat verliest geen toestand.
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Veelgestelde vragen

Waarom blijft mijn Start-Processing-knop grijs?

Je hebt nog geen beelden of geen video geïmporteerd. Sleep minstens één bestand 
naar de drop-zone of gebruik „Browse Files“. Zodra de beeldlijst rechts minstens één 
entry bevat, wordt de knop actief. (Bij slechts 1–2 beelden start hij weliswaar, maar SfM 
breekt direct met fout af — zie de rode validatie-banner.)

Waarom is mijn export-knop vergrendeld?

In de beginnersmodus zijn er twee trappen: (a) Wanneer de trainings-pipeline nog niet 
klaar is en je geen hebt, is de knop gedeactiveerd — je moet eerst Z2 afronden. 
(b) Wanneer je de volledige versie nog niet hebt gekocht (PurchaseManager.hasAccess 
== false), zie je in plaats van de export-bühne een lock-aanzicht met slot-icoon en 
„Unlock Full Version“-knop, die het purchase-sheet opent. Quick- en Preview-voorin
stellingen staan training gratis toe, maar export is Premium.

Waarom kan ik geen voorinstelling kiezen?

Je kunt het kiezen — maar mocht je een Premium-voorinstelling (Balanced, Quality, 
MCMC-varianten) zonder gekochte volledige versie aantikken, springt de picker auto
matisch terug op Preview en het purchase-sheet opent zich. Quick en Preview zijn de 
enige gratis bruikbare voorinstellingen.

Waarom is mijn drop-zone leeg en gestreept-grijs hoewel ik beelden erin sleep?

Waarschijnlijk een UTI-type-mismatch. De app accepteert JPG, PNG, TIFF, HEIC, MP4, 
MOV plus de app-eigen splat-formaten. Andere beeldformaten (BMP, GIF, WebP, RAW-
formaten) worden NIET herkend. Mocht je zeker zijn dat je beeldtype erbij zou moeten 
zijn, controleer de bestandsnamen-extensie — de app gaat primair naar extensie, niet 
naar bestandsinhoud.

Waarom duurt SfM zo lang hoewel ik slechts 30 beelden heb?

Apple Photogrammetry schaalt niet lineair — bij sommige beeld-constellaties (binnen
ruimtes met complexe texturen, bewegingsonscherpte, slecht licht) heeft het duidelijk 
langer nodig dan het beeld-count laat vermoeden. Mocht SfM na 10+ minuten bij 30 
beelden nog hangen, breek af en probeer het opnieuw met beter materiaal, of wissel 
naar de Expert-modus en probeer COLMAP/Native-SfM (Cmd+2 → Inspector → Camera 
Alignment).

Waar vind ik mijn training-logs?

Help → Open Training Logs (Cmd+⇧+L). Dat opent ~/​Documents/​RadianceKit/​Logs/​. 
Elke trainingssessie schrijft een eigen JSONL-bestand met timestamp in de bestands
naam — eerste regel is de configuratie, daarna volgt een progress-regel elke 100 
iteraties, laatste regel is de summary met finale loss en success-flag.
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